Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, refer to the “Important Safety Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.

Symbol Meanings

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Protective Earth" /></td>
<td>This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>This symbol on the equipment refers you to important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td>The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td><img src="image" alt="Notice" /></td>
<td>The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Hazardous Voltages" /></td>
<td>The symbol with the word “Notice” within the equipment manual indicates a situation which, if not avoided, may result in major or minor equipment damage or a situation which could place the equipment in a non-compliant operating state.</td>
</tr>
<tr>
<td><img src="image" alt="ESD Susceptibility" /></td>
<td>This symbol is intended to alert the user to the presence of uninsulated &quot;dangerous voltage&quot; within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.</td>
</tr>
<tr>
<td><img src="image" alt="ESD Susceptibility" /></td>
<td>This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.</td>
</tr>
</tbody>
</table>

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with a dry cloth.
7) Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.

8) Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12) Unplug this apparatus during lightning storms or when unused for long periods of time.

13) Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

14) Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.

15) To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

16) The mains plug of the power supply cord shall remain readily operable.

17) The QMD-X, MD-X, QMD, or MD (Live Production Engine) chassis is to be rack mounted only.

**Warning**

18) **Indoor Use:** WARNING: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

19) The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.

20) **WARNING:** This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

21) **CAUTION:** These service instructions are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing other than that contained in the operating instructions unless you are qualified to do so (Engineering Manual only).

**Caution**

22) These apparatus contain Lithium batteries, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type. Dispose of used batteries according to the manufacturer’s instruction.

23) Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.

24) Certain parts of this equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance connectors before servicing.

25) This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical shock. Components contained within the product’s power supplies and power supply area are not intended to be customer-serviced and should be returned to the factory for repair.
26) To reduce the risk of fire, replacement fuses must be the same type and rating.

27) The safe operation of this equipment requires that the user heed and adhere to all installation and servicing instruction contained within the equipment’s Engineering Manuals.

EMC Notices

United States of America

FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Notice

Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

CANADA

This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

EUROPE

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

INTERNATIONAL

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, and found to comply with the limits for a Class A Digital device.

Notice

This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

General Handling Guidelines

• Careful handling, using proper ESD precautions, must be observed.
• Power down the system before PCB removal.
A Word About Static Discharge

Throughout the many procedures in this Engineering Manual, please observe all static discharge precautions.

Notice

Avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of ONE YEAR from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

An extended warranty is available. Contact your dealer or Ross Video for details.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
## Company Address

<table>
<thead>
<tr>
<th>Ross Video Limited</th>
<th>Ross Video Incorporated</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 John Street</td>
<td>P.O. Box 880</td>
</tr>
<tr>
<td>Iroquois, Ontario, K0E 1K0</td>
<td>Ogdensburg, New York</td>
</tr>
<tr>
<td>Canada</td>
<td>USA 13669-0880</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Contact Information</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Business Office</td>
<td>(+1) 613 • 652 • 4886</td>
</tr>
<tr>
<td>Fax</td>
<td>(+1) 613 • 652 • 4425</td>
</tr>
<tr>
<td>Technical Support</td>
<td>(+1) 613 • 652 • 4886</td>
</tr>
<tr>
<td>After hours emergency</td>
<td>(+1) 613 • 349 • 0006</td>
</tr>
<tr>
<td>E-mail (Technical Support)</td>
<td><a href="mailto:techsupport@rossvideo.com">techsupport@rossvideo.com</a></td>
</tr>
<tr>
<td>E-mail (General Information)</td>
<td><a href="mailto:solutions@rossvideo.com">solutions@rossvideo.com</a></td>
</tr>
<tr>
<td>Website</td>
<td><a href="http://www.rossvideo.com">http://www.rossvideo.com</a></td>
</tr>
</tbody>
</table>
## Contents

### Volume I

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>System Architecture</td>
<td>2</td>
</tr>
<tr>
<td>Physical Installation</td>
<td>3</td>
</tr>
<tr>
<td>Preliminary Cabling and Video Installation</td>
<td>4</td>
</tr>
<tr>
<td>Using the Menu System</td>
<td>5</td>
</tr>
<tr>
<td>Software Upgrades and Options</td>
<td>6</td>
</tr>
<tr>
<td>BNC Configuration and Check</td>
<td>7</td>
</tr>
<tr>
<td>Output Configuration</td>
<td>8</td>
</tr>
<tr>
<td>Basic Communications Setup</td>
<td>9</td>
</tr>
<tr>
<td>Custom Controls</td>
<td>10</td>
</tr>
<tr>
<td>Additional Installation Setups</td>
<td>11</td>
</tr>
<tr>
<td>Completing Setup</td>
<td>12</td>
</tr>
<tr>
<td>SmartConversion™</td>
<td>13</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>GL</td>
</tr>
<tr>
<td>Index</td>
<td>IX</td>
</tr>
</tbody>
</table>
Volume II

VTRs (Betacam)  

In This Chapter ............................................................................................................... 14-1
Supported VTRs .............................................................................................................. 14-2
Communications Connections ......................................................................................... 14-3
  VTR Interface Cable Pinouts ...................................................................................... 14-4
Communications Setup .................................................................................................... 14-7
  Setting up the Switcher .............................................................................................. 14-7
  Setting up the VTR ..................................................................................................... 14-11
Setting up VTR BNCs ..................................................................................................... 14-14
Roll VTR Setup ............................................................................................................... 14-16
VTR Custom Controls ..................................................................................................... 14-17
VTR Clip Setup ............................................................................................................... 14-20
  Programming VTR Clips ......................................................................................... 14-20
  Grabbing a Timecode .............................................................................................. 14-22
VTR Operation ................................................................................................................ 14-24
  Clip Control Overview ............................................................................................ 14-24
  Cueing a Clip Using the Keypad .............................................................................. 14-24
  VTR Remote Control Menu ..................................................................................... 14-25

Audio Servers  

In This Chapter ............................................................................................................... 15-1
Supported Audio Servers ................................................................................................. 15-2
Communications Connections ......................................................................................... 15-3
  Audio Server Interface Cable Pinouts ...................................................................... 15-4
Communications Setup ................................................................................................... 15-7
  Setting up the Switcher ............................................................................................ 15-7
  Setting up the Audio Server .................................................................................... 15-9
Roll VTR Setup ............................................................................................................... 15-12
Previewing Audio Server Clips ....................................................................................... 15-13
  Previewing Audio Server Clips .................................................................................. 15-13
Audio Server Custom Controls ....................................................................................... 15-15
Audio Server Clip Setup ................................................................................................. 15-19
  Programming Audio Server Clips .............................................................................. 15-19
Audio Server Operation ................................................................................................... 15-22
  Clip Control Overview ............................................................................................ 15-22
  Cueing a Clip Using the Keypad ................................................................................ 15-22

Video Servers (VDCP)  

In This Chapter ............................................................................................................... 16-1
Supported Video Servers ................................................................................................. 16-2
Communications Connections ......................................................................................... 16-3
  Video Server Interface Cable Pinouts ........................................................................ 16-5
Communications Setup ................................................................................................... 16-14
  Setting up the Switcher ............................................................................................ 16-14
  Setting up the Video Server .................................................................................... 16-20
Setting up Video Server BNCs ....................................................................................... 16-32
Roll VTR Setup ............................................................................................................... 16-35
Video Server Custom Controls ....................................................................................... 16-36
**Routers**  

In This Chapter ................................................................. 17-1  
Supported Routing Switchers .............................................. 17-2  
Communications Connections ............................................ 17-3  
  Router Interface Cable Pinouts ............................................. 17-4  
Communications Setup .......................................................... 17-5  
  Setting up the Switcher ...................................................... 17-15  
  Setting up the Router ....................................................... 17-18  
Setting up Router BNCs ....................................................... 17-26  
Router Custom Controls ....................................................... 17-29  
  Source/BNC Crosspoint Pair ................................................. 17-29  
  Fire a Router Salvo ............................................................ 17-30  
Router Operation .............................................................. 17-32  
  Router Communications Notes ........................................... 17-33

**External Still Stores**  

In This Chapter ........................................................................ 18-1  
Supported Still Store .............................................................. 18-2  
Communications Connections ............................................ 18-3  
  Still Store Interface Cable Pinouts ........................................ 18-4  
Communications Setup .......................................................... 18-5  
  Setting up the Switcher ...................................................... 18-5  
  Setting up the Still Store .................................................... 18-7  
Setting up Still Store BNCs ..................................................... 18-8  
Still Store Operation .......................................................... 18-10

**Audio Mixers**  

In This Chapter ........................................................................ 19-1  
Supported Audio Mixers .......................................................... 19-2  
Serial Communication Connections ...................................... 19-3  
  Connecting an Audio Mixer without a MIdIator ..................... 19-3  
  Connecting an Audio Mixer with a MIdIator ......................... 19-5  
  Connecting Multiple Audio Mixers ....................................... 19-7  
  Audio Mixer Interface Cable Pinouts ..................................... 19-9  
Ethernet Communication Connections .................................. 19-12  
  Connecting to an Ethernet Network ....................................... 19-12  
Setting Up the Switcher .......................................................... 19-13  
Setting Up the Audio Mixer .................................................... 19-19  
  Yamaha 01V96 .................................................................. 19-19  
  Yamaha 02R96 .................................................................. 19-20  
  Yamaha DM2000 ............................................................... 19-21  
  Yamaha PM5D ................................................................. 19-22  
  Yamaha M7CL-48 .............................................................. 19-22  
  Wheatstone D-9 Digital Television Audio Control System .......... 19-23  
  Calrec Sigma Digital Audio Mixing System .......................... 19-24  
  Studer Audio Mixer .......................................................... 19-24
Assigning Sources to Audio Channels ................................................................. 19-26
Setting Up Audio Channels and Groups ............................................................... 19-28
  Setting Up Audio Channels ............................................................................ 19-28
  Setting Up Audio Groups ............................................................................. 19-28
Audio Channel Assignment ................................................................................ 19-30
  Assigning Audio Channels to a BNC ............................................................. 19-30
  Audio Transition MLE Assignment ............................................................... 19-31
Setting Up Audio Overrides ............................................................................... 19-32
  Audio Custom Control Bank Setup .............................................................. 19-32
  Audio Custom Controls ................................................................................ 19-33
Audio Modes ....................................................................................................... 19-46
  Audio-Follow-Video Mode ........................................................................... 19-46
  Override Mode ............................................................................................... 19-46
  Editor Mode ................................................................................................... 19-46
Operation Overview ............................................................................................ 19-47
  Audio Transitions ......................................................................................... 19-47
Audio Specific Functions .................................................................................... 19-48
  Audio Only Transitions ................................................................................ 19-48
  Audio Levels and Pan Settings .................................................................... 19-48

Robotic Cameras 20

In This Chapter ................................................................................................... 20-1
Supported Robotic Cameras ............................................................................... 20-2
Serial Communications Connections ................................................................. 20-3
  Connecting a Robotic Camera to the Synergy Q/MD-X Switcher ................. 20-3
  Robotic Camera Interface Cable Pinouts ....................................................... 20-4
Ethernet Communication Connections ............................................................. 20-10
  Connecting to an Ethernet Network ............................................................ 20-10
Setting up the Switcher ................................................................................... 20-11
Setting up the Robotic Camera ......................................................................... 20-18
Setting up Robotic Camera BNCs ..................................................................... 20-22
Robotic Camera Custom Controls .................................................................... 20-24
  Recall Camera ............................................................................................... 20-24
  Recall a Shot ................................................................................................. 20-25
  Camera All Stop ........................................................................................... 20-27

Character Generators 21

In This Chapter ................................................................................................... 21-1
Supported Character Generators ....................................................................... 21-2
Communications Connections .......................................................................... 21-3
  Character Generator Interface Cable Pinouts ................................................ 21-4
Communications Setup ..................................................................................... 21-7
  Setting up the Switcher ................................................................................ 21-7
  Setting up the Character Generator ............................................................. 21-9
Setting up Character Generator BNCs ............................................................... 21-14
Character Generator Custom Controls .............................................................. 21-18

Monitor Walls 22

In This Chapter ................................................................................................... 22-1
Supported Monitor Walls ................................................................................... 22-2
Communications Connections .......................................................................... 22-3
  Monitor Wall Interface Cable Pinouts .......................................................... 22-4
Communications Setup ..................................................................................... 22-6
  Setting up the Switcher ................................................................................ 22-6
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up the Monitor Wall</td>
<td>22-9</td>
</tr>
<tr>
<td>Monitor Wall Under Monitor Display</td>
<td>22-12</td>
</tr>
<tr>
<td>Monitor Wall UMD Communications Connections</td>
<td>22-12</td>
</tr>
<tr>
<td>Monitor Wall UMD Interface Cable Pinouts</td>
<td>22-12</td>
</tr>
<tr>
<td>Monitor Wall UMD Communications Setup</td>
<td>22-13</td>
</tr>
<tr>
<td>Monitor Wall Custom Controls</td>
<td>22-16</td>
</tr>
<tr>
<td>Loading a Monitor Wall Layout</td>
<td>22-16</td>
</tr>
<tr>
<td>Assigning Input Channels</td>
<td>22-18</td>
</tr>
<tr>
<td>Modifying Dynamic Monitor Wall Text</td>
<td>22-20</td>
</tr>
<tr>
<td>Monitor Wall Operation</td>
<td>22-23</td>
</tr>
<tr>
<td>Layouts</td>
<td>22-23</td>
</tr>
<tr>
<td>Input Channels</td>
<td>22-23</td>
</tr>
<tr>
<td>Dynamic Text</td>
<td>22-23</td>
</tr>
</tbody>
</table>

**Editors/OverDrive**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Chapter</td>
<td>23-1</td>
</tr>
<tr>
<td>Supported Editors</td>
<td>23-2</td>
</tr>
<tr>
<td>Editor Communications Connections</td>
<td>23-3</td>
</tr>
<tr>
<td>OverDrive Communications Connections</td>
<td>23-4</td>
</tr>
<tr>
<td>OverDrive Interface Cable Pinouts</td>
<td>23-5</td>
</tr>
<tr>
<td>Editor Communications Setup</td>
<td>23-6</td>
</tr>
<tr>
<td>Setting up the Switcher</td>
<td>23-6</td>
</tr>
<tr>
<td>OverDrive Communications Setup</td>
<td>23-12</td>
</tr>
<tr>
<td>Setting up the Peripheral Port for OverDrive</td>
<td>23-12</td>
</tr>
<tr>
<td>Setting up the Aux 1 Port for OverDrive</td>
<td>23-14</td>
</tr>
<tr>
<td>OverDrive Custom Controls</td>
<td>23-16</td>
</tr>
<tr>
<td>Automation Custom Controls</td>
<td>23-16</td>
</tr>
<tr>
<td>Editor and OverDrive Operation</td>
<td>23-18</td>
</tr>
<tr>
<td>OverDrive Operation Notes</td>
<td>23-18</td>
</tr>
<tr>
<td>Using OverDrive with a Synergy 2 Switcher</td>
<td>23-18</td>
</tr>
</tbody>
</table>

**Calibration and Diagnostics**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Chapter</td>
<td>24-1</td>
</tr>
<tr>
<td>Switcher Calibration</td>
<td>24-2</td>
</tr>
<tr>
<td>Panel Diagnostic Tools</td>
<td>24-4</td>
</tr>
<tr>
<td>Displaying Panel Information</td>
<td>24-4</td>
</tr>
<tr>
<td>Potentiometer Test</td>
<td>24-5</td>
</tr>
<tr>
<td>Fader Test</td>
<td>24-5</td>
</tr>
<tr>
<td>Joystick Test</td>
<td>24-7</td>
</tr>
<tr>
<td>Button Test</td>
<td>24-8</td>
</tr>
<tr>
<td>Lamp Test</td>
<td>24-8</td>
</tr>
<tr>
<td>Memory Test</td>
<td>24-8</td>
</tr>
<tr>
<td>Display Test</td>
<td>24-9</td>
</tr>
<tr>
<td>TX/RX Test</td>
<td>24-9</td>
</tr>
<tr>
<td>Tally Test</td>
<td>24-10</td>
</tr>
<tr>
<td>DIP/Jump Test</td>
<td>24-12</td>
</tr>
<tr>
<td>Panel Monitoring</td>
<td>24-13</td>
</tr>
<tr>
<td>Frame Diagnostic Tools</td>
<td>24-17</td>
</tr>
<tr>
<td>TX/RX Test</td>
<td>24-17</td>
</tr>
<tr>
<td>GPI Test</td>
<td>24-18</td>
</tr>
<tr>
<td>LEDs Test</td>
<td>24-18</td>
</tr>
<tr>
<td>DIP Test</td>
<td>24-19</td>
</tr>
<tr>
<td>GfxBuffDDR Test</td>
<td>24-20</td>
</tr>
</tbody>
</table>
Power Supplies and Fans 25

In This Chapter ................................................................. 25-1
A Note About Redundant Power ........................................ 25-1
Replacing a Control Panel Power Supply ................................ 25-2
Calibrating the Control Panel Power Supply ...................... 25-4
Frame Power Supply ....................................................... 25-7
Power Supply Functional Components ............................. 25-7
Diagnosing a Power Supply ............................................... 25-8
Replacing a Power Supply ................................................. 25-9
Cooling Fans .................................................................... 25-12
Fan Carrier Assembly Functional Components ................. 25-12
Fan Controller Board ...................................................... 25-13
Fan Display Board .......................................................... 25-14
Cleaning the Air Filter ..................................................... 25-14

Control Panel Boards 26

In This Chapter ................................................................. 26-1
Synergy 2 Control Panel Boards .......................................... 26-2
Synergy 3 Control Panel Boards .......................................... 26-3
Synergy 4 Control Panel Boards .......................................... 26-4
Control Panel CPU Board Layout ....................................... 26-6
Rear Panel Connectors ..................................................... 26-7
Basic Interconnections ..................................................... 26-9

Frame Boards 27

In This Chapter ................................................................. 27-1
Frame Board Overview ..................................................... 27-2
Midplane (4800A-010) ..................................................... 27-2
Input Board (4800A-060) .................................................. 27-2
Output Board (4800A-064) ................................................ 27-2
Frame CPU Board (4800A-001) ........................................ 27-2
Video Processor Board (4800A-040) ................................. 27-2
Crosspoint Board (4800A-020) ......................................... 27-2
Squeeze & Tease Carrier Board (4800A-047) ..................... 27-2
Option Cards Overview .................................................. 27-3
Squeeze & Tease DSP Card (4800A-046) .......................... 27-3
Squeeze & Tease MD Card (4800A-048) .......................... 27-3
Squeeze & Tease MD WARP Card (4800AR-049) ............... 27-3
XFX Extra Effects Card (4800AR-042) ............................. 27-3
Midplane ........................................................................ 27-4
The Midplane Functional Components ......................... 27-4
Video Input Board .......................................................... 27-7
Functional Components of the Video Input Board with Reference Looping ......................... 27-7
The Video Input Board Rear Panel ................................. 27-8
Video Output Board ....................................................... 27-10
Video Output Board Functional Components .................... 27-10
Video Output Board Rear Panel ...................................... 27-12
CPU Board ..................................................................... 27-13
CPU Board Functional Components ............................... 27-13
CPU Board Rear Panel .................................................. 27-15
Video Processor Board .................................................... 27-17
Video Processor Board Functional Components ............... 27-17
Hardware Options 28

In This Chapter ........................................................................................................ 28-1
Hardware Option Overview .................................................................................. 28-2
Extended Tallies Option ....................................................................................... 28-3
Mnemonics Display Option .................................................................................. 28-5
Removing Cover Plates ........................................................................................ 28-5
Installing Mnemonics Display Modules ............................................................... 28-6
Installing Mnemonic Controller Board(s) ............................................................ 28-8
MediaCache™ Option ........................................................................................ 28-10
Upgrading the MediaCache Memory ..................................................................... 28-10
Hard Drive Replacement ...................................................................................... 28-14
Replacing the Hard Drive .................................................................................... 28-14
Remote Port Expander Cabling (BSS4) ................................................................. 28-20
Squeeze & Tease MD Option ............................................................................... 28-22
Installing the Squeeze & Tease MD Option .......................................................... 28-22
XFX Extra Effects Option ...................................................................................... 28-29
Installing the XFX Extra Effects Card ................................................................. 28-29
MediaCache™ for MLE-Store Option .................................................................. 28-31
Upgrading the MediaCache for MLE-Store Memory ............................................ 28-31
Shutdown the Switcher ......................................................................................... 28-31
Removing the Video Processor Board ................................................................. 28-32
Installing the MediaCache for MLE-Store Memory Module ................................ 28-33
Reinstalling a Video Processor Board ................................................................. 28-34
Powering-Up the Switcher .................................................................................... 28-34

Control Panel Maintenance 29

In This Chapter ........................................................................................................ 29-1
Replacing a Bulb ..................................................................................................... 29-2
Replacing a Button ................................................................................................. 29-4
Replacing a Fader .................................................................................................. 29-6
Replacing a Knob (Potentiometer) ........................................................................ 29-8
Replacing the Display ......................................................................................... 29-11

Appendix A. Specifications 30

In This Appendix .................................................................................................. 30-1
Standard Components ........................................................................................ 30-2
Physical Characteristics ....................................................................................... 30-3
General Specifications ......................................................................................... 30-3
Control Panel Specifications .............................................................................. 30-3
Rack Frame .......................................................................................................... 30-3
Rack Frame Connector Types .............................................................................. 30-4
<table>
<thead>
<tr>
<th>Appendix B. Installation Worksheets</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Appendix</td>
<td>31-1</td>
</tr>
<tr>
<td>Input Worksheet</td>
<td>31-2</td>
</tr>
<tr>
<td>Bus Map Worksheet</td>
<td>31-5</td>
</tr>
<tr>
<td>Output Worksheet</td>
<td>31-6</td>
</tr>
<tr>
<td>Remote Control Worksheet</td>
<td>31-8</td>
</tr>
<tr>
<td>Standard GPI Input Worksheet</td>
<td>31-10</td>
</tr>
<tr>
<td>Standard GPI Output Worksheet</td>
<td>31-11</td>
</tr>
<tr>
<td>Custom Control Worksheet</td>
<td>31-12</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix C. IP and Web Issues</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Appendix</td>
<td>32-1</td>
</tr>
<tr>
<td>Standard Network Security</td>
<td>32-2</td>
</tr>
<tr>
<td>Ethernet Connection Precautions</td>
<td>32-2</td>
</tr>
<tr>
<td>Understanding IP Addresses</td>
<td>32-3</td>
</tr>
<tr>
<td>IP Addresses</td>
<td>32-3</td>
</tr>
<tr>
<td>Default Services</td>
<td>32-3</td>
</tr>
<tr>
<td>Software Licenses</td>
<td>32-4</td>
</tr>
<tr>
<td>GNU General Public License</td>
<td>32-4</td>
</tr>
<tr>
<td>Lesser GNU Public License (LPGL)</td>
<td>32-7</td>
</tr>
<tr>
<td>BSD License</td>
<td>32-12</td>
</tr>
<tr>
<td>Apache License</td>
<td>32-13</td>
</tr>
<tr>
<td>Expat License</td>
<td>32-15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix D. Custom Device Protocols</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Appendix</td>
<td>33-1</td>
</tr>
<tr>
<td>Custom Devices – Uses and Limitations</td>
<td>33-2</td>
</tr>
<tr>
<td>Custom Devices Modify Menu</td>
<td>33-3</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Programming Commands</td>
<td>33-4</td>
</tr>
<tr>
<td>Programming Worksheets</td>
<td>33-6</td>
</tr>
<tr>
<td>Advanced Topics and Tables</td>
<td>33-8</td>
</tr>
</tbody>
</table>

**Glossary of Terms**

**Index**
In This Chapter

This chapter provides instructions for connecting, setting up and operating a VTR, DDR, or Video Server using the Sony Betacam protocol, with your Synergy Q/MD-X switcher. Before you begin, ensure that the VTR Remote Control option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported VTRs
- Communications Connections
- Communications Setup
- Setting up VTR BNCs
- Roll VTR Setup
- VTR Custom Controls
- VTR Clip Setup
- VTR Operation

Note

The VTR Remote Control option is required for any VTR, DDR, or Video Server that uses the Sony Betacam Protocol. This group of devices will be referred to as VTRs for this chapter.
Supported VTRs

The Synergy Series Switcher has been tested with a number of VTRs (VTRs, DDRs and Video Servers), using the Betacam Protocol, to ensure the highest standard for compatibility and reliability. The following devices are currently supported by your Synergy Q/MD-X switcher:

- Fast Forward Video Omega Digital Recorder (using the Betacam protocol)
- Alcorn McBride Digital Video Machine 2 (using the Betacam protocol)
- Accom APR Clipstore (using the Betacam protocol)
- BitCentral Précis (using the Betacam protocol)

Note: The Synergy Q/MD-X switcher will support any VTR that uses the Generic Sony Betacam Protocol. Refer to the section “Generic VTR Cabling” on page 14–6 for more information.
Communications Connections

You can connect a number of VTRs to your Synergy Q/MD-X switcher. The procedure for connecting the VTR will depend on the type of VTR you have. This section will provide general instructions for connecting the VTR to one of the Remote Ports on the back of the Synergy Control Panel.

Note

These instructions are provided as a guide, for specific information on the VTR you are connecting to the Synergy Q/MD-X switcher, refer to the documentation provided with the VTR.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **VTR Remote Control** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control a VTR.
- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your VTR. Refer to the section “VTR Interface Cable Pinouts” on page 14–4 for information on the pin-outs and connector required for your VTR. Ross Video does not supply this cable.

Use the following procedure to connect a VTR to your Synergy Q/MD-X switcher:

1. Connect and secure the **9-Pin, Male** end of the **Interface Cable** to one of the **Remote Ports** on the back of the Synergy Q/MD-X control panel.

2. Connect and secure the other end of the cable to the appropriate port on the VTR. The suggested port for each supported VTR is listed below:
   
   - **Fast Forward Video Omega Digital Recorder** — Connect the Interface cable to the RS-422 port on the Omega chassis. Refer to the section “Fast Forward Video Omega Digital Recorder VTR Cabling” on page 14–4 for more information on the cabling for this VTR.
   
   - **Alcorn McBride Digital Video Machine 2** — Connect the Interface cable to the RS-422 port on the Alcorn McBride DVM2 chassis. Refer to the section “Alcorn McBride Digital Video Machine 2 VTR Cabling” on page 14–4 for more information on the cabling for this VTR.
   
   - **BitCentral Précis** — Connect the Interface cable to the RS-422 Port on the BitCentral Précis chassis. Refer to the section “BitCentral Précis Cabling” on page 14–5 for more information on the cabling for this device.
   
   - **Generic** — Connect the Interface cable to the communications port on the chassis of the VTR. Refer to the section “Generic VTR Cabling” on page 14–6 for more information on general VTR cabling.
This completes the procedure for connecting a VTR to the Synergy Q/MD-X switcher. Refer to the section “Communications Setup” on page 14–7 for instructions on how to set up communications protocols on the Switcher, as well as on the VTR.

**VTR Interface Cable Pinouts**

Use the information in this section to connect the Interface Cable from the Synergy Q/MD-X switcher to the VTR.

*Fast Forward Video Omega Digital Recorder VTR Cabling*

The Synergy control panel connects to the Fast Forward Video Omega via the remote ports on the Synergy Q/MD-X switcher, and the RS-422 port on the Fast Forward Video Omega.

Cable connections in the following table refer only to those between the Synergy control panel and the Fast Forward Video Omega. Other cable connections present on the Fast Forward Omega can be found in the Fast Forward Video documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Fast Forward Video Omega</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected

*Alcorn McBride Digital Video Machine 2 VTR Cabling*

The Synergy control panel connects to the Alcorn McBride DVM2 via the remote ports on the Synergy Q/MD-X switcher, and the RS-422 port on the Alcorn McBride DVM2.

Cable connections in the following table refer only to those between the Synergy control panel and the Alcorn McBride DVM2. Other cable connections present on the Alcorn McBride DVM2 can be found in the Alcorn McBride documentation.
n/c = Not Connected

Accom APR Clipstore VTR Cabling

The Synergy control panel connects to the Accom APR via the remote ports on the Synergy Q/MD-X switcher, and the RS422 Master Port on the Accom APR.

Cable connections in the following table refer only to those between the Synergy control panel and the Accom APR. Other cable connections present on the Accom APR can be found in the Accom APR documentation.

BitCentral Précis Cabling

The Synergy control panel connects to the BitCentral Précis via the remote ports on the Synergy Q/MD-X switcher, and the RS-422 Port on the BitCentral Précis.

Cable connections in the following table refer only to those between the Synergy control panel and the BitCentral Précis. Other cable connections present on the BitCentral Précis can be found in the BitCentral documentation.
The Synergy control panel connects to a VTR via the remote ports on the Synergy Q/MD-X switcher. Refer to the documentation that came with your VTR for port and pinout information for your specific VTR.

### Generic VTR Cabling

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>BitCentral Précis</th>
<th>RS-422 Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td></td>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>2</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>7</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>8</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Synergy Q/MD-X RS-422 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Communications Setup

Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with a VTR, the remote port on the control panel that the VTR is connected to must be set up to communicate with the particular VTR you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a VTR:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.
3. Assign a Remote Com Port to the VTR as follows:
   - Use the Com Port knob to select the remote port on the Synergy Q/MD-X switcher that is connected to the VTR.
   - Use the Device knob to select VTR (CLIP).
4. Press Select Device to display the Select Device Menu.
5. Select the device you want to assign to the VTR communications port as follows:
   - Use the **Com Port** knob to select the communications port you want to assign a specific VTR to.
   - Use the **Device** knob to select **Betacam**.

   **Note**
   You can setup a custom device using the **CUSTOM 1** and **CUSTOM 2** options. Use these options, in conjunction with the **Custom Devices** button, to manually configure the communications protocol for your particular device. Refer to Appendix F, “Custom Device Serial Protocol” for more information.

   - Use the **VTR Preroll** knob to select the preroll interval (in frames).

   **Note**
   Preroll is applied when the **ROLL VTR** button is “armed” and the device is taken to air with a cut or auto-transition. When the transition is performed, the system will wait the selected preroll interval, and then roll the VTR. Refer to the section “Roll VTR Setup” on page 14–16 for more information.

6. Press **Com Settings** to display the **Com Settings Menu**.

   **Communications — Com Settings Menu**

7. Set the communications protocols for the VTR as follows:
   - Use the **Com Port** knob to select the VTR port you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the VTR. Refer to the section “Setting up the VTR” on page 14–11 for the specific settings for your VTR.
   - Use the **Parity** knob to select the parity, **NONE**, **ODD** or **EVEN** for the specific VTR. Refer to the section “Setting up the VTR” on page 14–11 for the specific settings for your VTR.

8. Press **Com Type** to display the **Com Type Menu**.

   **Communications — Com Type Menu**
9. Select the type of serial communications that will be used to communicate with the VTR as follows:
   - Use the **Com Port** knob to select the VTR port you want to set the communications type for.
   - Use the **Type** knob to select the type of serial communications (RS-232 or RS-422) for the selected port. Refer to the section “Setting up the VTR” on page 14–11 for the specific settings for your VTR.

   ![Note]
   **Network UDP** and **Network TCP** are not supported for this device type.

10. Press **Extra Options** to display the **Extra Options Menu**.

11. Assign a particular VTR to the selected com port as follows:
   - Use the **Com Port** knob to select the VTR port you want to assign a specific VTR to.
   - Use the **Option** knob to select **TargetMachine**.
   - Use the **Value** knob to select the VTR you want to assign to the selected com port. You can choose between the following:
     - **Generic** — Select this option to set up a device not specified in the list.
     - **FFV Omega** — Select this option to set up a Fast Forward Video Omega Digital Disk Recorder.
     - **DVM 2** — Select this option to set up an Alcorn McBride DVM2.
     - **Accom APR** — Select this option to set up an Accom APR Clipstore.
     - **BC Precis** — Select this option to set up a BitCentral Précis.

12. Set up the Decode NAKs (Not Acknowledgement) as follows:

   ![Important]
   **The Decode NAKs** option is enabled by default. The settings should only be modified if you encounter problems using the Play commands with your device or as advised by Ross Video Technical Support.
Communications — Extra Options (Decode NAKs) Menu

### Operating Tip

A NAK message is sent from the VTR to the Synergy Q/MD-X switcher to indicate that a Play command was received but not carried out. When you enable the Decode NAKs option, the Synergy Q/MD-X switcher will act upon the NAK message and resend the Play command to the VTR. You can assign the number of fields for the switcher to wait for a message before resending the Play command.

- Use the **Com Port** knob to select the VTR you want to enable the Decode NAKs option for.
- Use the **Option** knob to select **Decode NAKs**.
- Use the **Value** knob to select Yes or No as follows:
  - **Yes** — Select Yes to enable the Decode NAKs option.
  - **No** — Select No to disable the Decode NAKs option.

### Note

- The Decode NAKs option is set to **Yes** by default.
- The **Wait nFields** value is set to **0** by default.

### Communications — Extra Options (Wait nFields) Menu

13. Set the number of fields the switcher will wait before assuming the last Play command failed, or was not received, as follows:

- Use the **Com Port** knob to select the VTR you want to set up Decode NAKs for.
- Use the **Option** knob to select **Wait nFields**.
- Use the **Value** knob to select the number of fields you want the switcher to wait before assuming a NAK by default.
14. Set the number of Play command retries the switcher will attempt to send to the VTR as follows:
   - Use the **Com Port** knob to select the VTR you want to set up Decode NAKs for.
   - Use the **Option** knob to select **NPlayRetries**.
   - Use the **Value** knob to select the number times the switcher will attempt to send a Play command to the VTR.

**Note**

The **NPlayRetries** value is set to **4** by default.

15. Press **HOME** to display the **Installation Change Confirmation Screen**.

16. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the VTR, next you will have finish setting up the VTR to communicate with the Synergy Q/MD-X switcher.

**Setting up the VTR**

In order to have the Synergy Q/MD-X switcher communicate with a VTR, the VTR you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

**Fast Forward Video Omega Digital Recorder**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Fast Forward Video Omega Digital Recorder.
Use the following information to connect a Fast Forward Video Omega to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Fast Forward Omega to the Synergy Q/MD-X switcher:

  **Synergy Q/MD-X -to- Fast Forward Video Omega Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Alcorn McBride Digital Video Machine 2**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with an Alcorn McBride Digital Video Machine 2 (DVM2).

Use the following information to connect an Alcorn McBride DVM2 to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Alcorn McBride DVM2 to the Synergy Q/MD-X switcher:

  **Synergy Q/MD-X -to- Alcorn McBride DVM2 Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Accom APR Clipstore**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with an Accom APR Clipstore.

Use the following information to connect an Accom APR Clipstore to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Accom APR Clipstore to the Synergy Q/MD-X switcher:

  **Synergy Q/MD-X -to- Accom APR Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
**BitCentral Précis**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a BitCentral Précis.

Use the following information to connect a BitCentral Précis to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the BitCentral Précis to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
Setting up VTR BNCs

The VTR Setup Menu allows you to associate a VTR BNC input with a particular VTR communication port.

Use the following procedure to assign the VTR to a specific BNC input:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Type to display the BNC Type Menu.

3. Assign a BNC to VTR as follows:
   - Use the BNC knob to select the BNC that the VTR is connected to.
   - Use the Type knob to select VTR.
   - Use the Video Format knob to select the native video format of the VTR output.

   **Note**
   Assigning a Video Format to an Input BNC, that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an Aux Bus. Video formats may be converted to the operating video format using Smart Conversion. Refer to Chapter 13 “SmartConversion™”, for more information.

4. Press MORE to display the BNC Menu 2-3.
5. Assign a BNC Input to your VTR as follows:
   - Press VTR/VDCP Xpts to display the VTR/VDCP Xpts Menu.
• Use the **BNC** knob to select the BNC to assign to your VTR.
• Use the **Controller** knob to select the remote port that the VTR is connected to.

**Note**

If you select **NONE**, the BNC will not be assigned to a VTR nor will it be displayed in other Synergy menus associated with VTR control.

6. Press **HOME** to display the **Installation Change Confirmation Screen**.

7. Accept or reject the changes you have made as follows:
   • Press **Confirm** to accept the changes.
   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up a VTR to a BNC on the Synergy Q/MD-X switcher.
Roll VTR Setup

The Roll VTR Mode determines how the ROLL VTR button behaves when a VTR is selected. When you set the Roll VTR Mode, the setting affects all ROLL VTR buttons in all MLEs.

Use the following procedure to configure the Roll VTR Mode:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Roll VTR Mode.
3. Use the Value knob to select a mode for the ROLL VTR button. You can select between the following:
   - **Play** — Selecting this mode allows you to play a VTR clip directly by pressing the ROLL VTR button. Once pressed, the clip will start to play and will have to be taken on-air manually with the Fader, a Cut or Auto Transition.
   - **Arm** — Selecting this mode allows you to have a VTR clip play with the next transition that takes the MLE on-air by pressing the ROLL VTR button. This can be used to roll multiple VTRs if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a Cut, Auto Transition, or if you double-press the assigned crosspoint button.
   - **Armed Always** — Selecting this mode allows you to have a VTR clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

**Important**

When an OverDrive Production Control System production controller is connected to the switcher, activating the Editor button turns on all the Roll VTR buttons and sets the Roll VTR Mode to Arm, disabling the Roll VTR Mode selection in the Personality Menu.

**Note**

If an Auto Transition is performed with the ROLL VTR active, and in Arm Mode, the switcher will apply the Pre-Roll time for the VTR before it takes the VTR on-air.

This completes the procedure for configuring the Roll VTR Mode.
VTR Custom Controls

A custom control button can be programmed with the transport functions that are located on the VTR Clips Menu and the Remote Control Menu. This allows for quick access to these functions, or you can string a number of these functions together in a single custom control.

Use the following procedure to program custom control buttons that include special transport functions for VTRs:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Press Start Recording to display the Recording Menu.

---

**Note**

You must have the VTR Control option installed in order to control a VTR from the Synergy Q/MD-X switcher. Refer to the section “Setting up the Switcher” on page 14–7 for information on setting up a VTR.

---

**Operating Tip**

As a recommendation, keep transport control functions for similar devices grouped together on your physical custom control buttons.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **VTR** to display the **Insert VTR Menu**. This menu allows you to choose specific transport control functions to assign to the button.

**Note**
If an error message is displayed stating that there are no communications ports assigned to VTRs, ensure that the VTR you are trying to control has been properly set up.

![Insert VTR Menu](image)

6. Select a VTR function to insert as follows:
   - Use the **Device** knob to select the VTR that you want to assign the custom control to.
   - Use the **Function** knob to select the transport control function that you want to assign to the selected VTR. You can chose between the following:

   **Note**
   If you are using a **BitCentral Précis**, you can only choose between the **Play**, **Fast Forward (FFWD)**, and **Stop** commands. The **Fast Forward** command advances the VTR to the next clip in the rundown.

   - **Fast Forward** — Select this command to have the VTR go into full fast forward mode.
   - **Frame Advance** — Select this command to have the VTR move (jog) the video one frame forward.
   - **Frame Reverse** — Select this command to have the VTR move (jog) the video one frame reverse.
   - **Go to Clip** — Select this command to have the VTR cue to a selected clip.

   **Note**
   When you select **Go To Clip**, the Go To Clip knob appears, allowing you to select the number (00-99) for the clip you want to cue up.

   - **Rewind** — Select this command to have the VTR go into full fast rewind mode.
   - **Stop** — Select this command to have the VTR stop.
   - **Record** — Select this command to have the VTR go into record mode.
   - **Play** — Select this command to have the VTR go into play mode, or 1× forward.
~ **Play w/Alpha** — Select this command to have the VTR play two video clips at once (a video and an alpha). The video input BNC must have an associated alpha input BNC and the correct clip must be cued on both.

~ **Pause** — Select this command to have the VTR to into pause mode.

~ **Play Loop On** — Select this command to have the currently cued and playing clip loop back to the beginning when it finishes playing.

~ **Play Loop Off** — Select this command to have a currently looping clip stop playing the next time it reaches the clip end or outpoint.

7. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu**.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press **UP ONE** to display the **Recording Menu**.

10. Press **Finish Recording** to finish recording to the selected custom control.

This completes the procedure for programming custom control buttons that include special transport functions for VTRs.

Refer to Chapter 10, “**Custom Controls**” for more information on custom controls.
VTR Clip Setup

In order to easily recall clips on the VTR from the Synergy Q/MD-X switcher, you will have to store the clips you want to use to Clip Registers on the switcher. These Clip Registers store the location, or timecode, on the VTR for the clip, and the name of the clip.

The VTR Clips Menu allows you to perform the following functions:

- Select a VTR and a clip number.
- Grab or enter a timecode (and other device-specific data), name the clip, and store it in a clip register. Up to 100 clips can be stored (using registers 00 to 99).
- Cue and preview each clip.

Programming VTR Clips

Use the following procedure to program a VTR clip:

1. Navigate to the VTR Clips Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips.
2. Press Clip Type to display the Clip Type Menu.
3. Select the Clip Register you want to store a VTR Clip to as follows:
   - Use the Clip knob to select the Clip Register that you want to program (00-99).
   - Use the Device knob to select the remote port for the VTR you want to store the clip information for.
4. Press Name Clip to display the Clip Name Menu.

Note

The VTR Clip name is the one that will be displayed for the Clip Register on the display in the Global Memory System Group. This name will also be shown on the Remote Control Menu.
Use the **Horizontal** and **Vertical** knobs (in conjunction with the editing softkeys) to enter the desired clip name. A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.

---

**Important**

Do not enter a space as the first or last character of a clip name.

---

Press **Accept New Name** to complete the naming procedure and return to **VTR Clips Menu 1-2**. The new name is now shown in the status area and as one of the options for the **Clip** knob.

5. Select the **Timecode** to be stored in the **Clip Register** as follows:

---

**Note**

If you do not know the timecode for the clip you want to store to the Clip Register, you can manually preview the VTR video using the command on the **VTR Clips Menu 1-2** and grab the timecode. Refer to the section “**Grabbing a Timecode**” on page 14–22 for information on grabbing a timecode.

---

Press **Hours Minutes** to display the **Hours Minutes Menu**.

---

**Operating Tip**

As you adjust the Hours, Minutes, Seconds and Frames values, the corresponding fields are updated. These fields are as follows:

(hours):(minutes):(seconds):(frames).

---

- Use the **Hours** knob to adjust the hours field value.
- Use the **Minutes** knob to adjust the minutes field value.
- Press **Seconds Frames** to display the **Seconds Frames Menu**.
Use the **Seconds** knob to adjust the seconds field value.

Use the **Frames** knob to adjust the frames field value.

### Operating Tip
You can preview the Inpoint location by selecting the VTR on the PST Bus and pressing **Cue to Inpoint**.

- Press **Grab Timecode** to use the new timecode value for the Clip Register.

6. Press **HOME** to store your settings.

This completes the procedure for programming VTR clips.

### Grabbing a Timecode
If you do not know the timecode for the clip you want to store, you can manually scan the VTR video using the commands on the **VTR Clips Menu 2-2** and grab the timecode.

Use the following procedure to grab a timecode:

1. Navigate to the **VTR Clips Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Clips** ⇒ **VTR Clips**.
2. Select the Clip Register and VTR that you want to store. Refer to the section “**Programming VTR Clips**” on page 14–20 for more information on programming VTR Clips.
3. Grab a timecode as follows:
   - Press **MORE** to display **VTR Clips Menu 2-2**.

   - Cue the VTR to the desired clip location using the transport controls: **Rewind**, **Back Frame**, **Pause**, **Play**, **Ahead Frame** and **Fast Forward**.
   - Press **Pause** to hold the VTR at the desired timecode.
   - Press **MORE** ⇒ **MORE** to display the **VTR Clips Menu 1-2**.
4. Press **Grab Timecode** to grab the current timecode and display it in the **Inpoint** field.

This completes the procedure for grabbing a VTR timecode.
VTR Operation

VTR clips can be cued and played by selecting the Clip Register on the Remote Control Menu or by using the keypad in the Global Memory System Group, or by using the Clip ID from the VTR.

Clip Control Overview

There are two methods to recall VTR Clips using the keypad in the Global Memory System Group of the Synergy Q/MD-X switcher.

- **VTR Clip Number** — The VTR Clip Number is a 2 digit number that corresponds to the VTR Clip Register. Refer to the section “Programming VTR Clips” on page 14–20 for more information. When selecting a crosspoint associated with any VTR device, the keypad in the Global Memory System Group will be set to VTR Clip Number mode.

- **VTR Clip ID** — The VTR Clip ID is a 6 digit number that is established on the VTR. Leading zeros cannot be specified when entering VTR Clip ID. For example, entering 12 on the Global Memory System keypad will load Clip 12 from the device and not Clip 000012.

**Cueing a Clip Using the Keypad**

Use the following procedure to cue a VTR Clip from a VTR using the keypad in the Global Memory System Group:

1. Toggle the VTR CLIP button in the Global Memory System to display the VTR Clip ID screen.

**Operating Tip**

The same procedure can be used to cue a clip using the Clip Number. Toggle the VTR CLIP button until Clip ## VTR Clip appears in the display.

**Note**

All VTRs that support the VTR Clip ID mode, such as the Accom APR Clipstore, can toggle back to the VTR Clip Number mode by pressing the VTR Clip button.

The Clip IDs must be numeric to be able to recall them using the keypad.
2. Enter the VTR Clip ID using the keypad in the **Global Memory System Group**.

   ![Clip ID: 000012 M:015 D:008 F:20](image)

   **VTR Clip ID**

3. Press **Enter**.

This completes the procedure for cueing a clip using the keypad.

### VTR Remote Control Menu

The **VTR Remote Control Menu** allows you to cue different clips using the Clip Registers or by using the transport controls to move to different timecodes. You can then play the clip directly, or use the **ROLL VTR** button in the **MLE Transition Group** to play the clip on the next transition.

The **VTR Remote Control Menu** identifies the specific VTR you are controlling by the the BNC that it is connected to, and the communication protocol, or Type, is being used to control the VTR. Below the title are two columns, **Current Clip** and **Clip to Cue**.

- **Current Clip** — This column identifies the name of the clip (**Clip**), the timecode of the start of the clip (**Timecode**), the current timecode as the clip is playing (**Current**), and the speed at which the clip is playing (**Speed**).

- **Clip to Cue** — This column identifies the name of the clip (**Clip**), and the timecode of the start of the clip (**Timecode**).

Use the following procedure to display the **VTR Remote Control Menu**:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select**.

   ![Remote Control Select Menu](image)

   **Router Control Select Menu**

2. Press **VTR Control** to show a list of BNCs assigned to a VTR, Video Server or Audio Server.

3. Use the **BNC** knob to select the BNC you want to control.

4. Press **GO!!** to display the **VTR Remote Control Menu 1-2**.

   ![Note](image)

   **Note**

   If a “COMMUNICATIONS LOST” message appears on the menu, the Synergy Q/MD-X switcher has been unsuccessful at receiving a response from the VTR. Check the cable connections and the configuration on the switcher and the VTR.
5. Use the **Clip** knob to select the **Clip Register** you would like to Cue.

![Operating Tip]

To play or preview the clip manually from the menu, use the available transport control commands: **Rewind**, **Play**, **Pause**, and **Fast Forward**.

6. Press **Cue Clip** to have the clip listed in the **Clip to Cue** column. This clip will be the next clip taken on-air with the **ROLL VTR**. Refer to the section “Roll VTR Setup” on page 14–16 for more information on Roll VTR.

This completes the procedure for displaying the **VTR Remote Control Menu**.
Audio Servers

In This Chapter

This chapter provides instructions for connecting, setting up and operating an Audio Server protocol, with your Synergy Switcher. Before you begin, ensure that the Audio Server Control option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported Audio Servers
- Communications Connections
- Communications Setup
- Roll VTR Setup
- Previewing Audio Server Clips
- Audio Server Custom Controls
- Audio Server Clip Setup
- Audio Server Operation
Supported Audio Servers

The Synergy Series Switcher has been tested with a number of Audio Servers to ensure the highest standard for compatibility and reliability. The following devices are currently supported by your Synergy Q/MD-X switcher:

- 360 Systems DigiCart Audio Recorder
- 360 Systems DigiCart/E Audio Recorder
- Sony MiniDisc MDS-B4P MD Player (using the Sony MiniDisc ASCII protocol)
- Enco Digital Audio Delivery System (using the DAD Command Language)
Communications Connections

You can connect a number of Audio Servers to your Synergy Q/MD-X switcher. The procedure for connecting the Audio Server will depend on the type of Audio Server you have. This section will provide general instructions for connecting the Audio Server to one of the Remote Ports on the back of the Synergy Control Panel.

**Note**

These instructions are provided as a guide, for specific information on the Audio Server you are connecting to the Synergy Q/MD-X switcher, refer to the documentation provided with the Audio Server.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Audio Server Control** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control an Audio Server.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Audio Server. Refer to the section “Audio Server Interface Cable Pinouts” on page 15–4 for information on the pin-outs and connector required for your Audio Server. Ross Video does not supply this cable.

Use the following procedure to connect an Audio Server to your Synergy Q/MD-X switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Audio Server. The suggested port for each supported Audio Server is listed below:

   - **360 Systems DigiCart Audio Recorder** — Connect the Interface cable to the Serial Port 2 on the DigiCart. Refer to the section “360 Systems DigiCart Cabling” on page 15–4 for more information on the cabling for this Audio Server.

   - **360 Systems DigiCart/E Audio Recorder** — Connect the Interface cable to the AUX Serial Port on the DigiCart/E. Refer to the section “360 Systems DigiCart/E Cabling” on page 15–5 for more information on the cabling for this Audio Server.

---

**Important**

You cannot control a 360 Systems DigiCart Audio Server from a remote port on a BSS4. If you want to connect a DigiCart to the Synergy Q/MD-X switcher, you will have to use a standard Remote Port.
• **Sony MiniDisc MD Player** — Connect the Interface cable to the RS232C port on the Sony MiniDisc. Refer to the section “**Sony MiniDisc MDS-B4P Cabling**” on page 15–5 for more information on the cabling for this Audio Server.

• **Enco Digital Audio Delivery System** — Connect the Interface cable to the remote port configured for external automation on the Enco Digital Audio Delivery System. Refer to the section “**Enco Digital Audio Delivery System Cabling**” on page 15–6 for more information on the cabling for this device.

This completes the procedure for connecting an Audio Server to the Synergy Q/MD-X switcher. Refer to the section “**Communications Setup**” on page 15–7 for instructions on how to set up communications protocols on the Switcher, as well as on the Audio Server.

### Audio Server Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy Q/MD-X switcher to the Audio Server.

#### 360 Systems DigiCart Cabling

The Synergy control panel connects to the DigiCart Audio Server via the remote ports on the Synergy Q/MD-X switcher, and the Serial Port 2 on the DigiCart.

Cable connections in the following table refer only to those between the Synergy control panel and the DigiCart Audio Server. Other cable connections present on the DigiCart can be found in the DigiCart Audio Server documentation.

**Important**

Do not connect any signals to **Pin 2** of the DigiCart.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to- DigiCart Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy Control Panel</td>
</tr>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

n/c = Not Connected
**360 Systems DigiCart/E Cabling**

The Synergy control panel connects to the DigiCart/E Audio Server via the remote ports on the Synergy Q/MD-X switcher, and the AUX Serial Port on the DigiCart/E.

Cable connections in the following table refer only to those between the Synergy control panel and the DigiCart/E Audio Recorder. Other cable connections present on the DigiCart/E can be found in the 360 Systems documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>DigiCart/E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected

* Pins 4 and 6 are tied.

**Sony MiniDisc MDS-B4P Cabling**

The Synergy control panel connects to the Sony MiniDisc MD Player via the remote ports on the Synergy Q/MD-X switcher, and the RS232C Port on the MiniDisc.

Cable connections in the following table refer only to those between the Synergy control panel and the Sony MiniDisc MD Player using the ASCII protocol. Other cable connections present on the Sony MiniDisc can be found in the Sony documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Sony MiniDisc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
* Ports 4 and 6 are tied
† Ports 7 and 8 are tied

**Enco Digital Audio Delivery System Cabling**

The Synergy control panel connects to the Enco Digital Audio Delivery System via the remote ports on the Synergy Switcher, and a remote port configured for external automation on the Enco.

Cable connections in the following table refer only to those between the Synergy control panel and the Enco Digital Audio Delivery System. Other cable connections present on the Enco Digital Audio Delivery System can be found in the Enco documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Enco Digital Audio Delivery System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Communications Setup

Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with an Audio Server, the remote port on the control panel that the Audio Server is connected to must be set up to communicate with the particular Audio Server you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Audio Server:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME \ MORE \ Setup \ Installation \ Communications.

2. Press Type to display the Type Menu.

3. Assign a Remote Com port to the Audio Server as follows:
   - Use the Com Port knob to select the remote port on the Synergy Switcher that is connected to the Audio Server.
   - Use the Device knob to select Audio Server.

4. Press Select Device to select the device you want to assign to the Remote Com port as follows:
   - Use the Com Port knob to select the communications port you want to assign a specific Audio Server to.
   - Use the Device knob to select the device. You can select between the following:
     - DigiCart — Select this option to assign an 360 Systems DigiCart to the communications port.
~ **MiniDisc** — Select this option to assign a Sony MiniDisc to the communications port (using the Sony MiniDisc ASCII protocol)

~ **EncoDAD** — Select this option to assign an Enco Digital Audio Delivery System to the communications port.

6. Press **Com Settings** to display the **Com Settings Menu**.

7. Set the communications protocols for the Audio Server as follows:
   - Use the **Com Port** knob to select the Audio Server you want to set the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Audio Server. Refer to the section “Setting up the Audio Server” on page 15–9 for the specific settings for your Audio Server.
   - Use the **Parity** knob to select the parity, **NONE**, **ODD** or **EVEN** for the specific Audio Server. Refer to the section “Setting up the Audio Server” on page 15–9 for the specific settings for your Audio Server.

8. Press **Com Type** to display the **Com Type Menu**.

9. Select the type of serial communications that will be used to communicate with the Audio Server as follows:
   - Use the **Com Port** knob to select the Audio Server you want to set the communications type for.
   - Use the **Type** knob to select the type of serial communications (RS-232 or RS-422) for the selected port. Refer to the section “Setting up the Audio Server” on page 15–9 for the specific settings for your Audio Server.

   **Note**
   
   Network UDP and Network TCP are not supported for this device type.
10. Press **HOME** to display the **Installation Change Confirmation Screen**.

11. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Audio Server, next you will finish setting up the Audio Server to communicate with the Synergy Q/MD-X switcher.

**Setting up the Audio Server**

In order to have the Synergy Q/MD-X switcher communicate with an Audio Server, the Audio Server you are connecting must be set up to communicate and accept commands from the switcher.

**360 Systems DigiCart**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a 360 Systems DigiCart.

Use the following information to connect a DigiCart Audio Server to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the DigiCart Audio Server to the Synergy Q/MD-X switcher:

| Synergy Q/MD-X -to- DigiCart Communication Settings |
|---------------------------------|------------------|
| **Setting** | **Value** |
| Transmission Standard | RS-422 |
| Baud Rate | 38400 |
| Parity | Odd |
| Data Bits | 8 |
| Stop Bits | 1 |

**Important**

During operation (from the Synergy panel), the DigiCart must be enabled for remote control as per its manual.

This completes the set up of the 360 Systems DigiCart Audio Recorder.
360 Systems DigiCart/E Communication

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a 360 Systems DigiCart/E.

Use the following information to connect a DigiCart/E Audio Recorder to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the DigiCart/E Audio Recorder to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Even</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

On the 360 Systems DigiCart/E Audio Recorder, you must set up the communications parameters to allow it to properly connect to the Synergy Q/MD-X switcher. Refer to your 360 Systems documentation for further communication set up instructions.

**Important**

During operation (from the Synergy control panel), the DigiCart/E must be enabled for remote control as per its manual. Ensure the REMOTE CONTROL ADDRESS is set to 02 on the DigiCart/E.

Use the following procedure to set up the 360 Systems DigiCart/E:

1. On the SETUP MENU, select SET AUX PROTOCOL.
2. Select E-BUS to set the Aux Bus Protocol.
3. Press ENTER.

This completes the set up of the 360 Systems DigiCart/E Audio Recorder.

Sony MiniDisc MDS-B4P

This section describes the proper installation configuration required for a Synergy switcher to interface with a Sony MiniDisc using the ASCII protocol.

Use the following information to connect a Sony MiniDisc MD Player to your Synergy switcher:

- Use the following communications settings when connecting the Sony MiniDisc MD Player to the Synergy switcher:
This section describes the proper installation configuration required for a Synergy switcher to interface with an Enco Digital Audio Delivery System.

Use the following information to connect an Enco Digital Audio Delivery System to your Synergy switcher:

- Use the following communications settings when connecting the Enco Digital Audio Delivery System to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- You must configure a remote port on the Enco Digital Audio Delivery System for external automation using the DAD Command Language (DCL). Refer to your Enco documentation for setup and configuration information.

- You must create a blank Playlist on the Enco Digital Audio Delivery System, and name the Playlist “SYNERGY”. This Playlist enables the Synergy switcher to communicate with the Enco Digital Audio Delivery System.
Roll VTR Setup

The Roll VTR Mode determines how the ROLL VTR button behaves when an Audio Server is selected. When you set the Roll VTR Mode, the setting affects all ROLL VTR buttons in all MLEs.

Use the following procedure to configure the Roll VTR Mode:

1. Navigate to the Personality Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Roll VTR Mode.

3. Use the Value knob to select a mode for the ROLL VTR button. You can select between the following:
   - **Play** — This mode allows you to play an Audio Server clip directly by pressing the ROLL VTR button. Once pressed, the clip will start to play and will have to be taken on-air manually with the Fader, a Cut or Auto Transition.
   - **Arm** — This mode allows you to have an Audio Server clip play with the next transition that takes the MLE on-air by pressing the ROLL VTR button. This can be used to roll multiple Audio Servers if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a Cut, Auto Transition, or if you double-press the assigned crosspoint button.
   - **Armed Always** — Selecting this mode allows you to have an Audio Server clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

**Important**

When an OverDrive Production Control System is connected to the switcher, activating the Editor button turns on all the Roll VTR buttons and sets the Roll VTR Mode to Arm, disabling the Roll VTR Mode selection in the Personality Menu.

- **Play** — This mode allows you to play an Audio Server clip directly by pressing the ROLL VTR button. Once pressed, the clip will start to play and will have to be taken on-air manually with the Fader, a Cut or Auto Transition.
- **Arm** — This mode allows you to have an Audio Server clip play with the next transition that takes the MLE on-air by pressing the ROLL VTR button. This can be used to roll multiple Audio Servers if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a Cut, Auto Transition, or if you double-press the assigned crosspoint button.
- **Armed Always** — Selecting this mode allows you to have an Audio Server clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

**Note**

If an Auto Transition is performed with the ROLL VTR active, and in Arm Mode, the switcher will apply the Pre-Roll time for the Audio Server before it takes the Audio Server on-air.

This completes the procedure for configuring the Roll VTR Mode.
Previewing Audio Server Clips

The Audio Server Clip Menu allows you to preview your audio clips. You can verify any changes made on the device before creating Custom Controls or Clip Registers on the Synergy Q/MD-X switcher. Note that this is a preview function only, and you must create Custom Controls or Clip Registers in order to recall Audio Server clips for use during on-air production. Refer to the section “Audio Server Custom Controls” on page 15–15 for information on Custom Controls for your Audio Server.

The Audio Server Clip Menu identifies the Audio Server clip and the specific Audio Server you are controlling by the Remote Port that it is connected to. Below the title are three rows: Cut ID, Cut Name, and Cut Time.

<table>
<thead>
<tr>
<th>Note</th>
<th>If you have a Sony MiniDisc, the rows will be labeled as Track ID, Track Name, and Track Time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Cut ID — This row displays the current Drive, Directory, and Cut that has been selected. These fields are as follows 00(Drive).00(Directory)00(Cut)</td>
<td></td>
</tr>
<tr>
<td>• Cut Name — This row displays the name of the cut on the Audio Server.</td>
<td></td>
</tr>
<tr>
<td>• Cut Time — This row displays the time, or length, of the cut on the Audio Server. If you are using an Enco Digital Audio Delivery System, this row displays the current playout time on the Enco DAD for the selected clip.</td>
<td></td>
</tr>
</tbody>
</table>

Previewing Audio Server Clips

Use the following procedure to preview an Audio Server clip:

1. Navigate to the Clips Menu as follows:
   • Press HOME ⇒ MORE ⇒ Clips ⇒ Installation ⇒ Communications.
2. Press Audio Clips to display the Audio Server Clip Menu.
3. Select the device you want to preview as follows:
   • Press Device to display the Device Menu.

| Audio Server | Device
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Device: DigiCart (R1)</td>
<td>DigiCart (R1)</td>
</tr>
<tr>
<td>Cut ID: 000000</td>
<td>Cut Name:</td>
</tr>
<tr>
<td>Cut Time: 00:00:00</td>
<td></td>
</tr>
</tbody>
</table>

Audio Server — Device Menu

   • Use the Device knob to select the Audio Server you want to preview the clip information for.
4. Select the clip you want to preview as follows:
   • Press Cut ID to display the Cut ID Menu.

| Operating Tip | The Audio Server Clip Menu displays the last selected clip/track until a new one is selected. |

Synergy Q/MD-X Engineering Manual (v9.1 MD) Audio Servers • 15–13
Use the Drive knob to select the drive location on the Audio Server. Note that this knob is labeled as Disc when using a Sony MiniDisc.

Use the Directory knob to select the directory.

Use the Cut knob to select the clip number you want to preview. Note that this knob is labeled as Track when using a Sony MiniDisc.

5. Preview the selected audio clip as follows:

- Press Play to play the Audio Server clip from the selected device.
- Press Pause to pause the clip.
- Press Stop to stop the clip playout.

This completes the procedure to preview an Audio Server clip. Next you can program custom controls to play clips from your Audio Server, or setup Clip Registers for your Audio Server on the Synergy switcher.
Audio Server Custom Controls

A custom control button can be programmed with the transport functions that are located on the Audio Server Clips Menu and the Remote Control Menu. This allows for quick access to these functions, or you can string a number of these functions together in a single custom control.

Use the following procedure to program custom control buttons that include special transport functions for Audio Servers:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

     | Custom Controls Menu 1-2 |
     |---------------------------|
     | Start | Modify | Start Relative | Default |
     | Recording | Name | Recording | All Names | Delete Macro |

     Custom Controls — Recording Menu

   You must have the Audio Server Control option installed in order to control a Audio Server to the Synergy Switcher. Refer to the section “Setting up the Switcher” on page 15–7 for information on setting up a Audio Server.

   Note

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   Operating Tip

   As a recommendation, keep transport control functions for similar devices grouped together on your physical custom control buttons.

3. Press Start Recording to display the Recording Menu.

   Custom Controls — Recording Menu
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.

5. Press **MORE** to display the **Insert Special Menu 2-2**.

6. Press **Audio Server** to display the **Insert Audio Server Menu**. This menu allows you to choose specific transport control functions to assign to the button.

   **Note**

   If an error message is displayed stating that there are no communications ports assigned to Audio Servers, ensure that the Audio Server you are trying to control has been properly set up.

7. Select a drive on the Audio Server as follows:
   - Press **Drive** to display the **Drive Menu**. Note that this button is labeled as **Disc** when using a Sony MiniDisc, and as **Machine** when using the Enco DAD.
   - Use the **Device** knob to select the Audio Server that the cut is stored on.
   - Use the **Drive** knob to select the drive on the Audio Server that the cut is stored on. Note that this knob is labeled as **Disc** when using a Sony MiniDisc, and as **Machine** when using the Enco DAD and is used to select the machine or player that the cut is stored on.

8. Select a directory on the Audio Server as follows:
   - Press **Directory** to display the **Directory Menu**.

   **Audio Servers — Directory Menu**

   - Use the **Directory** knob to select the directory on the Audio Server that the cut is stored on.

9. Select a cut on the Audio Server as follows:
   - Press **Cut** to display the **Cut Menu**. Note that this button is labeled as **Track** when using a Sony MiniDisc.
Use the Cut knob to select the specific cut on the Audio Server that you want to recall using the Custom Control button. Note that this knob is labeled as Track when using a Sony MiniDisc.

10. Select an Audio Server function to insert as follows:

- Ensure the Audio Server and the clip are selected.
- Use the Command knob to select the transport control function that you want to assign to the selected Audio Server. You can choose between the following:
  ~ Go to Cut — Select this command to have the Audio Server cue to a selected cut or track.
  ~ Play — Select this command to have the Audio Server go into play mode, or 1× forward.
  ~ Pause — Select this command to have the Audio Server go into pause mode.
  ~ Stop — Select this command to have the Audio Server stop.

11. Press Insert to insert the selected command into the custom control and display the Insert Special Menu 1-2.

**Operating Tip**

Transport control functions can be strung together (while in programming mode), allowing one custom control button to perform *multiple functions* when it is pressed. For example, you can have the Go To Cut function followed by the Play function, allowing a single custom control macro to go to a cut or track and then run it.

12. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

13. Press UP ONE to display the Recording Menu.
14. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

**Note**

Any recorded custom control can be edited. Refer to Chapter 10, “**Custom Controls**”, for more information.

This completes the procedure for programming custom control buttons that include special transport functions for Audio Servers.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to Chapter 10, “**Custom Controls**”, for more information on naming custom control buttons.
Audio Server Clip Setup

In order to easily recall clips on the Audio Server from the Synergy Switcher, you will have to store the clips you want to use to Clip Registers on the switcher. These Clip Registers store the location, or cut, on the Audio Server for the clip, and the name of the clip.

The VTR Clips Menu allows you to perform the following functions:

- Select an Audio Server and a clip number.
- Grab or enter a timecode (and other device-specific data), name the clip, and store it in a clip register. Up to 100 clips can be stored (using registers 00 to 99).
- Cue each clip.

Programming Audio Server Clips

Use the following procedure to program an Audio Server clip:

1. Navigate to the VTR Clips Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips.
2. Press Clip Type to display the Clip Type Menu.
3. Select the Clip Register you want to store an Audio Server Clip to as follows:
   - Use the Clip knob to select the Clip Register that you want to program (00-99).
   - Use the Device knob to select the remote port for the Audio Server you want to store the clip information for.
   - Use the Enable/Disable knob to select if you want the clip to be displayed in the Remote Control Menu (for on-air use), or to be disabled for use later.
4. Press Name Clip to display the Clip Name Menu.

   Note
   If a clip is set to Clip Disabled, it will not be displayed on the Remote Control Menu, but you can still enter all required clip parameters. This can also be used to enable a clip that is already programmed.

5. Press Name Clip to display the Clip Name Menu.

   Note
   The Audio Server Clip name is the one that will be displayed for the Clip Register on the display in the Global Memory System Group. This name will also be shown on the Remote Control Menu.
• Use the **Horizontal** and **Vertical** knobs (in conjunction with the editing softkeys) to enter the desired clip name. A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.

⚠️ **Important**

Do not enter a space as the first or last character of a clip name.

• Press **Accept New Name** to complete the naming procedure and return to VTR Clips Menu 1-2.

### VTR Clips Menu 1-2

<table>
<thead>
<tr>
<th>Clip Type</th>
<th>Menu Clip</th>
<th>Cut Index</th>
<th>Stop</th>
<th>Play</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip: 00</td>
<td>Clip: &quot;VTR Clip&quot;</td>
<td>Device: DigiCart (R1)</td>
<td>Cut Id: 1,0000</td>
<td>Cut Name: Unknown</td>
</tr>
<tr>
<td>Clip: 01</td>
<td>Clip: &quot;VTR Clip&quot;</td>
<td>Device: DigiCart (R2)</td>
<td>Cut Id: 1,0000</td>
<td>Cut Name: Unknown</td>
</tr>
</tbody>
</table>

#### Important

Do not enter a space as the first or last character of a clip name.

**Note**

The new name is now shown in the status area and as one of the options for the **Clip** knob.

5. Press **Cut Index** to display the **Cut Index Menu**.

### VTR Clips — Cut Index Menu

The **Audio Server VTR Clips Menu** identifies the Audio Server Clip Register you are using, the name of the clip register the specific Audio Server you are controlling by the BNC that it is connected to, and the communication port that is being used to control the Audio Server. Below the title are three rows, **Cut Id**, **Cut Name**, and **Cut Time**.
• **Cut Id** — This show indicated the current Drive, Directory, and Cut that has been selected. This information is displayed as: \((\text{Drive}).(\text{Directory})000(\text{Cut})\).

• **Cut Name** — This is the name of the cut on the Audio Server.

• **Cut Time** — This is the time, or length, of the cut on the Audio Server. If you are using an Enco Digital Audio Delivery System, this row displays the current playout time on the Enco DAD for the selected clip.

6. Select a cut on the Audio Server as follows:

   • Use the **Drive** knob to select the drive \((0-6)\) on the Audio Server that the cut is stored on.

   • Use the **Directory** knob to select the directory \((0-9, \text{S})\) on the Audio Server that the cut is stored on.

   • Use the **Cut** knob to select the specific cut \((0-999)\) on the Audio Server that you want to store in the Clip Register.

7. Press **HOME** to store your settings.

This completes the procedure for programming and Audio Server clip.
Audio Server Operation

Audio Server clips can be cued and played by selecting the Clip Register by using the keypad in the Global Memory System Group.

Clip Control Overview

Audio Server Clips are recalled by using the keypad in the **Global Memory System Group** of the Synergy Switcher to enter the **VTR Clip Number**, or **Clip Register**, of the Audio Server Clip you want to recall. The **VTR Clip Number** is a 2 digit number that corresponds to the **Audio Server Clip Register**. Refer to the section “Programming Audio Server Clips” on page 15–19 for more information. When selecting a crosspoint associated with any VTR device, the keypad in the **Global Memory System Group** will be set to **VTR Clip Number** mode.

Cueing a Clip Using the Keypad

Use the following procedure to cue a **VTR Clip** from a Audio Server using the keypad in the **Global Memory System Group**:

1. Toggle the **VTR CLIP** button in the **Global Memory System** to display the VTR Clip Number screen.

2. Enter the VTR Clip Number using the keypad in the **Global Memory System Group**.

3. Press **Enter**.

This completes the procedure for cueing a clip using the keypad.
Video Servers (VDCP)

In This Chapter

This chapter provides instructions for connecting, setting up and operating a VTR, DDR, or Video Server using the VDCP protocol, with your Synergy Q/MD-X switcher. Before you begin, ensure that the Video Server Control option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

• Supported Video Servers
• Communications Connections
• Communications Setup
• Setting up Video Server BNCs
• Roll VTR Setup
• Video Server Custom Controls
• Video Server Clip Setup
• Video Server Operation

Note

The Video Server Control option is required for any VTR, DDR, or Video Server that uses the VDCP Protocol. This group of devices will be referred to as Video Servers for this chapter.
Supported Video Servers

The Synergy Series Switcher has been tested with a number of Video Servers (DDRs and Video Servers), using the VDCP Protocol, to ensure the highest standard for compatibility and reliability. The following devices are currently supported by your Synergy Q/MD-X switcher:

Note

The Synergy Q/MD-X switcher will support any Video Server that uses the **Generic VDCP Protocol**. Refer to the section “Generic Video Server Cabling” on page 16–13 for more information.

- **360 Systems Image Server 2000** (using the VDCP protocol)
- **Abekas 6000 MultiFlex DTV Production Server** (using the VDCP protocol)
- **Avid AirSpace Video Server** (using the Generic VDCP protocol)
- **Avid AirSpeed Video Server** (using the Generic VDCP protocol)
- **EVS Broadcasting Equipment maxS Video Server** (using the VDCP protocol)
- **Gee Broadcast Systems Geevs Video Server** (using the VDCP protocol)
- **GVG M-Series iVDR Video Server** (using the VDCP protocol)
- **GVG Profile Video File Server** (using the VDCP protocol)
- **GVG Turbo iDDR** (using the VDCP protocol)
- **Leitch ASC VR300 Video Server** (using either version 2 or 2.7 Leitch software and the VDCP protocol)
- **Leitch Nexio Video Server** (using the VDCP protocol)
- **Leitch VR440 Video Server** (using the VDCP protocol)
- **Omneon Video Server** (using the VDCP protocol)
- **Pinnacle Systems Thunder Video Servers** (using the VDCP protocol)
- **Pinnacle Systems ThunderLT Video Server** (using the VDCP protocol)
- **Pinnacle Systems ThunderMX Video Server** (using the VDCP protocol)
- **Ross Video SoftMetal Video Server** (using the VDCP protocol)
- **Spencer Technologies Video Server** (using the VDCP protocol)
Communications Connections

You can connect a number of Video Servers to your Synergy Q/MD-X switcher. The procedure for connecting the Video Server will depend on the type of Video Server you have. This section will provide general instructions for connecting the Video Server to one of the Remote Ports on the back of the Synergy Control Panel.

**Note**

These instructions are provided as a guide, for specific information on the Video Server you are connecting to the Synergy Q/MD-X switcher, refer to the documentation provided with the Video Server.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Video Server Control** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control a Video Server.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Video Server. Refer to the section “Video Server Interface Cable Pinouts” on page 16–5 for information on the pin-outs and connector required for your Video Server. Ross Video does not supply this cable.

Use the following procedure to connect a Video Server to your Synergy Q/MD-X switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Video Server. The suggested port for each supported Video Server is listed below:

   - **Avid AirSpace Video Server** — Connect the Interface cable to the com port on the AirSpace chassis. Refer to the section “Avid AirSpace Cabling” on page 16–5 for more information on the cabling for this Video Server.

   - **Leitch ASC VR300 Video Server** — Connect the Interface cable to the com port on the ASC VR300 chassis. Refer to the section “Leitch Video Server Cabling” on page 16–5 for more information on the cabling for this Video Server.

   - **Leitch VR440 Video Server** — Connect the Interface cable to the com port on the VR440 chassis. Refer to the section “Leitch Video Server Cabling” on page 16–5 for more information on the cabling for this Video Server.

   - **Pinnacle Systems Thunder** — Connect the Interface cable to the com port on the Thunder, ThunderLT, or ThunderMX chassis. Refer to the section “Pinnacle Systems Thunder Video Server Cabling” on page 16–6 for more information on the cabling for these Video Servers.
• **Spencer Technologies Video Server** — Connect the Interface cable to the com port on the Video Server. Refer to the section “Spencer Technologies Video Server Cabling” on page 16–7 for more information on the cabling for this Video Server.

• **Gee Broadcast Systems Geevs Video Server** — Connect the Interface cable to the com port on the Geevs chassis. Refer to the section “Gee Broadcast Systems Geevs Video Server Cabling” on page 16–7 for more information on the cabling for this Video Server.


• **EVS Broadcasting Equipment maXS Video Server** — Connect the Interface cable to the RS422 Ports (Remote), Port 1 on the maXS. Refer to the section “EVS Broadcasting Equipment maXS Video Server Cabling” on page 16–8 for more information on the cabling for this Video Server.

• **Avid AirSpeed Video Server** — Connect the Interface cable to the com port on the AirSpeed chassis. Refer to the section “Avid AirSpeed Video Server Cabling” on page 16–9 for more information on the cabling for this Video Server.

• **Omneon Video Server** — Connect the Interface cable to the com port on the Omneon chassis. Refer to the section “Omneon Video Server Cabling” on page 16–9 for more information on the cabling for this Video Server.

• **Ross Video SoftMetal Video Server** — Connect the Interface cable to the com port on the SoftMetal chassis. Refer to the section “Ross Video SoftMetal Video Server Cabling” on page 16–10 for more information on the cabling for this Video Server.

• **GVG M-Series iVDR Video Server** — Connect the Interface cable to the com port on the M-Series chassis. Refer to the section “GVG M-Series iVDR Video Server Cabling” on page 16–10 for more information on the cabling for this Video Server.

• **GVG Profile Video File Server** — Connect the Interface cable to a RS-422 Communications Port on the GVG RS-422 Connector Panel. Refer to the section “GVG Profile Video File Server Cabling” on page 16–11 for more information on the cabling for this Video Server.

• **GVG Turbo iDDR** — Connect the Interface cable to an RS422 com port on the Turbo chassis. Refer to the section “GVG Turbo iDDR Cabling” on page 16–11 for more information on the cabling for this Video Server.

• **Abekas6000 MultiFlex DTV Production Server** — Connect the Interface cable to the RS422 Serial Control Port on the Abekas chassis. Refer to the section “Abekas6000 MultiFlex DTV Production Server Cabling” on page 16–12 for more information on the cabling for this Video Server.

• **Leitch Nexio Video Server** — Connect the Interface cable to the rear panel port on the Nexio chassis for the channel you want to control. Refer to the section “Leitch Nexio Video Server Cabling” on page 16–12 for more information on the cabling for this Video Server.

• **Generic** — Connect the Interface cable to the communications port on the chassis of the Video Server. Refer to the section “Generic Video Server Cabling” on page 16–13 for more information on general Video Server cabling.

This completes the procedure for connecting a Video Server to the Synergy Q/MD-X switcher. Refer to the section “Communications Setup” on page 16–14 for instructions on how to set up communications protocols on the Switcher, as well as on the Video Server.
Video Server Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy Q/MD-X switcher to the Video Server.

Avid AirSpace Cabling

The Synergy control panel connects to the AirSpace Video Server via the remote ports on the Synergy Q/MD-X switcher, and the com port on the AirSpace.

Cable connections in the following table refer only to those between the Synergy control panel and the AirSpace Video Server. Other cable connections present on the AirSpace can be found in the Avid AirSpace documentation.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to- Avid AirSpace Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

n/c = Not Connected

Leitch Video Server Cabling

The Synergy control panel connects to the Leitch ASC VR300 and VR440 Video Servers via the remote ports on the Synergy Q/MD-X switcher.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X RS-422 Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

Refer to the documentation that came with your Video Server for port and pinout information for your specific Video Server.
**Pinnacle Systems Thunder Video Server Cabling**

The Synergy control panel connects to the Pinnacle Systems Thunder, ThunderLT, and ThunderMX Video Servers via the remote ports on the Synergy Q/MD-X switcher, and the RS-422 com ports (5-12) on the Thunder.

Cable connections in the following table refer only to those between the Synergy control panel and the RS-422 com ports (5-12) on the Thunder Video Server. This table is for use only with devices that have com ports labelled 5-12. Other cable connections present on the Thunder can be found in the Pinnacle Thunder documentation.

### Synergy Q/MD-X-to- Pinnacle Thunder V5.5 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Pinnacle Thunder V5.5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected

Cable connections in the following table refer only to those between the Synergy control panel and the RS-422 com ports (3-8) on the Thunder Video Server. This table is for use only with newer devices that have com ports labelled 3-8. Other cable connections present on the Thunder can be found in the Pinnacle Thunder documentation.

### Synergy Q/MD-X-to- Pinnacle Thunder V6.1 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Pinnacle Thunder v6.1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected
Spencer Technologies Video Server Cabling

The Synergy control panel connects to the Spencer Technologies Video Server via the remote ports on the Synergy Q/MD-X switcher.

**Synergy Q/MD-X RS-422 Wiring Chart**

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Refer to the documentation that came with your Video Server for port and pinout information for your specific Video Server.

Gee Broadcast Systems Geevs Video Server Cabling

The Synergy control panel connects to the Gee Broadcast Systems Geevs Video Server via the remote ports on the Synergy Q/MD-X switcher.

**Synergy Q/MD-X RS-422 Wiring Chart**

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Refer to the documentation that came with your Video Server for port and pinout information for your specific Video Server.
360 Systems Image Server 2000 Cabling


Cable connections in the following table refer only to those between the Synergy control panel and the Image Server 2000. Other cable connections present on the Image Server 2000 can be found in the 360 Systems Image Server 2000 documentation.

### Synergy Q/MD-X -to- Image Server 2000 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Image Server 2000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected

### EVS Broadcasting Equipment maXS Video Server Cabling

The Synergy control panel connects to the EVS maXS Video Server via the remote ports on the Synergy Q/MD-X switcher, and the RS422 Ports (Remote), Port 1 on the maXS.

**Important** You can only use **RS-422 Port 1** on the maXS to connect to the Synergy Q/MD-X switcher.

Cable connections in the following table refer only to those between the Synergy control panel and the maXS. Other cable connections present on the maXS can be found in the EVS maXS documentation.
Avid AirSpeed Video Server Cabling

The Synergy control panel connects to the AirSpeed Video Server via the remote ports on the Synergy Q/MD-X switcher, and the com port on the AirSpeed.

Cable connections in the following table refer only to those between the Synergy control panel and the AirSpeed Video Server. Other cable connections present on the AirSpeed can be found in the Avid AirSpeed documentation.

Omneon Video Server Cabling

The Synergy control panel connects to the Omneon Video Server via the remote ports on the Synergy Switcher.

Cable connections in the following table refer only to those between the Synergy control panel and the Omneon Video Server. Other cable connections present on the Omneon Video Server can be found in the Omneon documentation.
Ross Video SoftMetal Video Server Cabling

The Synergy control panel connects to the SoftMetal Video Server via the remote ports on the Synergy Q/MD-X switcher, and the com port on the SoftMetal Video Server.

Cable connections in the following table refer only to those between the Synergy control panel and the SoftMetal Video Server. Other cable connections can be found in the Ross Video SoftMetal Video Server documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>SoftMetal Video Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1 Chassis</td>
<td></td>
</tr>
<tr>
<td>2 RxA (Rx-)</td>
<td>→</td>
</tr>
<tr>
<td>3 TxB (Tx+)</td>
<td>→</td>
</tr>
<tr>
<td>4 n/c</td>
<td></td>
</tr>
<tr>
<td>5 Ground</td>
<td></td>
</tr>
<tr>
<td>6 Ground</td>
<td>→</td>
</tr>
<tr>
<td>7 RxB (Rx+)</td>
<td>→</td>
</tr>
<tr>
<td>8 TxA (Tx-)</td>
<td>→</td>
</tr>
</tbody>
</table>

GVG M-Series iVDR Video Server Cabling

The Synergy control panel connects to the M-Series Video Server via the remote ports on the Synergy Q/MD-X switcher, and the com port on the M-Series Video Server.

Cable connections in the following table refer only to those between the Synergy control panel and the M-Series Video Server. Other cable connections can be found in the M-Series Video Server documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>SoftMetal Video Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1 Chassis</td>
<td></td>
</tr>
<tr>
<td>2 RxA (Rx-)</td>
<td>→</td>
</tr>
<tr>
<td>3 TxB (Tx+)</td>
<td>→</td>
</tr>
<tr>
<td>4 n/c</td>
<td></td>
</tr>
<tr>
<td>5 Ground</td>
<td></td>
</tr>
<tr>
<td>6 Ground</td>
<td>→</td>
</tr>
<tr>
<td>7 RxB (Rx+)</td>
<td>→</td>
</tr>
<tr>
<td>8 TxA (Tx-)</td>
<td>→</td>
</tr>
</tbody>
</table>
GVG Profile Video File Server Cabling

The Synergy control panel connects to the GVG Profile via the remote ports on the Synergy Q/MD-X switcher, and a RS-422 Communications Port on the GVG RS-422 Connector Panel.

Cable connections in the following table refer only to those between the Synergy control panel and the GVG Profile. Other cable connections can be found in the GVG documentation.

GVG Turbo iDDR Cabling

The Synergy control panel connects to the GVG Turbo via the remote ports on the Synergy Q/MD-X switcher, and a RS422 Communications Port on the GVG Turbo.

Cable connections in the following table refer only to those between the Synergy control panel and the GVG Turbo. Other cable connections can be found in the GVG documentation.
Abekas6000 MultiFlex DTV Production Server Cabling

The Synergy control panel connects to the Abekas6000 MultiFlex DTV Production Server via the remote ports on the Synergy Q/MD-X switcher, and the com port on the Abekas6000.

Cable connections in the following table refer only to those between the Synergy control panel and the Abekas6000. Other cable connections can be found in the Abekas6000 documentation.

Leitch Nexio Video Server Cabling

The Synergy control panel connects to the Leitch Nexio Video Server via the remote ports on the Synergy Q/MD-X switcher, and the rear panel ports on the Leitch Nexio Video Server.

Cable connections in the following table refer only to those between the Synergy control panel and the Leitch Nexio Video Server. Other cable connections can be found in the Leitch documentation.
Generic Video Server Cabling

The Synergy control panel connects to a Video Server via the remote ports on the Synergy Q/MD-X switcher.

### Synergy Q/MD-X -to- Leitch Nexio Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Leitch Nexio</th>
<th>RS422 Com Ports</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td>2</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>8</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td>7</td>
<td>TxA (Tx-)</td>
</tr>
</tbody>
</table>

### Synergy Q/MD-X RS-422 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

Refer to the documentation that came with your Video Server for port and pinout information for your specific Video Server.
Communications Setup

Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with a Video Server, the remote port on the control panel that the Video Server is connected to must be set up to communicate with the particular Video Server you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Video Server:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.

3. Assign a Remote Com Port to the Video Server as follows:
   - Use the Com Port knob to select the remote port on the Synergy Q/MD-X switcher that is connected to the Video Server.
   - Use the Device knob to select VTR (CLIP).
4. Press Select Device to display the Select Device Menu.

5. Select the device you want to assign to the VTR communications port as follows:
   - Use the Com Port knob to select the communications port you want to assign a specific Video Server to.
   - Use the Device knob to select VDCP.
Use the VTR Preroll knob to select the preroll interval (in frames).

**Note**

Preroll is applied when the ROLL VTR button is “armed” and the device is taken to air with a cut or auto-transition. When the transition is performed, the system will wait the selected preroll interval, and then roll the Video Server. Refer to the section “Roll VTR Setup” on page 16–35 for more information.

6. Press **Com Settings** to display the **Com Settings Menu**.

7. Set the communications protocols for the Video Server as follows:
   - Use the **Com Port** knob to select the Video Server you want to set the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Video Server. Refer to the section “Setting up the Video Server” on page 16–20 for the specific settings for your Video Server.
   - Use the **Parity** knob to select the parity, **NONE**, **ODD** or **EVEN** for the specific Video Server. Refer to the section “Setting up the Video Server” on page 16–20 for the specific settings for your Video Server.

8. Press **Com Type** to display the **Com Type Menu**.

9. Select the type of serial communications that will be used to communicate with the Video Server as follows:
   - Use the **Com Port** knob to select the Video Server you want to set the communications type for.
10. Press Extra Options to display the Extra Options Menu.

11. Assign a Target Machine to the Video Server port as follows:
   - Use the Com Port knob to select the Video Server you want to set the Target Machine for.
   - Use the Option knob to select TargetMachine.
   - Use the Value knob to select the target machine that you are using.

**Important**

For the Video Servers listed in the table “Target Machine Default Values” on page 16–16, once the TargetMachine has been set, the remaining settings will automatically be adjusted to those shown in the table. You should not have to adjust these settings.

<table>
<thead>
<tr>
<th>TargetMachine Option</th>
<th>Media ID Length</th>
<th>Option Value Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Media ID Length</td>
</tr>
<tr>
<td>Generic</td>
<td>LongIDs</td>
<td>28</td>
</tr>
<tr>
<td>VR300 V2</td>
<td>ShortIDs</td>
<td>25</td>
</tr>
<tr>
<td>VR300 V2.7</td>
<td>LongIDs</td>
<td>25</td>
</tr>
<tr>
<td>PinnacleThund</td>
<td>LongIDs</td>
<td>28</td>
</tr>
<tr>
<td>Spencer</td>
<td>ShortIDs</td>
<td>50</td>
</tr>
<tr>
<td>GeeVS</td>
<td>LongIDs</td>
<td>15</td>
</tr>
<tr>
<td>360Sys IS2000</td>
<td>LongIDs</td>
<td>28</td>
</tr>
<tr>
<td>EVS MaxS</td>
<td>ShortIDs</td>
<td>6</td>
</tr>
<tr>
<td>AirSpeed</td>
<td>LongIDs</td>
<td>28</td>
</tr>
<tr>
<td>GVG M-Series</td>
<td>LongIDs</td>
<td>28</td>
</tr>
<tr>
<td>Ross SMS</td>
<td>LongIDs</td>
<td>28</td>
</tr>
<tr>
<td>ThunderMXe</td>
<td>LongIDs</td>
<td>28</td>
</tr>
</tbody>
</table>
12. Assign a Media ID Length for the selected device as follows:

Note: The Media ID Length sets the maximum character length of the Clip IDs displayed on the VTR Clips, Inpoint/Outpoint, and Remote Control Menus.

- Use the Com Port knob to select the Video Server you want to set the Media ID Length for.
- Use the Option knob to select **MediaIDLength**.
- Use the Value knob to select either **Short IDs** or **Long IDs**.
  - **Short IDs** — Select this option for devices that use ID lengths of up to 8 characters.
  - **Long IDs** — Select this option for devices that use ID lengths of up to 32 characters.

13. Assign a Timeout value to the selected device as follows:

Note: The Timeout value specifies the time, in fields, that the Synergy Q/MD-X switcher will wait for a reply from the Video Server before trying to send a command again.

- Use the Com Port knob to select the Video Server you want to set the Timeout value for.
- Use the Option knob to select **Timeout**.
- Use the Value knob to select the timeout value that you are using.

14. Assign a Send Tries value to the selected device as follows:

Note: The Send Tries value specifies the number of times that the Synergy Q/MD-X switcher will try to send the same command to the Video Server if the switcher has not received a confirmation response.

- Use the Com Port knob to select the Video Server you want to set the Send Tries value for.
- Use the Option knob to select **Send Tries**.
- Use the Value knob to select the send tries value that you are using.
15. Assign a Command Queuing value to the selected device as follows:

- Use the **Com Port** knob to select the Video Server you want to set the Command Queuing for.
- Use the **Option** knob to select **Cmd Queuing**.
- Use the **Value** knob to select either **Strict** or **Relaxed** command queuing:
  ~ **Strict** — When Command Queuing is set to Strict, the Synergy Q/MD-X switcher will keep re-sending a command, as set by the Send Tries value, until it receives a confirmation message from the Video Server.
  ~ **Relaxed** — When Command Queuing is set to Relaxed, the Synergy Q/MD-X switcher does not need to receive a confirmation from the Video Server for every command.

16. Assign a Record Time to the selected device as follows:

- Use the **Com Port** knob to select the Video Server you want to set the Record Time for.
- Use the **Option** knob to select **Record Time**.
- Use the **Value** knob to select the maximum amount of time (in minutes) that a Video Server will record when it receives the Record transport command from a custom control. The default time is set to 60 minutes, but you can assign any duration between 1 and 720 minutes.

17. Assign a Playback Mode to the selected device as follows:

- Use the **Com Port** knob to select the Video Server you want to set the Playback Mode for.
- Use the **Option** knob to select **Playback Mode**.
- Use the **Value** knob to select a Playback mode. You can chose between the following:
  ~ **PB** — Use this option if your device does not go to Electronics-to-Electronics (EE) mode.
  ~ **PB/EE** — Use this option if your device does go to EE mode. By selecting this option, you enable the serial device to automatically go into PB/EE mode. If a
Stop command is issued, the device will enter EE mode. If a pause command is issued, the device will stay in Playback mode.

18. Assign a Port Commands mode to the selected device as follows:
   - Use the **Com Port** knob to select the Video Server you want to set the Playback Mode for.
   - Use the **Option** knob to select **Port Cmds**.
   - Use the **Value** knob to select a Port Commands mode. You can chose between the following:
     ~ **No** — “Open”, “Select”, and “Close” port commands are **not** used.
     ~ **Yes** — “Open”, “Select”, and “Close” port commands are used when entering and exiting VDCP menus.

19. Select whether the switcher uses the extended character set for ClipIDs as follows:
   - Use the **Com Port** knob to select the Video Server you want to set the Playback Mode for.
   - Use the **Option** knob to select **ExtendedChar**.
   - Use the **Value** knob to select whether the switcher allows non-printing characters or not.
     ~ **No** — Use this option to have the switcher replace non-printing characters with spaces.
     ~ **Yes** — Use this option to have the switcher use the extended character set and not replace non-printing characters with spaces.

20. For looping playback, select the amount of time before the end of the clip that the switcher sends a play command as follows:
   - Use the **Com Port** knob to select the Video Server you want to set the Playback Mode for.
   - Use the **Option** knob to select **LoopReCueTime**.
   - Use the **Value** knob to select the amount of time, in frames, before the end of the clip that the switcher sends a loop command to the selected device.

   **Operating Tip**
   You may need to adjust this value to ensure smooth looping playback depending on the time it takes your Video Server to re-cue a clip.

21. Press **HOME** to display the **Installation Change Confirmation Screen**.

22. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Video Server, next you will have finish setting up the Video Server to communicate with the Synergy Q/MD-X switcher.
Setting up the Video Server

In order to have the Synergy Q/MD-X switcher communicate with a Video Server, the Video Server you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

Avid AirSpace Communication

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with an Avid AirSpace Video Server.

Use the following information to connect an Avid AirSpace Video Server to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the AirSpace Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Generic</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>

On the Avid AirSpace you will have to set the Mode to VDCP for each individual channel you have connected to the Synergy Q/MD-X switcher. Refer to your Avid AirSpace documentation for more information.

Leitch ASC VR300 Video Server

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Leitch ASC VR300 using version 2 or 2.7 of the Leitch software, and the Video Disk Communications Protocol (VDCP).

Use the following information to connect a Leitch ASC VR300 Video Server to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Leitch ASC VR300 Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>V2 Value</th>
<th>V2.7 Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>
This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Leitch VR440 using the Video Disk Communications Protocol (VDCP).

Use the following information to connect a Leitch VR440 Video Server to your switcher:

- Use the following communications settings when connecting the Leitch VR440 Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>VR300 V2</td>
<td>VR300 V2.7</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>ShortIDs</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>Send Tries</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Relaxed</td>
<td>Relaxed</td>
</tr>
</tbody>
</table>

### Leitch VR440 Video Server

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Leitch VR440 using the Video Disk Communications Protocol (VDCP).

Use the following information to connect a Leitch VR440 Video Server to your switcher:

- Use the following communications settings when connecting the Leitch VR440 Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>V2 Value</th>
<th>V2.7 Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>VR300 V2</td>
<td>VR300 V2.7</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>ShortIDs</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>Send Tries</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Relaxed</td>
<td>Relaxed</td>
</tr>
</tbody>
</table>

### Pinnacle Thunder

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Pinnacle Thunder server using the Video Disk Communications Protocol (VDCP).

This information is current for Synergy software version 9.1 MD, or higher, used in conjunction with Thunder software version 5.5 and Louth Serial Protocol uVer 5.4.19.

Use the following information to connect a Pinnacle Thunder Video Server to your switcher:

- Use the following communications settings when connecting the Thunder Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>VR440</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>ShortIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>25</td>
</tr>
<tr>
<td>Send Tries</td>
<td>2</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Relaxed</td>
</tr>
</tbody>
</table>
On the Pinnacle Thunder you will have to set up the communications parameters to allow it to properly connect to the Synergy Q/MD-X switcher.

Use the following procedure to set up the Pinnacle Thunder:

1. On the File Menu, select Preferences and click Protocol Setup to display the Protocol Setup Menu.
2. For each channel, select LouthSerial as the protocol.
3. Ensure that both the Preset/Cue and Stop Current Clip Before Preset boxes are checked.
4. Click on the associated Restart button(s), and close the dialogue box.

This completes the set up of the Pinnacle Thunder Video Server.

If you are setting up a Pinnacle Thunder with six RS-422 ports labeled as Com 3 to 8, and software version 6.1 or higher, there are additional communications parameters to setup.

Use the following procedure to setup additional communication parameters for your Pinnacle Thunder:

1. Navigate to the Device Manager as follows:
   - Right click on the My Computer icon and select Properties.
   - Select Hardware.
   - Select Device Manager.
2. For each channel, set the com settings as follows:
   - Select Com Ports.
   - Select Com.
   - Select Settings.
   - Set the Baud Rate to 38,400.
   - Set the Parity to Odd.
   - Close the dialog boxes.
3. Set the Channel Configuration as follows:
   - From the File Menu, select Preferences and click Channel Configuration to display the Channel Configuration Menu.
   - Set the com ports to control the associated channel.
   - Deselect all other channels.
   - Close the dialog boxes.

This completes the procedure to setup additional communication parameters for your Pinnacle Thunder.

**Pinnacle ThunderMX**

Use the following communications settings when connecting the Pinnacle ThunderMX Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>ThunderMXe</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>

**Pinnacle ThunderLT**

Use the following communications settings when connecting the Pinnacle ThunderLT Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>ThunderLT</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
</tbody>
</table>
Spencer Technologies Video Server

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Spencer Technologies Video Server.

Use the following information to connect a Spencer Technologies Video Server to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Spencer Technologies Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Spencer</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>ShortIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>50</td>
</tr>
<tr>
<td>Send Tries</td>
<td>2</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>

Gee Broadcast Systems Geevs

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Gee Broadcast Geevs Video Server.

Use the following information to connect a Gee Geevs Video Server to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Gee Geevs Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>GeeVS</td>
</tr>
</tbody>
</table>
This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a 360 Systems Image Server 2000.

Use the following information to connect a 360 Systems Image Server 2000 to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Image Server 2000 to the Synergy Q/MD-X switcher:

  **Synergy Q/MD-X -to- Image Server 2000 Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>15</td>
</tr>
<tr>
<td>Send Tries</td>
<td>15</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Relaxed</td>
</tr>
</tbody>
</table>

**360 Systems Image Server 2000 Communication**

On the Image Server 2000 you will have to set up the communications parameters to allow it to properly connect to the Synergy Q/MD-X switcher.

Use the following procedure to set up the Image Server 2000:

1. On the **Configuration Menu** click **System**... to open the **Configuration System Window**.
2. Select the **Control** tab.
3. In the **Serial Protocol Area**, select **VDCP** for the Channel you have connected to the Synergy Q/MD-X switcher.
4. In the **VDCP Option Area**, configure the options as follows:
   - **Cue shows 1st frame** — selected (check mark)
   - **Cue w/offset (vs timestamp)** — selected (check mark)
   - **Vari-play 1x equals play** — deselected (no check mark)
   - **Var-play 0 equals pause** — deselected (no check mark)
   - **Report Play (vs still) at end** — deselected (no check mark)
   - **Ignore preroll commands** — deselected (no check mark)
This completes the set up of the 360 Systems Image Server 2000.

**EVS Broadcast Equipment maXS Universal Production Server**

This section describes the proper installation and configuration required for a Synergy Q/MD-X switcher to interface with an EVS maXS video server.

Use the following information to connect an EVS maXS video server to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the EVS maXS video server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>EVS MaxS</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>ShortIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>6</td>
</tr>
<tr>
<td>Send Tries</td>
<td>3</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>

You must configure the maXS communications parameters to allow a proper connection to the Synergy Q/MD-X switcher. Ross Video recommends the following settings:

- Configure the EVS maXS to record clips using the VDCP 2R+2P application.
- Set the configuration for VDCP 2R+2P to Louth slave.
- Set the communication parameter to channel 1 when using the Synergy Q/MD-X switcher.

The Remote Reset Jumper 1 on the PC&CTRL Board must *not* have a jumper cap on it. Ensure that the jumper cap is on a port other than 1. Refer to your EVS maXS documentation for more information on locating and setting this jumper.

This completes the set up of the EVS maXS.

**Avid AirSpeed Communication**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with an Avid AirSpeed Video Server.

Use the following information to connect an Avid AirSpeed Video Server to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the AirSpeed Video Server to the Synergy Q/MD-X switcher:
• On the Avid AirSpeed, set the Mode to VDCP for each individual channel you have connected to the Synergy Q/MD-X switcher. Refer to your Avid AirSpeed documentation for more information.

• It is recommended that you use Channels 2 or 3 on the Avid AirSpeed.

• Ensure that the Playback Mode you select on the Synergy Communications Menu is the same mode set on the Avid AirSpeed.

This completes the set up of the Avid AirSpeed Video Server.

**Ross Video SoftMetal Video Server Communication**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Ross Video SoftMetal Video Server.

Use the following information to connect a Ross Video SoftMetal Video Server to your Synergy Q/MD-X switcher:

• Use the following communications settings when connecting the SoftMetal Video Server to the Synergy Q/MD-X switcher:

  **Synergy Q/MD-X -to- SoftMetal Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Ross SMS</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>
You must configure the SoftMetal Remote Client settings to enable communication between the SoftMetal Video Server and Synergy Q/MD-X switcher.

Use the following procedure to set the Remote Client configuration:

1. Open the SoftMetal Configuration Client as follows:
   - On the taskbar, click the **Start** button.
   - **Click All Programs ➔ Ross Video ➔ SoftMetal ➔ Configure SoftMetal.**
2. Click the **Remote Control** tab.
3. In the **Peripheral Port** drop-down list, select the port which you have connected to the Synergy Q/MD-X switcher.
4. In the **Protocol** drop-down list, select **VDCP**.
5. Click **OK** to save your settings.

**Note**

If you have a non-standard SoftMetal installation, refer to your SoftMetal documentation for more detailed configuration instructions.

This completes the procedure for setting the Remote Client configuration.

**GVG M-Series iVDR Video Server Communication**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a GVG M-Series Video Server.

Use the following information to connect a GVG M-Series Video Server to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the M-Series Video Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th><strong>Setting</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>GVG M-Series</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>Long IDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>

On the GVG M-Series iVDR, connection is made between the remote ports 1-8 on the Synergy control panel and the serial ports (PORT 1 through PORT 4) on the M-Series frame. Please refer to the GVG M-Series documentation for information on starting a remote control protocol application and setting the control port and control mode for the video players (P1 and P2).
On the Synergy Q/MD-X switcher, the channel and sub-address must be set as follows:

- **P1: Player** — channel 2, sub-address 0
- **P2: Player** — channel 4, sub-address 0

**GVG Profile Video File Server**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a GVG Profile Video File Server.

- Refer to the GVG Turbo documentation for information on setting up serial control on your device.
- Use the following communications settings when connecting the GVG Profile Video File Server to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>GVGProfile</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>

**GVG Turbo iDDR**

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a GVG Turbo iDDR.

- Refer to the GVG Turbo documentation for information on setting up serial control on your device.
- Use the following communications settings when connecting the GVG Turbo iDDR to the Synergy Q/MD-X switcher:
This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with an Abekas6000 MultiFlex DTV Production Server.

- Refer to the Abekas documentation for information on setting up serial control on your device.
- Use the following communications settings when connecting the Abekas6000 MultiFlex DTV Production Server to the Synergy Q/MD-X switcher:

### Synergy Q/MD-X -to- GVG Turbo Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>GVG Turbo</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>

### Synergy Q/MD-X -to- Abekas6000 Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Abekas6000</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>
Leitch Nexio Video Server

This section describes the proper installation configuration required for a Synergy Q/MD-X switcher to interface with a Leitch Nexio Video Server.

- Refer to the Leitch documentation for information on configuring the VDCP protocol on your Video Server.
- Use the following communications settings when connecting the Leitch Nexio Video Server to the Synergy Q/MD-X switcher:

Synergy Q/MD-X -to- Leitch Nexio Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Nexio</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>

Omneon Video Server

Use the following communications settings when connecting the Omneon Video Server to the Synergy Q/MD-X switcher:

Synergy Q/MD-X -to- Omneon Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Omneon</td>
</tr>
<tr>
<td>Media ID Length</td>
<td>LongIDs</td>
</tr>
<tr>
<td>Timeout</td>
<td>28</td>
</tr>
<tr>
<td>Send Tries</td>
<td>10</td>
</tr>
<tr>
<td>Cmd Queuing</td>
<td>Strict</td>
</tr>
</tbody>
</table>
Setting up Video Server BNCs

The Video Server Setup Menu allows you to associate a Video Server BNC input with a particular Video Server communication port.

Use the following procedure to assign the Video Server to a specific BNC input:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Type to display the BNC Type Menu.

   3. Assign a BNC to Video Server as follows:
      - Use the BNC knob to select the BNC that the Video Server is connected to.
      - Use the Type knob to select VTR.
      - Use the Video Format knob to select the native video format of the VTR output.

   **Note**
   Assigning a Video Format to an Input BNC, that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an Aux Bus. Video formats may be converted to the operating video format using Smart Conversion. Refer to Chapter 13 “SmartConversion™” for more information.

   4. Press MORE to display the BNC Menu 2-3.
5. Assign a BNC Input to your Video Server as follows:
   - Press VTR/VDCP Xpts to display the VTR/VDCP Xpts Menu.
• Use the **BNC** knob to select the BNC to assign to your Video Server.
• Use the **Controller** knob to select the remote port that the Video Server is connected to. The Remote ports assigned to the Video Server will be listed.

**Note**

If you select **NONE**, the BNC will not be assigned to a Video Server nor will it be displayed in other Synergy menus associated with VTR/VDCP control.

6. Press **MORE** to display the **BNC Menu 3-3**.

7. Select the channel and subaddress for the Video Server as follows:
   • Press **VDCP Setup** to display the **VDCP Setup Menu**.

   **BNC — VDCP Setup Menu**

   • Use the **BNC** knob to assign a BNC to your Video Server. BNCs that have been assigned to a Video Server are displayed in the list.

   • Use the **Channel** knob to select the channel on the Video Server you wish to control. For most Video Servers, you can select a channel between 0 and 8. Refer to the documentation for your device to verify its available channels.

   ~ If you are using a **360 Systems Image Server 2000**, you must select a channel between 1 and 3.

   ~ If you are using a **Pinnacle Thunder v6.1**, the channel must be set to 1.

   ~ If you are using a **Gee Broadcast Systems Geevs Video Server**, the channel must be set to 1.

   ~ If you are using an **Avid AirSpeed**, you must select channel 2 or 3.

   ~ If you are using an **Omneon Video Server**, the channel must be set to the same value as the configured VDCP Signal Port of the Omneon.

   ~ If you are using a **Ross Video SoftMetal Video Server**, you must select a channel between 1 and 4. The SubAddress will be set to the same value automatically.

   ~ If you are using a **GVG M-Series iVDR Video Server**, you must select channel 2 for player 1 or channel 4 for player 2.

   ~ If you are using a **Leitch Nexio Video Server**, you must select the channel that is controlled by the Leitch rear panel port connected to the Synergy Q/MD-X switcher.

   • Use the **SubAddress** knob to select the subaddress, or port number, of the Video Server. For most Video Servers, you can select a SubAddress between 0 and 15. Refer to the documentation for your device for more information:

   ~ If you are using a **360 Systems Image Server 2000**, the SubAddress must be set to the same value as the Channel.
~ If you are using a **Pinnacle Thunder v6.1**, the SubAddress must be set to **0**.
~ If you are using a **Gee Broadcast Systems Geevs Video Server**, the SubAddress must be set to **0**.
~ If you are using an **Avid AirSpeed**, the SubAddress for the selected channel must match the physical Remote Port it is associated with on the Avid AirSpeed. For example, if Channel 2 is associated with Remote Port 1, you must set the SubAddress to 1.
~ If you are using an **Omneon Video Server**, the SubAddress must be set to **1**.
~ If you are using a **Ross Video SoftMetal Video Server**, the SubAddress automatically follows the channel number that you set above.
~ If you are using a **GVG M-Series iVDR Video Server**, the SubAddress must be set to **0**.

8. Press **HOME** to display the **Installation Change Confirmation Screen**.

9. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up a Video Server to a BNC on the Synergy Q/MD-X switcher.
Roll VTR Setup

The Roll VTR Mode determines how the ROLL VTR button behaves when a Video Server is selected. When you set the Roll VTR Mode, the setting affects all ROLL VTR buttons in all MLEs.

Use the following procedure to configure the Roll VTR Mode:

1. Navigate to the Personality Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Roll VTR Mode.

   ![Personality — Roll VTR Mode Menu]

3. Use the Value knob to select a mode for the ROLL VTR button. You can select between the following:

   - **Play** — Selecting this mode allows you to play a Video Server clip directly by pressing the ROLL VTR button. Once pressed, the clip will start to play and will have to be taken on-air manually with the Fader, a Cut or Auto Transition.

   - **Arm** — Selecting this mode allows you to have a Video Server clip play with the next transition that takes the MLE on-air by pressing the ROLL VTR button. This can be used to roll multiple Video Servers if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a Cut, Auto Transition, or if you double-press the assigned crosspoint button.

   - **Armed Always** — Selecting this mode allows you to have a Video Server clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

   **Important**

   When an OverDrive Production Control System production controller is connected to the switcher, activating the Editor button turns on all the Roll VTR buttons and sets the Roll VTR Mode to Arm, disabling the Roll VTR Mode selection in the Personality Menu.

   - **Play** — Selecting this mode allows you to play a Video Server clip directly by pressing the ROLL VTR button. Once pressed, the clip will start to play and will have to be taken on-air manually with the Fader, a Cut or Auto Transition.

   - **Arm** — Selecting this mode allows you to have a Video Server clip play with the next transition that takes the MLE on-air by pressing the ROLL VTR button. This can be used to roll multiple Video Servers if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a Cut, Auto Transition, or if you double-press the assigned crosspoint button.

   - **Armed Always** — Selecting this mode allows you to have a Video Server clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

   **Note**

   If an Auto Transition is performed with the ROLL VTR active, and in Arm Mode, the switcher will apply the Pre-Roll time for the Video Server before it takes the Video Server on-air.

This completes the procedure for configuring the Roll VTR Mode.
Video Server Custom Controls

A custom control button can be programmed with the transport functions that are located on the Video Server Clips Menu and the Remote Control Menu. This allows for quick access to these functions, or you can string a number of these functions together in a single custom control.

Use the following procedure to program custom control buttons that include special transport functions for Video Servers:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   • Press HOME ⇒ Custom Controls.

   ![Custom Controls Menu](image)

   **Custom Controls Menu**

   **Note** You must have the Video Server Control option installed in order to control a Video Server to the Synergy Q/MD-X switcher. Refer to the section “Setting up the Switcher” on page 16–14 for information on setting up a Video Server.

2. Select the custom control button you want to record to as follows:
   • Use the Bank knob to select the custom control bank you want to record the custom control to.
   • Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   ![Operating Tip](image)

   **Operating Tip** As a recommendation, keep transport control functions for similar devices grouped together on your physical custom control buttons.

3. Press Start Recording to display the Recording Menu.

   ![Custom Controls — Recording Menu](image)
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.

5. Press **VTR** to display the **Insert VTR Menu**. This menu allows you to choose specific transport control functions to assign to the button.

**Note**

If an error message is displayed stating that there are no communications ports assigned to VTRs, ensure that the Video Server you are trying to control has been properly set up.

6. Select a Video Server function to insert as follows:

   • Use the **Device** knob to select the Video Server that you want to assign the custom control to.

   • Use the **Function** knob to select the transport control function that you want to assign to the selected Video Server. You can choose between the following:
     ~ **Fast Forward** — Select this command to have the Video Server go into full fast forward mode.
     ~ **Frame Advance** — Select this command to have the Video Server move (jog) the video one frame forward.
     ~ **Frame Reverse** — Select this command to have the Video Server move (jog) the video one frame reverse.
     ~ **Go to Clip** — Select this command to have the Video Server cue to a selected clip.

**Note**

When you select **Go To Clip**, the **Go To Clip** knob appears, allowing you to select the number (00-99) for the clip you want to cue up.

Most Video Servers allow you to enter a VTR Clip ID by toggling the **VTR Clip** button and using the keypad in the **Global Memory System**.

   ~ **Rewind** — Select this command to have the Video Server go into full fast rewind mode.
   ~ **Stop** — Select this command to have the Video Server stop.
   ~ **Record** — Select this command to have the Video Server go into record mode.

**Operating Tip**

If you are programming a **Record** custom control for a Video Server, the length of time that the Video Server will record will depend on the value assign by the Record Time. Refer to the **Record Time Extra Option** in the section “Setting up the Switcher” on page 16–14 for more information.
~ **Play** — Select this command to have the Video Server go into play mode, or 1x forward.

~ **Play w/Alpha** — Select this command to have the Video Server play two video clips at once (a video and an alpha). The video input BNC must have an associated alpha input BNC and the correct clip must be cued on both.

~ **Pause** — Select this command to have the Video Server to into pause mode.

~ **Play Loop On** — Select this command to have the currently cued and playing clip loop back to the beginning when it finishes playing.

~ **Play Loop Off** — Select this command to have a currently looping clip stop playing the next time it reaches the clip end or outpoint.

7. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu 1-2**.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press **UP ONE** to display the **Recording Menu**.

10. Press **Finish Recording** to finish recording to the selected custom control.

This completes the procedure for programming custom control buttons that include special transport functions for Video Servers.

Refer to chapter 10, “**Custom Controls**”, for more information on custom controls.
**Video Server Clip Setup**

In order to easily recall clips on the Video Server from the Synergy Q/MD-X switcher, you will have to store the clips you want to use to **Clip Registers** on the switcher. These Clip Registers store the location, inpoint and outpoint overrides, and the name of the clip.

The **VTR Clips Menu** allows you to perform the following functions:

- Select a Video Server and a clip number.
- Grab or enter a timecode (and other device-specific data), name the clip, and store it in a clip register. Up to **100** clips can be stored (using registers **00** to **99**).
- Cue and preview each clip.
- Trim the inpoint and outpoint.

**Programming Video Server Clips**

Use the following procedure to program a Video Server clip:

1. Navigate to the **VTR Clips Menu** as follows:
   - Press **HOME** → **MORE** → **Clips** → **VTR Clips**.
2. Press **Clip Type** to display the **Clip Type Menu**.

   ![Clip Type Menu](image)

3. Select the Clip Register you want to store a Video Server Clip to as follows:
   - Use the **Clip** knob to select the Clip Register that you want to program (**00** to **99**).
   - Use the **Device** knob to select the remote port for the Video Server you want to store the clip information for.
4. Press **Name Clip** to display the **Clip Name Menu**.

   ![Clip Name Menu](image)

**Note**

The **Video Server Clip** name is the one that will be displayed for the Clip Register on the display in the **Global Memory System Group**. This name will also be shown on the **Remote Control Menu**.
• Use the Horizontal and Vertical knobs (in conjunction with the editing softkeys) to enter the desired clip name. A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.

Important

Do not enter a space as the first or last character of a clip name.

• Press Accept New Name to complete the naming procedure and return to VTR Clips Menu 1-2.

5. Select a clip on the Video Server as follows:

• Press Choose ID to display the Choose ID Menu.

Operating Tip

If you know the name of the clip, press Enter ID and you can enter the name of the clip directly from the Enter Clip ID Menu.

Note

If you want to refresh the list of clips returned by the Video Server, press Refresh & Choose ID to poll the Video Server for a current list of clips. The total number of clips returned is indicated under the Showing.

• Use the ×1, ×10 or ×100 knobs to select the clip on the Video Server that you want to use.

Operating Tip

In the status area, the ID and Duration fields automatically update as you scroll, and each clip head frame will be visible if you have the Server selected on Preset.

6. Modify the Inpoint and Output of the Clip as follows:
• Press **Inpoint/Outpoint** to display the **Inpoint/Outpoint Menu**.

**Note**
If you select different start and end frames to use on air, the original inpoint and outpoint for the clip remain unchanged on the Video Server. This allows you to create sub-clips from a long master Video Server clip directly on the switcher.

---

**Inpoint/Outpoint Menu — Disabled**

• Toggle the **Enable** softkey to enable Inpoint/Outpoint Overrides:
  ~ **No** — Select this option to use the default inpoint and outpoint of the clip on the Video Server. If you have made changes to the inpoint or outpoint of the clip, these values will be saved, but not applied to clip until you select **Yes**.
  ~ **Yes** — Select this option to override the inpoint and outpoint of the clip on the Video Server. When you select **Yes**, the **Inpoint/Outpoint Menu** changes to allow you to modify the start and stop positions of the clip.

---

**Inpoint/Outpoint Menu — Enabled**

• Toggle the **Edit** softkey to **In** or **Out** to select either the Inpoint or Outpoint for editing.
  ~ **In** — Select this option to modify the inpoint, or start position, of the clip.
  ~ **Out** — Select this option to modify the outpoint, or stop position, of the clip.

**Note**
If you do not know the timecode for the Inpoint or Outpoint you want to store to the Clip Register, you can manually preview the Video Server video using the command on the **Video Server Clips Menu 2-2** and grab the timecode. Refer to the section “Grabbing a Timecode” on page 16–42 for information on grabbing a timecode.

• Press **Hours Minutes** to display the **Hours Minutes Menu**.
Inpoint/Outpoint Menu — Hours Minutes Menu

- Use the **Hours** knob to adjust the value in the hours field of the Inpoint or Outpoint.
- Use the **Minutes** knob to adjust the value in the minutes field of the Inpoint or Outpoint.
- Press **Seconds Frames** to display the Seconds Frames Menu.

Inpoint/Outpoint Menu — Seconds Frames Menu

- Use the **Seconds** knob to adjust the seconds field of the Inpoint or Outpoint.
- Use the **Frames** knob to adjust the frames field of the Inpoint or Outpoint.

You can preview the Timecode location by selecting the Video Server on the PST Bus and pressing **Cue to Timecode**.

- Press **Grab Timecode** to use the new timecode value for the Inpoint or Outpoint.

7. Press **HOME** to store your settings.

This completes the procedure for programming Video Server clips.

**Grabbing a Timecode**

If you do not know the timecode for the inpoint or outpoint, you can manually scan the Video Server video using the commands on the Video Server Clips Menu 2-2 and grab the timecode.

Use the following procedure to grab a timecode:

1. Navigate to the VTR Clips Menu 1-2 as follows:
2. Select the Clip Register and Video Server that you want to store. Refer to the section “Programming Video Server Clips” on page 16–39 for more information on programming Video Server Clips.

3. Grab a timecode as follows:

   - Press MORE to display VTR Clips Menu 2-2.

   ```markdown
   VTR Clips Menu — VTR Transport Controls
   ```

   ```markdown
   Clip: 07  Clip Name: "VTR Clip"
   Devices: BNC CH1 (RI)
   Inpoint: 00:00:00:00
   ```

   - Cue the Video Server to the desired clip location using the transport controls: **Rewind, Back Frame, Pause, Play, Ahead Frame** and **Fast Forward**.
   - Press Pause to hold the Video Server at the desired timecode.
   - Press MORE ⇒ MORE to display the VTR Clips Menu 1-2.
   - Press Grab Timecode to grab the current timecode and display it in the Timecode field.

4. Press HOME to store your settings.

This completes the procedure for grabbing a Video Server timecode.
Video Server Operation

Video Server clips can be cued and played by selecting the Clip Register on the Remote Control Menu or by using the keypad in the Global Memory System Group, or by using the Clip ID from the Video Server.

Clip Control Overview

There are two methods to recall Video Server Clips using the keypad in the Global Memory System Group of the Synergy Q/MD-X switcher.

- **VTR Clip Number** — The VTR Clip Number is a 2 digit number that corresponds to the Video Server Clip Register. Refer to the section “Programming Video Server Clips” on page 16–39 for more information. When selecting a crosspoint associated with any VTR device, the keypad in the Global Memory System Group will be set to VTR Clip Number mode.

- **VTR Clip ID** — The VTR Clip ID is a 6 digit number that is established on the Video Server. Leading zeros cannot be specified when entering VTR Clip ID. For example, entering 12 on the Global Memory System keypad will load Clip 12 from the device and not Clip 000012.

~ All Video Servers, except the EVS maXS, support the VTR Clip ID mode and can toggle back to the VTR Clip Number mode by pressing the VTR Clip button.

~ Clip IDs must be numeric to be able to recall them using the keypad.

Cueing a Clip Using the Keypad

Use the following procedure to cue a VTR Clip from a Video Server using the keypad in the Global Memory System Group:

1. Toggle the VTR CLIP button in the Global Memory System to display the VTR Clip ID screen.

   ![VTR Clip ID](Clip ID: 000000 M:015 D:008 F:20)

The same procedure can be used to cue a clip using the Clip Number. Toggle the VTR CLIP button until Clip ## VTR Clip appears in the display.

   ![VTR CLIP](Clip: 00 VTR Clip M:015 D:008 F:20)

   VTR Clip Number

   ![VTR CLIP](Clip ID: 000000 M:015 D:008 F:20)

   VTR Clip ID

Operating Tip

The same procedure can be used to cue a clip using the Clip Number. Toggle the VTR CLIP button until Clip ## VTR Clip appears in the display.

   "VTR CLIP"

1. Toggle the VTR CLIP button in the Global Memory System to display the VTR Clip ID screen.
2. Enter the VTR Clip ID using the keypad in the Global Memory System Group.

3. Press Enter.

This completes the procedure for cueing a clip using the keypad.

**Video Server Remote Control Menu**

The Video Server Remote Control Menu allows you to cue different clips using the Clip Registers or by using the transport controls to move to different timecodes. You can then play the clip directly, or use the ROLL VTR button in the MLE Transition Group to play the clip on the next transition.

Use the following procedure to display the Video Server Remote Control Menu:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.

   **Router Control Select Menu**

2. Press VTR Control to show a list of BNCs assigned to a VTR, Video Server or Audio Server.

3. Use the BNC knob to select the BNC you want to control.

4. Press GO!! to display the Video Server Remote Control Menu 1-2.

   **Note**

   If a “COMMUNICATIONS LOST” message appears on the menu, the Synergy Q/MD-X switcher has been unsuccessful at receiving a response from the Video Server. Check the cable connections and the configuration on the switcher and the Video Server.

   **Video Server Remote Control Menu 1-2**

   The Video Server Remote Control Menu 1-2 identifies the specific Video Server you are controlling by the BNC that it is connected to, and the communication protocol, or
Type, that is being used to control the Video Server. Below the title are two columns, **Current Clip** and **Clip to Cue**.

- **Current Clip** — This column identifies the name of the clip (**Clip**), the length of time the clip will play (**Duration**), and the Inpoint and Outpoint overrides that have been set (**In / Out**). At the bottom of the column is a progress bar indicating the current progress or time into the clip as it is being played.

- **Clip to Cue** — This column identifies the name of the clip (**Clip**), the length of time the clip will play (**Duration**), and the Inpoint and Outpoint overrides that have been set (**In / Out**).

5. Use the **Clip** knob to select the enabled **Clip Register** you would like to Cue.

| Note | The last clip cued or recalled using the keypad is shown at the bottom of the list with the (**ID**) label. |
| Operating Tip | To play or preview the clip manually from the menu, use the available transport control commands: **Rewind**, **Play**, **Pause**, and **Fast Forward**. |

6. Press **Cue Clip** to have the clip listed in the **Clip to Cue** column. This clip will be the next clip taken on-air with the **ROLL VTR**. Refer to the section “**Roll VTR Setup**” on page 16–35 for more information on Roll VTR.

This completes the procedure for displaying the **Video Server Remote Control Menu**.
Routers

In This Chapter

This chapter provides instructions for connecting, setting up and operating a Router with your Synergy Q/MD-X switcher. Before you begin, ensure that the Routing Switcher Interface option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported Routing Switchers
- Communications Connections
- Communications Setup
- Setting up Router BNCs
- Router Custom Controls
- Router Operation
Supported Routing Switchers

The Synergy Series Switcher has been tested with a number of Routers to ensure the highest standard for compatibility and reliability. The following Routers are currently supported by your Synergy Q/MD-X switcher:

- **Philips Jupiter Router** (using the ESswitch protocol)
- **PESA Cougar Router** (using the CPU-Link protocol)
- **Pro-Bel Freeway Router** (using the General Remote Control protocol)
- **Pro-Bel Halo Router** (using the General Remote Communication protocol)
- **Codan Kondor EOS-2000 Router** (using the Geneos protocol)
- **GVG SMS 7000 Router** (using the GVG Native protocol)
- **GVG Encore Control System** (using the GVG Native protocol)
- **Codan Kondor** (using the Codan ASCII protocol)
- **Codan NK Router** (using the Codan ASCII protocol)
- **Sierra Yosemite Router** (using the Native protocol)
- **Utah Scientific Router** (using the Utah RCP-1 Protocol)
Communications Connections

You can connect a number of Routers to your Synergy Q/MD-X switcher. The procedure for connecting the Router will depend on the type of Router you have. This section will provide general instructions for connecting the Router to one of the Remote Ports on the back of the Synergy Control Panel.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Routing Switcher Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control a Router.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Router. Refer to the section "Router Interface Cable Pinouts" on page 17–4 for information on the pin-outs and connector required for your Router. Ross Video does not supply this cable.

Use the following procedure to connect a Router to your Synergy Q/MD-X switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Router. The suggested port for each supported Router is listed below:

   - **Philips Jupiter Router** — Connect the Interface cable to an odd numbered (1, 3, 5, 7) serial port on the rear of the Jupiter chassis. Refer to the section “Philips Jupiter Router Cabling” on page 17–4 for more information on the cabling for this Router.
• **PESA Cougar Router** — Connect the Interface cable to the PESA port on the External Controller for the PESA Cougar Router. Refer to the section “**PESA Cougar Router Cabling**” on page 17–5 for more information on the cabling for this Router.

• **Pro-Bel Freeway Router** — Connect the Interface cable to the RS-485-2 port on the rear of the Chyron Freeway chassis. Refer to the section “**Pro-Bel Freeway Router Cabling**” on page 17–6 for more information on the cabling for this Router.

• **Pro-Bel Halo Router** — Connect the Interface cable to the CTRL 2 port on the rear of the Pro-Bel Halo chassis. Refer to the section “**Pro-Bel Halo Router Cabling**” on page 17–7 for more information on the cabling for this Router.

• **Codan Kondor EOS-2000 Router** — Connect the Interface cable to the PC Port on the Codan Kondor chassis, or the Device port on the CPU Port Expander. Refer to the section “**Codan Kondor EOS-2000 Router Cabling**” on page 17–7 for more information on the cabling for this Router.

• **Grass Valley SMS 7000 Router** — Connect the Interface cable to the ASYNC RS-232 port or the ASYNC RS-422-3 port on the rear of the SMS 7000 chassis. Refer to the section “**GVG SMS 7000 Router Cabling**” on page 17–9 for more information on the cabling for this Router.

• **GVG Encore Control System** — Connect the Interface cable to the one of the RS-422/RS-485 SIO ports (5-8) on the rear of the GVG Encore Control System chassis. Refer to the section “**GVG Encore Control System Cabling**” on page 17–10 for more information on the cabling for this device.

• **Codan Kondor Router** — Connect the Interface cable to the AUX com port on the Kondor chassis. Refer to the section “**Codan Kondor Cabling**” on page 17–11 for more information on the cabling for this Router.

• **Codan NK Router** — Connect the Interface cable to T-Bus port on the Codan NK Router. Refer to the section “**Codan NK Router Cabling**” on page 17–12 for more information on the cabling for this Router.

• **Sierra Yosemite Router** — Connect the Interface cable to Host Port (RS232/422 Port 2) on the Sierra Yosemite chassis. Refer to the section “**Sierra Yosemite Router Cabling**” on page 17–13 for more information on the cabling for this Router.

• **Utah Scientific Router** — Connect the Interface cable to RS-232 connector port 1, 3, or 5 on the Utah Scientific Router chassis. Refer to the section “**Utah Scientific Router Cabling**” on page 17–14 for more information on cabling for this Router.

This completes the procedure for connecting a Router to the Synergy Q/MD-X switcher. Refer to the section “**Communications Setup**” on page 17–15 for instructions on how to set up communications protocols on the Switcher, as well as on the Router.

## Router Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy Q/MD-X switcher to the Router.

### Philips Jupiter Router Cabling

The Synergy control panel connects to the Jupiter Router via the remote ports on the Synergy control panel, and an odd numbered (1, 3, 5, 7) serial port on the rear of the Jupiter chassis.
Cable connections in the following table refer only to those between the Synergy control panel and the Philips Jupiter Router. Other cable connections present on the Jupiter Router can be found in the Philips Jupiter documentation.

### Synergy Q/MD-X -to- Philips Jupiter Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Philips Jupiter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected

**PESA Cougar Router Cabling**

The Synergy control panel connects to the PESA Cougar Router via the remote ports on the Synergy control panel, and the External Controller for the Cougar chassis.

**Note**

In order to use the RS-422 communications protocol, you may have to use an External Controller to interface between the Cougar and the Synergy Q/MD-X switcher. Refer to your PESA Cougar documentation for more information on controlling your Router remotely.

Cable connections in the following table refer only to those between the Synergy control panel and the Pesa Cougar Router. Other cable connections present on the Cougar chassis can be found in the Pesa Cougar documentation.
Pro-Bel Freeway Router Cabling

The Synergy control panel connects to the Chyron Freeway Router via the remote ports on the Synergy control panel and the RS-485-2 port on the rear of the Chyron Freeway chassis.

**Important**

The Freeway must be configured to allow it to be controlled using the RS-485-2 port. For information concerning this set up, refer to your Chyron (Pro-Bel) Freeway documentation or contact your sales representative at Chyron (Pro-Bel).

Cable connections in the following table refer only to those between the Synergy control panel and the Chyron Freeway Router. Other cable connections present on the Freeway Router can be found in the Chyron Freeway documentation.

---

### Synergy Q/MD-X -to- PESA Cougar Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Remote Port</th>
<th>Signal</th>
<th>Pesa Cougar</th>
<th>PESA Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
<td>Ground</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>RxA (Rx-)</td>
<td>3</td>
<td>Tx-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>TxB (Tx+)</td>
<td>2</td>
<td>Rx+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
<td>Ground</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Ground</td>
<td>6</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>RxB (Rx+)</td>
<td>8</td>
<td>Tx+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>TxA (Tx-)</td>
<td>7</td>
<td>Rx-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
<td>Ground</td>
</tr>
</tbody>
</table>

n/c = Not Connected

---

### Synergy Q/MD-X -to- Pro-Bel Freeway Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Remote Port</th>
<th>Signal</th>
<th>Pro-Bel Freeway</th>
<th>RS-485-2 Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>RxA (Rx-)</td>
<td>2</td>
<td>Tx-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>TxB (Tx+)</td>
<td>3</td>
<td>Rx+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>RxB (Rx+)</td>
<td>7</td>
<td>Tx+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>TxA (Tx-)</td>
<td>8</td>
<td>Rx-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
</tbody>
</table>

n/c = Not Connected
**Pro-Bel Halo Router Cabling**

The Synergy control panel connects to the Pro-Bel Halo Router via the remote ports on the Synergy control panel and the CTRL 2 port on the rear of the Pro-Bel Halo chassis.

**Important**

The Pro-Bel Halo must be configured to allow it to be controlled using the CTRL 2 port. For information concerning this setup, refer to your Pro-Bel documentation.

Cable connections in the following table refer only to those between the Synergy control panel and the Pro-Bel Halo Router. Other cable connections present on the Router can be found in the Pro-Bel documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Pro-Bel Halo</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Codan Kondor EOS-2000 Router Cabling**

The Codan Kondor Router can be interface with the Synergy Q/MD-X switcher directly, or through a CPU Port Expander. The pinouts are provided for both options.

**With CPU Port Expander**

The Synergy control panel connects to the Codan Router via the remote ports on the Synergy control panel, and the device ports on the CPU Port Expander of the Codan Kondor Router.

Cable connections in the following table refer only to those between the Synergy control panel and the Codan Kondor (Geneos) Router. Other cable connections present on the Kondor rack frame can be found in the Kondor documentation.
Direct Connection

The Synergy control panel connects to the Codan Router via the remote ports on the Synergy Q/MD-X control panel, and the PC Port of the Codan Kondor Router.

Cable connections in the following table refer only to those between the Synergy control panel and the Codan Router. Other cable connections present on the Kondor rack frame can be found in the Router documentation.

### Synergy Q/MD-X -to- Codan (Geneos) Wiring Chart for RS-232

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Codan Geneos Rack Frame</th>
<th>CPU Port Expander Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
<td><strong>Signal</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>→</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>→</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>→</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

n/c = Not Connected

### Synergy Q/MD-X -to- Codan (Geneos) Wiring Chart for RS-422-485

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Codan Geneos Rack Frame</th>
<th>CPU Port Expander Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
<td><strong>Signal</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td>Ground*</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>→</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td>Ground Detect*</td>
</tr>
</tbody>
</table>

n/c = Not Connected

*Pins 1, 5, and 9 are tied.
GVG SMS 7000 Router Cabling

The Synergy control panel connects to the GVG SMS 7000 Router via the remote ports on the Synergy control panel and either the ASYNC RS-232 port or the ASYNC RS-422-3 port on the rear of the SMS 7000 chassis.

Cable connections in the following table refer only to those between the Synergy control panel and the GVG SMS 7000 Router. Other cable connections present on the SMS 7000 Router can be found in the Grass Valley documentation.

**Important**  
The port on the SMS 7000 is labelled RS-232, however it must be set to run in RS-422 mode.

### Synergy Q/MD-X -to- Codan (Geneos) Wiring Chart for RS-232

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Codan Geneos Rack Frame</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

_n/c = Not Connected_

### Synergy Q/MD-X -to- GVG SMS 7000 ASYNC RS–232 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>GVG SMS 7000</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

_n/c = Not Connected_
GVG Encore Control System Cabling

The Synergy control panel connects to the GVG Encore Control System via the remote ports on the Synergy control panel and one of the RS-422/RS-485 SIO ports (5-8) on the rear of the GVG Encore Control System chassis.

To construct the cabling between the Synergy control panel and the GVG Encore Control System, Ross Video recommends the following:

- Use an RJ-45 Female to DB-9 male adaptor to connect directly to the Synergy control panel; and
- Use a CAT 5e Ethernet patch (pin-to-pin) type cable to connect the GVG Encore Control System chassis to the RJ-45 to DB-9 adaptor.

Note that there are two different models of the GVG Encore Control System: 6101000xx and 6100884xx. Cabling for both models are provided in the sections below.

**GVG Encore Control System (6101000xx)**

Cable connections in the following table refer only to those between the Synergy control panel and the GVG Encore Control System model 6101000xx. Other cable connections present on the GVG Encore Control System can be found in the GVG documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>GVG SMS 7000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected

**Note**

While you can use one of the RS-232 SIO ports (1-4) on the GVG Encore Control System, Ross Video recommends using the RS-422/RS-485 ports.

**Note**

If you have a Redundant System setup, refer to your GVG documentation for cabling information.
Synergy Q/MD-X Engineering Manual (v9.1 MD)  Routers  •  17–11

GVG Encore Control System (6100884xx)

Cable connections in the following table refer only to those between the Synergy control panel and the GVG Encore Control System model 6100884xx. Other cable connections present on the GVG Encore Control System can be found in the GVG documentation.

### Synergy Q/MD-X -to- GVG Encore Control System (6101000xx) Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>COM Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→</td>
<td>7</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
</tr>
</tbody>
</table>

### Synergy Q/MD-X -to- GVG Encore Control System (6100884xx) Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>COM Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→</td>
<td>3</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→</td>
<td>6</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
</tr>
</tbody>
</table>

**Codan Kondor Cabling**

The Synergy control panel connects to the Codan Kondor Router via the remote ports on the Synergy control panel and the 25-Pin, D-Type, AUX com port on the Codan Kondor chassis.

**Note**  
A DB9 to DB25 adapter may be required to connect the Interface Cable to the Codan Kondor Router.
Cable connections in the following table refer only to those between the Synergy control panel and the **Codan Kondor** Router. Other cable connections present on the Kondor Router can be found in the Router documentation.

**Synergy Q/MD-X -to- Codan Kondor (ASCII) RS–422 Wiring Chart**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Codan Kondor (ASCII)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected

**Codan NK Router Cabling**

The Synergy control panel connects to the Codan NK Router via the remote ports on the Synergy control panel and the T-Bus port on the Codan NK Router.

Use the following procedure to connect a Codan NK Router to your Synergy Q/MD-X switcher:

1. Connect and secure the **9-Pin, Male**, end of the **DB9 to RJ-45 Adapter (Codan NK-SCP/A)** to one of the **Remote Ports** on the back of the Synergy control panel.

2. Connect and secure one end of the **CAT5** cable to the **DB9 to RJ-45 Adapter**.

3. Connect and secure the other end of the cable to the **T-Bus Port** on the **NK Router**.

This completes the procedure for connecting a Router to the Synergy Q/MD-X switcher. Refer to the section “**Communications Setup**” on page 17–15 for instructions on how to set up communications protocols on the Switcher, as well as on the Router.

Cable connections in the following table refer only to those between the Synergy control panel and the Codan NK Router. Other cable connections present on the NK Router can be found in the Router documentation.
Sierra Yosemite Router Cabling

The Synergy control panel connects to the Sierra Yosemite Router via the remote ports on the Synergy control panel, and the Host Port (RS232/422 Port 2) on the rear of the Sierra Router.

Important

The default settings for the Sierra Yosemite Router is RS-232 and 9600 Baud; however, Ross Video recommends that you use RS-422 and 38400 Baud. Refer to your Sierra Video Systems Yosemite Router documentation for information on changing the configuration.

Cable connections in the following table refer only to those between the Synergy control panel and the Sierra Yosemite Router. Other cable connections present on the Yosemite chassis can be found in the Sierra Yosemite documentation.

Synergy Q/MD-X -to- Codan NK (ASCII) RS–232 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Codan NK (ASCII)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected

Synergy Q/MD-X -to- Sierra Yosemite RS-232 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Sierra Yosemite</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

n/c = Not Connected
The Synergy control panel connects to a Utah Scientific Router via the remote ports on the Synergy control panel, and the RS-232 connector port on the rear of the Utah Scientific Router. Cable connections in the following table refer only to those between the Synergy control panel and the Utah Scientific Router. Other cable connections present on the Router can be found in the Utah Scientific documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Remote Port</th>
<th>Signal</th>
<th>Host Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→</td>
<td>2</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→</td>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→</td>
<td>7</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→</td>
<td>8</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

n/c = Not Connected

**Utah Scientific Router Cabling**

The Synergy control panel connects to a Utah Scientific Router via the remote ports on the Synergy control panel, and the RS-232 connector port on the rear of the Utah Scientific Router.

Cable connections in the following table refer only to those between the Synergy control panel and the Utah Scientific Router. Other cable connections present on the Router can be found in the Utah Scientific documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Remote Port</th>
<th>Signal</th>
<th>RS-232 Com Port (1, 3, or 5)</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>→</td>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>→</td>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>→</td>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

n/c = Not Connected
Communications Setup

Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with a Router, the remote port on the control panel that the Router is connected to must be set up to communicate with the particular Router you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Router:

1. Navigate to the **Communications Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press **Type** to display the **Type Menu**.

   **Type Menu**
   - Com Port: Remote 1 (R1)
   - Device: Jupiter

3. Assign a Remote Com Port to Router as follows:
   - Use the **Com Port** knob to select the remote port on the Synergy Q/MD-X switcher that is connected to the Router.
   - Use the **Device** knob to select **Router**.
4. Press **Select Device** to display the **Select Device Menu**.

   **Select Device Menu**
   - Com Port: Remote 1 (R1)
   - Device: Jupiter

5. Assign a specific Router to the Remote Com Port as follows:
   - Use the **Com Port** knob to select the Remote Com Port that the desired Router is connected to.
   - Use the **Device** knob to select the type of Routing Switcher that is connected to the port. You can select between the following:
     - **Jupiter** — Use this option to assign a Philips Jupiter Router to the selected com port using the ESswitch protocol. Refer to the section “Philips Jupiter” on page 17–18 for details.
~ **Pesa** — Use this option to assign a **PESA Cougar Router** to the selected com port using the CPU-Link protocol. Refer to the section “PESA Cougar” on page 17–19 for details.

~ **Pro-Bel** — Use this option to assign a **Pro-Bel Freeway Router** or a **Pro-Bel Halo Router** to the selected com port using the General Remote Communication (SW-P-08) protocol. Refer to the section “Pro-Bel Freeway” on page 17–20 for details on setting up a Chyron Freeway Router. For setup information on the **Pro-Bel Halo Router**, refer to the section “Pro-Bel Halo” on page 17–21.

~ **CodanEOS** — Use this option to assign a **Codan Kondor EOS-2000 Router** to the selected com port using the Geneos protocol. Refer to the section “Codan Kondor (Geneos)” on page 17–21 for details.

~ **GVG NP** — Use this option to assign a **Grass Valley SMS 7000 Router** or the **GVG Encore Control System** to the selected com port using the Native protocol. Refer to the section “GVG SMS 7000” on page 17–23 for details. For information on the GVG Encore Control System, refer to the section “GVG Encore Control System” on page 17–23.

~ **CodanASC** — Use this option to assign a **Codan Kondor** or **Codan NK Router** to the selected com port using the Codan ASCII protocol. Refer to the section “Codan (ASCII)” on page 17–24 for details.

~ **Yosemite** — Use this option to assign a **Sierra Yosemite Router** to the selected com port using the Native protocol. Refer to the section “Sierra Yosemite” on page 17–24 for details.

~ **Utah** — Use this option to assign a **Utah Scientific Router** to the selected com port using the Utah RCP-1 protocol. Refer to the section “Utah Scientific Router” on page 17–25 for details.

**Note**

If the Codan Router does not have a port expander, and a PC is required to be connected to the Router at all times, the Codan ASCII protocol will have to be used to allow the Synergy switcher to control the Router.

The Codan ASCII protocol does not support Mnemonics.

The Utah RCP-1 protocol does not support Mnemonics.

6. Press **Com Settings** to display the **Com Settings Menu**.
7. Set the communications protocols for the Router as follows:
   - Use the **Com Port** knob to select the Router you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Router. Refer to the section “Setting up the Router” on page 17–18 for router specific settings.
   - Use the **Parity** knob to select the parity, **NONE**, **ODD** or **EVEN** for the specific Router. Refer to the section “Setting up the Router” on page 17–18 for the specific settings for your Router.

   ![Note]
   Some of the communications settings are **Fixed**, or locked. These settings have been preset for the selected Router and do not need to be changed.

8. Press **Com Type** to display the **Com Type Menu**.

   ![Communications — Com Type Menu]

9. Select the type of serial communication that will be used to communicate with the Router as follows:
   - Use the **Com Port** knob to select the Router you want to set the communication type for.
   - Use the **Type** knob to select the type of serial communications (**RS-232** or **RS-422**) for the selected port. Refer to the section “Setting up the Router” on page 17–18 for the specific settings for your Router.

   ![Note]
   **Network UDP** and **Network TCP** are not supported for this device type.

10. Press **Extra Options** to display the **Extra Options Menu**. Refer to the section “Extra Options Setup” on page 17–18 for information on the Extra Options settings for Routers.

11. Press **HOME** to display the **Installation Change Confirmation Screen**.

12. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Routing Switcher, next you will have finish setting up the Router to communicate with the Synergy Q/MD-X switcher, and then set up the BNC inputs that you have connected to the Router.
Extra Options Setup

The Extra Options Menu for a Router allows you to complete the communications setup for some of the Routers on the Synergy Q/MD-X switcher. This Extra Option allows you to change the number of sources that will appear in the Synergy Router Menus.

The following Routers support this Extra Option:

- Philips Jupiter Router (using the ESswitch protocol)
- PESA Cougar Router (using the CPU-Link protocol)
- Chyron (Pro-Bel) Freeway Router (using the General Remote Control protocol)
- Codan Kondor (using the Codan ASCII protocol)
- Codan NK Router (using the Codan ASCII protocol)
- Sierra Yosemite Router (using the Native protocol)
- Utah Scientific Router (using the Utah RCP-1 protocol)

Use the following procedure to set up the Extra Options for a Router:

1. Set up communications between the Router, stopping after step 9, using the procedure in the section “Setting up the Switcher” on page 17–15.
2. Press Extra Options to display the Extra Options Menu.
3. Select the number of sources for your Router as follows:

![Communications (1-2)](Communication.png)

   - Use the Com Port knob to select the remote port that the Router is connected to.
   - Use the Option knob to select Xpts.
   - Use the Value knob to select the number of crosspoints on the Router.

This completes the procedure to set up the Extra Options for a Router.

Setting up the Router

In order to have the Synergy Q/MD-X switcher communicate with a Router, the Router you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

Philips Jupiter

Use the following information to configure and connect your Philips Jupiter Router, using the ESswitch protocol, to your Synergy Q/MD-X switcher:
• Use the following communications setting when connecting the Philips Jupiter to the Synergy Q/MD-X switcher:

> **Synergy Q/MD-X -to- Philips Jupiter Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

• The **Configuration Set** must be configured with the following (using Philips Configuration Editor Software — valid as of version 5.1.0):

  ~ In the **Configure\Serial Protocol Menu**, configure the ports to use ESswitch (ESW) protocol and the appropriate Baud rate setting. Repeat for all port(s) connected to Synergy.

  ~ In the **Configure\MPK Devices Menu**, set up a device with the “type” as **Serial** and set to use the port connected to the Synergy.

  ~ The **Input Set**, **Output Set** and **Level Set** must be set to the appropriate “sets” configured in the **Configure\Control Panel Sets Sub-menu**. Each Synergy to be attached must be configured as a separate MPK Device on the appropriate port.

  ~ For more information concerning the configuration of a Set and downloading the Set to the controller, refer to the Jupiter documentation.

If you are having trouble controlling a Jupiter router from your Synergy Q/MD-X switcher, you may need to change the **Base Extra Option** to 0 on the Synergy control panel.

Use the following procedure to change the **Base Extra Option** for the Jupiter router on the Synergy control panel:

1. Navigate to the **Extra Options Menu** as follows:

   * Press **HOME ⇔ MORE ⇔ Setup ⇔ Installation ⇔ Communications ⇔ Extra Options**.

2. Use the **Com Port** knob to select the remote port on the Synergy Q/MD-X switcher that is connected to the Jupiter Router.

3. Use the **Option** knob to select **Base**.

4. Use the **Value** knob to select 0.

This completes the procedure to set up the Extra Options for a Router.

**PESA Cougar**

Use the following information to configure and connect your **PESA Cougar** Router, using the **CPU-Link** protocol, to your Synergy Q/MD-X switcher:
• Use the following communications setting when connecting the PESA Cougar to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
</tbody>
</table>

• The **Cougar Configuration** must be configured to allow **CPU-Link Protocol** control on the port connected to Synergy. To accomplish this, follow the directions below using the Win3500Plus Control Software (valid as of version 1.2):
  ~ Open the configuration to be used on the Pesa (File\Open Configuration…).
  ~ Open the Configuration\CPU Link… menu.
  ~ Select an **RS-422** port.
  ~ Configure this RS-422 port for the CPU Link Protocol using the following:
    - Baud — 9600
    - Parity — NONE
    - Data Bits — 8
    - Stop Bits — 2
  ~ Exit this dialog box and save the configuration (File\Save Configuration…).
  ~ Download the configuration to the controller by selecting System\Download Configuration to Controller.
  ~ For more information concerning the set up and downloading of a Configuration, refer to the Pesa documentation for the Controller.

**Pro-Bel Freeway**

Use the following information to configure and connect your **Chyron Freeway** Router, using the **General Remote Control** protocol, to your Synergy Q/MD-X switcher:

• Use the following communications setting when connecting the Chyron Freeway to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
**Pro-Bel Halo**

Use the following information to setup your Pro-Bel Halo Router, using the General Remote Communications protocol (SW-P-08), to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Pro-Bel Halo Router to your Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

The Synergy switcher does not support the Pro-Bel General Switcher Protocol (SW-P-88).

**Codan Kondor (Geneos)**

Use the following information to configure and connect your Codan Kondor EOS-2000 Router, using the Geneos (EOS) protocol, to your Synergy Q/MD-X switcher. The Codan Kondor can be connected to your Synergy Q/MD-X switcher either using the CPU Port Expander on the Codan Kondor Router or not. Both methods are listed below.

**With CPU Port Expander**

- Use the following communications setting when connecting the Codan Kondor to your Synergy Q/MD-X switcher using the CPU Port Expander on the Codan Kondor:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
<td>RS-422/485</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>57600</td>
<td>57600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

The Codan Kondor can support both RS-232 and RS-422/485 with the CPU Port Expander. Settings for both are described here.

- The Codan CPU Port Expander device port must be configured as RS-422 and allow “Specified Dst Stat” to pass through. The Port Expander “CPU” port connects to the Geneos Rack Frame “PC” port.

- Codan Routing Systems Routers do not output source or destination names to the Synergy Q/MD-X switcher. Therefore, Synergy menus display:
“Src #” values (0-255) which represent the virtual input number of Level 1 on the Codan Router.

“Output #” values (1-256) which represent the virtual output number of Level 1 on the Codan Router.

**Important**

Ross Video recommends that you keep the virtual input#/output# selections consistent with the physical input#/output# selections of the router physical map. Refer to the Router documentation for further details.

- The Synergy Q/MD-X switcher controls the Codan Router via the virtual input to virtual output and breakaway function on the router. The breakaway number corresponds to the selected level in the BNC Menu 2-2 — Router Other Menu. Synergy supports levels 1-8.

**Without CPU Port Expander**

- Use the following communications setting when connecting the Codan Kondor to your Synergy Q/MD-X switcher:

  **Synergy Q/MD-X-to-Codan Kondor (Geneos) Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>57600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- Codan Routing Systems do not output source or destination names to the Synergy Q/MD-X switcher. Therefore, Synergy menus display:

  “Src #” values (0-255) which represent the virtual input number of Level 1 on the Codan Routing Systems.

  “Output #” values (1-256) which represent the virtual output number of Level 1 on the Codan Routing Systems.

**Important**

Ross Video recommends that you keep the virtual input#/output# selections consistent with the physical input#/output# selections in the Physical Map of the Codan Routing System. Refer to the Router documentation for further details.

- The Synergy Q/MD-X switcher controls the Codan Router using the virtual input to virtual output and breakaway function. The breakaway number corresponds to the selected level in the BNC Menu 2-2 — Router Other Menu. The Synergy Switcher supports levels 1-8.

For information concerning Codan Router cable assembly, AUX port, virtual input/output, and breakaway setup, please refer to your Codan Routing Systems manuals.
**GVG SMS 7000**

Use the following information to configure and connect your **Grass Valley Group (GVG) Signal Management System (SMS) 7000** Router, using the **Native** protocol, to your Synergy Q/MD-X switcher:

- Use the following communications setting when connecting the GVG SMS 7000 to the Synergy Q/MD-X switcher:

  ![Image](image.png)

  **Note**
  Use the SMS 7000 configuration tool to set the port (port number depends on the socket that the AMEZI is installed) as required.

**Synergy Q/MD-X -to- GVG SMS 7000 Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

---

**GVG Encore Control System**

Use the following information to configure and connect your **GVG Encore Control System**, using the **GVG Native Protocol**, to your Synergy Q/MD-X switcher:

- Use the following communications setting when connecting the GVG Encore Control System to the Synergy Q/MD-X switcher:

  ![Image](image.png)

  **Synergy Q/MD-X -to- GVG Encore Control System Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- Ensure that your GVG Encore Control System is configured to use the **GVG Native Protocol** on the desired chassis port. Refer to your GVG documentation for details on setting up your device.
**Codan (ASCII)**

Use the following information to configure and connect your **Codan Kondor** or **Codan NK** Router, using the ASCII protocol, to your Synergy Q/MD-X switcher:

**Note**
The Codan ASCII protocol does not support mnemonics.

- Use the following communications setting when connecting the Codan Kondor Router to the Synergy Q/MD-X switcher:
- Set up the communications on the Router as follows:
  ~ For the **Codan Kondor Router**, you must use the **Geneos** software on your PC, to set the **AUX Comm Port Baud Rate**, on the **CPU** tab, to **38.4k**.
  ~ For the **Codan NK Router**, you must use the **Codan IPS** interface on your PC to set the **Baud** rate to **38400**.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to- Codan (ASCII) Communication Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting</strong></td>
</tr>
<tr>
<td>Transmission Standard</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
</tbody>
</table>

**Sierra Yosemite**

Use the following information to configure and connect your **Sierra Yosemite** Router to your Synergy Q/MD-X switcher:

**Important**
The default settings for the **Sierra Yosemite** Router is **RS-232** and **9600** Baud; however, Ross Video recommends that you use **RS-422** and **38400** Baud. Refer to your Sierra Video Systems Yosemite Router documentation for information on changing the configuration.

- Use the following communications setting when connecting the Sierra Yosemite to the Synergy Q/MD-X switcher:

**Synergy Q/MD-X -to- Sierra Yosemite Communication Settings**

<table>
<thead>
<tr>
<th><strong>Setting</strong></th>
<th><strong>Default Value</strong></th>
<th><strong>Recommended Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>
**Utah Scientific Router**

Use the following information to configure and connect your Utah Scientific Router to your Synergy Q/MD-X switcher using the Utah RCP-1 Protocol:

Use the following communications setting when connecting a Utah Scientific Router to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Synergy Q/MD-X -to- Utah Scientific Communication Settings
Setting up Router BNCs

The **Router Setup Menu** allows you to associate a Router BNC input with a particular Router communication port. In addition, you can select which one of the outputs of the Router is feeding the input BNC on the Synergy Q/MD-X frame.

**Important**

You must have a Router set up on the Synergy Q/MD-X switcher before you can assign a BNC to that device. Refer to the section “Setting up the Switcher” on page 17–15 for more information on setting up router communications.

Use the following procedure to assign the Routing Switcher to a specific BNC input:

**Note**

On the Codan Routers the matrix is controlled by breakaways that have the different levels assigned to them. Refer to your Router documentation for information on assigning different levels to a breakaway.

1. Navigate to the **BNC Menu 1-3** as follows:
   - Press **HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC**.

2. Press **BNC Type** to display the **BNC Type Menu**.

3. Assign a BNC to a Router as follows:
   - Use the **BNC** knob to select the BNC that the Router is connected to.
   - Use the **Type** knob to select **Router**.
   - Use the **Video Format** knob to select the native video format of the VTR output.

**Note**

Assigning a **Video Format** to an **Input BNC**, that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an **Aux Bus**. Video formats may be converted to the operating video format using **Smart Conversion**. Refer to Chapter 13 “**SmartConversion™**” for more information.
4. Press Router Setup to display the Router Setup Menu.

   **BNC — Router Setup Menu**

<table>
<thead>
<tr>
<th>BNC Names</th>
<th>BNC Type</th>
<th>Tally</th>
<th>Alpha</th>
<th>Auto Key</th>
<th>Router</th>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC CBI (CBI)</td>
<td>Type: Router</td>
<td>Tally: 1</td>
<td>Auto Key: Black</td>
<td>Video Mode: 1080i 59.94</td>
<td>BNC CBI (CBI)</td>
<td>BNC: Jupiter (CBI)</td>
</tr>
</tbody>
</table>

5. Assign a specific Routing Switcher to the Router BNC as follows:
   - Use the BNC knob to select the BNC you want to assign the specific Router to.
   - Use the Router knob to select the Router you want to assign to the BNC.
   - Use the BNC Out knob to select the Output BNC (001-256) on the Router that is feeding the BNC on the Synergy Q/MD-X switcher.

6. Press Router Other to display the Router Other Menu.

   **Operating Tip**

   The Router Other Setup Menu allows you to set the levels, or breakaways, on the Router that will be switched when a new input source is selected. Refer to your Router documentation for more information on setting up the level matrix.

   **BNC — Router Other Menu**

<table>
<thead>
<tr>
<th>BNC Names</th>
<th>BNC Type</th>
<th>Levels</th>
<th>Router</th>
<th>Disable</th>
<th>Audio</th>
<th>Still/CG</th>
<th>Camera</th>
<th>UTR/ADCP</th>
<th>Xrefs</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC CBI (CBI)</td>
<td>Type: Router</td>
<td>Levels: 1</td>
<td>Router</td>
<td>Disable</td>
<td>Audio</td>
<td>Still/CG</td>
<td>Camera</td>
<td>UTR/ADCP</td>
<td>Xrefs</td>
</tr>
</tbody>
</table>

7. Select the Router levels that will be switched for the Router connected to the specific BNC as follows:

   **Note**

   On the Codan Routing Systems this is the Breakaway knob and you can only select from 1 through 8.

   - Use the BNC knob to select the Router you want to set the levels for.
• Use the **Level** knob to configure the Router level(s), or breakaways, that will be switched on the Router when a new input is selected. Choices are dependent upon the type of Router connected, and include:
  
  ~ **All** — Select this option when you want to switch all levels when you select a new input source.
  
  ~ **0-127** — Any one level (numbered from **0** to **127**).

**Note**

Zero (**0**) corresponds to the first level on the Router, possibly numbered as **1** on the Router.

8. Press **HOME** to display the **Installation Change Confirmation Screen**.

9. Accept or reject the changes you have made as follows:

  • Press **Confirm** to accept the changes.
  
  • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up a Routing switcher to a BNC on the Synergy Q/MD-X switcher. Refer to the section “**Router Operation**” on page 17–32 for information on selecting input sources on the Router.
Router Custom Controls

A custom control button can be programmed to set a specific source/BNC crosspoint pair or fire a salvo (run a pre-programmed macro) on a Router.

You must have the Router Control option installed in order to control a Router to the Synergy Q/MD-X switcher. Refer to the section “Setting up the Switcher” on page 17–15 for information on setting up a Router.

The following Custom Controls are covered in this section:

- Source/BNC Crosspoint Pair
- Fire a Router Salvo

Source/BNC Crosspoint Pair

The Source/BNC Crosspoint Pair custom control macro allows you to change the source on the Router that is assigned to the BNC input on the switcher.

Use the following procedure to add a Source/Destination pair to a custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Navigate to the Insert Router Control Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ MORE ⇒ Router.

4. Use the Router knob to select the remote port that the Router is connected to.

5. Use the Function knob to select Take XPT.
6. Select the destination on the Router you want to select as follows:
   • Press **Destination**.
   • Use the bottom knob to select the desired destination.
7. Select the source you want to assign to the destination as follows:
   • Press **Source**.
   • Use the bottom knob to select the source you wish to assign.
8. Select the router level you wish to assign as follows:
   • Press **Level**.
   • Use the bottom knob to select the level you wish to assign.
9. Press **Insert** to add this macro into the custom control and display the **Insert Special Menu 1-2**.
10. Press **UP ONE** to display the **Recording Menu**.
11. Press **Finish Recording** to finish recording to the selected custom control.

This completes the procedure for inserting a Source/Destination pair into a custom control.

**Fire a Router Salvo**

The Fire Router Salvo custom control macro allows you to fire a salvo on the Router. You must program salvos on the Router itself in order to fire them. Refer to your Router documentation for information on storing a salvo on your Router.

The following Routers support salvos:
   • Ross Kondor EOS-2000
   • Sierra Yosemite
   • Leitch VIA32
   • Grass Valley SMS 7000
   • Chyron (Pro-Bel) Freeway
   • PESA Cougar

Use the following procedure to fire a Router Salvo from the selected Router:

1. Navigate to the **Custom Controls Menu** as follows:
   • Press **HOME ⇒ Custom Controls**.

   ![Custom Controls Menu](image)

   **Custom Controls Menu**

2. Select the custom control button you want to record to as follows:
• Use the **Bank** knob to select the custom control bank you want to record the custom control to.

• Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button *directly* on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Navigate to the **Insert Router Control Menu** as follows:
   - Press **Start Recording** ⇔ **Insert Special** ⇔ **MORE** ⇔ **Router**.

4. Use the **Router** knob to select the remote port that the Router is connected to.
   - Use the **Function** knob to select **Fire Salvo**.

5. Select the salvo on the selected Router you want to fire as follows:
   - Use the **Salvo #** knob to select the salvo you want to fire.

6. Press **Insert** to add this macro into the custom control.

7. Press **Finish Recording** to finish recording to the selected custom control.

This completes the procedure for inserting a fire Router salvo into a custom control.

Refer to chapter 10, “**Custom Controls**”, for more information on custom controls.
Router Operation

The *Router Matrix Control Menu* allows you to assign different Router sources to a BNC that is assigned to the Router.

**Operating Tip**

You can access the Router input that is assigned to a BNC by pressing the corresponding crosspoint button. The *Router Matrix Control Menu* will be displayed.

Use the following procedure to change the source on a Router:

1. Navigate to the *Remote Control Select Menu* as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.

2. Press Router Control to show a list of BNCs assigned to a Router.

3. Use the BNC knob to select the BNC you want to change the source for.

4. Press GO!! to display the *Router Matrix Control Menu*.

**Operating Tip**

You can select a different BNC at this point by pressing the corresponding softkey.

5. Press Refresh Sources to update the list of available sources on the Router.

**Note**

If a “COMMUNICATIONS LOST” message appears on the menu, the Synergy Q/MD-X switcher has been unsuccessful at receiving a response from the Router. Check the cable connections and the configuration on the switcher and the Router.
6. Use the \textbf{x1} knob to select the source on the Router you want to assign to the selected BNC. When the source is selected, the Router automatically assigns it to the BNC.

\begin{OperatingTip}
Use the \textbf{x10} or \textbf{x100} knobs to move through the source list at 10 or 100 at a time.
\end{OperatingTip}

When you first enter the \textbf{Router Matrix Control Menu}, messages are sent to all connected Routers to determine the current Source-to-Destination (Router output to Synergy) mappings. Another message is sent to retrieve the names or numbers of all sources connected to the Router.

If either of these messages is not supported (in particular, the messages concerning mnemonics) then default values are created (i.e. “\textbf{Src ###}”, “\textbf{Dest ###}”).

\textbf{Router Communications Notes}

When properly configured, there is consistent communication from the Synergy to the Router.

- If the Synergy Q/MD-X switcher has not received a response of any sort from the Router for one full second, a message is sent to generate a response.
- If the Synergy Q/MD-X switcher has not received a response for two seconds, it is assumed that there is a communications problem. The message “\textbf{COMMUNICATIONS LOST}” will be displayed in the \textbf{Router Matrix Control Menu}.
External Still Stores

In This Chapter

This chapter provides instructions for connecting, setting up and operating a Still Store with your Synergy Q/MD-X switcher. Before you begin, ensure that the Still Store (Chyron Aprisa) Interface option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported Still Store
- Communications Connections
- Communications Setup
- Setting up Still Store BNCs
- Still Store Operation
Supported Still Store

The Synergy Q/MD-X switcher has been tested with the following Still Store:-X

- Chyron Aprisa 100 Still Store
Communications Connections

You can connect a number of external Still Stores to your Synergy Q/MD-X switcher. The procedure for connecting the Still Store will depend on the type of Still Store you have. This section will provide general instructions for connecting the Still Store to one of the Remote Ports on the back of the Synergy Control Panel.

**Note**

These instructions are provided as a guide, for specific information on the Still Store you are connecting to the Synergy Q/MD-X switcher, refer to the documentation provided with your Still Store.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Still Store (Aprisa) Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control an external Still Store.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Still Store. Refer to the section “Still Store Interface Cable Pinouts” on page 18–4 for information on the pin-outs and connector required for your Still Store. Ross Video does not supply this cable.

Use the following procedure to connect a Still Store to your Synergy Q/MD-X switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Still Store. The suggested port for each supported Still Store is listed below:

   - **Chyron Aprisa 100 Still Store** — Connect the Interface cable to the RS-422 port or the RS-232 port on the rear of the Aprisa 100 Still Store. Refer to the section “Chyron Aprisa 100 Still Store Cabling” on page 18–4 for more information on the cabling for this Still Store.

This completes the procedure for connecting a Still Store to the Synergy Q/MD-X switcher. Refer to the section “Communications Setup” on page 18–5 for instructions on how to set up communications protocols on the Switcher, as well as on the Still Store.
Still Store Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy Q/MD-X switcher to the Still Store.

**Chyron Aprisa 100 Still Store Cabling**

The Synergy control panel connects to an Aprisa 100 Still Store via the remote ports on the Synergy control panel, and the RS-422 port or the RS-232 port on the rear of the Aprisa 100 Still Store.

Cable connections in the following table refer only to those between the Synergy control panel and the Aprisa 100 router. Other cable connections present on the Aprisa 100 chassis can be found in the Chyron Aprisa 100 documentation.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to-Chyron Aprisa 100 RS-422 Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synergy Control Panel</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
</tbody>
</table>

n/c = Not Connected

**Important**

For RS-232 cables, only pins 2, 3, and 5 should be connected. All other pins must be disconnected.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to-Chyron Aprisa 100 RS-232 Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synergy Control Panel</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
</tbody>
</table>

n/c = Not Connected
Communications Setup

Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with a Still Store, the remote port on the control panel that the Still Store is connected to must be set up to communicate with the particular Still Store you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Still Store:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.

3. Assign a Remote Com Port to the Still Store as follows:
   - Use the Com Port knob to select the remote port on the Synergy Q/MD-X switcher that is connected to the Still Store.
   - Use the Device knob to select Still Store.
4. Press Select Device to display the Select Device Menu.

5. Assign a specific Still Store to the Remote Com Port as follows:
   - Use the Com Port knob to select the Remote Com Port that the desired Still Store is connected to.
   - Use the Device knob to select the type of Still Store that is connected to the port.
   You can select between the following:
   - Aprisa100 — Use this option to assign a Chyron Aprisa 100 Stillstore to the selected com port. Refer to the section “Chyron Aprisa 100” on page 18-7 for details.
6. Press **Com Settings** to display the **Com Settings Menu**.

```
<table>
<thead>
<tr>
<th>Type</th>
<th>Device</th>
<th>Con Settings</th>
<th>Con Type</th>
<th>Custom</th>
<th>Extra Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Communications — Com Settings Menu**

7. Select the type of serial communication that will be used to communicate with the Still Store as follows:
   - Use the **Com Port** knob to select the Still Store you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Still Store. Refer to the section “Setting up the Still Store” on page 18–7 for the specific settings for your Still Store.
   - Use the **Parity** knob to select the parity, **NONE**, **ODD**, or **EVEN** for the specific Still Store. Refer to the section “Setting up the Still Store” on page 18–7 for the specific settings for your Still Store.

8. Press **Com Type** to display the **Com Type Menu**.

```
<table>
<thead>
<tr>
<th>Type</th>
<th>Device</th>
<th>Con Settings</th>
<th>Con Type</th>
<th>Custom</th>
<th>Extra Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Communications — Com Type Menu**

9. Select the type of serial communication that will be used to communicate with the Still Store as follows:
   - Use the **Com Port** knob to select the Still Store you want to set the communication type for.
   - Use the **Type** knob to select the type of serial communications (**RS-232**, **RS-422**) for the selected port. Refer to the section “Setting up the Still Store” on page 18–7 for details.

**Note**

Network UDP and Network TCP are not supported for this device type.

10. Press **HOME** to display the **Installation Change Confirmation Screen**.

11. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Still Store, next you will have finish setting up the Still Store to communicate with the Synergy Q/MD-X switcher, and then set up the BNC inputs that you have connected to the Still Store.

**Setting up the Still Store**

In order to have the Synergy Q/MD-X switcher communicate with a Still Store, the Still Store you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

**Chyron Aprisa 100**

Use the following information to configure and connect your Chyron Aprisa 100 Still Store to your Synergy Q/MD-X switcher:

• Use the following communications setting when connecting a Chyron Aprisa 100 Still Store to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Synergy Q/MD-X -to- Aprisa 100 Communication Settings
Setting up Still Store BNCs

The Still Setup Menu allows you to associate a Still Store BNC input with a particular Still Store communication port. In addition, you can select which channel on the Still Store is feeding the input BNC on the Synergy Q/MD-X frame.

**Important**

You must have a Still Store set up on the Synergy Q/MD-X switcher before you can assign a BNC to that device. Refer to the section “Setting up the Switcher” on page 18–5 for more information on setting up Still Store communications.

Use the following procedure to assign the Still Store to a specific BNC input:

1. Navigate to the **BNC Menu 1-3** as follows:
   - Press **HOME** ➔ **MORE** ➔ **Setup** ➔ **Installation** ➔ **BNC**.
2. Press **BNC Type** to display the **BNC Type Menu**.

   **BNC — BNC Type Menu**

3. Assign a BNC to a Still Store as follows:
   - Use the **BNC** knob to select the BNC that is connected to the Still Store.
   - Use the **Type** knob to select **Still**.
   - Use the **Video Format** knob to select the native video format of the VTR output.

**Note**

Assigning a Video Format to an Input BNC, that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an Aux Bus. Video formats may be converted to the operating video format using Smart Conversion. Refer to Chapter 13 “SmartConversion™” for more information.

4. Press **MORE** to display the **BNC Menu 2-3**.
5. Press **Still Setup** to display the **Still Setup Menu**.

![BNC — Still Setup Menu](image)

6. Assign a specific Still Store to the Still BNC as follows:
   - Use the **BNC** knob to select the BNC you want to assign the specific Still Store to.
   - Use the **Still** knob to select the Still Store port for the specific Still Store you want to assign to the BNC.
   - Use the **Channel** knob to select the Channel (A-H) on the Still Store that is feeding the BNC on the Synergy Q/MD-X switcher.

![Operating Tip](image)

Pressing the associated BNC crosspoint button lights the **VTR CLIP** button in the **Global Memory System**, and allows you to recall a specific still using the numeric keypad.

7. Press **HOME** to display the **Installation Change Confirmation Screen**.

8. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for assigning a Still Store to a BNC on the Synergy Q/MD-X switcher. Refer to the section “**Still Store Operation**” on page 18–10 for details on accessing specific stills.
Still Store Operation

When you select a crosspoint button assigned to Still Store, the VTR CLIP button in the Global Memory System Group lights, indicating that the keypad has been assigned to the selected Still Store. The currently loaded still and channel for the Still Store are shown in the display.

Use the following procedure to load a still:

1. Select the crosspoint button for the Still Store you want to load a still on. The VTR CLIP button will light, and the current still number and channel will be shown in the display.
2. Enter the number for the still you want to load in the keypad.
3. Press ENTER to load the still.

This completes the procedure for loading a still.
Audio Mixers

In This Chapter

This chapter provides instructions for connecting, setting up and operating an Audio Mixer with your Synergy Q/MD-X switcher. Before you begin, ensure that the Small Audio Mixer Interface (16 or fewer inputs) or Large Audio Mixer Interface (more than 16 inputs) software option is installed. If not, please contact Ross Video for details.

The following topics are discussed:

- Supported Audio Mixers
- Serial Communication Connections
- Ethernet Communication Connections
- Setting Up the Switcher
- Setting Up the Audio Mixer
- Setting Up Audio Channels and Groups
- Audio Channel Assignment
- Setting Up Audio Overrides
- Audio Modes
- Operation Overview
Supported Audio Mixers

The Synergy Q/MD-X switcher has been tested with a number of Audio Mixers to ensure the highest possible standard for compatibility and reliability. The following Audio Mixers are currently supported by your Synergy Q/MD-X switcher:

- **Yamaha 01V96** — Requires a MIDIator and the Small Audio Mixer Interface option.
- **Yamaha 02R96** — Requires an RS-422 serial connection and the Large Audio Mixer Interface option.
- **Yamaha DM2000** — Requires an RS-422 serial connection and the Large Audio Mixer Interface option.
- **Yamaha PM5D** — Requires a MIDIator and the Large Audio Mixer Interface option.
- **Yamaha M7CL-48** — Requires a MIDIator and the Large Audio Mixer Interface option.
- **Wheatstone D-9 Digital Television Audio Control Surface** — Requires an Ethernet connection for the Synergy Q/MD-X frame, and the Large Audio Mixer Interface option.
- **Calrec Sigma Digital Audio Mixing System** — Requires an RS-422 serial connection and the Large Audio Mixer Interface option.
- **Studer Audio Mixer** — Requires an RS-232 serial connection and the Large Audio Mixer Interface option.
Serial Communication Connections

You can connect up to two Audio Mixers to your Synergy Q/MD-X switcher. The procedure for connecting the Audio Mixers will depend on the type of Audio Mixer you have and whether a MIDIator (MS-124W) is required to communicate with the Synergy Q/MD-X switcher. Refer to the section “Supported Audio Mixers” on page 19-2 for details about which Audio Mixer Interface option and connection is required for your particular Audio Mixer. For information on connecting a single Audio Mixer to a Synergy Q/MD-X switcher over an ethernet network, refer to the section “Ethernet Communication Connections” on page 19-12.

This section identifies how to make the serial communication connections between Audio Mixers and the Synergy Q/MD-X switcher. The following topics are discussed:

- Connecting an Audio Mixer without a MIDIator
- Connecting an Audio Mixer with a MIDIator
- Connecting Multiple Audio Mixers

**Note** These instructions are provided as a guide. For specific information on the Audio Mixer you are connecting to the Synergy Q/MD-X switcher, refer to the documentation provided with your device.

Connecting an Audio Mixer without a MIDIator

This section includes information to connect a single Audio Mixer without using a MIDIator. In order to properly complete this procedure, you will need the following software options, cables, and equipment:

- **Software Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control the Audio Mixer. You must have one of the following software options:
  - **Small Audio Mixer Interface** — This is the software option that allows your Synergy Q/MD-X switcher to control up to 16 audio channels on an audio mixer.
  - **Large Audio Mixer Interface** — This is the software option that allows your Synergy Q/MD-X switcher to control up to 240 audio channels on an audio mixer.

**Note** A single Audio Mixer may not be able to support 240 audio channels. Multiple Audio Mixers can be ganged together to increase the number of audio channels your Audio Mixers can support. Refer to the section “Connecting Multiple Audio Mixers” on page 19-7 for information on ganging Audio Mixers.

- **Interface Cable** — This is a serial cable that connects the Synergy Q/MD-X control panel to Audio Mixer. You must have one of the following cables depending on the type of Audio Mixer you are connecting to:
  - **Yamaha Audio Mixers** — This is a 15 foot serial cable that connects the 9-Pin, D-Type port on the Synergy Q/MD-X control panel to the 8-Pin, mini DIN port on the Audio Mixer.
  - **Calrec Sigma Digital Audio Mixing System** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end to connect to the Synergy control panel, and a connector on the other end to connect to your Calrec Sigma System.
Connecting without a MIDlator

The following diagram and procedure describe the basic physical connection of an Audio Mixer to your Synergy Q/MD-X switcher. The locations or names of ports may vary with your Audio Mixer.

Use the following procedure to connect a single Audio Mixer without a MIDlator to your Synergy Q/MD-X switcher:

1. If you are connecting a Yamaha Audio Mixer:
   - Connect and secure the 9-Pin D-Type end of the Interface Cable to one of the Remote Ports on the back of the Synergy Q/MD-X control panel.
   - Connect and secure the 8-Pin mini DIN end of the Interface Cable to the appropriate port on the Remote Audio Mixer. The suggested ports for each supported Audio Mixer are as follows:
     - Yamaha 02R96 — Connect the Interface Cable to the TO HOST SERIAL port on the Yamaha 02R96 panel. Refer to the section “Yamaha 02R96 Interface Cable Specifications” on page 19-10 for more information on cabling for this Audio Mixer.
     - Yamaha DM2000 — Connect the Interface Cable to the TO HOST SERIAL port on the Yamaha DM2000 panel. Refer to the section “Yamaha DM2000 Interface Cable Specifications” on page 19-10 for more information on cabling for this Audio Mixer.
     - Studer Audio Mixer — Connect the Interface Cable to the serial port on the Studer Audio Mixer panel. Refer to the section “Studer Audio Mixer Interface Cable Specifications” on page 19-11 for more information on cabling for this Audio Mixer.

2. If you are connecting a Calrec Sigma Digital Audio Mixing System to the Synergy Q/MD-X switcher:
   - Connect and secure the Interface Cable to the one of the Remote Ports on the back of the Synergy Q/MD-X control panel.
   - Ensure the RS422 port on the Calrec Sigma panel is configured for RS422 communications.
• Connect and secure the **Interface Cable** to the RS422 port on the Calrec Sigma panel. Refer to the section “Calrec Sigma Interface Cable Specifications” on page 19-11 for cabling information for this Audio Mixer.

This completes the procedure for connecting a single Audio Mixer to a Synergy Q/MD-X switcher without a MIDIator. Refer to the section “Setting Up the Switcher” on page 19-13 for instructions on how to set up the communications protocols on the Synergy Q/MD-X switcher, as well as the Audio Mixer.

### Connecting an Audio Mixer with a MIDlator

This section provides basic instructions for connecting a single Audio Mixer using a MIDlator (MS-124W). In order to properly complete the procedure, you will need the following software options, cables, and equipment:

- **Software Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control the Audio Mixer. You must have one of the following software options:
  - **Small Audio Mixer Interface** — This is the software option that allows your Synergy Q/MD-X switcher to control up to 16 audio channels on an audio mixer.
  - **Large Audio Mixer Interface** — This is the software option that allows your Synergy Q/MD-X switcher to control up to 240 audio channels on an audio mixer.

- **MIDlator** (MS-124W) — This device converts the serial interface from the Synergy Q/MD-X control panel to a MIDI format.

- **MIDlator Interface Cable** — This is a null modem cable with a DB9 to DB25 converter at one end. This cable connects the 9-Pin, D-Type port on the Synergy Q/MD-X control panel to the 25-Pin, D-Type port on the MIDlator. Refer to the section “MIDlator Interface Cable Specifications” on page 19-9 for information on this cable.

- **MIDI Cable** — This is a MIDI cable that connects the 5-Pin, DIN port on the MIDlator to the 5-Pin, DIN port on the Audio Mixer. You will need two of these cables.

#### Connecting with a MIDlator

The following diagram and procedure describe the basic physical connection of an Audio Mixer to your Synergy Q/MD-X switcher. The locations or names of ports may vary with your Audio Mixer.

Use the following procedure to connect a single Audio Mixer to your Synergy Q/MD-X switcher via a MIDlator:

1. Connect and secure the 9-Pin end of the **MIDlator Interface Cable** to one of the **Remote Ports** on the back of the Synergy Q/MD-X control panel.

2. Connect and secure the 25-Pin end of the **MIDlator Interface Cable** to the **Serial** port on the MIDlator.

3. Install the first **MIDI Cable** connecting the **MIDlator** to the Audio Mixer as follows:

---

**Note**

A single Audio Mixer may not be able to support **240** audio channels. Multiple Audio Mixer can be ganged together to increase the number of audio channels your Audio Mixers can support. Refer to the section “Connecting Multiple Audio Mixers” on page 19-7 for more information on connecting multiple Audio Mixers together.
• Connect on end of a MIDI Cable to the OUT 1 port on the MIDIator.
• Connect the other end of the MIDI Cable to the appropriate port on the Audio Mixer. The suggested ports for each supported Audio Mixer are as follows:
  ~ Yamaha 01V96 — Connect the first MIDI Cable to the MIDI IN port on the Yamaha 01V96 panel.
  ~ Yamaha PM5D — Connect the first MIDI Cable to the MIDI IN port on the Yamaha PM5D panel.
  ~ Yamaha M7CL-48 — Connect the first MIDI Cable to the MIDI IN port on the Yamaha M7CL-48 panel.

4. Install the second MIDI Cable connecting the MIDIator to the Audio Mixer as follows:
• Connect one end of a MIDI Cable to the IN port on the MIDIator.
• Connect the other end of the MIDI Cable to the appropriate port on the Audio Mixer. The suggested ports for each supported Audio Mixer are as follows:
  ~ Yamaha 01V96 — Connect the second MIDI Cable to the MIDI OUT port on the Yamaha 01V96 panel.
  ~ Yamaha PM5D — Connect the second MIDI Cable to the MIDI OUT port on the Yamaha PM5D panel.
  ~ Yamaha M7CL-48 — Connect the second MIDI Cable to the MIDI OUT port on the Yamaha M7CL-48 panel.

5. Set up the MIDIator to Multiple Burst as follows:
• Set the B–A switch to B.
• Set the S–M switch to M.

Connecting a Single Audio Mixer to a Synergy Q/MD-X Switcher via a MIDIator

This completes the procedure for connecting a single Audio Mixer to a Synergy \Server09\pending-X switcher with a MIDIator. Refer to the section “Setting Up the Switcher” on page 19-13 for
instructions on how to set up the communications protocols on the Synergy Q/MD-X switcher, as well as the Audio Mixer.

**Connecting Multiple Audio Mixers**

When connecting multiple Audio Mixers together you are telling the two Audio Mixers to act as one larger Audio Mixer. The total number of audio channels available will depend on the audio mixer you have, as well as the Audio Mixer Interface option you have.

| Note | If you have the Small Audio Mixer Interface option, you can control up to 16 audio channels. You will have to purchase the Large Audio Mixer Interface if you want to control more. |

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Audio Mixer Interface** — This is the software option, either the Large Audio Mixer Interface or Small Audio Mixer Interface, from Ross Video that allows your Synergy Q/MD-X switcher to control audio mixers.

- **Audio Mixer Ganging** — This is the hardware option from Ross Video that supplies a MIDIator and a MIDI Solutions Merger.

- **MIDIator (MS-124W)** — This device converts the serial interface from the Synergy Q/MD-X control panel to a MIDI format.

- **MIDIator Interface Cable** — This is a null modem cable with a DB9 to DB25 converter at one end. This cable connects the 9-Pin, D-Type port on the Synergy Q/MD-X control panel to the 25-Pin, D-Type port on the MIDIator. Refer to the section “MIDIator Interface Cable Specifications” on page 19-9 for information on this cable.

- **MIDI Solutions Merger** — This device allows you to connect two Audio Mixers and control them from the Synergy Q/MD-X control panel. The Merger is MIDI-powered from the Out MIDI cable. When the Merger is powered and operating normally, the red MIDI LED will illuminate. This MIDI LED will flash when the Merger is passing information.

| Note | If the MIDI LED goes out, and the MIDI cables are still properly connected to it, the Synergy Q/MD-X switcher is no longer receiving information from the Audio Mixers. Normal control of the Audio Mixers is still possible, but any manual level adjustment on the mixers will not be recorded by the switcher. To regain full communication between the Synergy Q/MD-X switcher and the Merger, cycle the power on the Merger by unplugging and reconnecting the Out MIDI cable. |

- **MIDI Cables** — This is a MIDI cable that connects the 5-Pin, DIN port on the MIDIator to the 5-Pin, DIN port on the Audio Mixer. You will need at least two of these cables, plus one for the MIDI Solutions Merger.
Connecting Multiple Audio Mixers

The diagram and procedure included in this section describe the physical connection of two Audio Mixers to your Synergy Q/MD-X switcher. The locations or names of ports may vary with your Audio Mixer.

**Note**

When connecting multiple Audio Mixers together, you must set the first Audio Mixer to Channel 1 and the second to Channel 2 on the Audio Mixers themselves. Refer to the section “Setting Up the Audio Mixer” on page 19-19 for more information.

Use the following procedure to connect multiple Audio Mixers to your Synergy Q/MD-X switcher:

1. Connect and secure the 9-Pin end of the MIDIator Interface Cable to one of the Remote Ports on the back of the Synergy Q/MD-X control panel.

2. Connect and secure the 25-Pin end of the MIDIator Interface Cable to the Serial Port on the MIDIator.

3. Connect the MIDI Solutions Merger to the MIDIator as follows:
   - Connect one end of a MIDI Cable to the IN port on the MIDIator.
   - Connect the other end of the MIDI Cable to the OUT port of the Merger.

4. Install the first MIDI Cable connecting the MIDIator to Audio Mixer 1 as follows:
   - Connect one end of a MIDI Cable to the OUT 1 port on the MIDIator.
   - Connect the other end of the MIDI Cable to the MIDI IN port on Audio Mixer 1.

Connecting Two Audio Mixers to a Synergy Q/MD-X Switcher
5. Install the second MIDI Cable connecting the MIDIator to Audio Mixer 2 as follows:
   - Connect one end of a MIDI Cable to the OUT 2 port on the MIDIator.
   - Connect the other end of the MIDI Cable to the MIDI IN port on Audio Mixer 2.

6. Install the first cable connecting the MIDI Solutions Merger to Audio Mixer 1 as follows:
   - Connect one end of a MIDI Cable to the In 1 port on the Merger.
   - Connect the other end of the MIDI Cable to MIDI OUT port on Audio Mixer 1.

7. Install the second cable connecting the MIDI Solutions Merger to Audio Mixer 2 as follows:
   - Connect one end of a MIDI Cable to the In 2 port on the Merger.
   - Connect the other end of the MIDI Cable to MIDI OUT port on Audio Mixer 2.

8. Set up the MIDIator to Multiple Burst as follows:
   - Set the B–A switch to B.
   - Set the S–M switch to M.

This completes the procedure for connecting multiple Audio Mixers to a Synergy Q/MD-X switcher. You must now set up the communications protocols on the Synergy Q/MD-X switcher, as well as the Audio Mixers. Refer to the section “Setting Up the Switcher” on page 19-13 for instructions.

Note
You must configure the Audio Mixers such that the first Audio Mixer controls the first set of channels and the second Audio Mixer controls the second set of channels. Refer to the section “Setting Up the Audio Mixer” on page 19-19 for more information on setting up multiple Audio mixers.

Audio Mixer Interface Cable Pinouts

Use the information in this section to connect the Synergy Q/MD-X switcher to the Audio Mixer.

MIDIator Interface Cable Specifications

The serial cable that connects the MIDIator to the Remote Port on the Synergy Q/MD-X switcher has the following pinouts.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>MIDIator MS-124</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>n/c</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>6</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
</tbody>
</table>
**Yamaha 02R96 Interface Cable Specifications**

The serial cable that connects the Yamaha 02R96 Audio Mixer to the Remote Port on the Synergy Q/MD-X switcher has the following pinouts.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Yamaha 02R96 Audio Mixer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Yamaha DM2000 Interface Cable Specifications**

The serial cable that connects the Yamaha DM2000 Audio Mixer to the Remote Port on the Synergy Q/MD-X switcher has the following pinouts.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Yamaha DM2000 Audio Mixer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Calrec Sigma Interface Cable Specifications

The serial cable that connects the Calrec Sigma Digital Audio Mixing System to the Remote Port on the Synergy Q/MD-X switcher has the following pinouts.

### Synergy Q/MD-X -to- Calrec Sigma Audio System Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Calrec Sigma Audio System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Studer Audio Mixer Interface Cable Specifications

The serial cable that connects the Studer Audio Mixer to the Remote Port on the Synergy Q/MD-X switcher has the following pinouts.

### Synergy Q/MD-X -to- Studer Audio Mixer Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Studer Audio Mixer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Ethernet Communication Connections

This section includes information to connect a single Audio Mixer to a Synergy Q/MD-X switcher over an ethernet network.

In order to complete this procedure, you will need the following software options, cables, and equipment:

- **Software Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control the Audio Mixer. You must have one of the following software options:
  - **Small Audio Mixer Interface** — This is the software option that allows your Synergy Q/MD-X switcher to control up to 16 audio channels on an audio mixer.
  - **Large Audio Mixer Interface** — This is the software option that allows your Synergy Q/MD-X switcher to control up to 240 audio channels on an audio mixer.

- **Ethernet Cable** — A standard network cable to connect the Audio Mixer to your network.

**Connecting to an Ethernet Network**

The following section presents a brief overview of the ethernet connection process. The exact steps taken in connecting your Audio Mixer and Synergy Q/MD-X switcher via an ethernet network depends on the network topology of your facility.

Use the following method to connect an Audio Mixer and Synergy Q/MD-X switcher via an ethernet network:

1. Connect the Synergy Q/MD-X switcher to your network. Refer to the section “Network Setup” on page 6-2 for information on network setup for your Synergy Q/MD-X switcher.

2. Connect the Audio Mixer to the same subnet as your Synergy Q/MD-X switcher or to a network that has a route to the network your switcher is on. Make a note of the IP Address and Port Number of your Audio Mixer as this information is required when configuring the communication settings on your Synergy Q/MD-X switcher.
   - Network topologies vary greatly between facilities. Contact your IT department for assistance in connecting your Audio Mixer to the appropriate network at your location.
   - Refer to the documentation that came with your Audio Mixer for instructions on connecting it to your network.

3. Configure the ethernet settings on your Synergy Q/MD-X switcher to communicate with the Audio Mixer. Refer to the section “Setting Up the Switcher” on page 19-13 for instructions.

This completes the procedure for connecting an Audio Mixer and Synergy Q/MD-X switcher via an ethernet network.
Setting Up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with an Audio Mixer, the communications port on the Synergy Q/MD-X switcher that the audio mixer is assigned to must be setup to communicate with the particular Audio Mixer you have connected. Refer to the section “Supported Audio Mixers” on page 19-2 for a list of supported Audio Mixers.

When configured, an Audio Mixer channel (or group of channels) will follow a crosspoint when that button is selected and taken to air. Channels will be brought up as the crosspoint is taken to air and unused channels will be brought down on the same transition.

Note

If the ethernet connection is lost between the Wheatstone D-9 and the Synergy Q/MD-X switcher, you may need to uninstall the device to regain control. Refer to the section “Wheatstone D-9 Digital Television Audio Control Surface” on page 19-23 for more information.

Use the following procedure to configure the communications port on the Synergy Q/MD-X switcher to communicate with an Audio Mixer:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.

![Communications Menu 1-2](image)

3. Assign a communications port to the Audio Mixer as follows:
   - Use the Com Port knob to select the Synergy Q/MD-X communications port that is connected to the Audio Mixer.
     ~ If your Audio Mixer requires a serial connection, you must select the remote port on the Synergy control panel that the Audio Mixer is connected to.
     ~ If your Audio Mixer requires an ethernet connection, you must assign a peripheral port to the Audio Mixer.

Note

Remote ports and peripheral ports can only have one device assigned to them at one time. You cannot assign an ethernet and serial device to the same remote or peripheral port.

- Use the Device knob to select Audio Mixers.
4. Press **Select Device** to display the **Select Device Menu**.

![Select Device Menu](image)

5. Assign a specific Audio Mixer to the communications port as follows:

   - Use the **Com Port** knob to select the communications port that the desired Audio Mixer is assigned to.
   - Use the **Device** knob to select the specific Audio Mixer that is connected to the selected communications port. The following Audio Mixers are currently supported:
     - **Ya 01V96** — Use this option to assign a *Yamaha 01V96 Audio Mixer* to the selected communications port.
     - **Ya 02R96** — Use this option to assign a *Yamaha 02R96 Audio Mixer* to the selected communications port.
     - **Ya DM2000** — Use this option to assign a *Yamaha DM2000 Audio Mixer* to the selected communications port.
     - **Ya PM5D** — Use this option to assign a *Yamaha PM5D Audio Mixer* to the selected communications port.
     - **Wheatston** — Use this option to assign a *Wheatstone D-9 Digital Television Audio Control Surface* to the selected Peripheral Port.
     - **Ya M7CL** — Use this option to assign a *Yamaha M7CL-48 Audio Mixer* to the selected communications port.
     - **RAP** — Use this option to assign a *Calrec Sigma Digital Audio Mixing System* to the selected communications port.
     - **Studer** — Use this option to assign a *Studer Audio Mixer* to the selected communications port.

6. Press **Com Type** to display the **Com Type Menu**.

![Com Type Menu](image)
7. Select the communications protocol for the communications port as follows:
   • Use the **Com Port** knob to select the communications port that the desired Audio Mixer is assigned to.
   • Use the **Type** knob to select the serial communications protocol. You can choose from the following:
     ~ **RS-232** — Select this option when you are using the MIDIator to connect an Audio Mixer or multiple Audio Mixers to the Synergy Q/MD-X switcher.
     ~ **RS-422** — Select this option when you are using an RS-422 Interface Cable to connect an Audio Mixer to the Synergy Q/MD-X switcher.

   ~ **Network UDP** — Select this option if your Audio Mixer is connected to the switcher through a network and uses the UDP/IP transmission standard.
   ~ **Network TCP** — Select this option if your Audio Mixer is connected to the switcher through a network and uses the TCP/IP transmission standard. Select this option if you are connecting a **Wheatstone D-9 Digital Television Audio Control Surface**.

---

8. Press **Com Settings** to display the **Com Settings Menu**.

---

9. Set up the communications parameters for the specific Audio Mixer as follows:
   • Use the **Com Port** knob to select the communications port that the desired Audio Mixer is assigned to.
   • Use the **Baud** knob to select **38400**.
   • Use the **Parity** knob to select **NONE**.

---

10. Press **Extra Options** to display the **Extra Options Menu**.

---

11. Set the Converter used to connect the Audio Mixer to your Synergy Q/MD-X switcher as follows:
   • Use the **Com Port** knob to select the communications port that the desired Audio Mixer is assigned to.
   • Use the **Option** knob to select **Converter**.
Communications – Extra Options Menu (Converter)

- Use the Value knob to select the Converter. You can select between the following:
  - None — Select this option when you are using an RS-422 Interface Cable to connect a large Audio Mixer to the Synergy Q/MD-X switcher.
  - MIDIator — Select this option when you are using a MIDIator to connect an Audio Mixer or Multiple Audio Mixers to the Synergy Q/MD-X switcher.

12. Set the number of Audio Mixers you want to connect to your Synergy Q/MD-X switcher as follows:

   • Use the Com Port knob to select the communications port that the desired Audio Mixers are assigned to.
   • Use the Option knob to select Mixers.

   **Important**
   You will need to use a MIDI Solutions Merger to combine the inputs from the multiple Audio Mixers to a single input for the MIDIator that connects to your Synergy Q/MD-X switcher. Refer to the section “Connecting Multiple Audio Mixers” on page 19-7 for information on connecting multiple Audio Mixers.

- Use the Com Port knob to select the communications port that the desired Audio Mixers are assigned to.
- Use the Option knob to select Mixers.

   **Note**
   When connecting multiple Audio Mixers, both must be of the type specified in the Select Device Menu. You cannot gang multiple Yamaha 01V Audio Mixers.

13. If you are not setting up an Audio Mixer that requires ethernet connections, proceed to Step 16 to complete the communications setup.
14. If your Audio Mixer requires an ethernet connection, specify the IP Address for the Audio Mixer as follows:

**Important**

Ensure the **Wheatstone D-9 Digital Television Audio Control Surface** is powered up and connected to the subnet or network before proceeding.

- Press **MORE** to display the **Communications Menu 2-2**.
- Press **Device Network** to display the **Device Network Setup Menu**.
- Use the **Com Port** knob to select the communications port the Audio Mixer is assigned to.
- Use the **IP Settings** knob to select **IP Address**.

![Device Network Setup Menu]

**IP Address — Device Network Setup Menu**

- Use the keypad in the **Global Memory System Group** to enter the IP Address of the specific Audio Mixer you want to control.
- Press **ENTER** in the **Global Memory System Group**.
- Press **Save** in the **Device Network Menu** to save the address, or press **Revert To Current** to reject the new address and return to the previously saved address.

15. If your Audio Mixer requires an ethernet connection, specify the Port Number for the Audio Mixer as follows:

- Use the **Com Port** knob to select the communications port the Audio Mixer is assigned to.
- Use the **IP Settings** knob to select **Port Number**.

**Note**

The **Port Number** is set to 55777 by default. Refer to the documentation for your specific Audio Mixer to determine the correct Port Number for your device.

![Device Network Setup Menu]

**Port Number — Device Network Setup Menu**
• Use the keypad in the **Global Memory System Group** to enter the Port Number of the specific Audio Mixer you want to control.
• Press **ENTER** in the **Global Memory System Group**.
• Press **Save** in the **Device Network Menu** to save the changes, or press **Revert To Current** to reject the new Port Number and return to the previously saved Port Number.

16. Press **HOME** to display the **Installation Change Confirmation Screen**.

17. Accept or reject the changes you have made as follows:
• Press **Confirm** to accept the changes.
• Press **Cancel** to exit the menus safely, without making any changes. The switcher returns to the previously stored settings.

This completes the procedure for basic communication setup of the Synergy Q/MD-X switcher. Next you must finish setting up the Audio Mixer to communicate with the switcher.
### Setting Up the Audio Mixer

In order to complete the communications setup you must configure the Audio Mixer to accept commands and communicate with the Synergy Q/MD-X switcher.

#### Yamaha 01V96

In order to allow the Synergy Q/MD-X switcher to communicate with this Audio Mixer, you must configure it as described in this section. For information on the Function Buttons and navigating the menu system on your Audio Mixer, refer to the documentation that came with your device.

Use the following procedure to set up your Yamaha 01V96 Audio Mixer:

1. Press the **DIO/SETUP** function button in the **Display Access Group** to display the **DIO/SETUP Menu**.
2. Press the **MIDI/HOST** tab to display the **MIDI I/O HOST SETUP Menu**.
3. Use the **Cursor** buttons to navigate to the following (you will have to press **ENTER** after each selection):
   - **Tx PORT** — Use the Parameter Dial to set this to **MIDI**.
   - **Rx PORT** — Use the Parameter Dial to set this to **MIDI**.
4. Press the **MIDI** function button in the **Display Access Group** to display the **MIDI Menu**.
5. Press the **SETUP** tab to display the **MIDI SETUP Menu**.
6. Use the **Cursor** buttons to navigate to the following (you will have to press **ENTER** after each selection):
   - **Tx CH** — Use the Parameter Dial to set this to **1**.
   - **Rx CH** — Use the Parameter Dial to set this to **1**.

**Note**

If you are ganging multiple Audio Mixers, you will have to set the second Audio Mixer to **Tx CH 2** and **Rx CH 2**.

- Use the following table to set the indicated parameters.

<table>
<thead>
<tr>
<th>Yamaha 01V96 Setup</th>
<th>Tx</th>
<th>Rx</th>
<th>OMNI</th>
<th>ECHO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Change</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>Control Change</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>--</td>
</tr>
<tr>
<td>Param Change</td>
<td>ON</td>
<td>ON</td>
<td>--</td>
<td>OFF</td>
</tr>
<tr>
<td>Bulk</td>
<td>--</td>
<td>OFF</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Other Commands</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>OFF</td>
</tr>
</tbody>
</table>

- **Fader Resolution** — Use the Parameter Dial to set this to **LOW**.

This completes the procedure for setting up the Yamaha 01V96 Audio Mixer to communicate with the Synergy Q/MD-X switcher.
Yamaha 02R96

In order to allow the Synergy Q/MD-X switcher to communicate with this Audio Mixer, you must configure it as described in this section. For information on the Function Buttons and navigating the menu system on your Audio Mixer, refer to the documentation that came with your device.

Use the following procedure to set up your Yamaha 02R96 Audio Mixer:

1. Press the **SETUP** function button in the **Display Access Group** to display the **SETUP Menu**.

2. Press the **MIDI/HOST** tab to display the **MIDI/HOST SETUP Menu**.

3. Use the **Cursor** buttons to navigate to the following (you will have to press **ENTER** after each selection):

   - **TO SERIAL HOST** — Use the Parameter Dial to set this to **PC-2**.

   **Note**
   
   If you are ganging multiple Audio Mixers, you must set the **Rx PORT** and **Tx PORT** values to **MIDI**, to connect to the MIDIator.

   - **Rx PORT** — Use the Parameter Dial to set this to **SERIAL**.
   - **Tx PORT** — Use the Parameter Dial to set this to **SERIAL**.

4. Press the **MIDI** function button in the **Display Access Group** to display the **MIDI Menu**.

5. Press the **SETUP** tab to display the **MIDI SETUP Menu**.

6. Use the **Cursor** buttons to navigate to the **RECEIVE Section** and select the following, all other parameters should be deselected (you will have to press **ENTER** after each selection):

   - **Channel 1**
   - **PROGRAM CHANGE**
   - **PARAMETER CHG**

   **Note**
   
   If you are ganging multiple Audio Mixers, you will have to set the second Audio Mixer to **Channel 2**.

7. Use the **Cursor** buttons to navigate to the **TRANSMIT Section** and select the following, all other parameters should be deselected (you will have to press **ENTER** after each selection):

   - **Channel 1**
   - **PROGRAM CHANGE**
   - **PARAMETER CHG**

   **Note**
   
   If you are ganging multiple Audio Mixers, you will have to set the second Audio Mixer to **Channel 2**.

8. Deselect all items in the **OMNI Section**.

9. Press **ENTER** to save your changes.

10. Deselect all items in the **ECHO Section**.

11. Press **ENTER** to save your changes.
This completes the procedure for setting up the Yamaha 02R96 Audio Mixer to communicate with the Synergy Q/MD-X switcher.

**Yamaha DM2000**

In order to allow the Synergy Q/MD-X switcher to communicate with this Audio Mixer, you must configure it as described in this section. For information on the Function Buttons and navigating the menu system on your Audio Mixer, refer to the documentation that came with your device.

Use the following procedure to set up your Yamaha DM2000 Audio Mixer:

1. Press the **SETUP** function button in the **Display Access Group** to display the **SETUP Menu**.
2. Press the **MIDI/HOST** tab to display the **MIDI/HOST SETUP Menu**.
3. Use the **Cursor** buttons to navigate to the following (you will have to press **ENTER** after each selection):
   - **TO SERIAL HOST** — Use the Parameter Dial to set this to **PC-2**.
4. Press the **MIDI** function button in the **Display Access Group** to display the **MIDI Menu**.
5. Press the **SETUP** tab to display the **MIDI SETUP Menu**.
6. Use the **Cursor** buttons to navigate to the **RECEIVE Section** and select the following, all other parameters should be deselected (you will have to press **ENTER** after each selection):
   - **Channel 1**
   - **PROGRAM CHANGE**
   - **PARAMETER CHG**
7. Use the **Cursor** buttons to navigate to the **TRANSMIT Section** and select the following, all other parameters should be deselected (you will have to press **ENTER** after each selection):
   - **Channel 1**
   - **PROGRAM CHANGE**
   - **PARAMETER CHG**
8. Deselect all items in the **OMNI Section**.
9. Press **ENTER** to save your changes.
10. Deselect all items in the **ECHO Section**.
11. Press **ENTER** to save your changes.

This completes the procedure for setting up the Yamaha DM2000 Audio Mixer to communicate with the Synergy Q/MD-X switcher.
Yamaha PM5D

In order to allow the Synergy Q/MD-X switcher to communicate with this Audio Mixer, you must configure it as described in this section. For information on the Function Buttons and navigating the menu system on your Audio Mixer, refer to the documentation that came with your device.

Use the following procedure to set up your Yamaha PM5D Audio Mixer:

1. Press the MIDI/Remote function button in the Display Access Group to display the MIDI/Remote Menu.
2. Press the MIDI/Remote function button to display the MIDI SETUP Screen.
3. In the MIDI Port row of the MIDI SETUP Screen, select the following values, pressing ENTER after each selection:
   - In the Tx column — Use the Track Pad buttons to set this field to MIDI.
   - In the Rx column — Use the Track Pad buttons to set this field to MIDI.
4. In the Single Mode MIDI CH row of the MIDI SETUP Screen, select the following values, pressing ENTER after each selection:
   - In the Tx column — Use the Track Pad buttons to set this to 1.
   - In the Rx column — Use the Track Pad buttons to set this to 1.

   Note

   If you are ganging multiple Audio Mixers, you will have to set the second Audio Mixer to Tx CH 2 and Rx CH 2. You will also need to set the MIDI Thru value to MIDI in the Rx Column for all the Audio Mixers you are connecting.

   • Use the following table to set the indicated parameters

   **Yamaha PM5D Setup**

<table>
<thead>
<tr>
<th></th>
<th>Tx</th>
<th>Rx</th>
<th>ECHO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Change</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Control Change</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>Parameter Change</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Other Commands</td>
<td>--</td>
<td>--</td>
<td>OFF</td>
</tr>
</tbody>
</table>

This completes the procedure for setting up the Yamaha PM5D Audio Mixer to communicate with the Synergy Q/MD-X switcher.

Yamaha M7CL-48

In order to allow the Synergy Q/MD-X switcher to communicate with this Audio Mixer, you must configure it as described in this section. For information on the Function Buttons and navigating the menu system on your Audio Mixer, refer to the documentation that came with your device.

Use the following procedure to set up your Yamaha M7CL-48 Audio Mixer:

1. Press the MIDI/Remote function button in the Display Access Group to display the MIDI/Remote Menu.
2. Press the MIDI/Remote function button to display the MIDI SETUP Screen.
3. In the MIDI Port row of the MIDI SETUP Screen, select the following values, pressing ENTER after each selection:
• In the **Tx column** — Use the **Track Pad** buttons to set this field to **MIDI**.
• In the **Rx column** — Use the **Track Pad** buttons to set this field to **MIDI**.

4. In the **Single Mode MIDI CH** row of the **MIDI SETUP Screen**, select the following values, pressing **ENTER** after each selection:
   • In the **Tx column** — Use the **Track Pad** buttons to set this to 1.
   • In the **Rx column** — Use the **Track Pad** buttons to set this to 1.

---

**Note**

If you are ganging multiple Audio Mixers, you will have to set the second Audio Mixer to **Tx CH 2** and **Rx CH 2**. You will also need to set the **MIDI Thru** value to **MIDI** in the **Rx Column** for all the Audio Mixers you are connecting.

---

**Yamaha M7CL-48 Setup**

<table>
<thead>
<tr>
<th></th>
<th>Tx</th>
<th>Rx</th>
<th>ECHO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Change</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Control Change</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>Parameter Change</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Other Commands</td>
<td>--</td>
<td>--</td>
<td>OFF</td>
</tr>
</tbody>
</table>

This completes the procedure for setting up the Yamaha M7CL-48 Audio Mixer to communicate with the Synergy switcher.

---

**Wheatstone D-9 Digital Television Audio Control Surface**

Use the following information when setting up and operating your Wheatstone D-9 Digital Television Audio Control Surface with the Synergy Q/MD-X switcher.

**Ethernet Connections**

If the ethernet connection is lost for longer than 2 minutes between the Wheatstone D-9 Digital Television Audio Control Surface and the Synergy Q/MD-X switcher, the switcher will no longer communicate with the Wheatstone D-9. Should this occur, you must uninstall and re-install the Wheatstone D-9 on the Synergy Q/MD-X switcher.

Use the following procedure to uninstall the Wheatstone D-9 on the Synergy Q/MD-X switcher:

1. Ensure the Wheatstone D-9 Digital Television Audio Control Surface is powered up and connected to the network.
2. Navigate to the **Communications Menu 1-2** as follows:
   • Press **HOME ➔ MORE ➔ Setup ➔ Installation ➔ Communications**.
3. Press **Select Device** to display the **Communications Device Menu**.
4. Use the **Com Port** knob to select the Peripheral Port that the Wheatstone D-9 is assigned to on the Synergy Q/MD-X switcher.
5. Use the **Device** knob to select **NONE**.
6. Press **HOME** to display the **Installation Change Confirmation Screen**.
7. Accept or reject the changes you have made as follows:
   • Press **Confirm** to accept the changes.
• Press **Cancel** to exit the menus safely, without making any changes. The switcher returns to the previously stored settings.

This completes the procedure for uninstalling the Wheatstone D-9 on the Synergy Q/MD-X switcher. Next you must reinstall the Wheatstone D-9 on the switcher. Refer to the section “Setting Up the Switcher” on page 19-13 for instructions.

**Calrec Sigma Digital Audio Mixing System**

Use the following information when setting up your **Calrec Sigma Digital Audio Mixing System** with the Synergy Q/MD-X switcher.

- Ensure the port on the Calrec Sigma panel, that is connected to the Synergy Q/MD-X switcher, is configured for RS422 communications.
- Use the following communications settings when connecting a Calrec Sigma Digital Audio Mixing System to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>115200</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Studer Audio Mixer**

Use the following information when setting up your **Studer Audio Mixer** with the Synergy Q/MD-X switcher.

The Studer Audio Mixer can have a variable number of input channels and has two program output channels. You must specify the number of input channels on your audio mixer as well as which output channel you wish to control with your Synergy Q/MD-X switcher.

Use the following procedure to configure your Synergy Q/MD-X switcher to control the Studer Audio Mixer:

1. Navigate to the **Communications Menu 1-2** as follows:
   - Press **HOME ➔ MORE ➔ Setup ➔ Installation ➔ Communications**.
2. Press **Extra Options** to display the **Extra Options Menu**.
3. Set the number of input channels on the Studer Audio Mixer as follows:
   - Use the **Com Port** knob to select the communications port that the desired Audio Mixer is assigned to.
   - Use the **Option** knob to select **Max Channels**.
Communications – Extra Options Menu (Max Channels)

- Use the Value knob to set the number of input channels on your Studer Audio Mixer. Values increase and decrease in multiples of 3.

4. Set the program output channel you wish to control as follows:

- Use the Option knob to select PGM Output.
- Use the Value knob to select which program output you wish to control. You can select between the following:
  - PGM A — Select this option to control program output A.
  - PGM B — Select this option to control program output B.

5. Press HOME to display the Installation Change Confirmation Screen.

6. Accept or reject the changes you have made as follows:

- Press Confirm to accept the changes.
- Press Cancel to exit the menus safely, without making any changes. The switcher returns to the previously stored settings.

This completes the procedure for configuring your Synergy Q/MD-X switcher to control the Studer Audio Mixer.
Assigning Sources to Audio Channels

You need to assign audio sources to the audio channels that you control with your Synergy Q/MD-X switcher. This allows you to select specific sources to control when there are more sources than input channels on your audio mixer.

**Note**

This feature is currently supported on the Studer Audio Mixer only.

Use the following procedure to assign audio sources to input audio channels:

1. Navigate to the **Assign Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Audio.
2. Press **Assign Source** ⇒ **Select Source** to display the **Assign Audio Source Menu**.
3. Use the **Audio Channel** knob to select the input audio channel you wish to assign a source to. The number of channels listed is the number of channels you specified when setting the **Max Channels** extra option for your audio mixer.
4. Use the **Audio Source** knob to select the audio source that you wish to assign to the selected input audio channel.
5. Press **Name Channel** to display the **Audio Source Names Menu** (if you do not wish to change the channel name, skip to step 8).
6. Use the knobs and softkeys to name your audio bank as follows:

**Operating Tip**

A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.

- Use the **Horizontal** knob to move the cursor horizontally.
• Use the **Vertical** knob to move the cursor vertically.
• Use the **Space** button to insert a space in the **New Name** field.
• Use the **Prev Letter** button to select the previous letter in the **New Name** field.
• Use the **Next Letter** button to select the next letter in the **New Name** field.

7. Press **Accept New Name** when you are done naming the channel.

8. Press **Assign All** to complete the assignment of audio sources to input audio channels.

| Note | If you do not press **Assign All**, an error message will be displayed when you attempt to control your audio mixer from the Synergy Q/MD-X control panel. |

This completes the procedure for assigning audio sources to input audio channels.
Setting Up Audio Channels and Groups

Audio, from a remote Audio Mixer, can be configured as individual channels or grouped together, with up to three channels per group. When you set up the audio channels, you also set the Default Levels for the individual channels. These default levels are the ones that the switcher will set the channels to when you perform an audio reset custom control. Refer to the section “Setting Up Audio Overrides” on page 19-32 for more information on audio custom controls.

Setting Up Audio Channels

Use the following procedure to setup the default audio level for a channel:

1. Navigate to the Audio Menu as follows:
   - Press HOME ⇔ MORE ⇔ Setup ⇔ Installation ⇔ MORE ⇔ Audio.
2. Press Audio Level to display the Audio Level Menu.

<table>
<thead>
<tr>
<th>Audio Channel 1</th>
<th>Audio Channel 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Level</td>
<td>(75, 85)</td>
</tr>
</tbody>
</table>

   Audio Level Menu

3. Set the level for each audio channel as follows:
   - Use the Audio Channel knob to select the audio channel that you want to set the default audio level for.

   Note: If you have programmed Audio Assign Custom Controls, the top Audio Channel knob will display the Custom## for the custom control that you assigned the channel to.

   - Use the Level knob to select the default audio level for the selected channel. All channels are initially set at 75%.

This completes the procedure for setting up the default audio levels for audio channels.

Setting Up Audio Groups

Use the following procedure to assign audio channels to groups:

1. Navigate to the Audio Menu as follows:
   - Press HOME ⇔ MORE ⇔ Setup ⇔ Installation ⇔ MORE ⇔ Audio.
2. Press **Audio Groups** to display the **Audio Group Menu**.

![Audio Group Menu Table]

3. Press **Group 1** to assign audio channels to that group. There are a total of six audio groups you can assign audio channels to.

4. Assign up to three audio channels to the selected group as follows:

   - Use the **Audio Channel 1** knob to select the first audio channel that you want to assign to the group.
   - Use the **Audio Channel 2** knob to select the second audio channel that you want to assign to the group.
   - Use the **Audio Channel 3** knob to select the third audio channel that you want to assign to the group.

This completes the procedure for assigning audio channels to groups.

**Note**

If you have programmed **Audio Assign Custom Controls**, the top **Audio Channel** knob will display the **Custom##** for the custom control that you assigned the channel to.

**Note**

Assigning audio channels to groups does not alter the default or custom audio levels that you have set for them.
Audio Channel Assignment

You can assign up to two audio sources to each BNC. Each source can be a channel or a group of channels. Channels and groups that are assigned to BNC inputs follow the BNC inputs to air on a transition. This Audio-Follow-Video (AFV) is the normal interaction of an Audio Mixer and the Synergy Q/MD-X switcher. You can alter this normal AFV operation at any time by applying an Audio Override. Refer to the section “Setting Up Audio Overrides” on page 19-32 for more information on applying an audio override.

Assigning Audio Channels to a BNC

Use the following procedure to assign audio channels, or groups, to a BNC:

1. Navigate to the BNC Menu 2-3 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC ⇒ MORE.
2. Press Audio to display the Audio Setup Menu.

   BNC – Audio Setup Menu

3. Assign audio channels, or groups, to your BNCs as follows:

   • Use the BNC knob to select the BNC, or video, that the audio mixer will follow for normal AFV operation.
   • Use the Audio 1 knob to select a channel or group you want to assign to the selected BNC.
   • Use the Audio 2 knob to select another channel or group you want to assign to the selected BNC.

Your configured audio mixer channels will now follow crosspoint transitions for normal AFV operation.
Audio Transition MLE Assignment

Depending on how you want audio transitions to be performed, you can set up the switcher so that it will either perform an audio transition when a transition is performed in any MLE, or only when a transition is performed in the PGM/PST MLE.

Use the following procedure to set up when your audio transitions are performed:

1. Navigate to the Personality Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select AudioTrans.

<table>
<thead>
<tr>
<th>Personality — Audio Trans Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AudioTrans</strong></td>
</tr>
<tr>
<td><strong>Auto Recall</strong></td>
</tr>
<tr>
<td><strong>Aux Lit</strong></td>
</tr>
<tr>
<td><strong>Db1 Press Rate</strong></td>
</tr>
<tr>
<td><strong>ESK1 Auto Cut</strong></td>
</tr>
<tr>
<td><strong>ESK2 Auto Cut</strong></td>
</tr>
<tr>
<td><strong>ESK3 Auto Cut</strong></td>
</tr>
<tr>
<td><strong>ESK4 Auto Cut</strong></td>
</tr>
<tr>
<td><strong>3D Pattern</strong></td>
</tr>
<tr>
<td><strong>Button Assign</strong></td>
</tr>
<tr>
<td><strong>Mnemonic</strong></td>
</tr>
<tr>
<td><strong>Plug</strong></td>
</tr>
</tbody>
</table>

3. Use the Value knob to select when an audio transition is performed. You can select between the following:
   - **All** — This option tells the switcher to perform an audio transition when any MLE is transitioned.
   - **Pgm** — This option tells the switcher to perform an audio transition only when a Program MLE is transitioned.

This completes the procedure for setting when audio transitions are performed.
Setting Up Audio Overrides

In normal operation, the switcher works in an Audio-Follow-Video (AFV) mode. In this mode, the audio channels, or groups, are faded on and off automatically following each video transition. In more complex audio situations, the AFV mode can be overridden, allowing audio to be transitioned independently, or multiple audio channels to be taken to air without their associated video. This override mode is useful if, for example, you are producing an interview, or debate, and you want to keep several audio channels on-air, even when the associated video signals are not.

In order to perform an audio override, you must set up an Audio Custom Control Bank and a number of audio specific custom controls. These custom controls will allow you to have the PGM/PST MLE, the bottom MLE, act as an audio mixer, turning the buttons on each bus into audio crosspoints.

Audio Custom Control Bank Setup

Audio banks are used to store audio custom controls, like normal custom control banks, as well as put the PGM/PST MLE into Audio Mixer Mode. When held, the Audio Bank button will allow you to perform overrides on the AFV settings, as well as perform audio only transitions. Refer to the section “Audio Only Transitions” on page 19-48 for more information.

Use the following procedure to set up an Audio Custom Control Bank:

1. Navigate to the Installation Menu 2-2 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE.
2. Press Custom Controls to display the Setup Banks Menu.
3. Assign a custom control button to an audio bank as follows:
   • Use the Bank knob to select the bank that you want to assign to Audio.
   • Use the Button knob to select the desired custom control button that you want to assign as the Audio Bank.

In this example we use Button # 1 because the corresponding video crosspoint (the crosspoint directly below it) is usually set to BLACK and will not have any associated audio. You can use any button you like.
• Use the Type knob to select Audio.

4. Press Modify Bank Name to display the Custom Control Bank Names Menu 1-2.

<table>
<thead>
<tr>
<th>Custom Control Bank Names (1-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>a b c d e f g h i j k l m n o p q r s t u v w x y z</td>
</tr>
<tr>
<td>&quot;ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
</tr>
<tr>
<td>0 1 2 3 4 5 6 7 8 9 + - _ * ( ) / , ? &quot;</td>
</tr>
</tbody>
</table>

5. Use the knobs and softkeys to name your audio bank as follows:

Operating Tip
A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.

Important
Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

• Use the Horizontal knob to move the cursor horizontally.
• Use the Vertical knob to move the cursor vertically.
• Use the Bank number knob if you want to name a different bank.
• Use the Space button to insert a space in the New Name field.
• Use the Prev Letter button to select the previous letter in the New Name field.
• Use the Next Letter button to select the next letter in the New Name field.

6. Press Accept New Name when you are done naming the Audio bank.

Note
If the Mnemonic Display option is purchased and installed, the Mnemonic field displays the bank name as it will appear in the associated mnemonic display.

7. Press HOME and Confirm to save the new settings.

This completes the procedure for setting up an Audio Custom Control Bank.

Audio Custom Controls

When an audio source is assigned as a single channel (or in a group) in an Audio Assign Custom Control, that channel can be controlled and brought to air independently, without being associated with any video input. In this way, audio output from microphones, audio servers, and other devices can be brought to air without associated video.

The following Custom Controls are covered in this section:

• Assign Audio
• Reset Audio
• Audio All Off
Assign Audio

The Assign Audio custom control has two roles when working with audio. In normal mode, it allows you to access the levels for the audio channel or group you have assigned to that button. When the Audio Bank Custom Control button is pressed and held, the audio channel or group that is assigned to that custom control will be mapped onto the PGM and PST buses of the bottom MLE. This allows you to change the audio channels that are on-air, by selecting them on the PGM bus, or they will be taken to air during the next transition, by selecting them on the PST bus. Refer to the section “Audio Modes” on page 19-46 for more information.

Use the following procedure to create an Assign Audio custom control:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record as follows:
   - Use the Bank knob to select the Audio bank you created.
   - Use the Button knob to select the custom control button that you want to program.

   Note
   If you have assigned Custom01 button as your Audio Bank, you will not be able to press it to access the Audio Level Menu.

3. Navigate to the Special Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ Special.
4. Select the audio channel you want to assign to the selected custom control as follows:
   • Use the **Function** knob to select **Assign Audio**.
   • Use the **Channel** knob to select the channel or group you wish to assign to the custom control.

   **Operating Tip**
   The Audio Channel that you assign to this custom control will be the channel that is mapped down to the PGM and PST buses when you are in Audio Mixer mode. You should assign the same audio channel that is assigned to the BNC crosspoint to the corresponding custom control. For example, if you have **Channel 01** assigned to **BNC crosspoint 4**, you should assign **Channel 01** to **Custom04**. This way, as you go back and forth to Audio Mixer Mode, the audio channels that are assigned to the video channels for AFV will be the same crosspoint buttons.

5. Press **Insert** to enter the command in your custom control macro and display the **Audio Level Menu**.

   **Note**
   Note that the name of the selected channel or group changes to **Custom##** when you press **Insert**.

![Audio Level Menu](image)

**Audio Level Menu**

When you press this custom control this **Audio Level Menu** will be displayed. Each menu allows you to adjust the level for the channel, as well as the Master Audio Level. Refer to the section “**Audio Levels and Pan Settings**” on page 19-48 for more information.

6. Press **HOME** to display the **Main Menu 1-2**.
7. Press **Custom Controls** to return to the **Custom Controls Menu 1-2**.
8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating an audio assign custom control. You will need to repeat this procedure for each audio channel you want to be able to override.

**Reset Audio**

The **Reset Audio** custom control allows you to return to the normal AVF mode and remove all currently selected overrides. This can be performed for either the PGM bus, or the PST. You will have to set up two custom controls if you want to be able to perform both.
Use the following procedure to program a **Reset Audio**:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME** ⇒ **Custom Controls**.

   ![Custom Controls Menu](image)

   **Custom Controls Menu**

   **Note** If you do not have any available custom control buttons on your **Audio Bank**, you can create a second **Normal Bank**.

2. Select the custom control button you want to assign the **Audio All Off** to as follows:
   - Use the **Bank** knob to select the Audio Bank you created.
   - Use the **Button** knob to select the custom control button that you wish to program.

3. Navigate to the **Special Menu** as follows:
   - Press **Start Recording** ⇒ **Insert Special** ⇒ **Special**.

   ![Insert Special — Special Menu](image)

4. Assign **Reset Audio** to the selected custom control button as follows:
   - Use the **Function** knob to select **Reset Audio**.
   - Use the **Audio Bus** knob to select the bus that you want to assign the **Reset Audio** to. You can choose between the following:
     - **Program** — This function will restore all AFV for the on-air audio. All audio channels that are associated with a BNC that is on-air will be turned on at the level they were last on at, and all other audio channels will be turned off.
     - **Preset** — This function will restore all Audio-Follow-Video and levels for the next transition. At the next audio transition, all audio channels and levels
associated with a BNC on the PST bus will be turned on at their default levels during the transition.

**Note**

A **Reset Audio** for the Preset bus will not change the **Preset** audio values for the audio channels, or groups, that are currently on-air. When this channel, or group, is taken off-air, the custom control button that is assigned to the **Reset Audio** for the Preset bus will have to be pressed *again* in order to set these channels, or groups, to their default values.

5. Press **Insert** to enter the command in your custom control macro.
6. Press **HOME** to display the **Main Menu 1-2**.
7. Press **Custom Controls** to return to the **Custom Controls Menu 1-2**.
8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating an **Reset Audio** custom control.

**Audio All Off**

The **Audio All Off** custom control will fade all audio channels on either the **PGM** bus or the **PST** bus off. This can be useful for quickly removing all audio from either bus or taking all audio channels off-air after you have performed an Audio Memory Recall. Refer to the section “**Audio Memory**” on page 19-38 for more details.

**Note**

This custom control functions as an override and will take all audio channels, including AFV off. In order to reinstate AFV you will have to run a **Reset Audio** custom control. Refer to the section “**Reset Audio**” on page 19-35 for more details.

Use the following procedure to create an **Audio All Off** custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ⇒ Custom Controls**.

   ![Custom Controls Menu](image)

   **Note**

   If you do not have any available custom control buttons on your **Audio Bank**, you can create a second **Normal Bank**.

2. Select the custom control button you want to assign the **Audio All Off** to as follows:
   - Use the **Bank** knob to select the Audio Bank you created.
   - Use the **Button** knob to select the custom control button that you wish to program.
3. Navigate to the **Special Menu** as follows:
Press **Start Recording ⇔ Insert Special ⇔ Special.**

4. Assign **Audio All Off** to the selected custom control button as follows:
   - Use the **Function** knob to select **Audio All Off**.
   - Use the **Audio Bus** knob to select the bus that you want to assign the **Audio All Off** to. You can choose from the following:
     ~ Program — This option will fade off all audio channels on the Program bus.
     ~ Preset — This option will fade off all audio channels on the Preset bus.

5. Press **Insert** to enter the command in your custom control macro.
6. Press **HOME** to display the **Main Menu 1-2**.
7. Press **Custom Controls** to return to the **Custom Controls Menu 1-2**.
8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating an **Audio All Off** custom control.

**Audio Memory**

**Important**

The switcher sends a MIDI Program Change Event command for audio memory recalls. Please ensure that the Audio Mixer is setup to recall the proper scene when the Program Change Event command is executed. Refer to the documentation for your device for setup details.

The **Audio Memory** custom control will recall a memory that has been stored on the Audio Mixer. This can be useful to take a number of channels to air at different levels all at once. The **Memory** numbers on the **Insert Special Menu** correspond to the memories that are stored on the Audio Mixer. For example, memory 02 on the Yamaha 02R96 Audio Mixer will be accessed by selecting 2 with the **Memory** knob. Refer to the documentation that came with your audio mixer for information on storing audio memories.

**Important**

When an **Audio Memory** is recalled, the only way to take the audio channels off-air is to run an **Audio All Off PGM/Reset PGM sequence**, refer to the section “**Audio All Off**” on page 19-37 for more details. The on-air channels will not appear on the **PGM/PST** buses.

Use the following procedure to create an **Audio Memory** recall custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ⇔ Custom Controls**.
2. Select the custom control button you want to assign the Audio Memory to as follows:
   • Use the Bank knob to select the Audio Bank you created.
   • Use the Button knob to select the custom control button that you wish to program.

3. Navigate to the Special Menu as follows:
   • Press Start Recording ⇒ Insert Special ⇒ Special.

4. Assign a particular Audio Memory to the selected custom control button as follows:
   • Use the Function knob to select Audio Memory.
   • Use the Memory knob to select the memory, or event, that you want to recall from the Audio Mixer.
     ~ If you are using a Wheatstone D-9 Digital Television Audio Control Surface, the Synergy switcher can recall audio events numbered 0 to 99 inclusive. Ensure your audio events are named using the default convention of PROG#0xx where xx is a number between 0 and 99.

5. Press Insert to enter the command in your custom control macro.

6. Press HOME to display the Main Menu 1-2.

7. Press Custom Controls to return to the Custom Controls Menu 1-2.

8. Press Finish Recording, or the flashing custom control button.

This completes the procedure for creating an Audio Memory custom control.
**Audio CH On**

The **Audio CH On** custom control will turn a channel, or group, on at the level it was last on at, or leave it unchanged if the channel is already on. This can be useful if you want to take a channel, or group, to air at once. You can use the **Audio CH On** for either the **PGM** bus or **PST** bus.

**Note**
You can assign multiple **Audio CH On** macros to the same custom control, allowing you to turn a number of channels, or groups, on for either the **PGM** bus or **PST** bus. Unlike the Audio Memory function, **Reset Audio** will return the switcher to AFV mode.

Use the following procedure to create an **Audio CH On** custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME** ⇒ **Custom Controls**.

   ![Custom Controls Menu Table]

   **Custom Controls Menu**

   ![Insert Special — Special Menu]

   **Insert Special — Special Menu**

2. Select the custom control button you want to assign the **Audio CH On** to as follows:
   - Use the **Bank** knob to select the Audio Bank you created.
   - Use the **Button** knob to select the custom control button that you wish to program.

3. Navigate to the **Special Menu** as follows:
   - Press **Start Recording** ⇒ **Insert Special** ⇒ **Special**.

4. Assign **Audio CH On** to the selected custom control button as follows:
   - Use the **Function** knob to select **Audio CH On**.
   - Use the **Channel** knob to select the audio channel you want to turn on.
• Use the **Audio Bus** knob to select the which bus, **PGM** or **PST**, the audio channels will be turned on for.

**Note**

If you select **Preset**, the audio channels will turn on for the **PST** bus and will be taken to air during the next transition. If you select **Program**, the audio channels will be taken to air immediately.

5. Press **Insert** to enter the command in your custom control macro.

6. Press **HOME** to display the **Main Menu 1-2**.

7. Press **Custom Controls** to return to the **Custom Controls Menu 1-2**.

8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating an **Audio CH On** custom control.

### Audio CH Off

The **Audio CH Off** custom control will turn a channel or group off. This can be useful if you want to turn a specific channel, or group, off while not affecting the other channels. You can use the **Audio CH Off** for either the **PGM** bus or **PST** bus.

Use the **Audio CH Off** feature to create a custom control that will fade out any audio channel or group. Any combination of channels (numbered 1 - 64) or groups (numbered 1 - 6) can be faded out at the touch of a single custom control button.

**Note**

You can assign multiple **Audio CH Off** macros to the same custom control, allowing you to turn a number of channels or groups off on either the **PGM** bus or **PST** bus.

Use the following procedure to create an **Audio CH Off** custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   • Press **HOME** ⇒ **Custom Controls**.

2. Select the custom control button you want to assign the **Audio CH Off** to as follows:
   • Use the **Bank** knob to select the Audio Bank you created.
   • Use the **Button** knob to select the custom control button that you wish to program.

3. Navigate to the **Special Menu** as follows:
   • Press **Start Recording** ⇒ **Insert Special** ⇒ **Special**.
4. Assign Audio CH Off to the selected custom control button as follows:
   • Use the Function knob to select Audio CH Off.
   • Use the Channel knob to select the audio channel you want to turn off.
   • Use the Audio Bus knob to select the which bus, PGM or PST, the audio channels will be turned off for.

   **Note** If you select Preset, the audio channels will turn off for the PST bus. If you select Program, the audio channels will be taken off air immediately.

5. Press Insert to enter the command in your custom control macro.

6. Press HOME to display the Main Menu 1-2.

7. Press Custom Controls to return to the Custom Controls Menu 1-2.

8. Press Finish Recording, or the flashing custom control button.

This completes the procedure for creating an Audio CH Off custom control.

**PGM Audio Level**

Use the PGM Audio Level feature to create a custom control that will override the audio levels on the program bus. Any combination of channels (numbered 1 - 64) or groups (numbered 1 - 6) can be set at the touch of a single custom control button.

The PGM Audio Level custom control will set the PGM bus level for an audio channel or group. If the Channel is on-air, this will alter the level for the channel. If the Channel is not on air, this will take it to air as an override. PGM Audio Level differs from Audio CH On in that you select the level that you want the channel to be set to. When run, the custom control will alter the level of the channel, even if it is on. Audio CH On will only turn the channel on if it is off and will not change the level. This could be useful when you want to alter the levels of a number of channels, or groups, at the same time.

   **Note** You can assign multiple PGM Audio Level macros to the same custom control, allowing you to alter the levels for a number of channels at the same time.

Use the following procedure to create a PGM Audio Level custom control:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   • Press HOME ➔ Custom Controls.
2. Select the custom control button you want to assign the **PGM Audio Level** to as follows:
   - Use the **Bank** knob to select the Audio Bank you created.
   - Use the **Button** knob to select the custom control button that you wish to program.

3. Navigate to the **Special Menu** as follows:
   - Press **Start Recording** ⇒ **Insert Special** ⇒ **Special**.

4. Assign **PGM Audio Level** to the selected custom control button as follows:
   - Use the **Function** knob to select **PGM Audio Lvl**.
   - Use the **Channel** knob to select the audio channel you want to change the level for.
   - Use the **Level** knob to select the level you want to set the channel to.

5. Press **Insert** to enter the command in your custom control macro.

6. Press **HOME** to display the **Main Menu 1-2**.

7. Press **Custom Controls** to return to the **Custom Controls Menu 1-2**.

8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating a **PGM Audio Level** custom control.

**PST Audio Level**

Use the **PST Audio Level** feature to create a custom control that will override the audio levels on the PST bus. The audio level for any combination of channels (numbered 1 - 64) or groups (numbered 1 - 6) can be set at the touch of a single custom control button.

The **PST Audio Level** custom control will set the PST bus level for an audio channel or group. If the channel is on-air, this will create an override that will take the channel to the new level during the next
transition. If the channel is off-air, this will create an override that will take the channel to air at the new level on the next transition. This could be useful if you want to prepare a number of channels or groups at a set level to be taken to air on the next transition.

Note

You can assign multiple PST Audio Level macros to the same custom control, allowing you to alter the levels for a number of channels at the same time.

Use the following procedure to create an PST Audio Level custom control:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

   ![Custom Controls Menu](image1)

2. Select the custom control button you want to assign the PST Audio Level to as follows:
   - Use the Bank knob to select the Audio Bank you created.
   - Use the Button knob to select the custom control button that you wish to program.

3. Navigate to the Special Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ Special.

   ![Insert Special — Special Menu](image2)

4. Assign PST Audio Level to the selected custom control button as follows:
   - Use the Function knob to select PST Audio Lvl.
   - Use the Channel knob to select the audio channel you want change the level for.
   - Use the Level knob to select the level you want to set the channel to.

5. Press Insert to enter the command in your custom control macro.

6. Press HOME to display the Main Menu 1-2.
7. Press **Custom Controls** to return to the **Custom Controls Menu 1-2**.

8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating an **PST Audio Level** custom control.
Audio Modes

When an Audio Mixer is connected to the Synergy Q/MD-X switcher, it can be operated in one of two ways: normal Audio-Follow-Video (AFV) mode, and Override mode.

Audio-Follow-Video Mode

The AFV mode is where an audio channel is taken to air when the video BNC it is assigned to is taken to air. The audio will follow the video on and off air like this for all transitions on the PGM/PST MLE, unless the Audio Transitions Personality has been set to All, refer to the section “Audio Transitions” on page 19-47 for more information.

For example, there may be a number of camera setups in the studio, each one focusing on a different talent. When a particular camera is taken to air, you also want the talent microphone audio taken to air. When that camera is taken off air, you also want the corresponding audio channel to be taken off air. This is the normal AFV mode of operation.

Note

Remember that if you Fly a Key and then expand it to full frame, the underlying video is still on-air, even though you cannot see it. The audio for both video sources will still be on-air. This is also important to remember if you are running shots from memories where you bring a Key full frame from an over the shoulder shot.

Override Mode

The Override mode is when the normal AFV mode has been altered, either by changing the levels, taking more or less channels to air, or altering the channels that will be taken to air on the next transition. Overrides are applied by using one of the custom controls discussed in the section “Setting Up Audio Overrides” on page 19-32. For example, if you have an over the shoulder shot, the audio channels for both the talent and the Key would be on-air as per normal AFV. If you transition to a shot with only the VTR clip, then the audio from the talent would be taken off. If you wanted both audio channels to remain, you would have to set up an override by turning on the audio crosspoint for the talent on the PST bus. When you make the transition, the switcher will take the video off air, but will keep the audio on.

Editor Mode

The Editor mode is when the switcher is being remotely operated by the OverDrive Editor. OverDrive will perform both AFV and overrides without having to setup any override custom controls. For more information on OverDrive contact Ross Video.
Operation Overview

This section provides a brief overview of the operation of the Synergy Q/MD-X switcher when performing audio transitions.

### Note

In the unlikely case that the ethernet connection is lost between the Wheatstone D-9 and the Synergy Q/MD-X switcher, you may need to uninstall and re-install the device on the switcher. Refer to the section “Wheatstone D-9 Digital Television Audio Control Surface” on page 19-23 for details.

During all audio transitions, the Synergy Q/MD-X switcher keeps track of three separate levels for each audio channel, or group:

- **Current** — The Current level is the level of the channel, or group, that is currently on-air. This level can be adjusted using the PGM Audio Lvl custom control that is assigned to that channel, or group.

- **Preset** — The Preset level is the level of the channel, or group, that will take effect during the next transition of the audio. This level can be adjusted using the PST Audio Lvl custom control that is assigned to that channel, or group. **Preset Levels only** take effect when an audio channel, or group, is transitioned to air, and do not take affect during cuts or crosspoint changes.

- **Default** — The Default level is the level that the channel, or group, was set to originally from the Audio Installation Menu. When you perform an Audio Reset, all off-air audio channels will have their preset levels changed to the default level. This will not change the Preset values for the audio channels that are on-air.

### Note

The Synergy Q/MD-X switcher keeps track of all three of these audio levels for each channel, or group, and will use them when that channel, or group, is transitioned.

### Audio Transitions

During an audio transition, the Synergy Q/MD-X switcher prepares to take the Preset audio channels to air as follows:

1. The switcher applies the normal Audio-Follow-Video rules to select which channels, or groups, will be taken to air.

2. The switcher checks for preset overrides that will turn channels, or groups, off or on, depending on how they are set in the Audio PST Bus.

3. The switcher performs the audio transition by fading the PST channels to their Preset audio levels. These levels then become the Current levels for those channels, or groups.

### Note

When an audio channel is faded off by dragging the level to zero on the Audio Mixer, that channel will return to the default level the next time it is taken to air.

4. The switcher then saves the Current levels of the audio channels that were taken off-air as the Preset levels for those channels, or groups. These levels will be used as the Preset levels for the next transition.
Audio Specific Functions

This section describes a number of audio only functions that can be performed on the switcher to adjust the audio setting of the Audio Mixer.

Audio Only Transitions

With the audio override custom controls properly set up, it is possible to perform an audio only transition. This transition will not alter the video signals on the PGM bus or PST bus, but will transition the audio crosspoints on those buses.

Use the following procedure to perform an Audio Only Transition:

1. Press and hold the Bank Custom Control Button to place the PGM/PST MLE into Audio Mixer mode.

2. Select the audio crosspoints that you want to take to air on the PST bus.

3. Press Auto Trans in the PGM/PST MLE Transition Group to perform the audio only transition.

Important

You must hold the Bank button referred to in step one for the entire procedure.

Note

The crosspoints on the PGM and PST buses are now audio crosspoints and represent the audio channels that are on-air and will be taken to air in the next transition, just like video is represented on the MLE. Each crosspoint represents an audio channel that was assigned to the corresponding custom control button. For example, the audio channel that was assigned to custom control button 03 will be mapped onto the 03 audio crosspoint.

Important

Audio Only Transitions should only be performed once as they will create an audio override. In order to properly perform your next transition, you should check the audio crosspoints and run as Audio Reset PST to return to AFV, if needed.

This completes the procedure for performing an Audio Only Transition.

Audio Levels and Pan Settings

You can adjust the Audio Level for a particular channel, or the Master level, and the Pan Settings using the Assign Audio custom control. Refer to the section “Assign Audio” on page 19-34 for more information.

Use the following procedure to adjust volume and pan settings of a selected audio channel or group:

1. Press the Custom Control button that has been assigned to the channel, or group, that you want to adjust to display the Audio Level Menu.
2. Adjust the audio level for the selected channel as follows:
   - Press the **F1** softkey. In this example it is **Custom02**, but changes depending on what you have named your audio channels.
   - Use the **Channel** knob to select the audio channel you want to adjust.
   - Use the **Level** knob to adjust the level of the channel. (0.0% is off).
   - Use the **Pan** knob to adjust the pan setting left or right. Turning the knob to the right will pan right and turning it left will pan left.

3. Adjust the Master Level as follows:
   - Press **Master Level**.

   - If your Audio Mixer has multiple Master Levels, use the **Master** knob to select the Master Level to adjust.
   - Use the **Level** knob to adjust the master level.

This completes the procedure for adjusting the pan and level settings for individual channels and the master.
Robotic Cameras

In This Chapter

This chapter provides instructions for connecting, setting up, and operating a Robotic Camera with your Synergy Q/MD-X switcher. Before you begin, ensure that the Robotic Camera System Interface option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

• Supported Robotic Cameras
• Serial Communications Connections
• Ethernet Communication Connections
• Setting up the Switcher
• Setting up Robotic Camera BNCs
• Robotic Camera Custom Controls
Supported Robotic Cameras

The Synergy Series Switcher has been tested with a number of Robotic Cameras to ensure the highest standard for compatibility and reliability. The following Robotic Cameras are currently supported by your Synergy Q/MD-X switcher:

- **Telemetrics PT-CP-S2 Robotic Camera Controller** — Requires a RS-422 serial connection.
- **Telemetrics PT-HP-S2 Robotic Camera Controller** — Requires a RS-422 serial connection.
- **Telemetrics PT-LP-S2 Robotic Camera Controller** — Requires a RS-422 serial connection.
- **Telemetrics STS-12 Serial Control Transfer Switch** — Requires a RS-422 or RS-232 serial connection.
- **Telemetrics DS-4 Device Server** — Requires a RS-422 or RS-232 serial connection.
- **Sony BRC-300/300P Robotic Camera** — Requires a RS-422 serial connection.
- **Eagle PT-101 Pan Tilt System Robotic Camera Controller** — Requires a RS-232 serial connection.
- **Panasonic AW-PH500p Pan/Tilt Head Robotic Camera Controller** — Requires a RS-232 serial connection.
- **Vinten AutoCam 200 Controller** — Requires an Ethernet connection for the Synergy Q/MD-X frame.
- **Grass Valley CameraMan 3e 3-CCD Robotic Camera** — Requires a RS-232 serial connection.
Serial Communications Connections

You can connect a number of Robotic Cameras to your Synergy Q/MD-X switcher. The procedure for connecting the Robotic Camera will depend on the type of Robotic Camera you have. This section will provide general instructions for connecting the Robotic Camera to one of the Remote Ports on the back of the Synergy Control Panel.

This section identifies how to make the serial communication connections between the Robotic Cameras and the Synergy Q/MD-X switcher. The following topics are discussed:

- Connecting a Robotic Camera to the Synergy Q/MD-X Switcher
- Robotic Camera Interface Cable Pinouts

Connecting a Robotic Camera to the Synergy Q/MD-X Switcher

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Robotic Camera System Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control a Robotic Camera.
- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Robotic Camera. Refer to the section “Robotic Camera Interface Cable Pinouts” on page 20–4 for information on the pin-outs and connector required for your Robotic Camera. Ross Video does not supply this cable.

Use the following procedure to connect a Robotic Camera to your Synergy Q/MD-X switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Robotic Camera. The suggested port for each supported Robotic Camera is listed below:

   - **Telemetrics Robotic Camera Controller** — Connect the Interface cable to the Serial port on the Telemetrics PT-CP-S2, PT-HP-S2 or PT-LP-S2 Robotic Camera Controller. Refer to the section “Telemetrics Robotic Camera Controller”
Cabling” on page 20–4 for more information on the cabling for this Robotic Camera.

- **Telemetrics STS-12 Serial Control Transfer Switch** — Connect the Interface cable to the Controller (DCE) Port on the Telemetrics STS-12 Serial Control Transfer Switch. Refer to the section “Telemetrics STS-12 Serial Control Transfer Switch” on page 20–5 for more information.

- **Telemetrics DS-4 Device Server** — Connect the Interface cable to a serial communication port on the back of the first Telemetrics DS-4. Refer to the section “Telemetrics DS-4 Device Server” on page 20–6 for more information.

- **Sony BRC-300/300P Robotic Camera** — Connect the Interface cable to the Video Connector port on the rear of the Sony BRC-300/300P Robotic Camera Controller. Refer to the section “Sony BRC-300/300P Robotic Camera Cabling” on page 20–7 for more information on the cabling for this Robotic Camera.

- **Eagle PT-101 Pan Tilt System Robotic Camera Controller** — Connect the Interface cable to the Phoenix Connection Block on the Eagle Pan Tilt System Robotic Camera Controller. Refer to the section “Eagle PT-101 Pan Tilt System Robotic Camera Controller Cabling” on page 20–8 for more information on the cabling for this Robotic Camera.

- **Panasonic AW-PH500p Pan/Tilt Head** — Connect the Interface cable to the Remote port on the rear of the Panasonic Control Panel Main Unit. Refer to the section “Panasonic AW-PH500p Pan/Tilt Head” on page 20–9 for more information on the cabling for this Robotic Camera.

- **Grass Valley CameraMan 3e 3-CCD Robotic Camera** — Connect the Interface cable to the RS-232 port on the rear panel of the Grass Valley Mini Docking Station. Refer to the section “Grass Valley CameraMan 3e 3-CCD Robotic Camera” on page 20–9 for more information.

This completes the procedure for connecting a Robotic Camera to the Synergy Q/MD-X switcher. Refer to the section “Setting up the Switcher” on page 20–11 for instructions on how to set up communications protocols on the Switcher, as well as on the Robotic Camera.

**Robotic Camera Interface Cable Pinouts**

Use the information in this section to connect the Interface Cable from the Synergy Q/MD-X switcher to the Robotic Camera.

**Telemetrics Robotic Camera Controller Cabling**

<table>
<thead>
<tr>
<th>Note</th>
<th>This information applies to the Telemetrics PT-CP-S2, PT-HP-S2 and PT-LP-S2 Robotic Camera Controllers.</th>
</tr>
</thead>
</table>

The Synergy control panel connects to the Telemetrics Robotic Camera Controller via the remote ports on the Synergy control panel, and the Serial port on the rear of the Telemetrics Robotic Camera Controller.

Cable connections in the following table refer only to those between the Synergy control panel and the Telemetrics Robotic Camera Controller. Other cable connections present on the Telemetrics Robotic Camera Controller can be found in the Telemetrics documentation.
The Synergy switcher can be connected to any of the Controller (DCE) Ports of the Telemetrics STS-12 Serial Control Transfer Switch.

- The DCE Ports are always female, the same as the ports on the PT Head.
- The Telemetrics PT Head connects to a DTE Port on the Telemetrics STS-12 Serial Control Transfer Switch using a straight through DB-9, pin to pin, male to female cable.
- Ports 1 and 2 are always DCE Ports.
- The Telemetrics STS-12 may have more than two DCE Ports. Refer to your Telemetrics documentation for information on the Port configuration for your device.

Note: The ports on the Telemetrics STS-12 Serial Control Transfer Switch are always paired, with each port in the pair configured the same.

- If the Telemetrics STS-12 DCE Port is configured as RS-232, the cable is a DB-9 male to male Null modem as follows:

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Telemetrics Camera Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Telemetrics STS-12 RS-232 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Telemetrics STS-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
• If the Telemetrics STS-12 DCE Port is configured as RS-422, the cable is a DB-9 custom male to male cable as follows:

Synergy Q/MD-X -to- Telemetrics STS-12 RS-422 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Telemetrics STS-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Telemetrics DS-4 Device Server

When you are connecting a pair of DS-4s across a network, you must connect the Synergy switcher to a serial port on the first Telemetrics DS-4 Device Server. The cameras are connected to the network via a second DS-4. Refer to your Telemetrics documentation for information on network setups.

Serial cable connections in the following table refer only to those between the Synergy control panel and the first Telemetrics DS-4 Device Server. Other cable connections present on the Telemetrics DS-4 Device Servers can be found in the Telemetrics documentation.

If the Telemetrics DS-4 port is configured as RS-232, the following pinouts are required:

Synergy Q/MD-X -to- Telemetrics DS-4 RS-232 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Telemetrics DS-4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
If the Telemetrics DS-4 port is configured as RS-422, the following pinouts are required:

### Sony BRC-300/300P Robotic Camera Cabling

The Synergy control panel connects to the Sony BRC-300/300P Robotic Camera Controller via the remote ports on the Synergy control panel, and the Video Connector port on the rear of the Sony BRC-300/300P Robotic Camera Controller, using the Sony VISCA protocol.

Cable connections in the following table refer only to those between the Synergy control panel and the Sony Robotic Camera. Other cable connections present on the Sony Robotic Camera can be found in the Sony documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Sony Robotic Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

### Sony BRC-300/300P Robotic Camera Cabling

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Sony Robotic Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
**Eagle PT-101 Pan Tilt System Robotic Camera Controller Cabling**

The Synergy control panel connects to the Eagle PT-101 Pan Tilt System Robotic Camera Controller via the remote ports on the Synergy control panel, and the Phoenix Connection Block on the Eagle Pan Tilt System Robotic Camera Controller.

![Note]

The **Phoenix Connection Block** is provided with your Eagle Pan Tilt System. Refer to your Eagle documentation to configure your device for RS-232 serial operation.

Cable connections in the following table refer only to those between the Synergy control panel and the Eagle Pan Tilt System. Other cable connections present on the Eagle Pan Tilt System can be found in the Eagle documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Eagle Pan Tilt System</th>
<th>Phoenix Connection Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
</tr>
</tbody>
</table>
**Panasonic AW-PH500p Pan/Tilt Head**

The Synergy control panel connects to the Panasonic AW-PH500p Pan/Tilt Head via the remote ports on the Synergy control panel, and the Remote port on the rear of the Panasonic Control Panel Main Unit.

Cable connections in the following table refer only to those between the Synergy control panel and the Panasonic Control Panel Main Unit. Other cable connections present on the Panasonic Pan/Tilt Head can be found in the Panasonic documentation.

**Synergy Q/MD-X -to- Panasonic Wiring Chart**

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Panasonic Control Panel Main Unit</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>2</td>
<td>Rx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>3</td>
<td>Tx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
</tr>
</tbody>
</table>

**Grass Valley CameraMan 3e 3-CCD Robotic Camera**

The Synergy control panel connects to the Grass Valley CameraMan 3e 3-CCD robotic camera via the remote ports on the Synergy control panel, and the RS-232 port on the rear of the Grass Valley Mini Docking Station.

Cable connections in the following table refer only to those between the Synergy control panel and the Grass Valley Mini Docking Station. Other cable connections present on the Grass Valley CameraMan can be found in the Grass Valley documentation.

**Synergy Q/MD-X -to- Grass Valley Wiring Chart**

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Grass Valley Mini Docking Station</th>
<th>RS-232 Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>2</td>
<td>Rx</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>3</td>
<td>Tx</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
</tbody>
</table>
Ethernet Communication Connections

This section includes information to connect a single Robotic Camera to a Synergy Q/MD-X switcher over an ethernet network.

In order to complete this procedure, you will need the following software options, cables, and equipment:

- **Robotic Camera System Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control a Robotic Camera.
- **Ethernet Cable** — A standard network cable to connect the Robotic Camera to your network.

Connecting to an Ethernet Network

The following section presents a brief overview of the ethernet connection process. The exact steps taken in connecting your Robotic Camera and Synergy Q/MD-X switcher via an ethernet network depends on the network topology of your facility.

Use the following method to connect a Robotic Camera and Synergy Q/MD-X switcher via an ethernet network:

1. Connect the Synergy Q/MD-X switcher to your network. Refer to the section “Network Setup” in Chapter 6 for information on network setup for your Synergy Q/MD-X switcher.

2. Connect the Robotic Camera to the same subnet as your Synergy Q/MD-X switcher or to a network that has a route to the network your switcher is on. Make a note of the IP Address and Port Number of your Robotic Camera as this information is required when configuring the communication settings on your Synergy Q/MD-X switcher.
   - Network topologies vary greatly between facilities. Contact your IT department for assistance in connecting your Robotic Camera to the appropriate network at your location.
   - Refer to the documentation that came with your Robotic Camera for instructions on connecting it to your network.

3. Configure the ethernet settings on your Synergy Q/MD-X switcher to communicate with the Robotic Camera. Refer to the section “Setting up the Switcher” on page 20–11 for instructions.

This completes the procedure for connecting a Robotic Camera and Synergy Q/MD-X switcher via an ethernet network.
Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with a Robotic Camera, the Communications Port on the Synergy Q/MD-X switcher that the Robotic Camera is assigned to must be set up to communicate with the particular Robotic Camera you have connected.

Use the following procedure to configure a Communications Port on the Synergy Q/MD-X switcher to connect with a Robotic Camera:

1. Navigate to the **Communications Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.

2. Press **Type** to display the **Type Menu**.

3. Assign a Communications Port to the Robotic Camera as follows:
   - Use the **Com Port** knob to select the Synergy Q/MD-X Communications Port that is connected to the Robotic Camera.
     ~ If you are using a Robotic Camera that requires a serial connection, you must select the Remote Port on the Synergy control panel that the Audio Mixer is connected to.
     ~ If you are using a Robotic Camera that requires an ethernet connection, you must assign a Peripheral port on the Synergy frame to the Robotic Camera.

   - Use the **Device** knob to select **Robotic Cam**.

4. Press **Select Device** to display the **Select Device Menu**.

**Note** Remote ports and Peripheral ports can only have one device assigned to them at one time. You cannot assign an ethernet and serial device to the same Remote or Peripheral port.

   • Use the **Device** knob to select **Robotic Cam**.
5. Select the device you want to assign to the Robotic Camera Communications Port as follows:
   • Use the **Com Port** knob to select the Communications Port you want to assign a specific Robotic Camera to.
   • Use the **Device** knob to select the type of Robotic Camera that is connected to the port. You can select between the following:
     ~ **Telemetrics** — Use this option to assign a Telemetrics PT-CP-S2, PT-HP-S2 or PT-LP-S2 Robotic Camera Controller to the selected com port. Refer to the section “Telemetrics Robotic Camera Controller” on page 20–18 for details.
     - Use this option to assign a Telemetrics STS-12 Serial Control Switch to the selected com port. Refer to the section “Telemetrics STS-12 Serial Control Transfer Switch” on page 20–18 for details.
     - Use this option to assign a Telemetrics DS-4 Device Server to the selected com port. Refer to the section “Telemetrics DS-4 Device Server” on page 20–18 for details.
     ~ **Sony** — Use this option to assign a Sony BRC-300/300P Robotic Camera to the selected com port. Refer to the section “Sony BRC-300/300P Robotic Camera” on page 20–19 for details.
     ~ **Eagle** — Use this option to assign an Eagle PT-101 Pan Tilt System to the selected com port. Refer to the section “Eagle Pan Tilt System Robotic Camera Controller” on page 20–20 for details.
     ~ **Panasonic** — Use this option to assign a Panasonic AW-PH500p Pan/Tilt Head to the selected com port. Refer to the section “Panasonic AW-PH500p Pan/Tilt Head” on page 20–20 for details.
     ~ **Vinten** — Use this option to assign a Vinten AutoCam 200 Controller to the selected Peripheral Port.
     ~ **CameraMan** — Use this option to assign a Grass Valley CameraMan 3e 3-CCD Robotic Camera to the selected com port. Refer to the section “Grass Valley CameraMan 3e 3-CCD Robotic Camera” on page 20–21 for details.

6. Press **Com Type** to display the **Com Type Menu**.

   ![Com Type Menu](image)

7. Select the communications protocol for the Communications Port as follows:
   • Use the **Com Port** knob to select the Communications Port that the desired Robotic Camera is assigned to.
   • Use the **Type** knob to select the communications for the selected port. Refer to the section “Setting up the Robotic Camera” on page 20–18 for the specific settings for your Robotic Camera. You can choose from the following:
 RS-232 — Select this option when you are using an RS-232 serial connection.
 RS-422 — Select this option when you are using an RS-422 serial connection.
 Network UDP — Select this option if your Robotic Camera is connected to the switcher through a network and uses the UDP/IP transmission standard.
 Network TCP — Select this option if your Robotic Camera is connected to the switcher through a network and uses the TCP/IP transmission standard.

Note
If you are connecting the Robotic Camera to the switcher through a network, you must select either the Network UDP or Network TCP transmission standards, then proceed to step 10 to complete the communications setup.

8. Press Com Settings to display the Com Settings Menu.

9. Set the communications protocols for the Robotic Camera as follows:
   - Use the Com Port knob to select the Robotic Camera you are setting the communications settings for.
   - Use the Baud knob to select the baud rate for the Robotic Camera. Refer to the section “Setting up the Robotic Camera” on page 20–18 for the specific settings for your Robotic Camera.
   - Use the Parity knob to select the parity for the specific Robotic Camera. Refer to the section “Setting up the Robotic Camera” on page 20–18 for the specific settings for your Robotic Camera.

Note
If you are not setting up a Robotic Camera that requires ethernet connections, proceed to step 12.

10. Specify the IP Address for the Robotic Camera as follows:

   Important
   Ensure the Robotic Camera is powered up and connected to the subnet or network before proceeding.
   - Press MORE to display the Communications Menu 2-2.
   - Press Device Network to display the Device Network Setup Menu.
   - Use the Com Port knob to select the Communications Port the Robotic Camera is assigned to.
   - Use the IP Settings knob to select IP Address.
IP Address — Device Network Setup Menu

- Use the keypad in the Global Memory System Group to enter the IP Address of the specific Robotic Camera you want to control.
- Press ENTER in the Global Memory System Group.
- Press Save in the Device Network Menu to save the address, or press Revert To Current to reject the new address and return to the previously saved address.

11. Specify the Port Number for the Robotic Camera as follows:

Note

The Port Number for the second Telemetrics DS-4 is selected using the BNC Setup Menus. If you are setting up a pair of Telemetrics DS-4s, proceed to step 12.

- Use the Com Port knob to select the Communications Port the Robotic Camera is assigned to.
- Use the IP Settings knob to select Port Number.

Port Number — Device Network Setup Menu

- Use the keypad in the Global Memory System Group to enter the Port Number of the specific Remote Robotic Camera you want to control.
- Press ENTER in the Global Memory System Group.
- Press Save in the Device Network Menu to save the changes, or press Revert To Current to reject the new Port Number and return to the previously saved Port Number.

Note

The Telemetrics and Eagle Robotic Cameras have Extra Options that may need to be set, depending on the configuration you have. If you are not setting up one of these Robotic Cameras, proceed to step 13.

12. Press Extra Options to display the Extra Options Menu.

- Telemetrics Robotic Camera Controller — Refer to the section “Telemetrics Extra Options” on page 20–15 for information on the Extra Options settings for a Telemetrics PT-CP-S2, PT-HP-S2 or PT-LP-S2 Robotic Camera Controller.
• Eagle PT-101 Pan Tilt System Robotic Camera Controller — Refer to the section “Eagle Extra Options” on page 20–16 for information on the Extra Options settings for an Eagle PT-101 Pan Tilt Robotic Camera Controller.

13. Press HOME to display the Installation Change Confirmation Screen.

14. Accept or reject the changes you have made as follows:
   • Press Confirm to accept the changes.
   • Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Robotic Camera, next you will have finish setting up the Robotic Camera to communicate with the Synergy Q/MD-X switcher, and then set up the BNC inputs that you have connected to the Robotic Camera. Refer to the section “Setting up the Robotic Camera” on page 20–18 for information on how to set up the Robotic Camera you are connecting to the Synergy Q/MD-X switcher.

**Extra Options Setup**

The Extra Options Menu for a Robotic Camera allows you to complete the communications setup for some of the Robotic Cameras on the Synergy Q/MD-X switcher. These extra options allow you to set up multiple Robotic Camera on the same Remote Port, the amount of time the Synergy Q/MD-X switcher allows for a Robotic Camera to recall a shot, and the type of lens you have installed on the Robotic Camera Head.

**Telemetrics Extra Options**

The Extra Options Menu for the Telemetrics Robotic Camera Controller allows you to:

• specify the amount of time the Synergy Q/MD-X switcher should wait before sending commands to the Robotic Camera after a Recall shot command

• specify that you are connecting to multiple cameras via a Telemetrics STS-12 Serial Control Transfer Switch, a Telemetrics CP-RMR-S Serial Receiver, or a Telemetrics DS-4 Device Server.

• specify an Offset value for displaying the Shot Box number on the Synergy switcher. For example, with the Offset value set to 1, Shot 2 on the Telemetrics Shot Box displays as Shot 2 on the Synergy menu system.

Use the following procedure to set up the Extra Options for a Telemetrics Robotic Camera Controller:

1. Assign the STS-12 or CP-RMR-S to the Telemetrics Robotic Camera as follows:

   Use the Com Port knob to select the remote port that the serial switch is connected to.

   Use the Option knob to select SerialSwitch.
Use the **Value** knob to select the type of serial switch that you are using. You can select between the following:

- **None** — Use this option to not assign a serial switch to the selected com port.
- **STS-12** — Use this option to assign an STS-12 Serial Control Transfer Switch to the selected com port.
- **CP-RMR-S** — Use this option to assign a CP-RMR-S Serial Receiver to the selected com port.
- **DS4** — Use this option to assign a DS-4 Device Server to the selected com port.

2. Set the amount of time that the switcher allows for the Robotic Camera to recall a shot as follows:

   Use the **Com Port** knob to select the Robotic Camera that you want to set the Recall Time for.
   
   Use the **Option** knob to select **RclTime**.
   
   Use the **Value** knob to select the amount of time, in seconds, you want the Switcher to wait after sending a recall shot command.

3. Enable the ShotOffset feature as follows:

   Use the **Com Port** knob to select the Robotic Camera that you want to enable the ShotOffset feature for.
   
   Use the **Option** knob to select **ShotOffset**.
   
   Use the **Value** knob to select the offset value for the Synergy control panel. You can select between the following:

   - **0** — Select this option to disable the feature. The Telemetrics Shot Box number will not match the Synergy menu system. This is the default setting.
   - **1** — Select this option to offset the Shot number by 1 on the Synergy control panel. The Synergy menu system matches the Telemetrics Shot Box number. For example, Shot 2 on the Telemetrics Shot Box is now displayed as Shot 2 on the Synergy menu system.

This completes the procedure to set up the Extra Options for the Telemetrics Robotic Camera.

**Eagle Extra Options**

The Extra Options Menu for the Eagle PT-101 Pan Tilt System Robotic Camera allows you to specify that you are using a Rainbow-CCTV lens or a Fujinon/Canon telecon lens.

Use the following procedure to set up the Extra Options for an Eagle PT-101 Pan Tilt Robotic Camera Controller with a Rainbow or Fujinon Lens:
1. Assign a lens type to your Eagle Pan Tilt System as follows:

   - Use the **Com Port** knob to select the remote port that the Eagle Pan Tilt System is connected to.
   - Use the **Option** knob to select **Lens Type**.
   - Use the **Value** knob to select the type of lens that you are using. You can select between the following:
     - **Rainbow** — Use this option if you are using a Rainbow-CCTV lens.
     - **Fujinon** — Use this option if you are using a Fujinon/Canon telecon lens.

This completes the procedure to assign a lens type to your Eagle Pan Tilt System.
Setting up the Robotic Camera

In order to have the Synergy Q/MD-X switcher communicate with a Robotic Camera, the Robotic Camera you are connecting to the switcher must be set up to communicate and accept commands from the Synergy Q/MD-X switcher.

**Telemetrics Robotic Camera Controller**

Use the following information to configure and connect your Telemetrics Robotic Camera Controller to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting a Telemetrics Robotic Camera Controller to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Telemetrics STS-12 Serial Control Transfer Switch**

Use the following information to configure and connect your Telemetrics STS-12 Serial Control Transfer Switch to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting a Telemetrics STS-12 Serial Control Transfer Switch to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Telemetrics DS-4 Device Server**

Use the following communications settings when connecting a Telemetrics DS-4 Device Server to the Synergy Q/MD-X switcher:

- When connecting the Synergy Q/MD-X switcher to a pair of Telemetrics DS-4s, one DS-4 connects directly to the Synergy control panel, while the second connects the cameras to the first DS-4 over a network. This second Telemetrics DS-4 has an IP Address you assign on the Synergy Communications Menu, and a Port Number that is assigned on the BNC Setup Menus.
- Ensure that the corresponding Telemetrics DS-4 jumper switch, for the serial port the Synergy control panel is connected to, is set for the communications standard you select on the Synergy menus.

- Use the following serial communications settings when connecting a Telemetrics DS-4 Device Server to the Synergy Q/MD-X switcher:

  **Synergy Q/MD-X -to- Telemetrics DS-4 Communications Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

**Sony BRC-300/300P Robotic Camera**

The Synergy Q/MD-X switcher can control up to 8 Sony Robotic Camera. The address for each camera is set through the jumpers on its bottom panel. Refer to the Sony documentation for more information on setting the address for your particular Robotic Camera.

Use the following information to configure and connect a single Sony Robotic Camera to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting a Sony Robotic Camera to the Synergy Q/MD-X switcher:

  **Synergy Q/MD-X -to- Sony Communications Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- Use the following information to set the jumpers located on the bottom of the Sony Robotic Camera:

  **Sony Robotic Camera Jumper Settings**

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No connection</td>
</tr>
<tr>
<td>2</td>
<td>Set to <strong>ON</strong> for RS-422 communication</td>
</tr>
<tr>
<td>3</td>
<td>Set to <strong>OFF</strong> for 9600 baud rate</td>
</tr>
<tr>
<td>4</td>
<td>Infra-red signal control (<strong>OFF</strong> disables the control)</td>
</tr>
<tr>
<td>5</td>
<td>Used for camera address</td>
</tr>
<tr>
<td>6</td>
<td>Used for camera address</td>
</tr>
<tr>
<td>7</td>
<td>Used for camera address</td>
</tr>
<tr>
<td>8</td>
<td>No connection</td>
</tr>
</tbody>
</table>

Refer to the Sony documentation for details on connecting additional cameras to the switcher.
**Eagle Pan Tilt System Robotic Camera Controller**

Use the following information to configure and connect an Eagle Pan Tilt System to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting an Eagle Pan Tilt System to a Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Panasonic AW-PH500p Pan/Tilt Head**

Use the following information to configure and connect a Panasonic AW-PH500p Pan/Tilt Head to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting a Panasonic AW-PH500p Pan/Tilt Head to a Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Vinten AutoCam 200 Controller**

Use the following information when connecting a Vinten AutoCam 200 Controller to a Synergy Q/MD-X switcher:

- Ensure the Transmission Standard (Com Type) is set to **Network TCP** on the Synergy Communications Menu.

- When assigning a BNC to the Vinten AutoCam 200 Controller, ensure that the BNC Name on the Synergy control panel matches the Device Name of the camera you are connecting to. If they are not named the same, you cannot communicate properly with your camera.

- The Synergy Q/MD-X switcher can only connect and control one Vinten AutoCam 200 Controller at a time.

- The Synergy Synergy Q/MD-X switcher can access a maximum of 64 shows, and 1024 shots per show, on 32 devices.
Grass Valley CameraMan 3e 3-CCD Robotic Camera

The Base Address for each Grass Valley CameraMan 3e 3-CCD camera is set through the Base Unit Address rotary switch on the Grass Valley Configuration Panel. Refer to the Grass Valley documentation for more information on configuring the switches on your device. Use the following information to configure and connect a Grass Valley CameraMan 3e 3-CCD camera to your Synergy switcher:

- Use the following communication settings to configure and connect a Grass Valley CameraMan 3e 3-CCD Robotic Camera to your Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>19200</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- Ensure that DIP switch 1 on Switch Bank B is set to the DOWN position (Basic Protocol) on the Grass Valley CameraMan Configuration Panel.
- Ensure that DIP switch 7 on Switch Bank A is set to the UP position (Baud Rate of 19200) on the Grass Valley CameraMan Configuration Panel.
Setting up Robotic Camera BNCs

The Robotic Camera Setup Menu allows you to associate a Robotic Camera BNC input with a particular Robotic Camera communication port. In addition, you can select which one of the outputs of the Robotic Camera is feeding the input BNC on the Synergy Q/MD-X frame.

**Important**

You must have a Robotic Camera set up on the Synergy Q/MD-X switcher before you can assign a BNC to that device. Refer to the section “Setting up the Switcher” on page 20–11 for more information on setting up robotic camera communications.

Use the following procedure to assign the Robotic Camera to a specific BNC input:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Type to display the BNC Type Menu.

   ![BNC Type Menu]

3. Assign a BNC to a Robotic Camera as follows:

   **Important**
   
   If you are assigning a BNC to a Vinten AutoCam 200 Controller, ensure that the BNC Name on the Synergy control panel matches the Device Name of the camera you are connecting to. If they are not named the same, you cannot communicate properly with your camera.

   - Use the BNC knob to select the BNC that the Robotic Camera is connected to.
   - Use the Type knob to select Robotic Cam.
   - Use the Video Format knob to select the native video format of the VTR output.

   **Note**
   
   Assigning a Video Format to an Input BNC, that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an Aux Bus. Video formats may be converted to the operating video format using Smart Conversion. Refer to Chapter 13 “SmartConversion™” for more information.

4. Press MORE ⇒ Camera Setup to display the Camera Setup Menu.
5. Assign a specific ganged Robotic Camera to the BNC as follows:
   - Use the **BNC** knob to select the BNC you want to assign the specific Robotic Camera to.
   - Use the **Controller** knob to select the remote port that the specific Robotic Camera you assigned to the BNC is connected to.
   - Use the **Port** knob to set the port or the specific camera you want to assign to the BNC. This is the port that you set the specific camera to when you set up your camera hardware.
     ~ For the **Telemetrics STS-12 Serial Control Transfer Switch**, select the STS-12 Controller (DTE) Port that the PT Head is connected to.
     ~ For the **Telemetrics DS-4 Device Server**, select the Telemetrics DS-4 port that the specific camera is connected to.
     ~ For the **Grass Valley CameraMan 3e 3-CCD**, select the Base Unit Address of the camera. Note that Positions O to F on the Grass Valley Configuration Plate corresponds to Ports 1 to 16, respectively, on the Synergy menu.

6. Press **HOME** to display the **Installation Change Confirmation Screen**.

7. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for assigning a Robotic Camera to a BNC on the Synergy Q/MD-X switcher.
Robotic Camera Custom Controls

You can program custom control macros to recall Robotic Camera controllers from the Synergy Q/MD-X switcher and specific shots on any Robotic Camera.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must have the Robotic Camera System Interface option installed in order to control a Robotic Camera from the Synergy Q/MD-X switcher. Refer to the section “Setting up the Switcher” on page 20–11 for information on setting up a Robotic Camera.</td>
</tr>
</tbody>
</table>

The following custom controls are discussed in this section:

- Recall Camera
- Recall a Shot

Recall Camera

The Recall Camera custom control allows you to recall a shot on the last selected robotic camera. If you recall a shot using this type of custom control, you must first select the camera crosspoint on the switcher, and then play the custom control.

Use the following procedure to recall a camera with a custom control button:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Navigate to the Insert Robotic Camera Control Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ MORE ⇒ Robotic Camera.

4. Assign a shot to be recalled on a camera as follows:
• Use the **Macro** knob to select **Recall Camera**.
• Use the **Camera** knob to select the communications port for the camera that you want to recall the shot on.
• Use the **Shot #** knob to select the number of the shot that you want to recall.

5. Press **Insert** to enter the recalled camera into your custom control macro.
6. Press **UP ONE** to return to the **Custom Controls Recording Menu**.
7. Press **Finish Recording** to finish recording to the selected custom control.

This completes the procedure for recalling a camera with a custom control button.

Refer to chapter 10, “**Custom Controls**”, for more information on custom controls.

## Recall a Shot

The Recall Shot custom control allows you to recall a shot on a particular robotic camera. When programming this custom control, you are recalling a specific camera on a remote port by selecting its BNC.

For example, you want to recall camera 4 on Remote Port 1. To do so, you program a Recall Shot custom control macro to recall the specified shot with camera 4 on BNC 4. When played, the custom control will always recall camera 4 on BNC 4 connected to Remote Port 1.

Use the following procedure to recall a camera shot with a custom control button:

1. Navigate to the **Custom Controls Menu** as follows:
   • Press **HOME** ⇒ **Custom Controls**.

   ![Custom Controls Menu](image)

   **Custom Controls Menu**

2. Select the custom control button you want to record to as follows:
   • Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   • Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   ![Operating Tip](image)

   **Operating Tip**

As a recommendation, keep transport control functions for similar devices grouped together on your physical custom control buttons.
3. Navigate to the **Insert Robotic Camera Control Menu** as follows:
   - Press **Start Recording** \(\Rightarrow\) **Insert Special** \(\Rightarrow\) **MORE** \(\Rightarrow\) **Robotic Camera**.

4. Assign a shot to be recalled on the specified camera as follows:
   - Use the **Macro** knob to select **Recall Shot**.
   - Use the **Camera** knob to select the camera that you want to recall the shot on. Note that each camera is listed with its remote port and its corresponding BNC.
   - Press **Select Show** to display the list of available Shows for the selected Camera.

   ![Insert Robotic Camera Control — Select Show](image)

   - Use the **Show** knob to select the Show you wish to recall the shot position from.
   - Press **Select Shot** to display the list of shots available in the selected Show.

   ![Insert Robotic Camera Control — Select Shot](image)

   - Use the **Shot** knob to select the shot that you want to recall.

   **Note**

   If the Telemetrics **ShotOffset** feature is set to **0** on the Synergy **Extra Options Menu**, the shot number displayed on the Synergy **Recall Shot Menu** will not match the Shot Box number on the Telemeterics camera.

5. Press **Insert** to enter the shot recall into your custom control macro.

6. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

7. Press **Finish Recording** to finish recording to the selected custom control.

This completes the procedure for recalling a camera shot with a custom control button.

Refer to chapter 10, "**Custom Controls**", for more information on custom controls.
Camera All Stop

Use the Camera All Stop command to quickly stop all robotic camera operations. Use this command to stop all motion of a robotic camera with a single command.

Use the following procedure to insert a Camera All Stop command into a custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Navigate to the Insert Robotic Camera Control Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ MORE ⇒ Robotic Camera.

4. Assign a shot to be recalled on a camera as follows:
   - Use the Camera knob to select the communications port for the camera that you want to recall the shot on.
   - Use the Macro knob to select Cam AllStop.

5. Press Insert to enter the recalled camera into your custom control macro.

6. Press UP ONE to return to the Custom Controls Recording Menu.

7. Press Finish Recording to finish recording to the selected custom control.

This completes the procedure for inserting a Camera All Stop command into a custom control. Refer to chapter 10, “Custom Controls”, for more information on custom controls.

Note

The Camera All Stop command is only available on Vinten cameras.

Operating Tip

As a recommendation, keep transport control functions for similar devices grouped together on your physical custom control buttons.
In This Chapter

This chapter provides instructions for connecting and setting up a Character Generator with your Synergy Q/MD-X switcher. Before you begin, ensure that the Character Generator Interface option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported Character Generators
- Communications Connections
- Communications Setup
- Setting up Character Generator BNCs
- Character Generator Custom Controls
Supported Character Generators

The Synergy Series Switcher has been tested with a number of Character Generators to ensure the highest standard for compatibility and reliability. The following Character Generators are currently supported by your Synergy Q/MD-X switcher:

- **Leitch (Inscriber) Inca Character Generator**
- **Chyron Duet LEX Character Generator** (using Lyric software version 5.23)
- **Chyron HyperX Character Generator** (using Lyric software version 5.22)
- **Avid (Pinnacle) FXDeko II Character Generator**
- **Vizrt Viz|Trio Character Generator** (Trio client version 2.5)
Communications Connections

You can connect a number of Character Generators to your Synergy Q/MD-X switcher. The procedure for connecting the Character Generator will depend on the type of Character Generator you have. This section will provide general instructions for connecting the Character Generator to one of the Remote Ports on the back of the Synergy Control Panel.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Character Generator Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control a Character Generator.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Character Generator. Refer to the section “Character Generator Interface Cable Pinouts” on page 21–4 for information on the pin-outs and connector required for your Character Generator. Ross Video does not supply this cable.

Use the following procedure to connect a Character Generator to your Synergy Q/MD-X switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Character Generator. The suggested port for each supported Character Generator is listed below:

   - **Leitch (Inscriber) Inca CG** — Connect the Interface cable to the COM port on the rear of the Inca Character Generator chassis. Refer to the section “Leitch (Inscriber) Inca Character Generator” on page 21–4 for more information on the cabling for this device.

   - **Chyron Duet LEX CG** — Connect the Interface cable to the COM 1 port on the rear of the Duet LEX Character Generator chassis. Refer to the section “Chyron Duet LEX and HyperX Character Generators” on page 21–4 for more information on the cabling for this device.

   - **Chyron HyperX CG** — Connect the Interface cable to the COM 1 port on the rear of the Chyron HyperX Character Generator chassis. Refer to the section “Chyron Duet LEX and HyperX Character Generators” on page 21–4 for more information on the cabling for this device.
• **Avid (Pinnacle) FXDeko II CG** — Connect the Interface cable to the COM port on the rear of the FXDeko II Character Generator chassis. Refer to the section “**Avid (Pinnacle) FXDeko II Character Generator**” on page 21–5 for more information on the cabling for this device.

• **Vizrt Viz|Trio Character Generator** — Connect the Interface cable to the COM port on the rear of the Trio client system. Refer to the section “**Vizrt Viz|Trio Character Generator**” on page 21–5 for more information on the cabling for this device.

This completes the procedure for connecting a Character Generator to the Synergy Q/MD-X switcher. Refer to the section “**Communications Setup**” on page 21–7 for instructions on how to set up communications protocols on the Switcher, as well as on the Character Generator.

**Character Generator Interface Cable Pinouts**

Use the information in this section to connect the Interface Cable from the Synergy Q/MD-X switcher to the Character Generator.

**Leitch (Inscriber) Inca Character Generator**

The Synergy control panel connects to the Inca Character Generator via the remote port on the Synergy control panel, and the COM port on the rear of the Leitch Inca Character Generator chassis.

Cable connections in the following table refer only to those between the Synergy control panel and the Leitch (Inscriber) Inca Character Generator. Other cable connections present on the Inca Character Generator can be found in the Leitch (Inscriber) documentation.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to- Inscriber Inca CG Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synergy Control Panel</strong></td>
</tr>
<tr>
<td><strong>Remote Port</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

n/c = Not Connected

**Chyron Duet LEX and HyperX Character Generators**

The Synergy control panel connects to the Chyron CG via the remote port on the Synergy control panel, and the COM 1 port on the rear of the Chyron CG chassis.

Cable connections in the following table refer only to those between the Synergy control panel and the Chyron CG. Other cable connections present on the Chyron CG can be found in the Chyron documentation.
Avid (Pinnacle) FXDeko II Character Generator

The Synergy control panel connects to the FXDeko II CG via the remote port on the Synergy control panel, and the COM port on the rear of the FXDeko II CG chassis.

Cable connections in the following table refer only to those between the Synergy control panel and the FXDeko II CG. Other cable connections present on the FXDeko II CG can be found in the Avid (Pinnacle) documentation.

Vizrt Viz|Trio Character Generator

The Synergy control panel connects to the Vizrt Viz|Trio Character Generator via the remote port on the Synergy control panel, and the COM port on the rear of the Viz|Trio Client system.

Cable connections in the following table refer only to those between the Synergy control panel and the Viz|Trio Client system. Other cable connections present on the Vizrt Viz|Trio Character Generator or the Viz|Trio Client system can be found in the Vizrt documentation.
### Synergy Q/MD-X -to- Vizrt Viz|Trio Trio Client Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>COM Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>→</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>→</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>→</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Communications Setup

This section will provide instructions for setting up the Character Generator to communicate with the Synergy switcher.

The following topics are discussed in this section:

- Setting up the Switcher
- Setting up the Character Generator

Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with a Character Generator, the remote port on the control panel that the Character Generator is connected to must be set up to communicate with the particular Character Generator you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Character Generator:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.

   ![Communications Menu 1-2]

3. Assign a Remote Com Port to the Character Generator as follows:
   - Use the Com Port knob to select the remote port on the Synergy Q/MD-X switcher that is connected to the Character Generator.
   - Use the Device knob to select CharGen.
4. Press Select Device to display the Select Device Menu.

   ![Communications Menu 1-2]

   ![Communications Menu 1-2]
5. Assign a specific Character Generator to the Remote Com Port as follows:

- Use the **Com Port** knob to select the Remote Com Port that the desired Character Generator is connected to.

- Use the **Device** knob to select the type of Character Generator that is connected to the port. You can select between the following:
  - **Inscriber** — Use this option to assign a Leitch (Inscriber) Inca Character Generator to the selected com port. Refer to the section “Leitch (Inscriber) Inca Character Generator” on page 21–4 for details.
  - **Chyron** — Use this option to assign a Chyron Duet LEX or HyperX Character Generator to the selected com port. Refer to the section “Chyron Duet LEX and HyperX Character Generators” on page 21–10 for details.
  - **Deko** — Use this option to assign an Avid (Pinnacle) FXDeko II Character Generator to the selected com port. Refer to the section “Avid (Pinnacle) FXDeko II Character Generator” on page 21–12 for details.
  - **Vizrt** — Use this option to assign a Vizrt Viz|Trio Character Generator to the selected com port. Refer to the section “Vizrt Viz|Trio Character Generator” on page 21–12 for details.

6. Press **Com Settings** to display the **Com Settings Menu**.

```
Communications (1-2)
This menu lets you set up your com port parameters.

<table>
<thead>
<tr>
<th>Com Port:</th>
<th>Chyron (R1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud:</td>
<td>9600, 19200</td>
</tr>
<tr>
<td>Parity:</td>
<td>NONE, ODD, EVEN</td>
</tr>
<tr>
<td>Type:</td>
<td>Device, Con Settings, Com Type, Custom, Extra Options</td>
</tr>
</tbody>
</table>
```

7. Set the communications protocols for the Character Generator as follows:

- Use the **Com Port** knob to select the Character Generator you are setting the communications settings for.

- Use the **Baud** knob to select the baud rate for the Character Generator. Refer to the section “Setting up the Character Generator” on page 21–9 for the specific settings for your Character Generator.

- Use the **Parity** knob to select the parity, **NONE**, **ODD**, or **EVEN** for the specific Character Generator. Refer to the section “Setting up the Character Generator” on page 21–9 for the specific settings for your Character Generator.

8. Press **Com Type** to display the **Com Type Menu**.

```
Communications (1-2)
This menu lets you set up your com port types.

<table>
<thead>
<tr>
<th>Com Port:</th>
<th>Chyron (R1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type:</td>
<td>RS-232, 485-422</td>
</tr>
<tr>
<td>Type:</td>
<td>Device, Con Settings, Com Type, Custom, Extra Options</td>
</tr>
</tbody>
</table>
```

---

21–8 • Character Generators Synergy Q/MD-X Engineering Manual (v9.1 MD)
9. Select the type of serial communication that will be used to communicate with the Character Generator as follows:
   - Use the **Com Port** knob to select the Character Generator you want to set the communication type for.
   - Use the **Type** knob to select the type of serial communications (RS-232 or RS-422) for the selected port. Refer to the section “**Setting up the Character Generator**” on page 21–9 for the specific settings for your Character Generator.

![Note]

**Network UDP and Network TCP** are not supported for this device type.

![Note]

If you are setting up a **Chyron Duet LEX** or **HyperX Character Generator**, there are extra options that you will have to set up. Refer to the section “**Chyron Duet LEX and HyperX Extra Options**” on page 21–11 for more information.

10. Press **HOME** to display the **Installation Change Confirmation Screen**.
11. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Character Generator, next you will have finish setting up the Character Generator to communicate with the Synergy Q/MD-X switcher, and then set up the BNC inputs that you have connected to the Character Generator.

**Setting up the Character Generator**

In order to have the Synergy Q/MD-X switcher communicate with a Character Generator, the Character Generator you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

**Leitch (Inscriber) Inca Character Generator**

Use the following information to configure and connect your Leitch (Inscriber) Inca Character Generator to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Leitch (Inscriber) Inca Character Generator to the Synergy Q/MD-X switcher:

   **Synergy Q/MD-X -to- Inscriber Inca CG Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
- Use the following procedure to configure the **Inscriber AutoCG** software:

**Note** Refer to your Leitch (Inscriber) documentation for additional information.

1. Click the **Preference** button in the AutoCG window to display the **Preferences Window**.
2. Click on the **General Tab**.
3. Select the **Serial Port** option in the **Receive Command From Area**.
4. Configure the serial port as follows:
   - **Com Port** — This must be set to the COM port that is connected to the Synergy Q/MD-X switcher.
   - **Baud Rate** — This must be set to **38400**.
   - **Data Bits** — This must be set to **8**.
   - **Parity** — This must be set to **None**.
   - **Stop Bits** — This must be set to **1**.

**Important** You can have only one INS template file per folder on your Inscriber computer. If you have more than one, the system will ignore the newest INS file(s).

5. Configure the **Strata Layers** as follows:
   - Layer 1: Quartz
   - Layer 2: IncaCG
   - Layer 3: Automation CG Max (AutoCG)
   - Layer 4: Automation CG Max (AutoCG)

**Chyron Duet LEX and HyperX Character Generators**

Use the following information to configure and connect your Chyron Duet LEX or HyperX Character Generator to your Synergy Q/MD-X switcher:

- Use the following communications settings when connecting the Chyron Duet LEX or HyperX CG to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to- Chyron CG Communication Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting</strong></td>
</tr>
<tr>
<td>Transmission Standard</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
</tbody>
</table>
**Chyron Duet LEX and HyperX Extra Options**

The **Playtime Extra Option** enables you to set a duration for animation playout for the Chyron Duet LEX and HyperX devices. This will prevent the Synergy Q/MD-X switcher from timing-out while an animation is playing.

Use the following procedure to set up the Extra Options for the Chyron Duet LEX or HyperX:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇨ MORE ⇨ Setup ⇨ Installation ⇨ Communications.
2. Press Extra Options to display the Extra Options Menu.
3. Assign a Playtime Duration as follows:
   - Use the Com Port knob to select the remote port that the Chyron Duet LEX is connected to.
   - Use the middle knob to select Playtime.
   - Use the Value knob to set a maximum duration for playing an animation in seconds.

   Note
   You can set a playtime between 10 and 120 seconds.

This concludes the procedure to set up the Extra Options for the Chyron Duet LEX or HyperX.

**Chyron Software Setup**

The Synergy Q/MD-X switcher communicates with the Chyron Character Generator using Chyron Lyric™ software and the Ross Video-II Translator plug-in. The plug-in intercepts all commands from the serial port and passes the data to the Lyric software for processing.

This information is current for Synergy Q/MD-X software version 9.1 MD, or higher, used in conjunction with the Chyron Duet LEX and Lyric software version 5.23 and the Chyron HyperX with Lyric software version 5.22.

   Note
   Refer to your Chyron documentation for additional setup information.

Use the following procedure to set up the Chyron software for the Ross Video - II Translator plug-in:

1. Ensure that the Ross Video - II Translator plug-in file **II Translator.ocx** is copied to the Plug-ins folder located in the Lyric main directory.
2. Ross Video recommends selecting Air Channel for each video processing board installed:
   - Click Config from the Lyric menu bar.
   - Select the Duet Configuration option.
   - Select the Configure Board Use tab.
   - Select Air Channel for each video processing board.
   - Click OK.
3. Ensure the Telnet option is enabled for the Ross Video II translator plug-in to communicate with the Lyric software and the Synergy Q/MD-X switcher:
   - Select Config from the Lyric menu bar.
   - Select the Intelligent Interface Setup option.
• Select **Enable Telnet** from the **Intelligent Interface Setup** dialog.
• Click **OK**.

4. Enable the Ross Video II translator plug-in as follows:
• Select **File** from the Lyric menu bar.
• Select **Ross Video - II translator** from the file list.
• Click **Run**.

This concludes the procedure to set up the Chyron software for the Ross Video - II Translator plug-in.

**Avid (Pinnacle) FXDeko II Character Generator**

Use the following information to configure and connect your FXDeko II Character Generator to your Synergy Switcher:

• Ensure that the **Unicode** check box is cleared (unchecked) on the FXDeko II Character Generator. This check box may be automatically selected (checked) when a Newsroom automation system is used with the FXDeko II Character Generator.

• Use the following communications settings when connecting the FXDeko II CG to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Note**

Ensure that the Automation feature is set up for your FXDeko II to enable communication with the Synergy switcher. Refer to your Avid documentation for details on enabling this feature.

**Vizrt Viz|Trio Character Generator**

Use the following communications settings to configure and connect the Viz|Trio Client system to the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

The Synergy Q/MD-X switcher communicates with the Vizrt Viz|Trio Character Generator using the Viz|Trio Client system and the **Intelligent Interface**.
Use the following procedure to set up the **Intelligent Interface** for the Viz|Trio Client system to communicate with the Synergy Q/MD-X switcher:

1. Ensure the Vizrt Viz|Trio Character Generator is set up.
2. In the Vizrt Viz|Trio software, navigate to the **Configuration Menu**.
3. From the **Configuration Menu**, select **External Interfaces** to display the **External Interfaces** dialog.
4. Select the **Intelligent Interface** tab.
5. Set the communication settings as follows:
   - **Com Port** — Select the Com Port on the Viz|Trio Client system that is connected to the Synergy control panel.
   - **Baud Rate** — Select **9600** for the baud rate.
   - **Show Path** — Select the folder the Synergy Q/MD-X switcher will load from the **Remote Control Menu**.
6. Save your changes.

This concludes the procedure to set up the **Intelligent Interface** for the Viz|Trio Client system to communicate with the Synergy Q/MD-X switcher.
## Setting up Character Generator BNCs

The CG Setup Menu allows you to associate a Character Generator input with a particular Character Generator communication port.

### Important

You must have a Character Generator set up on the Synergy Q/MD-X switcher before you can assign a BNC to that device. Refer to the section “Setting up the Switcher” on page 21–7 for more information on setting up Character Generator communications.

Use the following procedure to assign the Character Generator to a specific BNC input:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Type to display the BNC Type Menu.

   ![BNC — Type Menu](image)

3. Assign a BNC to the Character Generator Video, or Fill, signal as follows:
   - Use the BNC knob to select the BNC that the Video, or Fill, from the Character Generator is connected to.
   - Use the Type knob to select CharGen.
   - Use the Video Format knob to select the native video format of the Character Generator output.

### Note

Assigning a Video Format to an Input BNC, that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an Aux Bus. Video formats may be converted to the operating video format using Smart Conversion. Refer to Chapter 13 “SmartConversion™” for more information.

4. Navigate to the CG Setup Menu as follows:
   - Press MORE ⇒ Still/CG Setup.
5. Assign a specific Character Generator to the CharGen BNC as follows:

**Note**
For the Leitch Inca, Video and Alpha signals are fed from the SDI and SDI Key BNCs in the **Video Outputs** area on the Inca CG to the BNC inputs on the Synergy frame.

- Use the BNC knob to select the BNC you want to assign the specific Character Generator to.
- Use the CharGen knob to select the Character Generator you want to assign to the BNC.
- Use the Frame Buf knob to select the channel output of the Character Generator.
  - For the Chyron Duet LEX and HyperX, you must ensure the frame buffer matches the video processing board (VPB) for the Chyron CG connected to the selected BNC. Refer to your Chyron documentation for more information.
  - For the Avid (Pinnacle) FXDeko II, this knob is labeled as Channel and only channels defined as Program channels on the Character Generator should be selected.
  - For the Vizrt Viz|Trio, this knob is labeled as Channel and is fixed to Channel 1.

**Note**
The Frame Buf option is not available for the Leitch Inca Character Generator.

6. Navigate to the **BNC Type Menu** as follows:
- Press MORE ⇒ MORE ⇒ BNC Type.
7. Assign a BNC to the Character Generator Alpha signal as follows:
   • Use the BNC knob to select the BNC that the Alpha from the Character Generator is connected to.
   • Use the Type knob to select Alpha.
   • Use the Video Format knob to select the native video format of the Character Generator output.

8. Press **Alpha** to display the **Alpha Menu**.

9. Define the Character Generator Alpha as shaped or unshaped as follows:
   • Use the Alpha knob to select the BNC that the Alpha from the Character Generator is connected to.
   • Use the Mode knob to select the desired Alpha mode. You can choose between the following:

   - **Unshaped** — Select Unshaped to have the switcher perform a *multiplicative Key*. With an unshaped Alpha, the hole is cut based on the gradient values of the Alpha. Shades of gray are translated into transparency levels, giving the Character Generator video a soft edge. Unshaped Alphas can also be considered true Linear Alphas.

   - **Shaped** — Select Shaped to have the switcher perform an *additive Key*. With a shaped Alpha, the hole is cut based on the monochrome value of the Alpha. Shades of gray are translated into either white or black, giving the Character Generator video a hard edge.

10. Press **Auto Key Setup** to display the **Auto Key Setup Menu**.

---

**Operating Tip**

Shaped Alphas are used with Character Generator to cut very precise holes for the Video to fill.

---

Unshaped — Select Unshaped to have the switcher perform a multiplicative Key. With an unshaped Alpha, the hole is cut based on the gradient values of the Alpha. Shades of gray are translated into transparency levels, giving the Character Generator video a soft edge. Unshaped Alphas can also be considered true Linear Alphas.

Shaped — Select Shaped to have the switcher perform an additive Key. With a shaped Alpha, the hole is cut based on the monochrome value of the Alpha. Shades of gray are translated into either white or black, giving the Character Generator video a hard edge.
11. Associate the Character Generator Video with the Alpha as follows:
   • Use the **BNC** knob to select the BNC that is assigned to the **Video** of the Character Generator.
   • Use the **Alpha** knob to select the BNC that is assigned to the **Alpha** of the Character Generator.

12. Press **HOME** to display the **Installation Change Confirmation Screen**.

13. Accept or reject the changes you have made as follows:
   • Press **Confirm** to accept the changes.
   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for assigning a Character Generator to a BNC on the Synergy Q/MD-X switcher.
Character Generator Custom Controls

A custom control button can be programmed with a macro that:

- changes a folder, tag or field
- recalls a Character Generator (CG) page
- selects a Character Generator (CG) effect file
- runs an effect
- changes the assignment tag in the Character Generator page

You must have the Character Generator Control option installed in order to control a Character Generator from the Synergy Q/MD-X switcher. Refer to the section “Setting up the Switcher” on page 21–7 for information on setting up a Character Generator.

Use the following procedure to create a custom control macro with CG commands:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Navigate to the Insert CharGen Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ CharGen.

4. Add a Character Generator command to the custom control as follows:
   - Use the top knob to select the Character Generator on the Synergy control panel remote port that you want to create a custom control for.

Operating Tip

As a recommendation, keep special functions grouped together on your physical custom control buttons.
• Use the middle knob to select the command you want sent to the Character Generator. You can select between the following:

**Note**

Some commands may not be available for all Character Generators.

~ **Change Folder** — Select this option to assign a new directory path or folder to the Character Generator.

**Note**

You must use the keyboard to enter the new path in the Path/Folder line. A standard keyboard can be attached to the PS/2 port at the back on the Synergy control panel.

- Use the keyboard the enter the new path or folder.

~ **Recall CG** — Select this option to recall a CG template.

**Important**

You will only be able to recall Character Generator pages that have been stored with numerical names using the keypad.

- Use the keypad in the **Global Memory System Group** to select which template you want to recall.

~ **Run Effect** — Select this option to have the next Character Generator template listed in the **PV** taken to the **PGM** of the Character Generator.

- This option will be labeled as **Play Animatn** if you are using a Chyron Duet LEX Character Generator.

- This option is labeled as **Swap** if you are using a Pinnacle FXDeko II Character Generator.

~ **Change Tag** — Select this option to allow you to change the current text of a tag. The **Event** option will allow you select whether the tag you are changing is on the **PGM** or **PV** output of the Character Generator.

- Use the bottom knob to select the tag you want to change (**Tag #1 to Tag #6**).

- Use the keyboard the enter the new tag text.

~ **Load Playlist** — Select this option to load a specific playlist on your Character Generator.

- Use the keyboard the enter the playlist path.

~ **Playlist Next** — Select this option to select the next playlist on your Character Generator.

~ **Playlist Prev** — Select this option to select the previous playlist on your Character Generator.

5. Press **Insert** to enter the Character Generator command into your custom control macro.

6. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

7. Press **Finish Recording** to finish recording to the selected custom control.

This completes the procedure for creating a custom control macro with Character Generator commands.

Refer to chapter 10, “**Custom Controls**”, for more information on custom controls.
Monitor Walls

In This Chapter

This chapter provides instructions for connecting, setting up and operating a Monitor Wall with your Synergy Q/MD-X switcher. Before you begin, ensure that the Monitor Wall Interface option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported Monitor Walls
- Communications Connections
- Communications Setup
- Monitor Wall Under Monitor Display
- Monitor Wall Custom Controls
- Monitor Wall Operation
Supported Monitor Walls

The Synergy Series Switcher has been tested with a number of Monitor Walls to ensure the highest standard for compatibility and reliability. The following Monitor Walls are currently supported by your Synergy Q/MD-X switcher:

- Miranda Kaleido-K2
- Miranda Kaleido-X
Communications Connections

You can connect a number of Monitor Walls to your Synergy Q/MD-X switcher. The procedure for connecting the Monitor Wall will depend on the type of Monitor Wall you have. This section will provide general instructions for connecting up to 5 Monitor Walls to one of the Remote Ports on the back of the Synergy Q/MD-X control panel.

Note
These instructions are provided as a guide, for specific information on the Monitor Wall you are connecting to the Synergy Q/MD-X switcher, refer to the documentation provided with the Monitor Wall.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Monitor Wall Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control a Monitor Wall.
- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Monitor Wall. Refer to the section “Monitor Wall Interface Cable Pinouts” on page 22–4 for information on the pin-outs and connector required for your Monitor Wall. Ross Video does not supply this cable.

Use the following procedure to connect a Monitor Wall to your Synergy Q/MD-X switcher:

1. Connect and secure the **9-Pin, Male**, end of the **Interface Cable** to one of the **Remote Ports** on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Monitor Wall. The suggested port for each supported Monitor Wall is listed below:

   - **Miranda Kaleido-K2 and Kaleido-X Monitor Walls** — Connect the Interface cable to the COM port (1 or 2) on the computer with the Dispatcher™ software installed. Refer to the section “Miranda Kaleido-K2 and Kaleido-X Cabling” on page 22–4 for more information on cabling.

This completes the procedure for connecting a Monitor Wall to the Synergy Q/MD-X switcher. Refer to the section “Communications Setup” on page 22–6 for instructions on how to set up communications protocols on the Switcher, as well as on the Monitor Wall.
Monitor Wall Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy Q/MD-X switcher to the Monitor Wall.

Miranda Kaleido-K2 and Kaleido-X Cabling

The Synergy Q/MD-X switcher connects to the Miranda Kaleido-K2, and Kaleido-X, via the serial communications ports on the Synergy Q/MD-X switcher, and the COM 1 or COM 2 port on the Kaleido.

Note

The Miranda Kaleido-K2 and Kaleido-X support both RS-422 or RS-232 communication depending on the COM port connected to your Synergy Q/MD-X switcher.

Cable connections in the following table refer only to those between the Synergy Q/MD-X switcher and the COM 1 port on the Kaleido. Other cable connections present on the Miranda Kaleido can be found in the Kaleido documentation.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to- Kaleido RS-232 Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synergy Control Panel</strong></td>
</tr>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

Cable connections in the following table refer only to those between the Synergy Q/MD-X switcher and the COM 2 port on the Kaleido. Other cable connections present on the Miranda Kaleido can be found in the Kaleido documentation.
The Synergy control panel connects to the computer with the Dispatcher software via the remote ports on the Synergy control panel, and the COM ports (1 or 2) on the computer with the Dispatcher software installed.

The Miranda Kaleido-K2 Port Number must be set to **13000** in the Synergy Communications Menu. Refer to the section “Setting up the Monitor Wall” on page 22–9 for the procedure to setup communications for a Monitor Wall device.
Communications Setup

Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with a Monitor Wall, the remote port on the control panel that the Monitor Wall is connected to must be set up to communicate with the particular Monitor Wall you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Monitor Wall:

1. Navigate to the Communications Type Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications ⇒ Type.

2. Assign a com port to the Monitor Wall as follows:
   - Use the Com Port knob to select the remote port on the Synergy Q/MD-X switcher that is connected to the Monitor Wall.
   - Use the Device knob to select Monitor Wall.

3. Press Select Device to display the Select Device Menu.

4. Assign a specific Monitor Wall to the Remote Com Port as follows:
   - Use the Com Port knob to select the Remote Com Port that the desired Monitor Wall is connected to.
   - Use the Device knob to select the type of Monitor Wall that is connected to the port. You can select between the following:
     ~ Kaleido — Use this option to assign a Miranda Kaleido-K2 or Kaleido-X Monitor Wall to the selected com port. Refer to the section “Miranda Kaleido-K2” on page 22–9 or the section “Miranda Kaleido-X” on page 22–10 for interface specifics.
5. Press **Com Settings** to display the **Com Settings Menu**.

![Com Settings Menu](image)

6. Set the communications protocols for the Monitor Wall as follows:
   - Use the **Com Port** knob to select the Monitor Wall port you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Monitor Wall.
   - Use the **Parity** knob to select the parity, **NONE**, **ODD**, or **EVEN** for the Monitor Wall.

7. Press **Com Type** to display the **Com Type Menu**.

![Com Type Menu](image)

8. Select the type of serial communications that will be used to communicate with the Monitor Wall as follows:
   - Use the **Com Port** knob to select the Monitor Wall you want to set the communications type for.
   - Use the **Type** knob to select the type of serial communications (**RS-232**, or **RS-422**) for the selected port.

![Note](image)

   **Note**

   Network UDP and Network TCP are not supported for this device type.

9. Press **MORE** to display the **Communications Menu 2-2**.

10. Press **Mon Wall Setting** to display the **Mon Wall Setting Menu**.
11. Assign the **IP Address** as follows:

**Note**

For the Miranda Kaleido-K2 Monitor Wall, you must enter the **IP Address** of the Monitor Wall. Ensure that the Miranda Kaleido-K2 Monitor Wall is connected to the same network as the computer with the Dispatcher software.

- Use the **Device** knob to select the com port the Dispatcher Computer is connected to.
- Use the **Monitor Wall** knob to select the specific Monitor Wall connected to the Dispatcher Computer that you want to control.
- Use the knob to select **IP Address**.
- Enter the **IP Address** of the specific Monitor Wall you want to control from the selected Com Port. Use the keypad in the **Global Memory System** group or a PS/2 keyboard, to enter the IP Address. If you use the keypad, you must press **ENTER** after entering each portion of the address as there is no decimal (.) key.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

12. Assign the **Port Number** of the Monitor Wall connected to the Synergy Q/MD-X switcher as follows:

- Use the **Device** knob to select the com port the Dispatcher Computer is connected to.
- Use the **Monitor Wall** knob to select the specific Monitor Wall connected to the Dispatcher Computer that you want to control.
• Use the knob to select **Port Number**.

**Note**
The **Port Number** is set to **13000** by default. Refer to the documentation for your specific Monitor Wall to determine the correct Port Number for your device.

• Enter the Port Number of the specific Monitor Wall you want to control from the selected Com Port. You can enter the Port Number using the keypad in the **Global Memory System** group, or a PS/2 keyboard.

**Important**
Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

13. Press **HOME** to display the **Installation Change Confirmation Screen**.
14. Accept or reject the changes you have made as follows:
   • Press **Confirm** to accept the changes.
   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure to configure a Monitor Wall communication port for a Monitor Wall, next you will have finish setting up the Monitor Wall to communicate with the Synergy Q/MD-X switcher, and then set up the BNC inputs that you have connected to the Monitor Wall.

**Setting up the Monitor Wall**

In order to have the Synergy Q/MD-X switcher communicate with a Monitor Wall, the Monitor Wall you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

**Miranda Kaleido-K2**

Use the following information to configure and connect a Miranda Kaleido-K2 Monitor Wall to your Synergy Q/MD-X switcher:

**Important**
You must have a computer with the Dispatcher™ software properly installed in order for the Synergy Q/MD-X switcher to communicate with the Miranda Kaleido-K2 Monitor Wall. The Dispatcher software is the gateway program that enables the serial-TCP/IP communication between the Synergy Q/MD-X switcher and the Miranda Kaleido-K2. Refer to your Miranda documentation for more information.

The Miranda Kaleido-K2 Monitor Wall and the computer with Dispatcher software must be connected to the same network. Refer to your Miranda documentation for more information on connecting your devices to a network.

Use the following communications settings when connecting a Miranda Kaleido-K2 monitor wall to the Synergy Q/MD-X switcher. Ensure that the communication settings in the **SerialProperties.txt** file in the Dispatcher software match those you set on the Synergy Q/MD-X switcher.
Use the following procedure to connect the Miranda Kaleido-K2 Monitor Wall to the Synergy Q/MD-X switcher:

1. Ensure that the Dispatcher software is properly installed on your computer. The computer must be connected to your network.
2. Ensure the serial port parameters in the Dispatcher SerialPort.properties file match those of the Synergy Q/MD-X switcher.
3. Ensure the Kaleido-K2 Layouts accept text modified using the Synergy Q/MD-X switcher as follows:
   • Each text label you wish to modify for a Kaleido-K2 Layout must be set to Dynamic on the Kaleido-K2.
   • Each text label you wish to modify for a Kaleido-K2 Layout must also have its controlling source set as Gateway in order to accept the modified text from the Synergy Q/MD-X switcher. Refer to the Miranda documentation for more information.
   • Set the Text Label Address on the Kaleido-K2 and make a note of it. This address will be required when programming Synergy Q/MD-X switcher custom controls macros to modify text.

For information on changing text using the Synergy Q/MD-X switcher, refer to the section “Monitor Wall Operation” on page 22–23.

This completes the procedure to connect the Miranda Kaleido-K2 Monitor Wall to the Synergy Q/MD-X switcher.

Miranda Kaleido-X

Use the following information when configuring a Miranda Kaleido-X Monitor Wall to communicate with the Synergy Q/MD-X switcher:

- To send a command to Load a Layout into a Kaleido-X, ensure that the argument in the Ross command includes the Room name. Room names are displayed in the Layouts section of the Miranda XEdit window.

For example, MCR/Layout3.kg2 where MCR represents the Room name, Layout3 represents the Layout name, and .kg2 is the file extension.

- Refer to the Miranda documentation for more information on configuring layouts and sending commands on your Kaleido-X Monitor Wall.

Configuring the Miranda Kaleido-X

Use the following procedure to configure the Miranda Kaleido-X to receive Load Layout commands from the Synergy Q/MD-X switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
1. From the Miranda XEdit window, select the **Systems** tab.

2. Drag the **Serial to TCP/IP Dispatcher** icon from the **Equipment List** to the **System List** located in the **System-Description** tab.
   
   This creates a new icon that represents the connection between the Miranda Kaleido-X and the Synergy Q/MD-X switcher.

3. When prompted, enter a name for the new icon. For example, **Load Layout from Ross**.

4. From the **Systems** area, select the **Interconnects** tab.

5. Drag a connection from the Miranda Kaleido-X icon to the **Load Layout from Ross** icon.

6. Configure the communication settings for the Miranda Kaleido-X com port connect to the Synergy Q/MD-X switcher as follows:
   - Click the edit link located between the Miranda Kaleido-X icon and the **Load Layout from Ross** icon.
   - Select the com port on the Miranda Kaleido-X that is connected to the Synergy Q/MD-X switcher.
   - Click the **Load Layout from Ross** icon.
   - In the **Properties** tag of the selected com port, set up the communication settings.
   - Ensure the settings on the Miranda Kaleido-X match those of the Synergy Q/MD-X switcher. Refer to the section “**Setting up the Switcher**” on page 22–6 for details.

7. Ensure the physical cabling between the Miranda Kaleido-X and the Synergy Q/MD-X switcher is correct.

This completes the procedure for configuring the Miranda Kaleido-X to receive Load Layout commands from the Synergy Q/MD-X switcher.
Monitor Wall Under Monitor Display

The Monitor Wall Under Monitor Display (UMD) allows the Synergy Q/MD-X switcher to send source names to the Monitor Wall via a serial tally interface.

**Note**
The Kaleido software must be version 5.30 or higher to support the serial tally interface. All version of the Kalypso service are supported.

Ensure that the Serial Tally option is installed. If not, contact Ross Video for details.

Monitor Wall UMD Communications Connections

In order to properly connect the Monitor Wall UMD to the switcher, you will need the following:

- **UMD Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the Serial Communications port on the Synergy Q/MD-X switcher, and a connector on the other end to connect to your Monitor Wall. See section “Communications Connections” on page 22–3 for information on the pinouts and connector required for your Monitor Wall. Ross Video does not supply this cable.

Monitor Wall UMD Interface Cable Pinouts

Use the information in this section to connect the UMD Interface Cable from the Synergy Q/MD-X switcher to the Monitor Wall.

Miranda Kaleido Cabling

The Synergy Q/MD-X switcher connects to the Miranda Kaleido-K2, and Kaleido-X, via the serial communications ports on the Synergy Q/MD-X switcher, and the COM 1 or COM 2 port on the Kaleido.

**Note**
The Miranda Kaleido-K2 and Kaleido-X support both RS-422 or RS-232 communication depending on the COM port connected to your Synergy Q/MD-X switcher. Ross Video recommends that you use the RS-232 connection on the COM 1 port to connect to your switcher.

Cable connections in the following table refer only to those between the Synergy Q/MD-X switcher and the COM 1 port on the Kaleido. Other cable connections present on the Miranda Kaleido can be found in the Kaleido documentation.
Cable connections in the following table refer only to those between the Synergy Q/MD-X switcher and the COM 2 port on the Kaleido. Other cable connections present on the Miranda Kaleido can be found in the Kaleido documentation.

### Synergy Q/MD-X -to- Kaleido RS-232 Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Com Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Synergy Q/MD-X -to- Kaleido RS-422 Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Com Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (RX-)</td>
<td></td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td></td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td></td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td></td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Monitor Wall UMD Communications Setup

Use the following procedure to configure a Synergy Q/MD-X switcher communications port to send UMD information to a Monitor Wall:

1. Navigate to the **Communications Menus** as follows:
   - Press **HOME**, **More**, **Setup**, **Installation**, **Communications**.
2. Press **Type** to display the **Device Type Menu**.
3. Assign a communications port to the Monitor Wall as follows:
   - Use the **Com Port** knob to select the communications port on the Synergy Q/MD-X switcher that is connected, or assigned, to the Monitor Wall.
   - Use the **Device** knob to select **Serial Tally**.
4. Press **Select Device** to display the **Device Selection Menu**.

5. Use the **Device** knob to select **Contrib**.
6. Press **Com Type** to display the **Com Type Menu**.

7. Use the **Type** knob to select type of serial communications that is used to communicate with the Monitor Wall. You can choose between the following:
   - **RS-232** — Select this option if you are connecting to the COM 1 port on the Kaleido.
   - **RS-422** — Select this option if you are connecting to the COM 2 port on the Kaleido.
8. Press **Com Settings** to display the **Com Settings Menu**.
9. Set the communications protocols for the Monitor Wall as follows:
   - Use the **Baud** knob to select **38400**.
   - Use the **Parity** knob to select **NONE**.

10. Press **Extra Options** to display the **Extra Options Menu**.

11. Set the data rate for the Monitor Wall as follows:
    - Use the **Option** knob to select **Rate**.
    - Use the **Value** knob to select **26**.

12. Set the data transfer for the Monitor Wall as follows:
    - Use the **Option** knob to select **Data Txtr**.
    - Use the **Value** knob to select **Complete**.

13. Set whether the switcher includes the initialization message as follows:
    - Use the **Option** knob to select **Start**.
    - Use the **Value** knob to select **None**.

14. Set how the switcher reports being at black as follows:
    - Use the **Option** knob to select **At Black**.
    - Use the **Value** knob to select **All Off**.

15. Press **HOME** to display the **Installation Change Confirmation Screen**.

16. Accept or reject the changes you have made as follows:
    - Press **Confirm** to accept the changes.
    - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for configuring a Synergy Q/MD-X switcher communications port to send UMD information to a Monitor Wall.
Monitor Wall Custom Controls

A custom control button can be programmed to load layouts, change input channels or dynamic text on a selected Monitor Wall.

Note

Ensure that the Monitor Wall Interface option is installed and that the monitor wall you want to control is properly connected and configured with the Synergy Q/MD-X switcher.

The following custom controls are discussed in this section:

- Loading a Monitor Wall Layout
- Assigning Input Channels
- Modifying Dynamic Monitor Wall Text

Loading a Monitor Wall Layout

A Monitor Wall can have several different Layouts created, each with a variety of monitors and inputs. You can create a custom control macro that enables the Synergy Q/MD-X switcher to load a particular layout onto a selected Monitor Wall.

Use the following procedure to add a Load Layout macro to a Monitor Wall custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Press Start Recording to display the Recording Menu.

4. Press Insert Special to display the Insert Special Menu 1-2.

5. Press Monitor Wall to display the Insert Monitor Wall Control Menu.

Operating Tip

As a recommendation, keep special functions grouped together on your physical custom control buttons.
6. Select the Monitor Wall you want to apply the Load Layout custom control to as follows:
   - Use the Monitor Wall knob to select the Monitor Wall.
   - Use the knob to select Load Layout.

7. Use a standard PS/2 keyboard to enter the Layout Name, including the file extension, in the Layout field of the Insert Monitor Wall Control Menu. If you do not specify a file extension, the Synergy switcher will automatically include the file extension “.kg2”.

8. Press Insert to add this macro into the custom control.

9. Press UP ONE to return to the Custom Controls Recording Menu.

10. Press Finish Recording to finish recording to the selected custom control. The custom control button will stop flashing.

   **Operating Tip**
   You can also press the flashing custom control button, rather than the Finish Recording button, to finish recording.

   **Note**
   Any recorded custom control can be edited. Refer to Chapter 10, “Custom Controls” for more information.

This concludes the procedure to add a Load Layout macro to a Monitor Wall custom control.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to Chapter 10, “Custom Controls” for more information on naming custom control buttons.

To play back your macro, press the custom control button on the control panel that you recorded the custom control macro to.
Assigning Input Channels

Each monitor in a Layout requires an input channel. The Synergy Q/MD-X switcher allows you to assign input channels to any monitor by adding an Assign Channel macro to a Monitor Wall custom control.

Use the following procedure to add an Assign Channel macro to a Monitor Wall custom control:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press Monitor Wall to display the Insert Monitor Wall Control Menu.

6. Select the Monitor Wall you want to apply the Assign Channel custom control to as follows:
   - Use the Monitor Wall knob to select the Monitor Wall.
   - Use the middle knob to select Assign Chan.

As a recommendation, keep special functions grouped together on your physical custom control buttons.
7. Select the Monitor you want to assign the input channel to as follows:
   • Use the Monitor Wall knob to select the Monitor Wall.
   • Use the bottom knob to select Mon Number.
   • Use a standard PS/2 keyboard to enter the Monitor Number in the Monitor Number Field of the Insert Monitor Wall Control Menu.

   **Note**
   On the Miranda Kaleido-K2, this is the number assigned to a particular monitor in the currently loaded Layout. Refer to the Miranda documentation for more information.

   **Important**
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

8. Assign the input channel for the selected Monitor as follows:
   • Use the Monitor Wall knob to select the Monitor Wall.
   • Use the bottom knob to select Chan Name.
   • Ensure the Monitor Number is correct.
   • Use a standard PS/2 keyboard to enter the Input Channel Name in the Name Field of the Insert Monitor Wall Control Menu.

9. Press **Insert** to add this macro into the custom control.

10. Press **UP ONE** to return to the Custom Controls Recording Menu.

11. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

   **Operating Tip**
   You can also press the flashing custom control button, rather than the Finish Recording button, to finish recording.

   **Note**
   Any recorded custom control can be edited. Refer to Chapter 10, “Custom Controls” for more information.

This concludes the procedure to add an Assign Channel macro to a Monitor Wall custom control.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to Chapter 10, “Custom Controls” for more information on naming custom control buttons.

To play back your macro, press the custom control button on the control panel that you recorded the custom control macro to.
Modifying Dynamic Monitor Wall Text

There are two types of Monitor Wall Text Labels: Static and Dynamic. The Static Text Label is set during the creation of the Monitor Wall Layout on the device and can only be modified using the editware supplied with your device. The Dynamic Text Label is modified by the Synergy Q/MD-X switcher using a custom control macro.

Note

Ensure the parameters on your Monitor Wall are configured to accept Dynamic Text set by the Synergy Q/MD-X switcher. Refer to your device documentation for more information.

Use the following procedure to add a Modify Text macro to a Monitor Wall custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

   **Custom Controls Menu**

<table>
<thead>
<tr>
<th>Custom Controls (1-2)</th>
<th>Bank: Bank 1 (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Control buffers, 53: full</td>
<td></td>
</tr>
<tr>
<td>Selected: Bank 1 Button 9 [Custom9]</td>
<td>Button: 1 Custom8B</td>
</tr>
<tr>
<td>Custom Control Legend:</td>
<td>🔴  – normal custom control button</td>
</tr>
</tbody>
</table>

   **Start Recording**

   **Modify Name**

   **Start Relative**

   **Default Recording**

   **All Names**

   **Delete Macro**

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   **Operating Tip**

   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press Monitor Wall to display the Insert Monitor Wall Control Menu.

   **Insert Monitor Wall Control Menu**

   | Text Address: 12 | 1 |
   | New Text: Text12 | 3 |

   **Insert**

   **Cancel**

   **Monitor Wall:**

   **Kaleido 1**

   **Assign Charm**

   **Monitor Text**

   **Text Address**

   **Text Entry**
6. Select the Monitor Wall you want to apply the **Modify Text** macro to as follows:
   - Use the **Monitor Wall** knob to select the Monitor Wall.
   - Use the middle knob to select **Modify Text**.

7. Select the text address on the specified Monitor Wall as follows:
   - Use the **Monitor Wall** knob to select the Monitor Wall.
   - Use the bottom knob to select **Text Address**.
   - Use a standard PS/2 keyboard to enter the Text Address in the **Text Address Field** of the **Insert Monitor Wall Control Menu**.

8. Modify the Dynamic Text Label on the selected Monitor Wall as follows:
   - Use the bottom knob to select **Text Entry**.
   - Use a standard PS/2 keyboard to enter the new text you wish to have displayed in the selected Text Label.

9. Press **Insert** to add this macro into the custom control.

10. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

11. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

**Note**
The **Text Address** is assigned to a Text Label when creating a Monitor Wall Layout. Refer to the documentation for your Monitor Wall for information on adding Text Labels to your specific Layout.

**Important**
Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

**Operating Tip**
You can also press the flashing custom control button, rather than the **Finish Recording** button, to finish recording.

**Note**
Any recorded custom control can be edited. Refer to Chapter 10, “Custom Controls” for more information.
This concludes the procedure to create a custom control macro to modify dynamic Monitor Wall text. Once your custom control buttons have been programmed, be sure to properly name them. Refer to Chapter 10, “Custom Controls” for more information on naming custom control buttons.

To play back your macro, press the custom control button on the control panel that you recorded the custom control macro to.
Monitor Wall Operation

The Monitor Wall custom controls allow you control various aspects of the Monitor Wall from the Synergy Q/MD-X switcher. Refer to the section “Monitor Wall Custom Controls” on page 22–16 for more information on programming a Monitor Wall custom control. The basic function of these custom controls is outlined below:

**Layouts**

The Layout Custom Control allows you to program a custom control to load a specific layout on the Monitor Wall. A different Custom Control will have to be created for each layout you want to load on the Monitor Wall using the Synergy Q/MD-X switcher.

**Input Channels**

The Assign Channels Custom Control allows you to program a custom control to assign a specific input channel to a particular monitor on the Monitor Wall. A different Custom Control will have to be created for each channel you want to assign to a different monitor using the Synergy Q/MD-X switcher.

**Dynamic Text**

The Modify Text Custom Control allows you to program a custom control to assign specific, pre-defined text to a particular text address. The text address will have to assigned to a template for the custom control to be able to change the text. A different Custom Control will have to be created for each text change you want to make using the Synergy Q/MD-X switcher.
Editors/OverDrive

In This Chapter

This chapter provides instructions for connecting, setting up and operating an Editor, or the OverDrive Production Control System with your Synergy Q/MD-X switcher. Before you begin, ensure that the Editor and Automation Interface option is installed. If not, please contact Ross Video for details. Refer to Chapter 6, “Software Upgrades and Options” for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported Editors
- Editor Communications Connections
- OverDrive Communications Connections
- Editor Communications Setup
- OverDrive Communications Setup
- OverDrive Custom Controls
- Editor and OverDrive Operation
Supported Editors

The Synergy Series Switcher has been tested with a number of Editor Protocols to ensure the highest standard for compatibility and reliability. The following Editor Protocols are currently supported by your Synergy Q/MD-X switcher:

- Thomson Grass Valley GVG100 Protocol
- Thomson Grass Valley GVG200 Protocol
- Thomson Grass Valley GVG4000 Protocol
Editor Communications Connections

You can connect a number of Editors to your Synergy Q/MD-X switcher. These instructions are provided as a guide, for specific information on the Editor you are connecting to the Synergy Q/MD-X switcher, refer to the documentation provided with the Editor.

In order to properly complete this procedure you need the following software options, cables, and equipment:

- **Editor and Automation Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control an Editor.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the peripheral port on the frame, and a connector on the other end to connect to your Editor. Refer to the documentation that came with your Editor for information on using it with the Synergy Q/MD-X switcher. Ross Video does not supply this cable.

Use the following procedure to connect an Editor to your Synergy Q/MD-X switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to the Peripheral Port on the back of the Synergy Q/MD-X frame.

   ![Synergy Q/MD-X Frame CPU Board — Peripheral Ports](image)

2. Connect and secure the other end of the cable to the appropriate port on the Editor. Refer to the documentation that came with your Editor for information on the proper port and cable pinouts for connecting to the Synergy Q/MD-X switcher.

The Peripheral Port on the Synergy Q/MD-X switcher Frame has the following pinouts:

<table>
<thead>
<tr>
<th>Peripheral Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>TxA (Tx–)</td>
</tr>
<tr>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>RXA (Rx–)</td>
</tr>
</tbody>
</table>

This completes the procedure for connecting an Editor to the Synergy Q/MD-X switcher. Refer to the section “Editor Communications Setup” on page 23–6 for instructions on how to set up communications protocols on the Switcher, as well as on the Editor.
OverDrive Communications Connections

You can connect the OverDrive Production Control System to your Synergy Q/MD-X switcher. For the most up-to-date information on connecting your OverDrive Production Control System to the Synergy Q/MD-X switcher, refer to your OverDrive documentation. This section provides general instructions for connecting the OverDrive Production Control System to your Synergy Q/MD-X switcher.

Important

The Synergy 2.5 and 3.5 Q/MD-X Switchers do not support the OverDrive Production Control System at this time.

Note

These instructions are provided as a guide, for specific information on the Editor you are connecting to the Synergy Q/MD-X switcher, refer to the documentation provided with the Editor.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Editor and Automation Interface** — This is the software option from Ross Video that allows your Synergy Q/MD-X switcher to control an Editor.

- **Control Panel Interface Cable** — This is a 6-Pin cable with an RJ-12 male connector on one end, to connect to the RJ-12 to DB9 adapter in the Aux 1 port on the control panel, and a 9-Pin, D-Type (DB9) male connector on the other end to connect to the OverDrive Production Control System. Refer to the documentation that came with your OverDrive Production Control System for information on using it with the Synergy Q/MD-X switcher. Ross Video does supply a 33 foot Control Panel Interface Cable (#4000C-301).

Use the following procedure to connect an OverDrive Production Control System to your Synergy Q/MD-X switcher

Note

Refer to your OverDrive documentation for information on how to initially set up the OverDrive Production Control System.
Connecting the OverDrive Production Control System to the Synergy Q/MD-X Switcher

1. Connect and secure the **RJ-12** end of the **Control Panel Interface Cable** to the **AUX 1** port on the back of the Synergy control panel.

2. Connect and secure the **DB9** end of the **Control Panel Interface Cable** to one of the two com ports on the RS-422 card of the OverDrive computer. Refer to your OverDrive documentation for more information.

3. Ensure that your Synergy Q/MD-X frame is connected to the same network as the OverDrive computer. Refer to your OverDrive documentation for more information. Also, see the section “**Network Setup**” on page 6–2 for information on configuring Synergy network settings.

This completes the procedure for connecting an OverDrive Production Control System to the Synergy Q/MD-X switcher. Refer to the section “**OverDrive Communications Setup**” on page 23–12 for instructions on how to set up communications protocols on the switcher, as well as on OverDrive.

**OverDrive Interface Cable Pinouts**

Use the information in this section to connect the Control Panel Interface Cable from the Synergy Q/MD-X switcher to the OverDrive Production Control System.

**Control Panel Interface Cabling**

The Synergy Q/MD-X control panel connects to the OverDrive Production Control System via the **AUX 1** port on the Synergy control panel, and the RS-422 Card serial port on the rear of the OverDrive computer.

Cable connections in the following table refer only to those between the Synergy control panel and the OverDrive Production Control System. Other cable connections present on the OverDrive Production Control System can be found in the OverDrive documentation.

<table>
<thead>
<tr>
<th>Synergy Q/MD-X -to- OverDrive Control Panel Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synergy Control Panel</strong></td>
</tr>
<tr>
<td>AUX Port</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
</tbody>
</table>

n/c = Not Connected
Editor Communications Setup

Setting up the Switcher

In order to have the Synergy Q/MD-X switcher communicate with an Editor, the editor port on the frame that the Editor is connected to must be set up to communicate with the particular Editor you have connected.

Use the following procedure to configure the Editor port on the control panel to connect with an Editor:

1. Navigate to the **Communications Type Menu** as follows:
   - Press **HOME** ⇄ **MORE** ⇄ **Setup** ⇄ **Installation** ⇄ **Communications** ⇄ **Type**.

2. Activate the Editor Port as follows:
   - Use the **Com Port** knob to select the Peripheral port (**Periph**) that the Editor is connected to.
   - Use the **Device** knob to select **Editor**.

3. Press **Editor Protocol** to display the **Editor Protocol Menu**.

4. Select the Editor Protocol as follows:
   - Use the **Com Port** knob to select the Editor.
   - Use the **Device** knob to select the Editor Protocol used by the selected device. You can select from the following:
     - ~ **GVG4000** — Select this option when you are connecting an Editor using the Thomson Grass Valley GVG4000 Editor protocol.
     - ~ **GVG100** — Select this option when you are connecting an Editor using the Thomson Grass Valley GVG100 Editor protocol.
GVG200 — Select this option when you are connecting an Editor using the Thomson Grass Valley GVG200 Editor protocol.

5. Press **Com Settings** to display the **Com Settings Menu**.

6. Select the communications protocols for the Editor as follows:
   - Use the **Com Port** knob to select the Editor you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Editor. Refer to your Editor documentation for information on the communications settings required.
   - Use the **Parity** knob to select the parity for the Editor. Refer to your Editor documentation for information on the communications settings required.

7. Press **Com Type** to display the **Com Type Menu**.

8. Select the type of serial communication that will be used to communicate with the Editor as follows:
   - Use the **Com Port** knob to select Editor you want to set the communication type for.
   - Use the **Type** knob to select the type of serial communications (RS-232, or RS-422) for the selected port. Refer to your Editor documentation for information on the communications settings required.

---

**Note**

Network UDP and Network TCP are not supported for editors other than the OverDrive Production Control System.

**Note**

The GVG100 Editor Protocol has Extra Options that may need to be set, depending on the configuration you have. If you are not setting up an Editor using this protocol, skip to step 10.
9. Press **Extra Options** to display the **Extra Options Menu**.

   - **GVG100 Editor Protocol** — Refer to the section “**GVG100 Editor Protocol Extra Options**” on page 23–8 for information on the Extra Options settings for the Thomson Grass Valley GVG100 Editor Protocol.

10. Press **HOME** to display the **Installation Change Confirmation Screen**.

11. Accept or reject the changes you have made as follows:

   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Editor, next you will have finish setting up the Editor to communicate with the Synergy Q/MD-X switcher.

### Extra Options Setup

The **Extra Options Menu** for an Editor allows you to complete the communications setup for some of the Editors on the Synergy Q/MD-X switcher.

#### GVG100 Editor Protocol Extra Options

The **Extra Options Menu** for the GVG100 Editor Protocol allows you to specify the type of Editor that is connected to the Synergy Q/MD-X switcher, and the way you want to access the wipe patterns from the Editor.

Use the following procedure to set up the Extra Options for the GVG100 Editor Protocol:

1. Press **Extra Options** to display the **Extra Options Menu**.

2. Assign a specific type of the Editor to the Editor Port as follows:

   - Use the **Com Port** knob to select the Editor port that the Editor using the GVG100 Editor Protocol is connected to.
   - Use the **Option** knob to select **Editor Type**.
   - Use the **Value** knob to select the type of Editor you have connected to the Editor port. You can select from the following:
     - **Editware** — Select this option if you are connecting an Editware Editor to the selected port.
     - **Sony** — Select this option if you are connecting a Sony Editor to the selected port.
     - **Generic** — Select this option if you are connecting any other Editor to the selected port.
3. Select the way you access the wipe patterns as follows:

<table>
<thead>
<tr>
<th>Communications (1-2)</th>
<th>Com Port:</th>
<th>EUC100 (P1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol: EUC100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select Pattern # or Wipe Button for wipe</td>
<td>Option:</td>
<td>Pattern</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use Break</td>
</tr>
<tr>
<td></td>
<td>Value:</td>
<td>Pattern #</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wipe Bttn</td>
</tr>
<tr>
<td>Type</td>
<td>Editor</td>
<td>Protocol</td>
</tr>
<tr>
<td>Con Settings:</td>
<td>Con Type</td>
<td>Con Type</td>
</tr>
<tr>
<td>Custom Devices:</td>
<td>Extra Options:</td>
<td></td>
</tr>
</tbody>
</table>

Communications — GVG 100 (Pattern) Extra Options Menu

- Use the **Com Port** knob to select the Editor port that the Editor using the GVG100 Editor Protocol is connected to.
- Use the **Option** knob to select **Pattern**.
- Use the **Value** knob to select the way you access the wipe patterns. You can select from the following:
  - **Pattern #** — Select this option to use the wipe pattern numbers to enter the wipe into the editor.
  - **Wipe Bttn** — Select this option to use the wipe button numbers to enter the wipe into the editor.

4. Configure the **Use Break** feature as follows:

<table>
<thead>
<tr>
<th>Communications (1-2)</th>
<th>Com Port:</th>
<th>EUC100 (P1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol: EUC100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use 'Break' character to connect?</td>
<td>Option:</td>
<td>Pattern</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use Break</td>
</tr>
<tr>
<td></td>
<td>Value:</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Type</td>
<td>Editor</td>
<td>Protocol</td>
</tr>
<tr>
<td>Con Settings:</td>
<td>Con Type</td>
<td>Con Type</td>
</tr>
<tr>
<td>Custom Devices:</td>
<td>Extra Options:</td>
<td></td>
</tr>
</tbody>
</table>

Communications — GVG 100 (Use Break) Extra Options Menu

- Use the **Value** knob to toggle between **Yes** and **No** as follows:
  - **Yes** — Use this option to enable the Synergy Q/MD-X switcher to go into Active mode once a Break and an address has been received. This is the default setting.
  - **No** — Use this option to enable the Synergy Q/MD-X switcher to go into Active mode and the Editor does not have to send Breaks to the switcher. The Editor will send commands and messages without Breaks to the Synergy switcher.

This completes the procedure to set up the Extra Options for the GVG100 Editor.
**GVG4000 Editor Protocol Extra Options**

The **Extra Options Menu** for the GVG4000 Editor Protocol allows you to specify that memory recalls to a particular MLE should run a custom control rather than recalling the specified memory register.

You specify a number from 0-99 when performing a memory recall from the GVG4000. These numbers correspond directly to the 100 memory registers in each MLE of the Synergy Q/MD-X switcher. When calling custom controls, the numbers are mapped to custom controls as shown in the table below.

### GVG4000 Memory-to-Synergy Q/MD-X Custom Control Mapping

<table>
<thead>
<tr>
<th>GVG4000 Memory Number</th>
<th>Synergy Custom Control Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 19</td>
<td>Bank 1 Custom Control 1 - 20</td>
</tr>
<tr>
<td>20 - 39</td>
<td>Bank 2 Custom Control 1 - 20</td>
</tr>
<tr>
<td>40 - 59</td>
<td>Bank 3 Custom Control 1 - 20</td>
</tr>
<tr>
<td>60 - 79</td>
<td>Bank 4 Custom Control 1 - 20</td>
</tr>
<tr>
<td>80 - 99</td>
<td>Bank 5 Custom Control 1 - 20</td>
</tr>
</tbody>
</table>

Use the following procedure to set up the Extra Options for the GVG4000 Editor Protocol:

1. Press **Extra Options** to display the **Extra Options Menu**.

2. Select how memory recalls from the editor are handled by your Synergy Q/MD-X switcher as follows:
   - Use the **Com Port** knob to select the Editor port that the Editor using the GVG4000 Editor Protocol is connected to.
   - Use the **Option** knob to select the option you wish to configure. Currently, the only available option is **CC MLE**.
   - Use the **Value** knob to select how memory recalls from the editor are handled. You can select from the following:
     - **None** — Select this option if you do not wish to run a custom control when a recall is performed from the editor. A standard memory register recall will be performed. This is the default setting.
     - **Any** — Select this option if you want memory recalls to any MLE to run a custom control rather than performing a memory register recall.

**Note**

The MLE labels below match the standard GVG labelling that most editors are configured with.

---
~ **Pgm-Pst** — Select this option if you want memory recalls to the PGM-PST (bottom) MLE to run a custom control. Memory recalls to other MLEs will perform a memory register recall.

~ **MLE1** — Select this option if you want memory recalls to MLE 1 to run a custom control. Memory recalls to other MLEs will perform a memory register recall.

~ **MLE2** — Select this option if you want memory recalls to MLE 2 to run a custom control. Memory recalls to other MLEs will perform a memory register recall.

~ **MLE3** — Select this option if you want memory recalls to MLE 3 to run a custom control. Memory recalls to other MLEs will perform a memory register recall.

This completes the procedure to set up the Extra Options for the GVG4000 Editor.
OverDrive Communications Setup

The OverDrive Production Control System is a highly flexible production control system that enables touch screen control over your Synergy Q/MD-X switcher. For detailed instructions on connecting the OverDrive Production Control System to your Synergy Q/MD-X switcher, refer to the OverDrive documentation.

**Important**

The OverDrive Editor operates in an unusual manner when connected to a Synergy 2 switcher. Be sure to consult your OverDrive User Guide for more information on the operation of OverDrive with a Synergy 2 switcher. Refer to the section “Synergy 2 Limitations with OverDrive” on page 23–18 for more information on the Synergy 2 limitation when in OverDrive Editor mode.

Setting up the Peripheral Port for OverDrive

Use the following procedure to configure the Synergy frame to communicate with the OverDrive Editor:

**Important**

The OverDrive Production Control System requires that all buses on your switcher are assigned the same Bus Map. OverDrive does not support different Bus Maps on different buses.

1. Navigate to the Communications Type Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications ⇒ Type.

   ![Communications Type Menu]

   *Communications — Type Menu*

2. Activate the Editor port as follows:
   - Use the Com Port knob to select a Peripheral port (Periph) that you wish to assign to the OverDrive Production Control System.
Use the **Device** knob to select **EDITOR**.

3. Press **Editor Protocol** to display the **Editor Protocol Menu**.

4. Assign the OverDrive Editor to the Peripheral port as follows:

   **Note**
   The peripheral port you choose will correspond to a specific network port as follows:
   
<table>
<thead>
<tr>
<th>Peripheral Port</th>
<th>Corresponding Network Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9001</td>
</tr>
<tr>
<td>2</td>
<td>9002</td>
</tr>
<tr>
<td>3</td>
<td>9003</td>
</tr>
<tr>
<td>4</td>
<td>9004</td>
</tr>
</tbody>
</table>

   You will need the network port number when configuring your OverDrive Production Control System. Refer to your OverDrive documentation for more details.

   • Use the **Device** knob to select **EDITOR**.

   4. Assign the OverDrive Editor to the Peripheral port as follows:

   • Use the **Device** knob to select **EDITOR**.
   
   **Important**
   Even though the Synergy Q/MD-X frame communicates with the OverDrive computer via ethernet, the peripheral port assigned to OverDrive communications must not be used for any other purposes.

   • Use the **Com Port** knob to select the Peripheral port you designated for OverDrive.
   • Use the **Device** knob to select **OverDrive**.

5. Press **Com Type** to display the **Com Type Menu**.

   **Important**
   Even though the Synergy Q/MD-X frame communicates with the OverDrive computer via ethernet, the peripheral port assigned to OverDrive communications must not be used for any other purposes.

   • Use the **Com Port** knob to select the Peripheral port you designated for OverDrive.
   • Use the **Device** knob to select **OverDrive**.

6. Select the communications protocol for the OverDrive Editor as follows:

   • Use the **Com Port** knob to select the Peripheral port that OverDrive is connected to.
• Use the **Type** knob to select the network protocol you are using to communicate with the OverDrive computer. You can select from the following:
  ~ **Network TCP** — Use this option to select the Transmission Control Protocol (TCP). This is the recommended setting.
  ~ **Network UDP** — Use this option to select the Universal Datagram Protocol (UDP).

This completes the procedure for configuring your Synergy frame to communicate with OverDrive. Refer to your OverDrive documentation for information on how to set up the communications protocols on the OverDrive Production Control System.

Now that your Peripheral port is configured for OverDrive, you must configure your **Aux 1** port.

### Setting up the Aux 1 Port for OverDrive

Use the following procedure to configure the Synergy control panel to communicate with an OverDrive Production Control System:

1. Navigate to the **Communications Type Menu** as follows:
   • Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **Communications** ⇒ **Type**.

   ![Communications — Type Menu](image)

   **Communications — Type Menu**

2. Assign the Remote Aux 1 port to the OverDrive Production Control System as follows:
   • Use the **Com Port** knob to select **RemAux (A1)**.
   • Use the **Device** knob to select **Automation**.

3. Press **Select Device** to display the **Select Device Menu**.

   ![Communications — Select Device Menu](image)

   **Communications — Select Device Menu**
4. Assign OverDrive Automation to the Remote Aux 1 port as follows:
   • Use the Com Port knob to select RemAux (A1).
   • Use the Device knob to select Automatn.

5. Press Com Settings to display the Com Settings Menu.

6. Set the communications parameters for the Remote Aux 1 port as follows:
   • Use the Com Port knob to select Automatn (A1).
   • Use the Baud knob to select 38400.
   • Use the Parity knob to select ODD.

7. Press Com Type to display the Com Type Menu.

8. Select the serial communications protocol for the Remote Aux 1 port as follows:
   • Use the Com Port knob to select Automatn (A1).
   • Use the Type knob to select RS-422.

   **Important**
   You must toggle the EDITOR button in the Remote area of the Global Memory System Group to On to allow the OverDrive Production Control System to control the Synergy Q/MD-X switcher.

   **Note**
   When active, EDITOR mode turns on all the Roll VTR buttons and sets the Roll VTR Mode to Arm, disabling the Roll VTR Mode selection in the Personality Menu.

This completes the procedure for setting up the Synergy Q/MD-X switcher to be controlled by the OverDrive Production Control System.
OverDrive Custom Controls

The OverDrive Production Control System can use certain custom controls, or types of custom controls, to perform operations on the Synergy Q/MD-X switcher. Using these custom controls, the OverDrive Production Control System can have the Synergy Q/MD-X switcher perform a transition of all on-air MLEs, or transition all Keys off-air. These custom controls, or any other, can also be recorded as a relative custom control, allowing OverDrive to be more flexible in using the custom control.

Automation Custom Controls

Use the Automation function to create custom controls that accept commands from an external automation system.

Use the following procedure to create an Automation custom control macro:

1. Navigate to the Custom Controls Menu as follows:
   * Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   * Use the Bank knob to select the custom control bank you want to record the custom control to.
   * Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Press Start Recording ⇒ Insert Special ⇒ Special.

Operating Tip

As a recommendation, keep special functions for similar devices grouped together on your physical custom control buttons.
4. Assign an automation function to the selected custom control macro as follows:

   - Use the top knob to select **Automation**.
   - Use the **Command** knob to select the command you want the macro to perform. You can select between the follow:
     - **Keys Off Air** — Select this option when you want all on-air **Keys**, on all **MLEs**, to be dissolved off-air when the custom control is run.
     - **Act MLE Trans** — Select this option when you want all **MLEs** that are contributing the **PGM** output, except for the **PGM/PST MLE**, to be transitioned according to the settings in the **MLE Transition Group**. For example, if **MLE 1**, of a **Synergy 3 Switcher**, is re-entered onto **MLE 2** and **MLE 2** is re-entered onto **MLE 3**, the **Active MLE Trans** custom control will perform a transition on *both MLE 1 and MLE 2*.

   ![Important]

   If you have more than one re-entry set up for a shot, the **Active MLE Trans** custom control will transition all on-air **MLEs**. If you have an **MLE** re-entered onto the **BKGD** bus of another **MLE**, the **Active MLE Trans** custom control will transition the **MLE** re-entry with whatever you have selected on the **PST** bus of that **MLE**.

5. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu**.

6. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

7. Press **UP ONE** to display the **Recording Menu**.

8. Press **Finish Recording**, or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to Chapter 10, “**Custom Controls**” for more information on naming custom control buttons. Any recorded custom control can be edited. Refer to Chapter 10, “**Custom Controls**” for more information.

To play back your macro, press the custom control button on the control panel that you recorded the custom control macro to.
Editor and OverDrive Operation

The Editor Interface button in the Global Memory System Group allows the Synergy Q/MD-X switcher to be controlled by a remote editing system, using a GVG Editor Protocol, or the OverDrive Production Control System.

Toggle the EDITOR button ON, lit, to enable control of the Synergy Q/MD-X switcher from the editor or OverDrive system. In Editor mode, you can still perform most switcher functions.

OverDrive Operation Notes

When the OverDrive Production Control System is connected to the switcher, activating the EDITOR button will cause the following to occur:

- The ROLL VTR buttons turn on, and Roll VTR Mode is set to Arm, disabling the Roll VTR Mode selection in the Personality Menu.
- MLE copying to the bottom (PGM) MLE is disabled. If you try to copy an MLE to the PGM MLE, a message is displayed indicating you must turn the EDITOR button OFF before copying.
- The Synergy switcher cannot control a Robotic Camera that has been disabled in the OverDrive menus. You must toggle the EDITOR button OFF to enable control of the camera from the Synergy switcher. Refer to the OverDrive documentation for details.

Using OverDrive with a Synergy 2 Switcher

The OverDrive Production Control System requires at least two Effects MLEs in order to operate. With a Synergy 2 Switcher, there is only one Effects MLE and the PGM MLE. OverDrive will compensate for this lack of a second Effects MLE by using the PGM MLE as an Effects MLE. This requires OverDrive to configure the switcher in a manner that will alter the way the PGM MLE operates. This configuration involves how OverDrive recalls a shot and performs a transition and how you will be able to use the control panel when it is in Editor mode.

Synergy 2 Limitations with OverDrive

Because OverDrive must use MLE 2 of the switcher as both a BKGD/PST MLE and a PGM/PST MLE, there are a number of special limitations that result. These limitations are as follows:

- The two internal DSKs are turned into Keyers for MLE 2; therefore, they cannot be used as Downstream Keyers. If you attempt to transition a DSK on-air when MLE 2 is off-air, a warning message will pop up. If DSKs are required, the Additional Downstream Keyer option will be required.
- If a Key is included in the shot set up on MLE 2, a transition of both the Background and any Keys will be required. In this case you cannot perform an S&T Wipe transition because the Key is included. This limitation only applies if there are Keys on-air in the memory recall.

Important

These operational limitation will only apply if the EDITOR button in the Global Memory System Group is ON and an OverDrive Production Control System has been set up in the Communications Menus.
• If a Key is flown in the memory recall on MLE 2, an S&T Wipe cannot be used to transition the memory on-air. This limitation applies whether the Key is on-air or not.
• You will not be able to preview a transition on MLE 2 as you can on MLE 1.
• Because OverDrive has to recall memories on MLE 2, you will have to duplicate your memories on MLE 1 and MLE 2.

Operating Tip

It will be easier to create your memories in MLE 1 and copy them down onto MLE 2, than trying to recreate them on MLE 2.

These limitations apply to both the Synergy 2 Switcher and the OverDrive Production Control System. If full functionality of your Synergy 2 Switcher is required, you can toggle the EDITOR button Off, to return to normal switcher operation.
In This Chapter

This appendix provides information on switcher calibration and the Synergy Q/MD-X diagnostic tools. The following topics are discussed:

- Switcher Calibration
- Panel Diagnostic Tools
- Displaying Panel Information
- Potentiometer Test
- Fader Test
- Joystick Test
- Button Test
- Lamp Test
- Memory Test
- Display Test
- TX/RX Test
- Tally Test
- DIP/Jump Test
- Panel Monitoring
- Frame Diagnostic Tools
- TX/RX Test
- GPI Test
- LEDs Test
- DIP Test
- GfxBuffDDR Test
Switcher Calibration

The Calibration Menu allows you to calibrate all analog controls on the switcher panel, including the faders, the XYZ positioner, and all knobs (excluding those to the right of the display).

Notice

Use this mode with caution. Perform the calibration only when you suspect that there has been “drift” in the knobs or the joystick, or that there is a “limit” problem with a fader.

Use the following procedure to calibrate the analog controls of the Synergy Q/MD-X switcher:

1. Navigate to the Calibration Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Calibration.

   Calibration Menu

   The Main Area provides a visual display of all analog controls, including the faders, positioner, and all knobs.

   Notice

   The screen shot shown above is for a Synergy 3. The number of Faders (as shown in the FADERS column) differs on the Calibration Menu for the different Synergy control panels.

   • The Scroll Area is blank.
   • The Label Area provides only one function, Accept.

   Important

   You must calibrate all analog controls on your switcher. Failure to do so will map a false limit into switcher memory [for the control(s) that you did not calibrate], thus preventing proper switcher operation.

2. To calibrate the faders, move each fader to its full upper and lower limit. Repeat this procedure two or three times for each fader. As you move the faders, you will see a series of numbers appear in the Main Area, under the FADERS heading. The numbers for each fader may not match — this is normal.

3. To calibrate the positioner, move each axis as follows:
   • Calibrate the X-Axis by moving the joystick fully left and right. Repeat this procedure two or three times.
   • Calibrate the Y-Axis by moving the joystick fully up and down. Repeat this procedure two or three times.
   • Calibrate the Z-Axis by twisting the joystick knob fully clockwise, then counterclockwise. Repeat this procedure two or three times.
As you move the joystick, you will see a series of numbers appear in the Main Area, under the POSITIONER heading. The numbers for each axis may not match — this is normal.

4. To calibrate the knobs, move each knob fully left and right. Repeat this procedure two or three times for each knob. As you move the knobs, you will see a series of numbers appear in the Main Area, under the KNOBS heading. The numbers for each knob may not match — this is normal.

5. Ensure that the label Not Moved does not appear in the Main Area. This guarantees that you moved each control.

6. At this point, you can complete the calibration or exit the menu safely:
   • To exit the menu safely, without accepting the newly calibrated controls, press HOME.
   • To complete the calibration, press Accept.

Notice

When you press Accept, do not hold the positioner off center. This will program a false “center” for the joystick, and you will have to re-calibrate the switcher again to clear it.

This completes the procedure for calibrating the analog controls of the Synergy Q/MD-X switcher.
Panel Diagnostic Tools

All Synergy Q/MD-X switchers provide a full array of panel diagnostic tools.

Displaying Panel Information

Use the following procedure to display panel information:

1. Navigate to the Panel Diagnostics Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.

2. Press Information to display the Panel Information Menu. Software version information is provided for both the panel and the frame.

3. Press Errors to display a list of Errors. Information is provided for both the panel and frame.

   - Use the Panel knob to scroll through a list of individual panel ports, with the communication errors for the selected port being displayed in the main area of the display. If Total Errors is selected, the displayed information will include all communication errors for the entire panel.

   - Use the Frame knob to scroll through a list of individual frame ports, with the communication errors for the selected port being displayed in the main area of the display. If Total Errors is selected, the displayed information will include all communication errors for the entire frame.

4. Press Reset Count to manually reset the error counts. Please note, however, that all counts are automatically reset on power up.

All of the above menus are for reference only. No action can be taken.

This completes the procedure for displaying panel information.
Potentiometer Test

The **Potentiometer Test** allows you to test the response of all potentiometers on the panel.

Use the following procedure to test the pots:

1. Navigate to the **Panel Diagnostics Menu 1-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press **Pots Test** to display the **Pots Test Menu**.

   ![Pots Test Menu]

3. Select **Normal**, **Scaled** or **Raw** values for the menu display, and test each panel potentiometer as required.

   **Note**  
   Contact **Technical Support** for details on each display value.

This completes the procedure for testing the pots.

Fader Test

The **Fader Test** allows you to test all the MLE faders on the panel.

Use the following procedure to test the faders:

1. Navigate to **Panel Diagnostics Menu 1-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press **Fader Test** to display the **Fader Test Menu**.

   ![Fader Test Menu]

3. Select **Normal**, **Scaled** or **Raw** values for the menu display, and test each panel fader as required.

   **Note**  
   Contact **Ross Video Technical Support** for details on each display value.

This completes the procedure for testing the faders.
**Synergy Slots**

The Synergy Q/MD-X control panel incorporates a special mode in which pseudo-random information is statistically measured on a cumulative basis.

Use the following procedure to play the Synergy Slots:

1. Navigate to the Fader Test Menu as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Panel Diagnostics** ⇒ **Fader Test**.
2. Press the **F6** softkey to display the Synergy Slots Menu.

   **Synergy Slots Menu**

   This action causes all button LEDs to turn off, with only the **F1** and **MORE** softkeys, and the Fader in the Transition Area of MLE 1 remaining active. The Fader serves as a “slot machine arm”.

3. Move the fader in the Transition Area of MLE 1 first to the upper limit and then to the lower limit.
   - This will cause the Synergy Slots to cycle for several seconds, and then settle on various pay line symbols.

   **Synergy Slots Menu — Pay line Symbols**

   - When a winning combination of pay line symbols occurs, the panel reacts as follows:
     ~ the button LEDs on the lower area of the control panel flash randomly
     ~ the number of credits won flashes with the new total number of credits on the Synergy Slots Menu
   - Winning pay line symbol combinations award credits as per the payout table “Pay Line Payout Table” on page 24-7. The average payoff rate is approximately 239.4 percent.

**Operating Tip**

You can also press **MORE** to display the Pay Line Payout Table.
The amount of credits won on any one pull of the arm will determine the number of flashing buttons on the panel. There are three “levels” of a “win”. Refer to the table “LED Illumination Levels Table” on page 24-7 for detailed information.

- The highest number of credits you can accumulate is 9999, and the lowest is 0.

<table>
<thead>
<tr>
<th>Level</th>
<th>% of LEDs Illuminated</th>
<th>Credits Won</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6.25%</td>
<td>&lt; 10</td>
</tr>
<tr>
<td>2</td>
<td>12.5%</td>
<td>10 to 100</td>
</tr>
<tr>
<td>3</td>
<td>25%</td>
<td>&gt; 100</td>
</tr>
</tbody>
</table>

4. Exit the Synergy Slots as follows:
   - Press HOME to display the Main Menu 1-2.
   OR
   - Press UP ONE to display the Fader Test Menu.

This completes the procedure for playing Synergy Slots.

**Joystick Test**

The Joystick Test Menu allows you to test all three axes of the joystick.

Use the following procedure to test the joystick:

1. Navigate to the Panel Diagnostics Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press Joystick Test to display the Joystick Test Menu.
3. Select **Normal, Scaled** or **Raw** values for the menu display, and test each joystick axis as required.

**Note**

Contact [Ross Video Technical Support](mailto:technicalsupport@rossvideo.com) for details on each display value.

This completes the procedure for testing the joystick.

**Button Test**

The **Button Test Menu** allows you to test all pushbuttons on the switcher panel.

Use the following procedure to test the buttons:

1. Navigate to the **Panel Diagnostics Menu 1-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press **Button Test** to display the **Button Test Menu**.

3. Press each button as required.
4. To exit the menu, press both **Exit** buttons beneath the display.

This completes the procedure for testing the buttons.

**Lamp Test**

The **Lamp Test Menu** allows you to test large groups of buttons on the panel.

Use the following procedure to test the lamps:

1. Navigate to **Panel Diagnostics Menu 1-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press **Lamp Test** to display the **Lamp Test Menu**.

![Lamp Test Menu]

3. Press buttons in selected panel regions, to test *all lamps* in those regions as required.
4. To exit the menu, press *both Exit* buttons beneath the display.

This completes the procedure for testing the lamps.

### Memory Test

The **Memory Test Menu** allows you to test various system EPROMs.

Use the following procedure to test the memory:

1. Navigate to **Panel Diagnostics Menu 2-3** as follows:
   - Press HOME \(\Rightarrow\) MORE \(\Rightarrow\) Setup \(\Rightarrow\) Panel Diagnostics \(\Rightarrow\) MORE.
2. Press **Memory Test** to display the **Memory Test Menu**.

![Memory Test Menu]

3. Press **Test** to initiate the test of the first EPROM. Press **Test** again to continue testing each EPROM in succession. The menu will report *Pass* or *Fail* per the results of each test.

This completes the procedure for testing the memory.

### Display Test

The **Display Test Menu** allows you to test the main menu display of the Synergy Q/MD-X System.

Use the following procedure to test the display:

1. Navigate to **Panel Diagnostics Menu 2-3** as follows:
   - Press HOME \(\Rightarrow\) MORE \(\Rightarrow\) Setup \(\Rightarrow\) Panel Diagnostics \(\Rightarrow\) MORE.
2. Press **Display Test** to display the **Display Test Menu**.

The menu and mnemonics displays are exercised.

3. Press **any button** below the display to advance to the next in the series of display tests. A variety of tests are available.

This completes the procedure for testing the display.

**TX/RX Test**

The **TX/RX Test Menu** allows you to test communications with various remote control and communications ports.

Use the following procedure to test TX/RX functions:

1. Navigate to **Panel Diagnostics Menu 2-3** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Panel Diagnostics** ⇒ **MORE**.
2. Press **TX/RX Test** to display the **Panel TX/RX Test Menu**.

   The main area of the screen shows the state of each of the control-panel UART transmit and receive LEDs.

3. Toggle the persistent display of UART LEDs by pressing **Uart LEDs**. You can choose between the following:
   - **On** — A small persistent display of the UART LEDs is shown on most Synergy Q/MD-X menus. This is useful for monitoring the UART LEDs from other menus.
   - **Off** — The persistent display is not shown.
4. Use the **Com Port** knob to select the port that you wish to test.

5. Press **Test** to begin the TX/RX test. The menu will report **Pass** or **Fail** per the results of the test.

6. Repeat steps 3 – 5 for additional ports that you wish to test.

7. Press **Monitor** to display the **Com Port Monitor Menu**. This menu monitors the traffic on the port selected in step 4.

   **Note**
   
   This option is used primarily for troubleshooting and diagnostic purposes. Therefore, the user should not need to use this menu.

8. Press **Format** to toggle between **Hex** and **ASCII**. This will change the way the information is displayed. In **Hex** mode, the raw data is displayed as Hexadecimal numbers. In **ASCII** mode, the data is displayed as printed characters.

9. Press **View** to toggle between **Tx** and **Rx**. **Tx** displays the traffic being transmitted from the panel, while **Rx** shows the traffic being received by the panel.

10. Press **Freeze** to toggle between **Yes** and **No**. If **Yes** is selected, the current data is frozen on the display and new traffic data is not recorded. If **No** is selected, the old traffic data is continuously cycled out to allow space for the newest traffic data to be displayed.

   **Note**
   
   Streaming (see below) is not available if **Freeze** is set to **Yes**.

11. Press **Streaming** to toggle streaming of data to a file on the switcher hard drive. Toggling this option to **Yes** starts the streaming. Data is added to the file until you toggle the option to **No** or one hour elapses. The data file may be retrieved from the
switcher via the Synergy Q/MD/X Web Interface. Refer to the section “Synergy MD/X Web Interface” on page 6-4 for more information.

**Note** You can not stream data from the panel frame port or any port set to a communication rate of 115 kb/s or greater.

12. Press **Save** to save currently collected data that has not been streamed. The data is stored to a file on the switcher hard drive and may be retrieved via the Synergy Q/MD/X Web Interface. Refer to the section “Synergy MD/X Web Interface” on page 6-4 for more information.

13. Press **Clear** to clear all recorded data for the selected **Tx** or **Rx** traffic.

This completes the procedure for testing TX/RX functions.

### Tally Test

The **Tally Test Menu** allows you to test all tally relays.

Use the following procedure to test tally relays:

1. Navigate to **Panel Diagnostics Menu 2-3** as follows:
   - Press **HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ MORE**.
2. Press **Tally Test** to display the **Tally Test Menu**.

![Tally Test Menu]

3. Select the desired tally function:
   - Press **Prev** to test the previous relay (as indicated on the menu).
   - Press **Next** to test the next relay (as indicated on the menu).
   - Press **All On** to turn all tally relays on.
   - Press **All Off** to turn all tally relays off.

This completes the procedure for testing the tally relays.

### DIP/Jump Test

The **DIP/Jump Test** allows you to test the DIP and jumper switches in the panel with the aid of a graphical representation on the display.

Use the following procedure to test the panel DIP and jumper switches:

1. Navigate to **Panel Diagnostics Menu 2-3** as follows:
   - Press **HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ MORE**.
2. Press **DIP/Jump Test** to display the **DIP/Jump Test Menu**.

The graphical representation runs in real time, meaning any changes made to the physical state of the panel DIP or jumper switches will be displayed instantly. However, as the switches are located within the electronics bay inside the control panel and covered with a protective plate, we do not advise accessing these switches without first contacting Technical Support for assistance.

This completes the procedure for testing the panel DIP and jumper switches.

**Panel Monitoring**

Panel monitoring allows you to keep a log of all user interactions with your switcher control panel (button presses, knob rotations, fader movements). Panel monitoring generates a significant amount of data and typically is used for diagnostic purposes. Panel monitoring should only be enabled as directed by Ross Video Technical Support.

There are two methods for capturing panel monitoring data: via a log file on the frame or via a computer attached to a control panel remote port.

**Logging Panel Monitoring Data to a Log File**

Panel monitoring data can be stored on your Synergy Q/MD-X frame. Use this method when you wish to retrieve the data with a computer attached to the same network as your switcher.

Use the following procedure to enable panel monitor logging to a file on your switcher frame:

1. Navigate to the **Panel Diagnostics Menu 3-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ MORE ⇒ MORE.
2. Press **Panel Monitor** to display the **Panel Monitor Menu**.
3. If not already set, toggle the log file destination to **Frame** by pressing **Dest**. Do not toggle the destination to **Log**.
4. Toggle panel monitoring by pressing **Monitor**. You can select from the following:
• **Start** — Panel monitoring is started and data is written to the log file on the switcher frame.

• **Stop** — Panel monitoring is stopped.

**Note**

You can only modify panel monitoring settings when the monitor is stopped.

This completes the procedure for enabling panel monitor logging to a file on your switcher frame. The panel monitoring log file is located in the `/mnt/hda1/log` directory on your switcher frame. Contact Ross Video Technical Support for instructions on retrieving this file.

**Logging Panel Monitoring Data to a Remote Port**

Panel monitoring data can be streamed to a remote port on your Synergy control panel.

**Important**

Do not use this mode unless instructed to by Ross Video Technical Support.

Use the following procedure to enable panel monitor logging to a remote port on your control panel:

1. Navigate to the **Communications Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.

2. Press **Type** to display the **Type Menu**.

   ![Communications Menu 1-2](image)

3. Assign a Communications Port to Panel Monitoring as follows:
   - Use the **Com Port** knob to select the Synergy Q/MD-X Communications Port that is connected to the Robotic Camera.
   - Use the **Device** knob to select **Diagnostic**.

4. Press **Select Device** to display the **Select Device Menu**.

   ![Communications Menu 1-2](image)
5. Use the **Device** knob to select **Log Port**.

6. Press **Com Type** to display the **Com Type Menu**.

7. Use the **Type** knob to select **RS-232**.

8. Press **Com Settings** to display the **Com Settings Menu**.

9. Set the communications protocols as follows:
   - Use the **Baud** knob the baud rate for the log port. Make sure that this is set to the same value as the serial port on the computer connected to the switcher.
   - Use the **Parity** knob to select the parity for the log port. Ensure that this is set to the same value as the serial port on the computer connected to the switcher.

10. Press **HOME** to display the **Installation Change Confirmation Screen**.

11. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

12. Navigate to the **Panel Diagnostics Menu 3-3** as follows:
   - Press **HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ MORE ⇒ MORE**.
13. Press Panel Monitor to display the Panel Monitor Menu.

![Panel Monitor Menu](image)

14. If not already set, toggle the log file destination to Log by pressing Dest. Do not toggle the destination to Frame.

15. Toggle panel monitoring by pressing Monitor. You can select from the following:
   - **Start** — Panel monitoring is started and data is written to the control panel remote port.
   - **Stop** — Panel monitoring is stopped.

**Note** You can only modify panel monitoring settings when the monitor is stopped.

This completes the procedure for enabling panel monitor logging to a remote port on your control panel.

Ensure that the computer is connected to the switcher remote port with an RS-232 crossover cable and that you set the baud and parity to the same values as above. Refer to the section “Remote Ports” on page 30-15 for information on the Synergy switcher remote port pinouts.
Frame Diagnostic Tools

All Synergy Q/MD-X switchers provide several frame diagnostic tools.

Use the following procedure to reach the frame diagnostics menu:

1. Navigate to the **Frame Diagnostics Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.

<table>
<thead>
<tr>
<th>Frame Diagnostics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame fans: OK, speed 100 kHz, inlet temperature 38°C</td>
</tr>
<tr>
<td>Frame power supplies: OK</td>
</tr>
<tr>
<td>Frame graphics buffer FPGA temperature: 48°C</td>
</tr>
<tr>
<td>Vfd card temp - MLE 1: Front and 89°C, FPGA 85°C</td>
</tr>
<tr>
<td>Vfd card temp - MLE 2: Front and 71°C, FPGA 85°C</td>
</tr>
<tr>
<td>Vfd card temp - MLE 3: Front and 89°C, FPGA 67°C</td>
</tr>
<tr>
<td>Vfd card temp - MLE 4: Front and 89°C, FPGA 67°C</td>
</tr>
</tbody>
</table>

   **Frame Diagnostics Test Menu**

   This completes the procedure to reach the frame diagnostics menu.

   The **Frame Diagnostics Menu** displays information on frame and card temperatures as well as power supply and fan status.

**TX/RX Test**

The **TX/RX Test Menu** allows you to test frame communications with various remote control and communications ports.

Use the following procedure to test frame TX/RX functions:

1. Navigate to the **Frame Diagnostics Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.

2. Press **TX/RX Test** to display the **Frame TX/RX Test Menu**.

<table>
<thead>
<tr>
<th>Frame TX/RX Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press Test button to test...</td>
</tr>
</tbody>
</table>

   **Frame TX/RX Test Menu**

3. Use the **Com Port** knob to select the port that you wish to test.

4. If you wish to have the test repeat continuously, press the **Loop** button to toggle it to Yes. The test will repeat until you press **Loop** again or turn the **Com Port** knob.

5. Press **Test** to begin the Frame TX/RX test. The menu will report **Pass** or **Fail** per the results of the test.

6. Repeat steps 2 – 5 for additional ports that you wish to test.
This concludes the procedure for testing frame TX/RX functions.

**GPI Test**

The GPI Test uses a graphical display of light bulbs to indicate to the user which GPI inputs and outputs are On or Off.

Use the following procedure to test the GPI inputs and outputs:

1. Navigate to the Frame Diagnostics Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.
2. Press GPI Test to display the GPI Test Menu.

<table>
<thead>
<tr>
<th>GPI Test Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI Inputs</td>
</tr>
<tr>
<td>GPI Outputs</td>
</tr>
<tr>
<td>Prev</td>
</tr>
</tbody>
</table>

3. Select the desired GPI function as follows:
   - Press Prev to test the previous input or output (as indicated on the menu).
   - Press Next to test the next input or output (as indicated on the menu).
   - Press All On to turn all GPI inputs and outputs on.
   - Press All Off to turn all GPI inputs and outputs off.

This concludes the procedure for testing the GPI inputs and outputs.

**LEDs Test**

The LEDs Test allows you to test the CPU board LEDs in the Synergy Q/MD-X frame. To perform this test, you will need access to the actual frame so that you can verify the operation of the LEDs.

The LEDs are visible with the frame door removed. The LEDs are on the CPU board.

Use the following procedure to test the LEDs operation:

1. Navigate to the Frame Diagnostics Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.
2. Press LEDs Test to display the LEDs Test Menu.

![LEDs Test Menu]

3. Check the Q/MD-X frame and ensure that all CPU board LEDs are lit.

4. When you are finished, press UP ONE to conclude the test and return to the Frame Diagnostics Menu.

This concludes the procedure for testing the LEDs operation.

DIP Test

The DIP Test allows you to test the DIP switch operation on the Synergy Q/MD-X frame. To perform this test, you will need access to the actual frame so that you can verify the position of the DIP switches.

The DIP switches are located on the Frame CPU board.

**Important**

Do not unseat the Frame CPU board to verify DIP switch position while the switcher is running.

Use the following procedure to test the DIP switch operation:

1. Navigate to the Frame Diagnostics Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.
2. Press DIP Test to display the DIP Test Menu.

![DIP Test Menu]

3. The screen shows a representation of the Q/MD-X frame DIP switches. Ensure the following:
   - The actual DIP switches on the frame correspond to what is shown on the DIP Test Menu.
   - Toggle the DIP switches on the frame and check that the DIP Test Menu updates to reflect the changes.
4. When you are finished, press **UP ONE** to conclude the test and return to the **Frame Diagnostics Menu**.

This concludes the procedure for testing the DIP switch operation.

**GfxBuffDDR Test**

The **GfxBuffDDR Test** allows you to test the Graphics Buffer memory. The test verifies both read and write operations to and from the memory.

Use the following procedure to test the Graphics Buffer memory:

1. Navigate to the **Frame Diagnostics Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.
2. Press **GfxBuffDDR Test** to display the **GfxBuffDDR Test Menu**.
3. Press **Bus test**. The Frame Bus test will be performed. When it is complete, you should see the following:

   ![Successful Completion of Bus Test](image)

4. Press **Device test**. During the test, the following screen will display and update to reflect progress:

   ![Note](image)

   The Device test takes a significant amount of time to complete.

5. When you are finished, press **UP ONE** to conclude the test and return to the **Frame Diagnostics Menu**.

This concludes the procedure for testing the Graphics Buffer memory.
Power Supplies and Fans

In This Chapter

The following topics are discussed in this chapter:

- A Note About Redundant Power
- Replacing a Control Panel Power Supply
- Calibrating the Control Panel Power Supply
- Frame Power Supply
- Power Supply Functional Components
- Diagnosing a Power Supply
- Replacing a Power Supply
- Cooling Fans
- Fan Carrier Assembly Functional Components
- Fan Controller Board
- Fan Display Board
- Cleaning the Air Filter

A Note About Redundant Power

The Redundant Power Supply option provides protection against power supply failure — in both the frame and control panel. With the option installed, complete failure of one power supply will not affect switcher operation.

The procedures for replacing power supplies outlined in this chapter can also be applied to the installation of the Redundant Power Supply option. For more information on upgrading your Synergy Q/MD-X System with redundant power, please contact Ross Video Technical Support.
Replacing a Control Panel Power Supply

This section provides detailed instructions for replacing a failed power supply in the Synergy Q/MD-X control panel. Note that a supply failure will be indicated by the PANEL LED on the control panel.

![Control Panel — Power Fail LED](image)

When the PANEL LED is lit, it indicates that there is either a fault with the control panel primary or redundant power supply, or a loss of A/C power. Ensure you verify your power cord connection, the A/C source, the power supply fuses, and the position of the power switch. If you suspect that a power supply has failed, use the following procedure to change a control panel power supply.

1. Turn off the control panel power switches. If a redundant power supply is installed, ensure that both switches are turned off.
2. Check the fuses. Each switch has an associated fuse holder that corresponds to the proper power supply. The fuse rating is printed on the panel surface. If the fuse is blown, spare fuses are available in the spare parts kit, or from Ross Video Technical Support. If the fuse is intact, replace it in the holder and continue with the next step.
3. Check that the main breaker for your AC supply has not tripped. If the breaker has tripped, reset it to restore power. If the breaker is intact, please continue with the next step.
4. Unplug all AC power cords from the AC outlets.
5. Lift the top of the control panel to reveal the electronics bay inside.
6. Remove the protective cover from the electronics bay, and set the screws in a safe place for later re-installation.
7. Locate the power supply that you wish to replace.
   - On the Synergy 3 and Synergy 4 control panels, the “main” power supply is located on the right (as you face the control panel); the “redundant” supply is on the left.
   - On the Synergy 2 control panel, the “main” power supply is located to the right of the circuit board (as you face the control panel); the “redundant” supply is located in front of the circuit board.
8. There are ten connections to the power supply, plus four bolts that secure the power supply mounting plate to the control panel bay.

Warning

Hazardous voltages are present inside the control panel tub. This procedure should be performed by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing unless you are qualified to do so.

Parts of the equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C line cords from the rear appliance connectors before servicing.

POWER FAIL

PANEL FRAME
Control Panel Power Supply Connections

Prior to removing the supply and its connections, use masking tape to label all ten cables that are connected to the supply. Use the numbering scheme as illustrated above:

- 1 to 6 for the front six connections.
- 7 to 10 for the rear four connections.

This step ensures that all cables are replaced in the same location.

9. Remove cables 1 through 6 from the power supply. Set the nuts aside in a safe place for later re-installation. For cables 1, 3, 4 and 6, note the orientation of components as shown in the side view below.

10. Remove the four corner nuts and washers, and set them aside in a safe place. Lift the power supply from the captive bolts, and slide it forward to facilitate easy removal of the rear connections.

11. Remove cables 7 through 10 from the supply. Set the nuts aside in a safe place for later re-installation. Then remove the old power supply assembly from the control panel bay and set it aside.

12. Unpack the new power supply, and install it onto the captive bolts inside the control panel bay.

13. Re-pack the old power supply in the empty shipping container, and return it to Ross Video Technical Support. The supply will be inspected to determine the cause of the failure.

14. Re-attach cables 7 through 10 to the rear of the new supply. Use the diagram on the previous page for reference.

15. Replace the washers and nuts on the securing bolts.
16. Re-attach cables 1 through 6 to the front of the new supply. Use the diagram on the previous page for reference.

17. Verify all connections. It is not necessary to remove the labels from the ten power supply cables.

18. Re-connect all AC power cords and turn on control panel power.

Note

Do not replace the protective cover over the electronics bay until you have completed the calibration procedure.

This completes the procedure for replacing a control panel power supply. Please continue with the procedure for calibrating the power supply voltages.

Calibrating the Control Panel Power Supply

Warning

Hazardous voltages are present during this calibration procedure. Keep clear of all A/C wiring areas when performing this calibration.

Although each control panel power supply is calibrated at the factory, it is highly recommended that you check the voltages and re-calibrate the supply only if required — once it has been installed in the control panel.

Use the following procedure to check and calibrate the control panel power supply.

1. Ensure that the power supply switch is in the OFF position.

2. Ensure that you have access to a digital voltmeter.

3. Turn on only the newly installed power supply (or the one that you want to test). If both power supplies are on, turn the old one (or the one that you do not want to test) off. This step ensures that correct voltages will be measured.

4. If the top of the control panel is up, lower it momentarily in order to place the panel in the “Lamp Test” mode. This diagnostic mode ensures that a suitable load is placed on the power supply.

5. Place the panel in the “Lamp Test” mode as follows:

   • Navigate to the Panel Diagnostics Menu 1-2:
     ~ Press HOME (to display the Main Menu 1-2).
     ~ MORE (to display the Main Menu 2-2).
     ~ Setup (to display the Setup Menu 1-2).
     ~ Panel Diagnostics (to display the Panel Diagnostics Menu 1-2).

   • Press Lamp Test to display the Lamp Test Menu.

Note

Do not replace the protective cover over the electronics bay until you have completed the calibration procedure.
• Press any button in the **Pattern Control Group** to light all of the buttons in the group.
• Leave the system in “**Lamp Test**” mode for now.

6. Raise the top of the control panel to access the circuit board below.

7. Locate the calibration controls at the front edge of the circuit board. Use the figure below for reference.

The following controls are provided:

For the main supply (PS1):
• **RV1** adjusts the +12 volt supply.
• **RV3** adjusts the +5 volt supply.

*For the redundant supply (PS2):*
• **RV2** adjusts the +12 volt supply.
• **RV4** adjusts the +5 volt supply.

*For both supplies:*
• **DS26** (green) indicates that +12 volt power is on.
• **DS27** (green) indicates that +5 volt power is on.
• **TP30** is the +12V test point.
• **TP31** is the +5V test point.
• **TP26** is the ground test point.

8. Ensure that the green LEDs **DS26** and **DS27** are both on.

9. To test the +5V supply, connect the voltmeter probes between **TP26** (ground) and **TP31**. Measure the voltage. The proper reading should be +5V, ± 50 millivolts. If not, adjust as follows:
   • Adjust trim pot **RV3** (for power supply 1)
   • Adjust trim pot **RV4** (for power supply 2)

10. To test the +12V supply, connect the voltmeter probes between **TP26** (ground) and **TP30**. Measure the voltage. The proper reading should be +12V, ± 50 millivolts. If the voltage does not fall into the correct range, adjust as follows:
   • Adjust trim pot **RV1** (for power supply 1)
   • Adjust trim pot **RV2** (for power supply 2)

11. Once the new supply has been calibrated, lower the top of the control panel momentarily in order to exit the “**Lamp Test**” mode. Exit the mode by pressing **both Exit** buttons beneath the display (F5 and F6).

12. Turn off the control panel power.
13. Raise the top of the panel, and replace the protective cover over the electronics bay. Secure all screws around the edges of the top cover. Lower the top of the control panel to complete the procedure.

This completes the procedure for checking and calibrating the control panel power supply.
Frame Power Supply

The Synergy MD-X frame comes standard with three 12 Volt, 500 Watt power supplies. In addition, if desired, an additional power supply can be added by purchasing the Redundant Power option. This upgrade allows the power supplies to operate in a load sharing mode, where, if one power supply fails, the remaining power supplies are able to provide sufficient power to the system. This redundancy enables hot-swapping of a power supply without interruption of the system.

This section provides an overview of the power supplies located in the Synergy MD-X chassis, and includes details of the functional components, as well as the procedures required to diagnose and replace a failed power supply.

Your frame may require additional power supplies depending on the hardware installed in the frame. If the control panel displays a message indicating there are not enough power supplies, you need to add a power supply to your frame.

**Notice**

Proper system ventilation requires the frame door to be closed. As removing the door while the system is operational can create potential overheating considerations, hot swapping a power supply should be done in a timely manner to reduce the risk of system over-heating.

**Warning**

Hazardous voltages will be present within the power supply module for a short period of time after removal from the system chassis. The power supply cover is intended to protect the user from access to these areas, and should not be removed. Ross Video power supplies are intended to be factory serviced by qualified Ross Video service personnel only. Service or any component replacement other than the AC input fuse is not advised.

**Power Supply Functional Components**

There are six key components located inside the power supply. These components include the power switch, status indicators, and the midplane connections.

**Power Supply — Functional Components**

<table>
<thead>
<tr>
<th>1) Power Switch</th>
<th>2) Green Power Indicator</th>
<th>3) Yellow Standby Indicator</th>
<th>4) Red Fail Indicator</th>
<th>5) AC Input Fuse</th>
<th>6) Midplane Connector</th>
</tr>
</thead>
</table>

To Midplane
1. **Power Switch**
   The Power Switch is used to turn the individual power supplies on and off. The switch is in the off position when it is toggled down.

2. **Green Power Indicator**
   This green indicator illuminates to show that the power supply is functioning properly.

3. **Yellow Standby Indicator**
   This yellow indicator illuminates to show that the power supply is in standby mode. This is because the master power switch on the frame or the power switch on the power supply has been turned off.

4. **Red Fail Indicator**
   This red indicator illuminates to show that the power supply is not operating. This is because it has failed or is installed incorrectly.

5. **AC Input Fuse**
   This 250 V AC, 10 AMP fuse is accessible from the back of the power supply and can be replaced without removing the protective metal cage. If the fuse does need to be replaced, it is a 5x20 mm, time lag (slow blow) fuse that meets CSA, UL, and IEC standards.

6. **Midplane Connector**
   The power supply has a single connector that is used to pass power and command signals between the midplane, the power supply, and the AC power inlets on the back of the frame.

**Diagnosing a Power Supply**

When a power supply fails, or is in stand-by, the **FRAME** LED in the **Power Fail** area on the control panel will illuminate. When this happens, you will need to diagnose the problem to determine if the power supply needs to be replaced.

![Control Panel — Power Fail Indicators](image_url)

The **Frame Power Fail** indicator on the control panel and the indicators and switch on the power supply can help you diagnose the status of the power supply and what actions to take to correct the problem.
### Power Supply Troubleshooting

<table>
<thead>
<tr>
<th>Power Switch</th>
<th>Green Power Indicator</th>
<th>Yellow Standby Indicator</th>
<th>Red Fail Indicator</th>
<th>Status</th>
</tr>
</thead>
</table>
| ON           | ON                    | OFF                      | OFF               | Normal Operation  
  • Check the RJ-45 cable connecting the control panel to the frame |
| OFF          | OFF                   | ON                       | OFF               | Power supply is in stand-by mode  
  • Toggle the power switch to ON for normal operation |
| ON           | OFF                   | ON                       | OFF               | Power supply is in stand-by mode  
  • Toggle the power switch to ON for normal operation  
  • Check the main power switch on the frame |
| ON           | OFF                   | OFF                      | ON                | Fail Mode  
  1. Check AC cable and building circuit breakers  
  2. Replace power supply if needed |
| ON           | OFF                   | OFF                      | OFF               | Fail Mode  
  1. Check AC cable and building circuit breakers  
  2. Check AC input fuse and replace if needed  
  3. Replace power supply if needed |
| OFF          | OFF                   | OFF                      | OFF               | Fail Mode  
  1. Check AC cable and building circuit breakers  
  2. Check AC input fuse and replace if needed  
  3. Replace power supply if needed |

Use the table above to help you identify the problem with the power supply. After taking corrective action, confirm that the failure has been corrected by checking the Frame Power Fail indicator on the control panel. If the failure has not been corrected, consult the table again. If needed, replace the power supply according to the procedures provided in “Replacing a Power Supply” section below.

**Note**
For further assistance, contact Ross Video Technical Support.

### Replacing a Power Supply

When a power supply needs to be removed, the power supply itself and the frame must be powered down. If you do not have the Redundant Power option installed, this will result in the Synergy MD-X system being off-line. Refer to the section “Diagnosing a Power Supply” on page 25-8 for information on when to replace a power supply.

**Note**
If the Redundant Power option is installed in the frame, the main power switch should not be toggled off. With this option installed, the frame can remain in operation while a power supply is removed and replaced.
Use the following procedure to replace a power supply:

1. Remove the front cover of the frame.
2. Locate the power supply you wish to replace.
3. Locate the main power switch located on the Fan Carrier Board on the left side of the frame. If you do not have redundant power installed, toggle the main power switch OFF. If you do have redundant power, proceed to step 4.

4. Switch the power supply OFF by toggling the power switch down.
5. Loosen the two screws holding the slider catch in place until the catch moves freely.
6. Move the slider catch all the way to the right.
7. Grasp the tab and gently pull the power supply out of the frame.
8. Switch the replacement power supply OFF by toggling the power switch down.
9. Install the new power supply by sliding it into the open slot and pushing it into place.
10. Move the slider catch to the left until it hooks the side of the slot.
11. Tighten the screws to secure the slider catch in place.
12. Switch the new power supply ON by toggling the power switch up.
13. Switch the main power switch ON by toggling it up. (This step is not necessary if you were not required to turn off your main power switch.)

Caution: Hazardous voltages are present on the pins of supply mating connectors within the chassis power supply housing area. To reduce the risk of electric shock, keep clear of mating connectors within the supply area when power supplies modules are not installed.

Warning: In a system without redundant power, the main power switch must be set to OFF before you turn the power supply off. Failure to do so may result in an overload of the remaining power supply. This does not apply if you have the Redundant Power option installed.

Caution: The metal cage surrounding the power supply may be hot after prolonged system operation.

Warning: The 500 Watt (4800AR-014) and 700 Watt (4800AR-024) power supplies cannot be used in the same frame at the same time; doing so may damage the power supply, the frame, or both.
14. Replace the front cover of the frame.

The control panel will automatically detect the new power supply and the Frame Power Fail indicator on the control panel will turn off.

This completes the procedure for replacing a power supply.
Cooling Fans

The Synergy MD-X frame has a single **Fan Carrier Board** (4800A-012) supporting fifteen 92mm cooling fans. Also mounted on the carrier is the **Fan Controller Board** (4800A-011) and the **Fan Display Board** (4800A-016).

In addition to the Fan Carrier and the daughter cards, there is an air filter that prevents dust and airborne contaminants from getting inside the frame.

When a fan fails, the **FRAME** LED in the **Power Fail** area on the control panel will flash. This is an indication that a fan has failed, and not the power supply, as described in the section “**Diagnosing a Power Supply**” on page 25-8.

![Control Panel — Power Fail Indicators](image)

This section provides a description of the Fan Carrier Assembly that is located in the Synergy MD-X frame. This overview includes the functional components of the Fan Carrier and daughter cards, as well as the procedures required to remove and clean the air filter.

**Notice**

Proper system ventilation requires the frame door to be closed. As removing the door while the system is operational can create potential overheating considerations, any online servicing should be done in a timely manner to reduce the risk of system over-heating.

**Fan Carrier Assembly Functional Components**

The Fan Carrier board has two interface slots that support the Fan Controller board and the Fan Display card.

![Fan Carrier Board — Functional Components](image)

1) Fan Display Board  2) Fan Controller Board
1. **Fan Display Board**
   This board shows the status of the Fan Carrier board and the fans.

2. **Fan Controller Board**
   This board controls Fan Carrier board functions, and the communication with the midplane.

**Fan Controller Board**
The **Fan Controller Board** has seven key components that provide the control functions and midplane communication for the Fan Carrier Board.

1. **On-Board Controller**
The on-board controller governs the on-board communication and control, as well as the communication with the midplane through the Fan Controller board.

2. **Fan Controllers**
   These controllers regulate the speed and operation of the fans as requested by the system for cooling of the frame. The controller also monitors the fans for failures.

3. **Reset Button**
The reset button provides a local, hard reset of the Fan Carrier, and should only be used for diagnostic purposes.

4. **Power Indicator**
   These two indicators show that the Fan Controller board and the Fan Display board are receiving power.

5. **Power Connectors**
   These two power connectors plug into the midplane when the Fan Controller board is installed.

6. **Midplane Connector**
The midplane connector passes control information from the midplane to the Fan Controller board.

7. **Fan Carrier Board Slot**
   This slot provides the interface between the Fan Carrier board and the Fan Controller board.

---

**Fan Controller Board — Functional Components**

<table>
<thead>
<tr>
<th>1) On-Board Controller</th>
<th>4) Power Indicator</th>
<th>7) Fan Carrier Board Slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>2) Fan Controllers</td>
<td>5) Power Connectors</td>
<td></td>
</tr>
<tr>
<td>3) Reset Button</td>
<td>6) Midplane Connector</td>
<td></td>
</tr>
</tbody>
</table>

---
Fan Display Board

The Fan Display Board has two key components that provide the interface to the Fan Carrier Board, as well as supply power to the Fan and Power Indicators.

1. Fan Fail Indicators
   These 16 indicators (8 red and 8 green) display the status of the fans through the front cover of the frame. One pair, consisting of one red and one green LED, is associated with each fan controller. If all fans are functioning correctly, all of the green LEDs will be illuminated. A solid red LED indicates a fan failure.

   For a few seconds on system power up, the indicators will flash red. As groups of fans begin functioning, the red LEDs will turn off, and green LEDs will illuminate. On system shutdown (from the menu), the LEDs will flash alternately between all on and their state prior to shutdown. This acts as an indication that the switcher chassis has been shut down from the control panel frame.

2. Fan Carrier Board Connectors
   These two connectors provide the interface between the Fan Display board and the Fan Carrier board.

Cleaning the Air Filter

The Synergy MD-X frame has a single air filter that is used to prevent dust and airborne particulates from contaminating the frame. This filter should be cleaned every three months and may require more frequent cleaning in some environments.

Use the following procedure to clean the air filter:

1. Remove the front cover of the frame.
2. Locate the air filter on the far left side of the frame, next to the Fan Carrier assembly.
3. Grasp the end of the filter and gently pull it out of the frame.
4. While servicing the air filter, replace the front cover of the frame.
5. Brush any loose dust off of the filter.
6. Place the filter under warm running water to remove any remaining dust.

**Note**

On one side of the filter is a “bug screen” mesh. When rinsing, water should flow out of this side.

7. Remove the filter from the water and pat dry with a towel to remove any moisture.
8. Remove the front cover of the frame.
9. Replace the clean, dry filter back into the air filter slot in the frame. Ensure that the side with the mesh is facing the outer wall of the chassis, and the edge without the foam is situated at the front of the chassis.
10. Replace the front cover of the frame.

With the air filter cleaned, it is a good idea to record how dirty it was and how long it has been since the last cleaning. If the filter was very dirty, you should shorten the interval between cleanings to compensate for your particular conditions.
Control Panel Boards

In This Chapter

This chapter provides details about each “switch” board in each of the control panels of the Synergy Q/MD-X switcher, plus the control panel CPU Board layout.

The following topics are discussed:

- Synergy 2 Control Panel Boards
- Synergy 3 Control Panel Boards
- Synergy 4 Control Panel Boards
- Control Panel CPU Board Layout
- Basic Interconnections
Synergy 2 Control Panel Boards

The figure below illustrates the layout of the control panel boards within the Synergy 2 control panel.

Following are board numbers and brief descriptions of each board shown above:

In the lower control panel section:

- **4317A-130** — all crosspoint bus, Aux bus and re-entry switches.
- **4317A-034** — buttons, switches and potentiometers in the entire effects area (Key, Matte, Effects Control, Positioner, Transition, Fade to Black, and Downstream Keyers).
- **4000A-430** — contains the circuitry to control the Mnemonics displays.
- **4000A-435 (up to Qty. 6)** — 5-display mnemonics module.
- **4000A-437 (up to Qty. 3)** — 7-display mnemonics module.

In the upper control panel section:

- **4317A-036** — buttons, switches and pots in the Pattern Control group and Global Memory System group, A-D converters for all knobs, faders, and joystick, plus the FPGA that decodes the optical potentiometers beside the large display.
- **4317A-037** — function switches (F1, F2, etc.) that surround the large display, plus a power module (attached to the top side of the board) that provides power to the display backlight. A guard shield is included, because the power module generates over 1000 VAC.
Synergy 3 Control Panel Boards

The figure below illustrates the layout of the control panel boards within the Synergy 3 control panel. This panel is used with both the Synergy 2.5 and the Synergy 3 Switchers.

Following are board numbers and brief descriptions of each board shown above.

In the lower control panel section:

- **4530A-130** — upper crosspoint bus switches (MLE 1).
- **4530A-131** — lower crosspoint bus switches (MLE 2, MLE 3).
- **4530A-034** — buttons, switches and potentiometers on the right-hand side of effects area (Key, Effects Control, Positioner, Fade to Black, and Downstream Keyer 2).
- **4530A-035** — buttons, switches and potentiometers on the left-hand side of effects area (Transition, Memory, Preview Overlay and Downstream Keyer 1).
- **4530A-138** — crosspoint re-entry switches.
- **4000A-430** (QTY. 2) — contains the circuitry to control the Mnemonics displays.
- **4000A-437** (up to Qty. 8) — 7-display mnemonics module.
- **4000A-438** (up to Qty. 8) — 8-display mnemonics module.

In the upper control panel section:

- **4735A-032B** — switches and display for the Global Memory System.
- **4735A-036B** — buttons, switches and potentiometers in the Pattern Control and Matte groups, A-D converters for all knobs, faders and joystick, plus the FPGA that decodes the optical potentiometers beside the large display.
- **4735A-037** — switches (F1, F2...) that surround the large display, plus a power module attached to the top side of the board, that provides power to the display backlight. A guard shield is included because the power module generates over 1000 V AC.
- **4530A-202** — crosspoint switches for the Aux Bus and Aux Bus Assign groups.
Synergy 4 Control Panel Boards

The figure below illustrates the layout of the control panel boards within the Synergy 4 control panel. This panel is used for both the Synergy 3.5 and the Synergy 4 Switchers.

**Layout of Panel Boards — Synergy 4 Control Panel**

Following are board numbers and brief descriptions of each board shown above:

In the lower control panel section:

- **4735A-130** — left-hand crosspoint bus switches.
- **4735A-131** — right-hand crosspoint bus and re-entry switches.
- **4735A-034** — buttons, switches and potentiometers on the right-hand side of effects area (**Key, Matte, Effects Control, Positioner, Fade to Black**, and **Downstream Keyer 2**).
- **4735A-035** — buttons, switches and potentiometers on the left-hand side of effects area (**Transition, Memory, Preview Overlay**, and **Downstream Keyer 1**).
- **4000A-430** (Qty. 2) — contains the circuitry to control the Mnemonics displays.
- **4000A-435 (up to Qty. 20)** — 5-display mnemonics module.
- **4000A-437 (up to Qty. 5)** — 7-display mnemonics module.
- **4000A-438 (up to Qty. 5)** — 8-display mnemonics module.

In the upper control panel section:

- **4735A-032** — switches and display for the **Global Memory System**.
- **4735A-036A** — buttons, switches and pots in the **Pattern Control** group, A-D converters for all knobs, faders and joystick, plus the FPGA that decodes the optical potentiometers beside the large display.
• **4735A-037** — function switches (F1, F2, etc.) that surround the large display, plus a power module (attached to the top side of the board) that provides power to the display’s backlight. A guard shield is included, because the power module generates over 1000 VAC.

• **4735A-202** — left-hand crosspoint bus switches for Aux Bus and Aux Bus Assign groups.

• **4735A-203** — right-hand crosspoint bus switches for the Aux Bus.
Control Panel CPU Board Layout

The figure below illustrates a top view of the control panel CPU Board (4000A-033A), which is identical for all Synergy Q/MD-X control panels.

Control Panel CPU Board — Functional Components

1) Power Distribution 6) Display Controller 11) Reset Button
2) Micro Processor 7) Display Connector 12) Keyboard Controller
3) Boot PROM 8) Control Connector 13) Jumpers and DIP Switches
4) Tallies 9) USB Connector
5) Tally Card Connectors 10) USB Controller

The major functional blocks are described below:

1. Power Distribution
   This area contains the power distribution connectors and adjustment controls for most of the boards in the Control Panel. Each board has a dedicated power supply connection.

2. Micro Processor
   This area contains the micro processor, control FPGA and the system and flash memory that support them.

3. Boot PROM
   The Boot PROM provides the initial hardware instructions for the CPU Board when the system is powered on.

4. Tallies
   This area provides the relays for the 36 standard tallies.

5. Tally Card Connectors
   These two 36-pin connectors accommodate the optional Extended Tally board (4000A-038) that provides an additional 36 tallies when installed.
6. **Display Controller**
   The Display Controller provides the command interface for the LCD Display on the front of the Control Panel.

7. **Display Connector**
   This 26-pin connector accommodates the ribbon cable for the LCD Display on the front of the Control Panel.

8. **Control Connector**
   This 50-pin connector accommodates the main data cable for communication between the CPU Board and the other Control Panel boards.

9. **USB Connector**
   This 34-pin connector accommodates the ribbon cable from the USB Port.

10. **USB Controller**
    The USB Controller provides the command interface for the USB Port on the front of the Control Panel.

11. **Reset Button**
    The Reset Button provides a hard, local, reset for the CPU Board and should only be used for diagnostic purposes.

12. **Keyboard Controller**
    The Keyboard Controller provides the interface for the PS/2 connector located on the rear of the control panel. This port is provided for future expansion.

13. **Jumpers and DIP Switches**
    The jumpers on the CPU Board are set from the factory for the various system loadouts and should not be altered unless advised to do so by Ross Video Technical Support.

---

**Rear Panel Connectors**

The figure below illustrates the various connectors on the rear of all of the Synergy Q/MD-X control panels. These connectors allow the Control Panel to communicate with the frame, serial peripheral devices, the tally device, as well as an optional keyboard. All connectors are always present, whether or not you have options installed. Refer to Appendix A, “Specifications” for details of all control panel connector pinouts.
1. Panel and Keyboard Communications

Four connectors are provided for panel communications.

- **FRAME** — One 8-pin shielded RJ-45 connector is provided for communications between the chassis (PANEL connector) and the control panel.
- **AUX 1 and 2** — Two 6-pin shielded RJ-12 connectors are provided for communications between the control panel and remote Aux panels.
- **PS/2** — This port is provided for future expansion.

2. Remote Device Control

Eight 9-pin “D” connectors (RS-422) are provided for communicating with remote peripheral devices, such as VTRs, disk recorders, video servers, or audio servers. The appropriate remote control software option (VTR Remote Control, Video Server Remote Control, Audio Server Remote Control, etc.) must be installed in order to activate these ports.

- The ports can be configured as RS-422 or RS-232 through the menu system.

3. Tally Connectors

Four 25-pin “D” connectors are provided for tallies.

- The functionality of connectors 1 and 2 is standard, providing 36 tally relays.
- The functionality of connectors 3 and 4 is optional, providing an additional 36 tally relays. The Extended Tallies option must be installed.

**Note**

Refer to the section “Extended Tallies Option” on page 28-3 for instructions on installing the Extended Tallies option.
Basic Interconnections

This section describes the basic types of interconnections on the control panel boards. As a general rule, the panel CPU communicates with the upper boards through 50-pin ribbon cables — essentially, an extended CPU data bus.

- In the **Synergy 2** panel, a single cable is used that runs from the CPU board (4000A-033A) to the 4317A-037 board, over to the 4317A-130, across to the 4317A-034 and then down to the 4317A-036.
- In the **Synergy 2.5** panel, there are two cables. One runs along the back of the top section, and the other runs along the bottom.
- In the **Synergy 3** panel, there are two cables. One runs along the back of the top section, and the other runs along the bottom.
- In the **Synergy 4** panels, there are two cables. One runs along the back of the top section, and the other runs along the bottom.

All ribbon cable connectors are the same, but the orientation of each connector only allows them to be attached in one place.

Please note:

- Each upper control panel board has a 6-pin keyed power connector (white), that carries +5V, +12V and ground.
- All faders are the same, and all fader assemblies are interchangeable. Each is connected through a 16-pin dip-style socketed connector, with an indicator that shows the location of pin 1.
- Each blue display (for example, in the panel memory areas) also has a 16-pin connector, directly beside each display module.
- The positioner connects with a 16-pin ribbon cable.
- On the Synergy 3 control panel, the 4530A-138 is not connected to the main ribbon cable. Instead, it is connected via a 34-pin cable to the 4530A-131 board. A dedicated power connector also connects the 4530A-138 to the 4530A-131.
- On the Synergy 3 control panel, the 4735A-037 is also not connected to the main ribbon cable. Instead, it is connected via a 16-pin cable to the 4735A-036B board.
- On the Synergy 3 and Synergy 4 control panels, a small 34-pin ribbon cable connects the 4530A-034 to the 4735A-036B. This cable carries analog signals from the potentiometers to the A-D converter board.
- On the Synergy 3 and Synergy 4 control panels, a 16-pin ribbon cable connects the 4530A-035 to the 4735A-036B. This cable carries fader analog signals, and connects the switches in the transition area to the A-D converter board.
- On the Synergy 4 only, a small 26-pin ribbon cable connects the 4735A-202 to the 4735A-203 (Aux Bus crosspoint switch boards).
- On all switchers, the USB Port has a dedicated data connector and power connector that each run from the Panel CPU Board.

Note the following important points regarding the optical encoders:
• The optical encoders (at the edge of the display) use 4-pin connectors that plug into the edge of the 036 board.

**Notice**

If you need to remove these connectors in order to service an optical encoder, *do not* plug them in backwards. If the connection polarity is wrong, it will destroy the encoder. These connectors are keyed, so if you remove them, take note of the polarity.

Note the following point regarding the LCD Display (for all Q/MD-X control panels):

• A flat ribbon cable runs from the panel CPU board and connects to a mating connector on the 037. The 037, in turn, has a single 15-pin cable that runs to the display itself, plus another 2-pin connector that plugs into the Backlight Converter Module for purposes of power and control.
Frame Boards

In This Chapter

This chapter provides an overview of the various system boards that comprise the Synergy Q/MD-X frame.

The following topics are discussed:

- Frame Board Overview
- Option Cards Overview
- Midplane
- Video Input Board
- Video Output Board
- CPU Board
- Video Processor Board
- Crosspoint Board
- Squeeze & Tease Carrier Board
- Squeeze & Tease DSP Card
- Squeeze & Tease MD Card
- Squeeze & Tease MD WARP Card
- XFX Extra Effects Card
Frame Board Overview

The following system boards are described in this chapter:

**Midplane (4800A-010)**

The **Midplane** is a non-removable board that provides the interconnects between the system chassis boards, the power supplies, and the fan assembly, as well as the routing through which all video signals, communication, and control commands pass. The board has no active components.

**Input Board (4800A-060)**

The **Input Board** comes in two configurations, one with an analog reference loop (4800A-060A), and one without (4800A-060B). Both versions contain 16 multi-definition serial digital inputs, but the 060A contains 2 additional BNC inputs for the reference connections.

The Synergy Q/MD-X chassis can support up to six Input boards. Inputs are configured and assigned through the menu system.

**Output Board (4800A-064)**

The Synergy Q/MD-X can support up to three **Video Output Boards**, in Slots I, J, and K of the frame. Each board contains 16 fully configurable multi-definition video outputs that can be used as Aux Buses, MLE Program, MLE Preview, MLE Clean Feed, Preview Overlay, External DVE Send, MultiDSK, or AuxKeys.

**Frame CPU Board (4800A-001)**

The **CPU Board** resides in Slot A at the rear of the chassis, and is connected to the midplane. It contains the hard disk, the system memory, and the main system microprocessor, and is responsible for the high-level control functions and all Ethernet and remote serial communication for the frame, and between the frame and control panel.

**Video Processor Board (4800A-040)**

The **Video Processor Board** performs all of the basic video effects in the Synergy Q/MD-X switcher. Functions such as the interface to the Squeeze & Tease MD boards, Chroma Keying, patterns and wipes, and transitions are all generated on this card.

The Video Processor Board includes two slots to support future hardware options.

**Crosspoint Board (4800A-020)**

The **Crosspoint Board** is a 144 x 144 switch that can route HD as well as SD video signals. Only one Crosspoint Board can be installed, in the fifth slot from the top at the front of the Synergy Q/MD-X frame.

**Squeeze & Tease Carrier Board (4800A-047)**

The **Squeeze & Tease Carrier Board** provides four slots for the Squeeze & Tease MD Cards and two slots for the Squeeze & Tease WARP MD Cards. The board also provides local control as well as video routing and power to these cards.
Option Cards Overview

The following option cards are described in this chapter:

**Squeeze & Tease DSP Card (4800A-046)**

The Squeeze & Tease DSP Card provides all the control functions for the Squeeze & Tease MD Cards and Squeeze & Tease WARP MD Cards. This allows the cards to communicate with the other cards installed on the board, as well as with the rest of the system.

**Squeeze & Tease MD Card (4800A-048)**

The Squeeze & Tease MD Card performs all the Squeeze & Tease video manipulation for the system. This includes planar processing, pre-processing, lighting, 3D borders, and filtering.

**Squeeze & Tease MD WARP Card (4800AR-049)**

The Squeeze & Tease MD WARP Card performs all the 3D WARP effects.

**XFX Extra Effects Card (4800AR-042)**

The XFX Extra Effects card provides support for the MLE-Store and Dual Border Generator options.
The Synergy Q/MD-X frame has an 8-RU (Rack Unit) Midplane (4800A-010) to which all the frame boards are connected. The midplane also contains the routing through which all video signals pass, as well as all command and control communication, and power to the boards.

This section will identify and describe the various functional components of the front and rear of the Synergy Q/MD-X midplane.

**The Midplane Functional Components**

The midplane is a vertically mounted board that provides a series of connectors on both the rear and front to accept the corresponding connectors found on each of the frame boards. Each of these slots is designed to accommodate one specific board.
**Rear Connections**

The rear connections on the midplane accommodate the following boards that are installed in the rear section of the switcher frame:

- CPU Board
- Video Input Board
- Video Output Board

---

**Mid-Plane Rear View — Functional Components**

1. **CPU Board Slot**
   
   Only the CPU Board can be installed in Slot A.

2. **Future Expansion Slot**
   
   Slot B will be used for future expansion.

3. **Video Input Board Slots**
   
   Only the Video Input Board can be installed in Slots C through H.

4. **Video Output Board Slots**
   
   Only the Video Output Board can be installed in Slots I through K.

5. **Future Expansion Slots**
   
   Slots L and M will be used for future expansion.

6. **Power Input Connectors**
   
   These connectors take the input power from the AC power filters at the back of the frame and route it to the power supplies at the front of the midplane.
**Front Connections**

The connections on the front of the midplane accommodate the Video Processor Boards, the Squeeze & Tease Carrier Boards, the Crosspoint Board, and the power supplies. Refer to the following diagram.

1. **Squeeze & Tease Carrier Board Slot**
   Only the Squeeze & Tease Carrier Board can be installed in these two slots.

2. **Video Processor Board Slots**
   Only the Video Processor Board can be installed in these two slots.

3. **Crosspoint Board Slot**
   Only the Crosspoint Board can be installed in this slot.

4. **Future Expansion Slots**
   These slots will be used for future expansion.

5. **Power Supply Slots**
   The Synergy Q/MD-X frame supports four 12 Volt, 500 Watt power supplies. At any time, three of these power supplies are active with one in a hot stand-by mode. This redundancy allows the hot-swapping of any one power supply without interruption of the system.

6. **Cooling Fan Board Connectors**
   These connectors provide the interface for the Cooling Fan Board to the midplane.
Video Input Board

The Video Input Board comes in two configurations, with reference inputs (4800A-060A) or without reference inputs (4800A-060B). Both of these boards can capture up to 16 Serial Digital Interface (SDI) or High Definition Serial Digital Interface (HD-SDI) video signals, but the Video Input Board with reference looping has two additional connectors used for analog reference inputs.

This section will identify and describe the various functional components and rear panel connections for both Video Input Boards.

**Important**

There must be at least one Video Input Board with reference looping installed on the frame with an active analog reference signal to it.

**Note**

The Synergy Q/MD-X frame can support up to six Video Input Boards, giving a maximum of 96 multi-definition video inputs.

**Functional Components of the Video Input Board with Reference Looping**

The Video Input Board with reference looping (4800A-060A) has six primary components that control and support the video signal inputs.

**Note**

The Video Input Board without reference looping (4800A-060B) does not have the two reference connectors that are shown on the far right of the diagram below. All other functionality is identical.

---

**Rear Panel Connections**

1) Reference Processors  
2) Power Connector  
3) Midplane Connectors  
4) Power Converter  
5) Reset Button

---

`Video Input Board with Reference Looping — Functional Components`
1. **Reference Processors**  
The reference processors act together to process the black burst or tri-level sync clock and timing signals from the reference connectors.

2. **Power Connector**  
The Video Input Board has a single power connector that connects to the midplane when the Video Input Board is installed.

3. **Midplane Connectors**  
The Video Input Board has four 20-pair connectors that connect to the midplane when the Video Input Board is installed. These connectors use Ethernet and SMPTE protocols to communicate and pass video signals with other boards connected to the midplane.

4. **Power Converter**  
The Video Input Board uses a non-isolated power converter to generate the voltage that is needed by the various components on the board.

5. **Reset Button**  
The reset button provides a hard, local, reset for the Video Input Board, and should only be used for diagnostic purposes.

**The Video Input Board Rear Panel**

The rear panel of the Video Input Board with reference looping has two different types of inputs. These inputs are an array of 16 video input connectors and the reference loop connectors, with a reference lock indicator.

---

**Note**  
The Video Input Board without reference looping does not have the reference connectors or the reference lock indicator. All other functionality is identical.

---

1) Reference Connectors  
2) Reference Lock Indicator  
3) Video Input Connectors

---

1. **Reference Connectors**  
The two reference loop connectors provide a reference input with a looping output. These connectors allow the Video Input Board to extract reference information from either a tri-level sync or analog black burst reference source. The Video Input Board can then use this reference information to drive the timing on the internal buses to provide timing for the system.

---

**Important**  
The reference loop connector must be terminated if it is the last device in the series.
2. **Reference Lock Indicator**
   The reference lock indicator will illuminate when the board has locked a reference signal.

3. **Video Input Connectors**
   The 16 video input connections on the Video Input Board support both HD-SDI and SDI video signals.
The Video Output Board (4800A-064) provides 16 SDI or HD-SDI video signal outputs. This section will identify and describe the various functional components and rear panel connections of the Video Output Board.

**Note**
The Synergy Q/MD-X frame can support up to three Video Output Boards, giving a maximum of 48 multi-definition video outputs.

### Video Output Board Functional Components

The Video Output Board has several primary components that control on-board operations and video signal routing from the midplane to the video output connectors.

1. **On-Board Processor**
   
   The on-board processor is used for internal ethernet access, and local control of the board.

2. **FPGAs**
   
   The Video Output Board uses two FPGAs to re-time the video signals, as well as perform AuxKey™, Mix/DSK and MultiDSK™ functions.

---

**Video Output Board — Functional Components**

<table>
<thead>
<tr>
<th>1) On-Board Processor</th>
<th>5) On-Board System Memory</th>
<th>9) Power Converters</th>
</tr>
</thead>
<tbody>
<tr>
<td>2) Routing FPGA</td>
<td>6) Flash Memory</td>
<td>10) Power Connector</td>
</tr>
<tr>
<td>3) Control and Video Features FPGA</td>
<td>7) Temperature Sensor</td>
<td>11) Midplane Connectors</td>
</tr>
<tr>
<td>4) Future Expansion Socket</td>
<td>8) Reset Buttons</td>
<td>12) Diagnostic Indicators</td>
</tr>
</tbody>
</table>

---
3. **Control and Video Features FPGA**
   A single FPGA is used to provide an interface to the Preview Overlay when the Mix/DSK or MultiDSK™ is used.

4. **Future Expansion Socket**
   This socket is reserved for future expansion.

5. **On-Board System Memory**
   The Video Output Board uses four 256MB SDRAM chips for system memory.

6. **Flash Memory**
   The Video Output Board has 64MB of flash memory for code store, still store images, and FPGA loads.

7. **Temperature Sensor**
   A temperature sensor is used to ensure that the board is not operated beyond a set temperature threshold.

8. **Reset Buttons**
   The two reset buttons provide a local, hard reset of the on-board processor and the entire Video Output Board, and should only be used for diagnostic purposes.

9. **Power Converters**
   The frame Video Output Board uses three non-isolated power converters to generate the voltages that are needed by the various components on the board.

10. **Power Connector**
    The Synergy Q/MD-X Video Output Board has a single power connector that connects to the midplane when the Video Output Board is installed.

11. **Midplane Connectors**
    The Synergy Q/MD-X Video Output Board has three 20-pair connectors that connect to the midplane when the Video Output Board is installed. These connectors use Ethernet and SMPTE protocols to communicate and pass video signals with other boards connected to the midplane.

12. **Diagnostic Indicators**
    The three diagnostic indicators illuminate to show various board states and should only be used for diagnostic purposes.
Video Output Board Rear Panel

The rear panel of the Video Output Board has an array of 16 video output connections. Each of these output connections can support either an HD-SDI or SDI video signal, depending on the output signal that is being routed through them.

1. Video Output Connectors

   The 16 video output connections on the Video Output Board support both HD-SDI and SDI video signals.
CPU Board

Each Synergy Q/MD-X system has a single CPU Board (4800A-001) that controls the operation of the various boards that are installed in the frame. The CPU Board also controls the communication between the frame and the switcher, peripheral devices, and external networks.

This section will identify and describe the various functional components and rear panel connections found on the CPU Board.

CPU Board Functional Components

The CPU Board has several primary components that control various aspect of the operation of the CPU Board.

1. CPU

   The Central Processing Unit (CPU) on the CPU Board is a 32-bit 440GX PowerPC 533 Mhz processor. It controls the high-level communications for all the system peripherals on the frame.
2. **Ethernet Transceiver**
   The 10/100 Ethernet transceiver controls the two external LAN ports found on the rear panel of the frame CPU Board. Refer to the section “CPU Board Rear Panel” on page 27-15 for a more detailed description of the external LAN ports.

3. **UART**
   The Universal Asynchronous Receive and Transmit (UART) provides external serial communication through the four DB-9 connectors and through the RJ-45 control panel connector.

4. **Global-Store and Preview Overlay FPGA**
   The CPU Board uses an FPGA to implement the Global-Store and Preview Overlay.

5. **Flash Memory**
   The two flash memory chips provide 64MB of memory for CPU code storage.

6. **Ethernet Switch**
   The 22-port 10/100 Ethernet switch controls the internal, ethernet based, communication that is used between the CPU Board and all the other boards connected to the midplane.

7. **Midplane Connectors**
   The CPU Board has four 20-pair connectors that connect to the midplane when the CPU Board is installed. These connectors use Ethernet and SMPTE protocols to communicate and pass video signals with other boards connected to the midplane.

8. **ATA Connector**
   The ATA connector provides the interface for the hard disk to the CPU Board.

9. **Global-Store and MediaCache Memory**
   This 200-pin DDR SODIMM socket is populated with a 256 MB DDR SDRAM module that is dedicated as a graphic buffer. This module can be upgraded to 1 GB with the MediaCache™ upgrade.

10. **System Memory**
    This 200-pin DDR SODIMM socket is populated with a 256MB DDR SDRAM module that is dedicated as system memory.

11. **Hard Drive**
    The hard drive is a 2.5 inch, 160GB, Ultra ATA drive that is mounted directly onto the CPU Board. It provides storage for Still Stores and additional memory sets, as well as a backup of the software for all the cards in the system.

12. **Battery**
    The battery is used to maintain the non-volatile memory when the CPU Board is powered down. If the battery needs to be replaced, use a 3V Lithium CR 2032 type battery.

13. **Power Connector**
    The CPU Board has a single power connector that connects to the midplane when the CPU Board is installed.
14. Power Converter
The CPU Board uses five non-isolated power converters to generate the voltages that are needed by the various components on the board.

15. Reset Button
The reset button provides a local, hard reset of the board, and should only be used for diagnostic purposes.

16. DIP Switch
This 8 switch DIP sets various system configurations and operational modes for the entire Synergy Q/MD-X system. All DIP switches should be in the OFF position for normal operation of the Synergy Q/MD-X switcher.

DIP Switch 1 may be set to ON to override the network IP address and netmask of your switcher. You may wish to set this if you need to access your switcher via the web interface and do not have access to the control panel and do not know the current IP address.

Setting DIP Switch 1 to ON will set the switcher IP address to 192.168.1.1 and the netmask to 255.255.0.0 the next time the switcher is restarted. When you turn DIP Switch 1 OFF, the switcher reverts to the previously saved IP address and netmask the next time it is restarted.

If you attempt to change the switcher network settings while DIP Switch 1 is ON, a warning message will be displayed indicating that the IP address will revert to 192.168.1.1 and the netmask to 255.255.0.0 the next time the switcher is restarted unless you turn DIP Switch 1 OFF.

Caution
Incorrect DIP switch settings may make your switcher inoperable. If your switcher does not appear to boot and will not pass a video signal, check that all DIP switches are in the OFF position. Do not change the position of the DIP switches unless instructed to do so by Ross Video Technical Support.

CPU Board Rear Panel
The rear panel of the CPU Board has six different types of connections. These connections allow the frame to communicate with serial peripheral, USB and GPI devices, as well as connect to the control panel, and other ethernet networks.

1. LAN Connectors
The two 10/100 Base TX Ethernet connectors allows the connection of the frame to a network for upgrades, as well as support Automatic MDI Crossover (Auto-MDIX). The Auto-MDIX will detect the position of the transmit and receive cable pairs on the
connected device and swap them if needed. This means that there is no need for a crossover cable.

2. **GPI I/O Port**
   The General Purpose Interface (GPI) port allows the connection of an interface device that will typically control the auto transition functions.

3. **Peripheral Ports**
   The four 9-pin integrated serial ports support the RS-232 and RS-422 standards to allow the connection of various serial peripheral devices. The appropriate software may need to be installed in order to properly communicate with these devices.

4. **Panel Connector**
   The RJ-45 panel connector is used to connect the frame to the control panel. This connection is hard-wired on the CPU Board, so no software setup is required.

5. **USB Ports**
   The two integrated USB ports allow the connection of USB peripheral devices.

6. **Time Code Input**
   The time code input allows the system to be synchronized to an external time reference.

---

**Important**
The cable for connecting the Synergy Control Panel to the Synergy Frame is *not* wired as a standard CAT5 ethernet cable. If you need a cable of a specific length, contact your Ross Video Representative for ordering information.
Video Processor Board

The Video Processor Board (4800A-040) performs all the non-Squeeze & Tease video manipulation for the system. This manipulation includes all the keyers, transitions, washes, pattern rotation and manipulation, and wipes.

This section will identify and describe the various functional components found on the Video Processor Board.

Video Processor Board Functional Components

The Video Processor Board has slots for two daughter cards, plus the command and power infrastructure required to support these cards. This infrastructure includes the on-board processor, system memory, graphics buffers, video core, video interface and configuration FPGAs, as well as various power converters, a reset button, and system status or system communication indicators.

1. On-Board Processor
   The PowerPC on-board processor governs the on-board communication and control, as well as the communication with the midplane.

2. Configuration FPGA
   The configuration FPGA routes the configuration communication between the on-board processor and the video core and interface FPGAs.

3. Video Core FPGA
   The video core FPGA governs all the video signal manipulation on the board.
4. **Video Interface FPGA**
   Two video interface FPGAs are used to route all the video signals from the midplane to the video core FPGA.

5. **System Memory**
   This 200-pin DDR SODIMM socket is populated with a DDR SDRAM module that is dedicated to the on-board processor as system memory.

6. **System Buffers**
   Three SDRAM pairs are provided as buffers for the video core and video interface FPGAs.

7. **Temperature Sensor**
   A temperature sensor is used to ensure that the board is not operated beyond a set temperature threshold.

8. **Reset Button**
   The reset button provides a local, hard reset of the board, and should only be used for diagnostic purposes.

9. **Power Converters**
   There are five non-isolated power converters to generate the voltages that are needed by the various components on the board.

10. **Power Connectors**
    There are two power connectors that connect to the midplane when the Video Processor Board is installed.

11. **Midplane Connectors**
    The Video Processor Board has three 20-pair connectors that connect to the midplane when the board is installed. These connectors use Ethernet and SMPTE protocols to communicate and pass video signals with other boards connected to the midplane.

12. **System Indicators**
    There are seven system indicators on the board that show various system states or communications. The CAN and Ethernet indicators show the communication activity on the board. The heartbeat, reset, and power indicators show the software, reset and power status on the board.

13. **XFX Card Slots**
    These two slots accommodate XFX cards which provide various options including a dual-border generator and MLE-Store.
The Crosspoint Board (4800A-020) can switch 144 x 144 HD-SDI and SDI video signal channels. The routing of the video signals is controlled by the CPU Board, which passes the connections information to the crosspoint switch.

This section will identify and describe the various functional components found on the Crosspoint Board.

The Crosspoint Board Functional Components

The Crosspoint Board has a single crosspoint switch that is supported by the on-board microcontroller and interface FPGA. These are accompanied by a number of diagnostic indicators, power converters, and midplane connections.

1. Crosspoint Switch
   The crosspoint switch routes the video signals from the input port to the specified output port.

2. Interface FPGA
   The interface FPGA controls the interface between the crosspoint switch and the microcontroller.
3. **Micro Controller**  
The micro controller is used for on-board control and monitoring, as well as providing the CAN interface.

4. **Power Converters**  
The Crosspoint Board uses three non-isolated power converters to generate the voltages that are needed by the various components on the board.

5. **Midplane Connections**  
The Crosspoint Board has seven 40-pair connectors that connect to the midplane when the Crosspoint Board is installed. These connectors use SMPTE protocols to pass video signals to other boards connected to the midplane.

6. **Power Connector**  
The Crosspoint Board has a single power connector that connects to the midplane when the Crosspoint Board is installed.

7. **Guide Modules**  
The two mounting guide modules at either end of the board fit over the guide pins mounted on the midplane to ensure that the large 40-pair connectors are properly seated.

8. **Diagnostic Indicators**  
The four diagnostic indicators illuminate to show various board states and should only be used for diagnostic purposes.

9. **Reset Button**  
The reset button provides a hard, local, reset for the Crosspoint Board, and should only be used for diagnostic purposes.

10. **System Indicators**  
There are seven system indicators on the board that show various system states or communications. The CAN indicators show the communication activity on the board. The heartbeat, reset, and power indicators show the software, reset and power status on the board.
Squeeze & Tease Carrier Board

The Synergy Q/MD-X switcher uses up to two Squeeze & Tease Carrier Boards (4800A-047) to support up to two Squeeze & Tease WARP MD Cards, four Squeeze & Tease MD Cards and the Squeeze & Tease DSP Card. These cards allow you to perform various planar and pixel manipulation on the video signal.

Squeeze & Tease Carrier Board Functional Components

The Squeeze & Tease Carrier Board has slots for seven daughter cards, plus the command and power infrastructure required to support these cards. This infrastructure includes the on-board CPU, system and video memory, various power converters, reset buttons and system status or system communication indicators.

Squeeze & Tease Carrier Board — Functional Components

1. On-Board Processor
   The PowerPC On-Board Processor governs the on-board communication and control, as well as the communication with the Midplane and the daughter cards mounted on the board.

2. Flash Memory
   The two Flash Memory chips provide 64MB of permanent storage for the On-Board Processor.
3. **On-Board System Memory**
   There are two SDRAM chips used for system memory.

4. **Reset Button**
   The two reset buttons provide a local, hard reset of the On-Board Processor and the entire Squeeze & Tease Carrier Board, and should only be used for diagnostic purposes.

5. **Power Converters**
   There are six Non-Isolated Power Converters to generate the voltages that are needed by the various components on the board.

6. **Power Indicators**
   There are two Power Indicators that illuminate to show power status. There are for diagnostic purposes only.

7. **System Indicators**
   There are seven System Indicators on the board that show various system states or communications. The CAN and Ethernet indicators show the communication activity on the board. The Heartbeat, Reset and Power indicators show the software, reset and power status on the board.

8. **Midplane Connectors**
   The Squeeze & Tease Carrier Board has two 20-pair connectors that connect to the Midplane when the board is installed. These connectors use Ethernet and SMPTE protocols to communicate and pass video signals with the other boards connected to the midplane.

9. **Power Connectors**
   There are four Power connectors that connect to the midplane when the Squeeze & Tease Carrier Board is installed.

10. **Squeeze & Tease DSP Card Slot**
    This single slot will only accommodate the Squeeze & Tease DSP Card.

11. **Squeeze & Tease MD Card Slot**
    These four slots will only accommodate the optional Squeeze & Tease MD Cards.

   **Note**
   The Squeeze & Tease DSP Card and at least one Squeeze & Tease MD Card must be installed in order for the system to operate properly.

12. **Squeeze & Tease WARP MD Card Slot**
    These two slots will only accommodate the optional Squeeze & Tease WARP MD Cards.
**Squeeze & Tease DSP Card**

The Squeeze & Tease DSP Card (4800A-046) provides the interface between the Squeeze & Tease Carrier Board and the other cards installed on the board. This allows these cards to communicate with the frame, and each other, as well as receive status and configuration control information from the Squeeze & Tease DSP Card.

This section will identify and describe the various functional components found on the Synergy MD-X frame Squeeze & Tease DSP Card.

---

**Note**

The Squeeze & Tease DSP Card can only be installed in the Squeeze & Tease DSP Card Slot on the Squeeze & Tease Carrier Board.

---

**Squeeze & Tease DSP Card Functional Components**

The Squeeze & Tease DSP Card has seven primary components that are used for the operation and communications of the card. These are the DSP processor, Interface FPGA, Flash and DSP memory, as well as various diagnostic connectors and indicators.

---

**Squeeze & Tease DSP Card — Functional Components**

1. **DSP Processor**
   The Fixed Point Digital Signal Processor (DSP) performs all the calculations needed for each video field, including borders.

2. **Interface FPGA**

3. **Flash Memory**

4. **DSP Memory**

5. **Reset**

6. **Diagnostic Indicators**
2. **Interface FPGA**
   The Interface FPGA provides the communication and configuration control for the interface between the Squeeze & Tease Carrier Board and the daughter cards installed on it.

3. **Flash Memory**
   The two Flash Memory chips provide 64MB of permanent storage for the DSP.

4. **DSP Memory**
   There are two SDRAM chips used for system memory for the DSP.

5. **Reset**
   The Reset button provides a hard, local, reset for the card and should only be used for diagnostic purposes.

6. **Diagnostic Indicators**
   The six indicators show the different operational states for diagnostic purposes.
Squeeze & Tease MD Card

The Squeeze & Tease MD Card (4800A-048) performs all the Squeeze & Tease video manipulation for the system. It provides all the planar processing, pre-processing, lighting, bordering and filtering. Each card supports up to ten high-speed digital channels for SDI or HD-SDI video signals. Two of these channels are routed to the rest of the frame, two are routed to the previous Squeeze & Tease MD Cards, two are routed to the next Squeeze & Tease MD Cards and another two are routed to the optional Squeeze & Tease MD WARP Cards. These channels are synchronized using a single-ended V-Sync signal.

This section will identify and describe the various functional components found on the Synergy MD-X frame Squeeze & Tease MD Card.

Note

The Squeeze & Tease MD Cards can only be installed in the four Squeeze & Tease MD Card Slots on the Squeeze & Tease Carrier Board.

Squeeze & Tease MD Card Functional Components

The Squeeze & Tease MD Card has five primary components used for the operation and communication of the card. These are the Channel Processor, Buffers, Power Regulators, Temperature Sensor and Diagnostic Indicators.

1. Channel Processor FPGA

The Channel Processor FPGA performs all the video manipulation and channel assignments for the card. Channels are routed to and from the Channel Processor FPGA using high-speed serial link that pass the video signals between the Video Processor Board and the Squeeze & Tease MD WARP Card.
2. **Video Buffers**
   There are eight Quad Data Rate (QDR) Static Random Access Memory (SRAM) buffers that are used by the Channel Processor FPGA. Two of the buffers are located on the underside of the card and are not visible when it is installed.

3. **Power Regulators**
   There are two power regulators installed on the card to regulate the voltages that are needed by the components on the card.

4. **Temperature Sensor**
   A one-wire temperature sensor is used to ensure that the card is not operated beyond a set temperature threshold.

5. **Diagnostic Indicators**
   Three diagnostic indicators are used to show operation of the card.
**Squeeze & Tease MD WARP Card**

The Squeeze & Tease MD WARP Card (4800AR-049) performs all the 3D WARP effects for the system. There are two high-speed digital channels for SDI or HD-SDI video between the WARP card and the Squeeze & Tease MD card.

This section will identify and describe the various functional components found on the Synergy MD-X frame Squeeze & Tease MD WARP Card.

---

**Note**

The Squeeze & Tease MD WARP Cards can only be installed in the two Squeeze & Tease MD WARP Card Slots on the Squeeze & Tease Carrier Board.

---

**Squeeze & Tease MD WARP Card Functional Components**

The Squeeze & Tease MD WARP Card has five primary components used for the operation and communication of the card. These are the FPGA, DSPs, RAM, flash memory, and diagnostic indicators.

1. **Channel Processor FPGA**
   
The FPGA (Field Programmable Gate Array) performs the glue-logic functions connecting the complex circuits of the WARP card together. It also provides a DDR memory interface and handles memory bus arbitration.

2. **DSPs**
   
   There are three 1 GHz DSPs (Digital Signal Processors) on the WARP card that handle all the calculations necessary for providing the various 3D WARP effects.
3. **DDR SDRAM**
   There are six DDR SDRAM (Double Data Rate Synchronous DRAM) chips (three on each side of the WARP card) providing system memory for the three DSPs.

4. **FLASH Memory**
   The flash RAM (Random Access Memory) provides permanent shared storage space for the three DSPs.

5. **LED Diagnostic Indicators**
   The diagnostic indicators are used to show operation of the card.
**XFX Extra Effects Card**

The XFX Extra Effects Card (4800AR-042) performs different functions depending on the options you purchase. Current options include a dual-border generator and MLE-Store.

The dual-border generator option provides visually dynamic border, shadow, and outline effects to both linear MLE keyers, with either hard or soft edges. The option can also enhance Self Keys, Chroma Keys, and Preset Pattern Keys.

The MLE-Store option provides four channels of still images per MLE. Each MLE can have separate images loaded and images with embedded alpha channels are supported by dedicating one of the MLE-Store channels to the alpha channel.

This section will identify and describe the various functional components found on the Synergy MD-X frame XFX Extra Effects Card.

**Note**

The XFX Extra Effects Cards can only be installed in the two slots on the Video Processor.

**XFX Extra Effects Card Functional Components**

The XFX Extra Effects Card has six primary components used for the operation and communication of the card. These are the two FPGAs, DSP, memory, diagnostic indicators, and memory expansion slot.

1) Border FPGA
2) MLE-Store FPGA
3) DSP
4) SDRAM
5) Diagnostic Indicators
6) RAM Expansion Slot
1. **Border FPGA**
   This is the same FPGA (Field Programmable Gate Array) used in the Squeeze & Tease MD WARP card. It also provides the dual-border generator functionality.

2. **MLE-Store FPGA**
   This FPGA provides the MLE-Store functionality. It also serves as a messaging interface to the DSP (see below) and LVDS (Low Voltage Differential Swing) video interface.

3. **DSP**
   The 600 MHz DSP (Digital Signal Processor) will be used in the future to provide calculations to handle various 3D effects.

4. **SDRAM**
   There are 6 SDRAM (Synchronous DRAM) chips providing system memory for the XFX card.

5. **Diagnostic Indicators**
   The diagnostic indicators are used to show operation of the card.

6. **RAM Expansion Slot**
   The RAM expansion slot is an SODIMM socket that can receive between 256 MB and 2 GB of DDR SDRAM. This memory is used to cache MLE-Store images and animations.
Hardware Options

In This Chapter

This chapter provides instruction for installing a variety of hardware options. The following topics are discussed:

- Hardware Option Overview
- Extended Tallies Option
- Mnemonics Display Option
- MediaCache™ Option
- Hard Drive Replacement
- Remote Port Expander Cabling (BSS4)
- Squeeze & Tease MD Option
- XFX Extra Effects Option

Note

If you wish to add any of these options to your Synergy Q/MD-X switcher, please contact Ross Video Technical Support for ordering information.

Important

For all installation procedures, avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Hardware Option Overview

The following option cards and modules may be installed in the switcher to provide additional functionality:

- The **Extended Tallies** option provides an additional 36 tallies, bringing the total number to 72.
  ~ Requires 1 **Extended Tallies Board (4000A-038)**

- The **Mnemonics Display** options enable the source names to be displayed directly above the PGM bus, the Custom Control bus, and each MLE on the **Switcher** control panels.
  ~ **Synergy 2 Q/MD-X** requires 1 Mnemonic Controller board (4000A-430A), up to six Mnemonics Display Modules (4000A-435), and up to 3 Mnemonics Display Modules (4000A-437)
  ~ **Synergy 3 Q/MD-X** requires 1 set of Mnemonic Controller boards (4000A-430B), up to eight Mnemonics Display Modules (4000A-437), and up to eight Mnemonics Display Modules (4000A-438)
  ~ **Synergy 4 Q/MD-X** requires 1 set of Mnemonic Controller boards (4000A-430B), up to twenty Mnemonics Display Modules (4000A-435), up to 5 Mnemonics Display Modules (4000A-437), and up to 5 Mnemonics Display Modules (4000A-438)

- The **MediaCache** option increases the Global-Store memory on the frame CPU Board, allowing animated logos, moving graphics, and short uncompressed clips to be played from the Global-Store.
  ~ Requires one **1 GB DDR SDRAM Module**.

- The **Squeeze & Tease MD** option allows you to Fly Keys, perform pre-processor, lighting, picture frame border and sequence effects.
  ~ Requires a **Squeeze & Tease Carrier Board** with at least one **Squeeze & Tease MD Card** installed per MLE.

- The **XFX** option provides the MLE-Store still-store functionality as well as a dual border generator for flying keys on each MLE it is installed for.

- The **MediaCache** for MLE-Store option increases the MLE-Store memory on the XFX card, allowing animated logos, moving graphics, and short uncompressed clips to be played from the MLE-Store.
  ~ Requires one **1 GB DDR SDRAM Module**.
Extended Tallies Option

This section provides instructions for installing the Extended Tallies option, which offers an additional 36 tallies (bringing the total number to 72). The figure below illustrates the Extended Tallies Board (4000A-038).

1. Mounting Holes
   Three holes are provided for mounting the Extended Tallies Board on the control panel CPU Board, where three permanent standoffs are provided.

2. Connector Sockets
   Two multi-pin female connector sockets are provided on the Extended Tallies Board. When the board is mounted on the connectors below (on the control panel CPU Board), the pins push up from underneath, through the board itself, and into the socket from below.

Note
There are no DIP switches, jumpers, LEDs, or user serviceable areas on the Extended Tallies Board.
Use the following procedure to install the Extended Tallies option. The procedure is universal for all three Synergy Q/MD-X switchers.

1. Observe all static discharge precautions throughout the procedure.
2. Lift the top of the control panel to reveal the electronics bay inside.
3. Turn the control panel power switch off.
4. Remove the protective cover from the electronics bay, and set the screws in a safe place for later re-installation.
5. In the upper left corner of the control panel CPU Board, locate the **Extended Tallies Section**, as shown below. You will find two headers and three standoffs in this region.

   ![](Rear_of_Control_Panel.png)

   **Control Panel CPU Board — Extended Tallies Section**

6. Unpack the Extended Tallies kit.
7. Align the Extended Tallies board with the connectors on the control panel **CPU Board**.
8. Slowly press the board down onto the connectors (which will mate with holes on the bottom of the Extended Tallies board). Ensure that there are no bent or misaligned pins. Continue pressing down, until there is a positive snap — as the board seats fully.
9. Secure the board with screws, into the three mounting holes and standoffs.
10. Prior to replacing the cover on the electronics bay, turn on control panel power and perform the tally diagnostic test. Refer to the section “**Tally Test**” on page 24-12 for complete instructions.
11. With the test complete, turn off control panel power, and replace the protective cover over the electronics bay. Secure all screws around the edges of the top cover. Lower the top of the control panel to complete the procedure.

This completes the procedure for installing the Extended Tallies option.

With the Extended Tallies option properly installed, you now have 36 additional tallies to program and use, and tally connectors 3 and 4 on the rear of the control panel are now active.

- Refer to the “**Tally Connections**” section in Chapter 3 for instructions on connecting tallies.
- Refer to the “**Setting Up Tallies**” section in Chapter 7 for instructions on programming tallies through the menu system.
Mnemonics Display Option

The Mnemonics Display option is available for field installation on all Synergy Q/MD-X control panels. Mnemonics Display modules are available for the PGM bus, the Custom Control bus, and each MLE on your Switcher.

Installing the mnemonics display option is a three part process:

1. Removing Cover Plates
2. Installing Mnemonics Display Modules
3. Installing Mnemonic Controller Board(s)

Removing Cover Plates

Use the following procedure to remove cover plates from control panel.

Caution: Observe all static discharge precautions throughout the procedure.

1. Open the control panel top as wide as possible.
2. Power down the switcher control panel.
3. Locate the Crosspoint (or XPT) Switch circuit board. This board is on the left side of the panel top as you view it from the inside.
4. On the Crosspoint (XPT) Switch circuit board, locate the bolt positions for the cover plates you are removing. The positions are marked with a bolt icon and an arrow head on the silk screening. See the figure and table below for bolt position icons and labels.
5. Using a Phillips #1 screwdriver, remove the slot cover plate screws and place them in a handy spot. You will need these screws to install the mnemonic display components.

6. On the top side of the panel, lift the unscrewed cover plate away, and store it in a safe place with your Synergy Q/MD-X hardware accessories.

7. Repeat steps 4 to 6 for each display row you wish to install.

8. Once all the required cover plates have been removed, close the panel top and proceed to “Installing Mnemonic Display Modules”, below.

This completes the procedure for removing cover plates from control panel.

### Installing Mnemonics Display Modules

Use the following procedure to install mnemonic display modules in your Synergy Q/MD-X control panel.

**Caution**

Observe all static discharge precautions throughout the procedure.

1. Carefully remove the mnemonic display modules from their shipping packages.

<table>
<thead>
<tr>
<th>Switcher</th>
<th>Mnemonic Display Bus Row</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PGM</td>
</tr>
<tr>
<td>Synergy 2 Q/MD-X</td>
<td>MP 38-44</td>
</tr>
<tr>
<td>Synergy 2.5 Q/MD-X</td>
<td>MP 55-68</td>
</tr>
<tr>
<td>Synergy 3 Q/MD-X</td>
<td>MP 55-68</td>
</tr>
<tr>
<td>Synergy 3.5 Q/MD-X</td>
<td>MP 63, 64, 66-69, 65, 30, 72-76, 78,77</td>
</tr>
<tr>
<td>Synergy 4 Q/MD-X</td>
<td>MP 63, 64, 66-69, 65, 30, 72-76, 78,77</td>
</tr>
</tbody>
</table>

Depending on which switcher you have, and how many rows of mnemonics you are installing, you will have a corresponding amount of mnemonics display modules to install based on the configuration groupings listed above.
The Crosspoint (XPT) Switch boards are all silk-screened with outlines and text indicating which type of modules fit in each slot.

2. Based on the configurations described in the previous step, select the leftmost display module and align it over the slot with the pin headers over the pin sockets. When properly aligned, the arrows above the standoff labels (MP 1, etc.) on the underside of the module will point upward.

3. Gently press the module pins onto the pin sockets on the Crosspoint (XPT) Switch circuit board.

4. Working from left to right, repeat steps 3 and 4 to align and insert each module into each row socket until all modules are installed on the panel.

5. Open the panel top as wide as possible.

6. Using a Phillips #1 screwdriver, fasten the bolts (from the cover plate removal procedure) to their corresponding positions as outlined in the following table.

7. When all bolts are inserted, proceed to “Installing Mnemonic Controller Board(s)”, below.

This completes the procedure for install mnemonic display modules in your Synergy Q/MD-X control panel.

### Mnemonic Display Bolt Position Labels (from left to right)

<table>
<thead>
<tr>
<th>Switcher</th>
<th>Mnemonic Display Bus Row</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGM</td>
<td>Cust Ctrl</td>
</tr>
<tr>
<td>Synergy 2 Q/MD-X</td>
<td>MP 38-44</td>
</tr>
<tr>
<td>Synergy 2.5 Q/MD-X</td>
<td>MP 55-68</td>
</tr>
<tr>
<td>Synergy 3 Q/MD-X</td>
<td>MP 55-68</td>
</tr>
<tr>
<td>Synergy 3.5 Q/MD-X</td>
<td>MP 63, 64, 66-69, 65, 30, 72-76, 78, 77</td>
</tr>
<tr>
<td>Synergy 4 Q/MD-X</td>
<td>MP 63, 64, 66-69, 65, 30, 72-76, 78, 77</td>
</tr>
</tbody>
</table>

### Important

In the following steps, failure to reinstall a module with a precise 1:1 pin-to-socket orientation will damage the Crosspoint (XPT) Switch board, the selected module — or both! Double check your work!

### Note

Do not over tighten the bolts. Over tightening the bolts will damage the Crosspoint (XPT) Switch board, the selected module — or both.
Installing Mnemonic Controller Board(s)

Use the following procedure to install Mnemonic Controller Board(s) in the Synergy Q/MD-X control panel.

1. Observe all static discharge precautions throughout the procedure.
2. Carefully remove the Mnemonic Controller board(s) from the shipping package.

<table>
<thead>
<tr>
<th>Synergy 2 Q/MD-X</th>
<th>uses one Mnemonic Controller board, p/n 4000A-430A.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy 3 Q/MD-X</td>
<td>uses two Mnemonic Controller boards, p/n 4000A-430B.</td>
</tr>
<tr>
<td>Synergy 4 Q/MD-X</td>
<td>uses two Mnemonic Controller boards, p/n 4000A-430B.</td>
</tr>
</tbody>
</table>

3. Depending on which switcher you have, you will have 1 or 2 Mnemonic Controller boards to install, as outlined in the configuration groupings listed above.

⚠️ **Important**

In the following steps, failure to reinstall a Mnemonic Controller board with a precise 1:1 pin-to-socket orientation will damage the Crosspoint (XPT) Switch board, the Mnemonic Controller board — or both! Double check your work!

4. With the panel top still open, locate the three light gray socket rows on the Crosspoint (XPT) Switch circuit board(s).

<table>
<thead>
<tr>
<th>Synergy 2 Q/MD-X</th>
<th>The input sockets are on the lower right edge of the Crosspoint Switch board. The Mnemonic Controller board installs edge to edge with the Crosspoint Switch board.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy 2.5 Q/MD-X</td>
<td>The input sockets for the two cards are on the left edge of the Lower XPT Switch board and the lower right edge of the Upper XPT Switch board. The Mnemonic Controller boards install piggy-back on top of the Crosspoint (XPT) Switch boards, resting fully over each XPT board in both cases.</td>
</tr>
<tr>
<td>Synergy 3 Q/MD-X</td>
<td>The input sockets for the two cards are on the left edge of the Lower XPT Switch board and the lower right edge of the Upper XPT Switch board. The Mnemonic Controller boards install piggy-back on top of the Crosspoint (XPT) Switch boards, resting fully over each XPT board in both cases.</td>
</tr>
<tr>
<td>Synergy 3.5 Q/MD-X</td>
<td>The input sockets for the two cards are on the lower left edge of both the Left and the Right XPT Switch boards. The Mnemonic Controller boards install piggy-back on top of the Crosspoint (XPT) Switch boards, resting fully over each XPT board in both cases.</td>
</tr>
<tr>
<td>Synergy 4 Q/MD-X</td>
<td>The input sockets for the two cards are on the lower left edge of both the Left and the Right XPT Switch boards. The Mnemonic Controller boards install piggy-back on top of the Crosspoint (XPT) Switch boards, resting fully over each XPT board in both cases.</td>
</tr>
</tbody>
</table>

5. On the Crosspoint (XPT) or, in the case of the Synergy 2 panel, Key Switch circuit boards, locate the standoffs which correspond to the mounting holes labeled on the solder side of the Mnemonic Controller boards, and remove any bolts from the standoffs if there are any present.
6. Based on the configurations described in step 3, hold the Mnemonic Controller board with the component side away from you and align it over the slots with the pin groupings over the pin sockets.

7. Gently press the Mnemonic Controller board pins onto the pin sockets on the Crosspoint (XPT) Switch circuit board.

8. Using a Phillips #1 screwdriver and the supplied mounting bolts, fasten the Mnemonic Controller board(s) to the host Crosspoint (XPT) Switch board at the standoff positions.

**Important**

| Do not over tighten the bolts. Over tightening the bolts will damage the Crosspoint (XPT) Switch board, the Mnemonic Controller board — or both! Double check your work! |

This completes the procedure for installing Mnemonic Controller Board(s) in the Synergy Q/MD-X control panel.

This completes the installation of the Mnemonics Display option. For configuration information, refer to the section, “**Standard Mnemonics**” in Chapter 12. For information on BNC and Custom Control names in mnemonics displays, refer to Chapter 7, “**BNC Configuration and Check**”, and Chapter 10, “**Custom Controls**”, respectively.
MediaCache™ Option

The MediaCache upgrade for the Synergy Q/MD-X Systems increases the Global-Store and MediaCache memory on the CPU Board of the frame. This upgrade allows animated logos, moving graphics, and short uncompressed clips to be played from the Global-Store.

The MediaCache option consists of both a hardware upgrade and software that enables this feature. For the hardware component, the existing 256 MB DDR SDRAM module is removed and replaced with a larger 1 GB DDR SDRAM module. The new feature is then enabled using a software access code provided by Ross Video Technical Support.

Upgrading the MediaCache Memory

The MediaCache upgrade requires that you replace the existing Global-Store and MediaCache memory module with a new, larger memory module. This procedure requires you to power down the frame and remove the CPU Board.

In order to upgrade the MediaCache Memory you will have to power down your switcher, remove the CPU board from the frame, install the MediaCache Memory Module, re-install the CPU board into the frame, and power up the switcher.

Shutdown the Switcher

Use the following procedure to perform a shutdown of the switcher:

1. Navigate to the System Shutdown Menu as follows:
   - Press HOME ⇒ MORE ⇒ System Shutdown.

   System Shutdown Menu

2. Press Shut Down.

This completes the procedure for shutting down the switcher. Next you will have to remove the CPU Board from the frame.

Removing the CPU Board

Use the following procedure to remove the CPU Board:

Important

Do not turn the switcher frame power off until you have completed the proper shutdown procedure or you may damage the hard disk. Refer to the section “Shutting Down the Switcher” on page 4-14 for this procedure.

1. Remove the front door of the frame.
2. Locate the main power switch located on the Cooling Fan Carrier on the left side of the frame.
3. Toggle the main power switch OFF.
4. Locate the CPU Board in Slot A at the back of the frame.

```
CPU Board — Rear Panel
```

---

**Note**
You may want to label the cables connected to the back of the frame so that they can be easily reconnected when you have completed this procedure.

---

5. Remove all the cables connected to the CPU Board.
6. Unscrew the **Locking Screws** located at either end of the rear panel of the CPU Board.

---

**Caution**
Always remember to ground yourself by touching the chassis or wearing a grounded wrist strap before handling any electronic components.

---

7. Remove the CPU Board by sliding it out of slot in the frame.

```
Synergy Q/MD-X — CPU Board Removal
```

8. Place the CPU Board on a clean, static free surface.

With the CPU Board removed from the frame, you can now replace the existing Global-Store and MediaCache module with the new MediaCache module.
Installing the MediaCache Memory Module

Use the following procedure to install the MediaCache Memory Module:

1. Locate the MediaCache on the CPU Board.

![CPU Board — MediaCache Location](image)

2. Using your thumbs, spread the Retaining Clips on either side of the Memory Socket outward until the Memory Module is released.

![Removing the Memory Module](image)

3. Grasping the Memory Module by the edge, remove it from the Memory Socket and place it on a clean, static free surface.

4. Gently slide the new MediaCache Memory Module down at an angle into the Memory Socket you just removed the memory module from.

![MediaCache Memory Module](image)

5. Gently push the MediaCache Memory Module down into place until the two Retaining Clips click shut and secure the MediaCache in the Memory Socket.

With the new MediaCache module installed on the CPU Board, you will reinstall the CPU Board in the frame.

Caution

Always remember to ground yourself by touching the chassis or wearing a grounded wrist strap before handling any electronic components.
Reinstalling the CPU Board

Use the following procedure to reinstall the CPU Board:

1. Ensure that the frame is powered OFF.
2. Slide the CPU Board into Slot A at the back of the frame until it is fully seated.
3. Screw in the Locking Screws at either end of the rear panel of the CPU Board to secure the board in place.
4. Reconnect the cables to the rear panel of the CPU Board.
5. Locate the main power switch located on the Cooling Fan Carrier on the left side of the frame.
6. Toggle the main power switch ON to power up the frame.
7. Replace the front door of the frame.

This completes the procedure for installing the hardware component of the MediaCache option. Refer to Chapter 6, “Software Upgrades and Options” for details on activating the software component.
Hard Drive Replacement

In the event that the hard drive installed in your Synergy Q/MD-X switcher needs to be replaced, a spare hard drive, with the current shipping version of the software on it, is provided in the spare parts kit.

**Note**

The software provided on the spare hard drive should be the current shipping version at the time the hard drive was imaged. This may not be the newest version of software available. Refer to Chapter 6, “Software Upgrades and Options” for the procedure to upgrade your software. Once you have installed the spare hard drive you should contact Ross Video for the most current version of the software.

Replacing the Hard Drive

In order to replace your hard drive you will have to power down your switcher, remove the CPU board from the frame, replace the hard drive, re-install the CPU board into the frame, and power up the switcher.

**Shutdown the Switcher**

Use the following procedure to perform a shutdown of the switcher:

1. Navigate to the System Shutdown Menu as follows:
   - Press HOME ⇄ MORE ⇄ System Shutdown.
2. Press Shut Down.

This completes the procedure for shutting down the switcher. Next you will to remove the CPU Board from the frame.
Removing the CPU Board

Use the following procedure to remove the CPU Board:

1. Remove the front door of the frame.
2. Locate the main power switch on the Cooling Fan Carrier on the left side of the frame.

**Important**

Ensure that the switcher is in power-down mode before you proceed. Do not turn the switcher frame power off until you have completed the proper shutdown procedure or you may damage the hard disk. Refer to the section “Shutting Down the Switcher” on page 4-14 for this procedure.

3. Toggle the main power switch **OFF**.
4. Wait for the System Status Indicators to go out.
5. Locate the CPU Board in **Slot A** at the back of the frame.

System Status Indicator and Main Power Switcher — Synergy Q/MD-X

- Toggle the main power switch **OFF**.
- Wait for the System Status Indicators to go out.
- Locate the CPU Board in **Slot A** at the back of the frame.
6. Remove all the cables connected to the CPU Board.

7. Unscrew the **Locking Screws** located at either end of the rear panel of the CPU Board.

**Caution**

Always remember to ground yourself by touching the chassis or wearing a grounded wrist strap before handling any electronic components.

8. Remove the **CPU Board** by sliding it out of slot in the frame.

9. Place the **CPU Board** on a clean, static free surface.

With the **CPU Board** removed from the frame, you can now replace the existing Hard Drive with the replacement **Hard Drive**.
Replacing the Hard Drive

Use the following procedure to replace the Hard Drive:

1. Locate the **Hard Drive** on the **CPU Board**.

2. Release the **Ribbon Cable** from the **Ribbon Cable Connector** by pressing down and out on the **Ejector Tabs** at either end of the **Ribbon Cable Connector**.

**Notice**

Always remember to ground yourself by touching the chassis or wearing a grounded wrist strap before handling any electronic components.
3. Flip the **CPU Board** over so that the Hard Drive is facing down.

4. Locate the four **Retaining Screw** securing the **Hard Drive** in place.

5. Using a non-magnetic (electronics safe) screwdriver, remove the **4 Retaining Screws** securing the **Hard Drive**.

6. While holding the **Hard Drive** to the **CPU Board**, flip the **CPU Board** back over so that the **Hard Drive** is facing up again.

**Note**

Ensure that you do not damage the rubber spacers located at each screw hole when you remove the **Hard Drive**.

7. Remove the **Hard Drive** from the **CPU Board** and place in a safe location.

8. Remove the **Ribbon Cable** from the **Hard Drive** you just removed and install it onto the replacement **Hard Drive** using the **44 pin Hard Drive Ribbon Cable Pins**. Ensure that the stripe on the **Ribbon Cable** is aligned towards the four unused pins as illustrated.

**Warning**

Ensure that you connect the **Ribbon Cable** to the pins illustrated. If the **Ribbon Cable** is not properly connected your **Hard Drive** could be damaged when the switcher is powered On.
9. Ensuring that the Rubber Spacers are in place, install the replacement Hard Drive using the 4 Retaining Screws you removed.

![Image](rubber_spacer.png)

**CPU Board — Screws**

**Caution**

Do not overtighten the Retaining Screws. These screws only need to be snug in order to secure the Hard Drive in place.

10. Push the Ribbon Cable into the Ribbon Cable Connector until the Ejector Tabs at either end of the Ribbon Cable Connector close together, securing the Ribbon Cable in place.

With the replacement Hard Drive installed on the CPU Board, you will reinstall the CPU Board in the frame.

**Reinstalling the CPU Board**

Use the following procedure to reinstall the CPU Board:

1. Ensure that the frame is powered OFF.
2. Slide the CPU Board into Slot A at the back of the frame until it is fully seated.
3. Screw in the Locking Screws at either end of the rear panel of the CPU Board to secure the board in place.
4. Reconnect the cables to the rear panel of the CPU Board.
5. Locate the main power switch at the front of the frame.
6. Toggle the main power switch ON to power up the frame.
7. Replace the front door of the frame.

This completes the procedure for installing a replacement Hard Drive. You may have to reset your network configurations or update your software version. Refer to Chapter 6 “Software Upgrades and Options” for more information.
Remote Port Expander Cabling (BSS4)

To connect the BSS4 Remote Port Expander to the Synergy Q/MD-X switcher, you will have to make a connection from one of the Remote Ports on the back of the control panel to the Master Port on the BSS4.

In order to properly complete this procedure you will need the following:

- **BSS4 Interface Cable** — An RS-422 cable with a male 9-pin, D-type connector on one end, and a female 9-pin, D-type connector on the other end. Refer to the table “Synergy-to-BSS4 Wiring Chart” on page 28-20 for wiring information.

  

<table>
<thead>
<tr>
<th>Synergy Panel</th>
<th>BSS4 Remote Port Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port (Female)</td>
<td>Signal</td>
</tr>
</tbody>
</table>
  | 1 | Chassis | 2 | TxA (Tx-)
  | 2 | RxA (Rx-) | 3 | RxB (Rx+)
  | 3 | TxB (Tx+) | 4 | n/c
  | 5 | Ground | 6 | Ground
  | 7 | RxB (Rx+) | 8 | TxA (Tx-)
  | 9 | Chassis |

  

- **BSS4 Power Supply** — The 5 Volt, 100mA power supply that was supplied with your BSS4 switch.

The Synergy Q/MD-X switcher connects to the BSS4 Remote Port Expander via the remote ports on the back of the Synergy control panel, and the Master Port on the BSS4.

- The Synergy control panel remote port requires a 9-Pin, D-Type RS-422 connector.
- The BSS4 Master Port requires a 9-Pin, D-Type RS-422 connector.

Use the following procedure to connect a BSS4 Remote Port Switch to your Synergy Q/MD-X switcher:

1. Connect and secure the male end of the **BSS4 Interface Cable** to one of the **Remote Ports** on the back of the Synergy Q/MD-X control panel.
2. Connect and secure the female end of the **BSS4 Interface Cable** to the **Master Port** on the BSS4. Refer to the section “Connecting the BSS4 Remote Port Expander to the Synergy Q/MD-X Control Panel” on page 28-21 for an illustration.

**Caution** Ensure that you have the correct power supply for your type of power before you attempt to plug the BSS4 Power Supply in a power socket.
3. Connect the **BSS4 Power Supply** to the **BSS4** and plug into an appropriate AC outlet.

**Connecting the BSS4 Remote Port Expander to the Synergy Q/MD-X Control Panel**

This completes the procedure for connecting the BSS4 Remote Port Switch to the Synergy Q/MD-X switcher. Next, you will have to set up the communications protocols in order to use the Extended Remote Ports on the BSS4. Refer to Chapter 9, “**Basic Communications Setup**” for information on setting up the communications protocols for the BSS4.
Squeeze & Tease MD Option

The Squeeze & Tease™ MD option consists of a carrier board and a number of daughter cards that are installed into the Synergy Q/MD-X frame.

In order to install the Squeeze & Tease MD option, you will have to upgrade the switcher software, install the daughter cards onto the Squeeze & Tease Carrier Board, and install the Squeeze & Tease Carrier Board into the frame.

The hardware for the Squeeze & Tease MD option consists of 2 Squeeze & Tease MD Carrier Boards, each with slots for 4 Squeeze & Tease MD Cards, each providing 2 channels of DVE, a slot for 1 DSP Card, and slots for 2 Squeeze & Tease WARP MD Cards.

The total number of Squeeze & Tease MD boards and cards you can install will depend on the Synergy Q/MD-X switcher you have. Refer to the following table for information on the number of Squeeze & Tease MD options you can install.

<table>
<thead>
<tr>
<th>Switcher</th>
<th>Squeeze &amp; Tease MD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy 2 Q/MD-X</td>
<td>1 × Squeeze &amp; Tease Carrier Board</td>
</tr>
<tr>
<td></td>
<td>4 × Squeeze &amp; Tease MD Cards</td>
</tr>
<tr>
<td></td>
<td>2 × Squeeze &amp; Tease WARP MD Cards</td>
</tr>
<tr>
<td>Synergy 2.5 Q/MD-X</td>
<td>1 × Squeeze &amp; Tease Carrier Board</td>
</tr>
<tr>
<td></td>
<td>4 × Squeeze &amp; Tease MD Cards</td>
</tr>
<tr>
<td></td>
<td>2 × Squeeze &amp; Tease WARP MD Cards</td>
</tr>
<tr>
<td>Synergy 3 Q/MD-X</td>
<td>2 × Squeeze &amp; Tease Carrier Boards</td>
</tr>
<tr>
<td></td>
<td>6 × Squeeze &amp; Tease MD Cards</td>
</tr>
<tr>
<td></td>
<td>3 × Squeeze &amp; Tease WARP MD Cards</td>
</tr>
<tr>
<td>Synergy 3.5 Q/MD-X</td>
<td>2 × Squeeze &amp; Tease Carrier Boards</td>
</tr>
<tr>
<td></td>
<td>6 × Squeeze &amp; Tease MD Cards</td>
</tr>
<tr>
<td></td>
<td>3 × Squeeze &amp; Tease WARP MD Cards</td>
</tr>
<tr>
<td>Synergy 4 Q/MD-X</td>
<td>2 × Squeeze &amp; Tease Carrier Boards</td>
</tr>
<tr>
<td></td>
<td>8 × Squeeze &amp; Tease MD Cards</td>
</tr>
<tr>
<td></td>
<td>4 × Squeeze &amp; Tease WARP MD Cards</td>
</tr>
</tbody>
</table>

Note: The additional Keys of the MultiDSK option or the additional half MLE of the Mix/DSK option cannot Fly a Key.

Installing the Squeeze & Tease MD Option

In order to install the Squeeze & Tease MD option, you must update the switcher software, install the daughter cards onto the Squeeze & Tease Carrier Board, and install the carrier into the frame.

If you are adding Squeeze & Tease MD Cards or Squeeze & Tease WARP MD Cards to an existing Squeeze & Tease Carrier Board, you must remove the board from the frame, install the daughter cards.
and then reinstall the Squeeze & Tease Carrier Board into the frame. Refer to Chapter 3, “Physical Installation” for information on removing and installing frame circuit boards.

Important

Although the Squeeze & Tease Carrier Boards are hot-swappable, any Squeeze & Tease resources on those cards that are being used, Flying Keys for example, will be lost when the board is removed.

Upgrading the Software

When a new board is installed, the switcher checks the current version of software on the board. If the software on the board is the same as the software on the switcher, there is no change. If the board has a software version that is different than the version on the switcher, the switcher will upgrade the board to the same version as the switcher. For this reason it is important that you upgrade your switcher to the latest version of Synergy Q/MD-X software prior to installing a new board into the frame.

Refer to Chapter 6, “Software Upgrades and Options” for information on upgrading your switcher.

Installing the Squeeze & Tease DSP Card

Use the following procedure to install the Squeeze & Tease DSP Card onto the Squeeze & Tease Carrier Board:

Caution

Always remember to ground yourself by wearing a grounded wrist strap before handling any electronic components.

1. Place the Squeeze & Tease Carrier Board on a clean, static-free surface.
2. Locate the Squeeze & Tease DSP Card Slot on the Squeeze & Tease Carrier Board.

3. Orient the Squeeze & Tease DSP Card so that the 2 connectors on the bottom of the card line up with the connectors in the Squeeze & Tease DSP Card Slot.

4. Apply firm, even, pressure to seat the card in the slot.

Caution
Do not overtighten the Retaining Screws. These screws only need to be snug in order to secure the card in place.

5. Install the 2 Retaining Screws into the Retaining Screw Mounts on the Squeeze & Tease Carrier Board to secure the card in position. The screws insert from the bottom of the Squeeze & Tease Carrier Board, into the daughter card.

This completes the procedure for installing the Squeeze & Tease DSP Card. Next, install any Squeeze & Tease MD Cards onto the Squeeze & Tease Carrier Board.

Installing a Squeeze & Tease MD Card

Use the following procedure to install a Squeeze & Tease MD Card onto the Squeeze & Tease Carrier Board:

Notice
Always remember to ground yourself by wearing a grounded wrist strap before handling any electronic components.

1. Place the Squeeze & Tease Carrier Board on a clean, static-free surface.
2. Locate the **Squeeze & Tease MD Card Slot** (MD Slots 1 through 4) on the **Squeeze & Tease Carrier Board** that you want to install the Squeeze & Tease MD Card into.

   **Note**
   The **Squeeze & Tease MD Card Slots** should be populated from Slot 1 through to Slot 4.

3. Orient the **Squeeze & Tease MD Card** so that the 3 connectors on the bottom of the card line up with the connectors in the **Squeeze & Tease MD Card Slot**.

   **Operating Tip**
   The **Retaining Screw Holes** on either side of the card will line up with the mounts on the board.

   **Caution**
   Do not attempt to use the **Retaining Screws** to seat the card in the slot.
4. Apply firm, even pressure to seat the card in the Slot.

**Caution** Do not overtighten the Retaining Screws. These screws only need to be snug in order to secure the card in place.

5. Install the 2 Retaining Screws into the Retaining Screw Mounts on the Squeeze & Tease Carrier Board to secure the card in position. The screws insert from the bottom of the Squeeze & Tease Carrier, into the daughter card.

This completes the procedure for installing the Squeeze & Tease MD Card. Use this same procedure to install any additional Squeeze & Tease MD Cards. Next, install any Squeeze & Tease WARP MD Cards or install the Squeeze & Tease Carrier Board into the frame.

**Installing a Squeeze & Tease MD WARP Card**

Use the following procedure to install a Squeeze & Tease MD WARP Card onto the Squeeze & Tease Carrier Board:

**Notice** Always remember to ground yourself by wearing a grounded wrist strap before handling any electronic components.

1. Place the Squeeze & Tease Carrier Board on a clean, static-free surface.

2. Locate the Squeeze & Tease MD WARP Card Slot (WARP Slots 1 and 2) on the Squeeze & Tease Carrier Board that you want to install the Squeeze & Tease MD WARP Card into.

**Note** WARP slot 1 should be populated first.
3. Orient the **Squeeze & Tease MD WARP Card** so that the 3 connectors on the bottom of the card line up with the connectors in the **Squeeze & Tease MD WARP Card Slot**.

**Operating Tip**

| The Retaining Screw Holes on either side of the card will line up with the mounts on the board. |

**Retaining Screw Hole**

![Squeeze & Tease MD WARP Card](image)

**Caution**

Do not attempt to use the **Retaining Screws** to seat the card in the slot.

4. Apply firm, even, pressure to seat the card in the Slot.

**Caution**

Do not overtighten the **Retaining Screws**. These screws only need to be snug in order to secure the card in place.

5. Install the **2 Retaining Screws** into the **Retaining Screw Mounts** on the **Squeeze & Tease Carrier Board** to secure the card in position. The screws insert from the bottom of the Squeeze & Tease Carrier, into the daughter card.

This completes the procedure for installing the Squeeze & Tease MD WARP Card. Use this same procedure to install any additional Squeeze & Tease MD WARP Cards.

**Installing the Squeeze & Tease Carrier Board into the Frame**

The Squeeze & Tease Carrier Board can be installed in **Slot 3** and **Slot 8**. The Slot that the Squeeze & Tease Carrier Board is installed in will determine which MLEs have access to the Squeeze & Tease resources. If you install the Squeeze & Tease Carrier Board into **Slot 3**, only **MLEs 1 and 2** will have access to the DVE resources. If you install the carrier into **Slot 8**, only **MLEs 3 and 4** will have access to the DVE Resources.

When you install the Squeeze & Tease Carrier Board into the frame, the switcher will detect the new board and attempt to upgrade it. Once the Squeeze & Tease Carrier Board has been upgraded, the DSP card on the Squeeze & Tease Carrier Board will be upgraded. The DSP Card will then upgrade the Squeeze & Tease MD and WARP Cards as needed. To check the progress of this upgrade you can use the Card Info page on Upgrade Manager. Refer to Chapter 6, “**Software Upgrades and Options**” for information on viewing the status of an upgrade and how to perform a hard restart of the switcher to initialize the new software.
Refer to Chapter 3, “Physical Installation” for information on installing the Squeeze & Tease MD Carrier Board into the frame.

**Important**

Do not shutdown or restart the switcher, or remove the board from the switcher, while the Squeeze & Tease Carrier or DSP card is being upgraded. You should wait at least 10 minutes after installing the board before performing any of these actions.
**XFX Extra Effects Option**

The XFX Extra Effects option consists of a daughter card that is installed onto the Video Processor board. Two XFX Extra Effects cards can be installed into each video processor for a maximum of 4 XFX Extra Effects cards in your Synergy Q/MD-X switcher.

**Installing the XFX Extra Effects Card**

In order to install the XFX Extra Effects card, you must update the switcher software, remove the video processor(s), install the XFX Extra Effects cards onto the video processor(s), and then re-install the video processor(s) into the frame.

If you are adding cards to an existing video processor board, you must remove the board from the frame, install the daughter cards and then reinstall the video processor into the frame. Refer to Chapter 3, “Physical Installation” for information on removing and installing frame circuit boards.

**Upgrading the Software**

When a new board is installed, the switcher checks the current version of software on the board. If the software on the board is the same as the software on the switcher, there is no change. If the board has a software version that is different than the version on the switcher, the switcher will upgrade the board to the same version as the switcher. For this reason it is important that you upgrade your switcher to the latest version of Synergy Q/MD-X software prior to installing a new board.

Refer to Chapter 6, “Software Upgrades and Options” for information on upgrading your switcher.

**Installing the XFX Extra Effects Card**

Use the following procedure to install the XFX Extra Effects card onto the Video Processor board:

1. Remove the Video Processor board that you are going to install the XFX Extra Effects card into. Refer to Chapter 3, “Physical Installation” for information on removing and installing frame circuit boards.

2. Place the Video Processor board on a clean, static-free surface.

---

**Caution**

Always remember to ground yourself by wearing a grounded wrist strap before handling any electronic components.

---

**Video Processor Board — XFX Card Slots**
3. Locate the XFX card slot on the Video Processor board.

4. Orient the XFX Extra Effects card so that the 2 connectors on the bottom of the card line up with the XFX slot connectors on the Video Processor board.

![Operating Tip]

The Retaining Screw Holes on either side of the card will line up with the mounts on the board.

![XFX Extra Effects Card]

5. Apply firm, even, pressure to seat the card in the Slot.

![Caution]

Do not attempt to use the Retaining Screws to seat the card in the slot.

6. Install the 2 Retaining Screws into the Retaining Screw Mounts on the XFX Extra Effects card to secure the card in position. The screws insert from the bottom of the Video Processor board, into the daughter card.

This completes the procedure for installing the XFX Extra Effects card.

![Caution]

Do not overtighten the Retaining Screws. These screws only need to be snug in order to secure the card in place.
MediaCache™ for MLE-Store Option

The MediaCache for MLE-Store upgrade for the Synergy Q/MD-X Systems increases the MLE-Store and MediaCache memory on the XFX card. This upgrade allows animated logos, moving graphics, and short uncompressed clips to be played from the MLE-Store.

The MediaCache for MLE-Store option consists of both a hardware upgrade and software that enables this feature. For the hardware component, the existing 256 MB DDR SDRAM module is removed and replaced with a larger 1 GB DDR SDRAM module. The new feature is then enabled using a software access code provided by Ross Video Technical Support.

Upgrading the MediaCache for MLE-Store Memory

The upgrade requires that you replace the existing MediaCache for MLE-Store memory module with a new, larger memory module. This procedure requires you to power down the frame and remove the Video Processor(s).

In order to upgrade the MediaCache memory module you will have to complete the following steps:

- Shutdown your switcher
- Remove the Video Processor board(s) with one or two installed XFX Extra Effects cards from the frame
- Install the MediaCache memory module(s) onto the XFX card(s).
- Re-install the Video Processor board(s) into the frame
- Power-up the switcher.

Shutdown the Switcher

Use the following procedure to perform a shutdown of the switcher:

1. Navigate to the System Shutdown Menu as follows:
   - Press HOME ⇒ MORE ⇒ System Shutdown.

2. Press Shut Down.

This completes the procedure for shutting down the switcher. Next, you must remove the Video Processor board from the frame.
Removing the Video Processor Board

Each Video Processor board, carrying one or two XFX cards that you are upgrading the MediaCache for, must be removed from the switcher.

Use the following procedure to remove a Video Processor board:

1. Remove the front door of the frame.
2. Turn the switcher frame power off as follows:
   - Locate the main power switch located on the Cooling Fan Carrier on the left side of the frame.
   - Toggle the main power switch **OFF**.
3. Locate the Video Processor board(s) at the front of the frame.
   - The Video Processor board for MLEs 1 and 2 is in **slot 4**
   - The Video Processor board for MLEs 3 and 4 is in **slot 9**
4. If a tie wrap has been used to secure the locking tabs on the sides of the board, remove the tie wrap.
5. Grasp both locking tabs and rotate them towards you and out towards the outer sides of the frame. This will unseat the board from the midplane.
6. Remove the Video Processor board by sliding it out of the slot in the frame.
7. Place the Video Processor board on a clean, static free surface.
8. If you need to remove the second Video Processor, repeat steps 3 - 7.
This completes the procedure for removing the Video Processor board from the frame. Now you can replace the existing MediaCache for MLE-Store memory module with the new MediaCache memory module.

**Installing the MediaCache for MLE-Store Memory Module**

Use the following procedure to install the MediaCache memory module:

1. Locate the XFX card(s) on the Video Processor (your system may have one or two XFX cards on the Video Processor board).

![Video Processor — XFX Card and MediaCache Location](image)

2. Locate the MediaCache on the XFX card(s).

3. Using your thumbs, spread the retaining clips on either side of the memory socket outward until the memory module is released.

![Removing the Memory Module](image)

**Caution**

Always remember to ground yourself by touching the chassis or wearing a grounded wrist strap before handling any electronic components.

2. Locate the MediaCache on the XFX card(s).

3. Using your thumbs, spread the retaining clips on either side of the memory socket outward until the memory module is released.

4. Grasping the memory module by the edge, remove it from the memory socket and place it on a clean, static free surface.

5. Gently slide the new MediaCache memory module down at an angle into the Memory socket you just removed the memory module from. The memory socket is keyed to fit
the mating connectors on the memory module so ensure you correctly align the memory module with the memory socket.

6. Gently push the MediaCache memory module down into place until the two retaining clips click shut and secure the memory module in the memory socket.

7. Repeat steps 3 to 6 for any additional MediaCache memory modules you are replacing.

This completes the procedure for installing the MediaCache for MLE-Store memory module. Next, you must reinstall the Video Processor board(s) in the frame.

**Reinstalling a Video Processor Board**

Use the following procedure to reinstall a Video Processor board:

1. Ensure that the frame is still powered **OFF**.
2. Slide the Video Processor board into the appropriate slot at the front of the frame until it is fully seated.
   - Video Processor board 1 installs in **slot 4**
   - Video Processor board 2 installs in **slot 9**
3. Re-secure the locking tabs.
4. Repeat steps 1 - 3 if you need to reinstall the second Video Processor board.

This completes the procedure for reinstalling the Video Processor board. The final step is to power-up the switcher.

**Powering-Up the Switcher**

Use the following procedure to power-up the switcher:

1. Power-on the switcher frame as follows:
   - Locate the main power switch located on the cooling fan carrier on the left side of the frame.
   - Toggle the main power switch **ON** to power up the frame.
2. Replace the front door of the frame.

This completes the procedure for installing the hardware component of the MediaCache for MLE-Store option. Refer to the section “**Installing Software Options**” on page 6-29 for details on activating the software component.
Control Panel Maintenance

In This Chapter

This chapter provides instructions for a variety of control panel maintenance procedures. The following topics are discussed:

- Replacing a Bulb
- Replacing a Button
- Replacing a Fader
- Replacing a Knob (Potentiometer)
- Replacing the Display
Replacing a Bulb

This section provides instructions for replacing a burned-out bulb in a control panel switch:

1. Verify that the target bulb is burned out as follows:
   - Navigate to the Lamp Test Menu as follows:
     - Press HOME ➔ MORE ➔ Setup ➔ Panel Diagnostics ➔ Lamp Test.
     - Press buttons in selected panel regions, to test all lamps in those regions as required.
     - To exit the menu, press both Exit buttons beneath the display.

2. Once you have located the burned-out bulb, turn the control panel power switch off.

3. Remove the keycap to reveal the sleeve and bulb within.

4. Carefully push down the sleeve with your fingers.

5. While holding down the sleeve, use needle-nose pliers to carefully grab the plastic body of the bulb and pull it out. Note that the bulb has a two-wire connection in which polarity is not important.

Note: Check the bulb before you proceed. The button may not be lighting simply because the bulb has become loose. Try pushing the bulb down to fully seat it. If this does not solve the problem, please continue with the replacement procedure.

Operating Tip: If you have trouble removing a control panel button, use a pair of wide-tipped pliers (1/2 inch) with masking tape wrapped around the ends. For best results, wiggle the button back and forth as you extract it. This helps to remove the button easily, and also avoids scratching the surface paint.
6. Replace the burned-out bulb with a new one from your spare-parts kit. You can easily use your fingers to replace it. Align the two pins of the replacement bulb with the two holes in the button — the orientation of the bulb does not matter.

7. Replace the keycap, and be careful to align the notch in the base of the keycap vertically to the panel, as shown below. If it is not aligned in this manner, it will not properly snap in place.

8. Turn on control panel power, and verify that the bulb is now working properly.

This completes the procedure for replacing a bulb in a control panel switch.
Replacing a Button

This section provides instructions for replacing a button in the control panel. This procedure may become necessary if a button contact fails, or if the button becomes sticky.

**Notice**

This procedure should be performed by qualified service personnel only — in particular, those highly skilled at de-soldering and soldering components. To reduce the risk of damage to the button solder pads, do not perform any servicing unless you are qualified to do so.

Use the following procedure to replace a control panel button.

1. Verify that the target button is sticky or has failed as follows:
   - Navigate to the **Button Test Menu** as follows:
     - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ Button Test.

   **Button Test Menu**

   - Hold down F5 and F6, then release them to exit button test mode
   - Last action: Button Up

   - Press the target panel button(s) as required.
   - To exit the menu, press both Exit buttons beneath the display.

2. Once you have located the failed button, turn control panel power off.

3. Remove the keycap to reveal the sleeve and bulb within.

   **Control Panel Button — Sleeve and Keycap**

   If you have trouble removing a control panel button, use a pair of wide-tipped pliers (1/2 inch) with masking tape wrapped around the ends. For best results, wiggle the button back and forth as you extract it. This helps to remove the button easily, and also avoids scratching the surface paint.
4. Carefully push down the sleeve with your fingers.

5. While holding down the sleeve, use needle-nose pliers to carefully grab the plastic body of the bulb and pull it out. Note that the bulb has a two-wire connection in which polarity is not important.

6. Lift up the top of the panel to reveal the circuit boards underneath, and locate the button that has failed. There are two types of buttons used in the panel — a large tall button used for the crosspoint buses, and a smaller, short button used for all other functions.

The figure below shows the underside of each button and the arrangement of solder pads. Each type of button has six solder pads.

7. Carefully heat each solder pad, and use a solder-sucker to remove the solder.

8. Once all solder has been removed, pull out the button from the top of the control panel.

9. Insert a new button in the same orientation as the removed one:
   - For large buttons, ensure that the peg on the base of the button is properly aligned with the keyhole in the switcher board itself.
   - For small buttons, ensure that the + indicator on the base of the button is properly aligned with the + sign (or square pad) on the switcher board itself.

10. Re-solder the button to secure it in position.

11. Close the top of the control panel.

12. Replace the bulb and keycap, and be careful to align the notch in the base of the keycap vertically to the panel, as shown below. If it is not aligned in this manner, it will not properly snap in place.

13. Turn on panel power, and verify that the button now works properly.

This completes the procedure for replacing a control panel button.
Replacing a Fader

This section provides instructions for replacing a fader in the control panel.

Use the following procedure to replace a fader on the control panel.

1. Verify that the target fader has failed as follows:
   - Navigate to the Fader Test Menu as follows:
     ~ Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ Fader Test.

2. Once you have located the failed fader, turn control panel power off.

3. Remove the screws on either side of the handle, as illustrated below. Once removed, the handle will separate, leaving the fader shaft. Set all parts aside for later reassembly.

4. Open the control panel, and locate the failed fader. The figure below illustrates a view of the fader assembly, as seen from below.

   Disconnect the cable from the circuit board to the connector/pot assembly, and note its orientation.

5. Remove the two nuts that secure the entire fader assembly to the tub, and set them aside for later reassembly.

6. Remove the entire assembly, and replace with a new fader assembly.
7. Secure the assembly to the tub using the two nuts, then re-attach the connector from the circuit board to the fader.

8. Although the fader is factory-calibrated, ensure that the fader arm is positioned directly in the middle of the control panel slot. If not, loosen the **Horizontal Position Adjustment** screw, re-position the shaft, and secure once again.

9. If required, adjust the tension of the fader using the **Tension Adjustment** screw.

10. Close the control panel top and re-attach the two sides of the handle. If the handle does not seat tightly or if it rattles, insert a small piece of tissue paper inside the inner machine groove, as shown below.

11. Re-attach the two sides of the handle, and tighten them securely.

12. Turn on control panel power, and verify that the fader now functions properly.

This completes the procedure for replacing a fader on the control panel.

---

**Note**

The tension of all faders should be adjusted to suit user preference, and to ensure that the tension on all switcher faders is similar. Do not overtighten the tension adjustment screw.
Replacing a Knob (Potentiometer)

This section provides instructions for replacing a knob (potentiometer) in the **Pattern Control**, **Effects Control** and **Mattes** areas. The procedure does not cover changing the rotary encoders to the right of the display in the **System Control** area. Contact **Ross Video Technical Support** for instructions if one of the rotary encoders has failed.

Use the following procedure to replace a knob (potentiometer):

1. Verify that the target potentiometer has failed:
   - Navigate to **Pots Test Menu** as follows:
     - Press HOME ⏷ MORE ⏷ Setup ⏷ Panel Diagnostics ⏷ Pots Test.
     ![Pots Test Menu](image)
   
   - For the three knobs to the right of the display (in the **System Control** area), select **Normal**. Turn each knob left and right. The display will indicate the rate at which you are turning the knob numerically, and graphically with a bar graph.
   
   - For all other knobs, select **Scaled**. Turning the knob will display the absolute position of the knob both numerically and graphically using a bar graph. The number (displayed in hexadecimal) should range from **0** (full counter-clockwise) to **FFF** (full clockwise). The number should be stable and jitter-free. If the number does not reach both limits, perform a calibration.
   
   - Repeat the pots test after the calibration. If the number does not reach both limits or if it does not respond, please continue with the replacement procedure.

2. Once you have located the failed knob, turn the control panel power switch off.

3. Remove all the knob caps in the **entire section** that contains the failed knob (see below). Each knob has a small screw that secures the knob to the shaft. Loosen the screw ¼ turn and lift off the cap.

   Please note:
   - **Synergy 2** control panel boards and sections:
     - **Pattern Control** knobs are all in one section on the **4317A-036** board.
     - **Effects Control** and **Mattes** knobs are all in one section on the **4317A-034** board.
   - **Synergy 3** control panel boards and sections:

---

Note: If all pots appear to be bad, the problem is in the cable or in the A-D converter. In this situation, please contact Ross Technical Support, as a board swap may be required.
~ Pattern Control and Mattes knobs are all in one section on the 4735A-036B board.

~ Effects Control knobs are all in one section on the 4530A-034 board.

• Synergy 4 control panel boards and sections:

~ Pattern Control knobs are all in one section on the 4735A-036A board.

~ Effects Control and Mattes knobs are all in one section on the 4735A-034 board.

4. Lift up the top of the control panel to reveal the circuit boards underneath, and locate the board that contains the failed pot.

5. Disconnect all power and data connectors from the board. Because the end of each connector rests in close proximity to the mating header (when disconnected), there is no need to label the connectors.

6. Remove all screws from the bottom of the board, and set them in a safe place for later reconnection.

7. Carefully drop the board out from underneath the control panel, and set it on a clean, flat, static-free surface. All pots are secured to the board by a metal plate. Note the position of the failed pot.

8. Using a socket driver, loosen and remove all nuts and lock washers that secure the pots to the metal plate. Remove the metal plate and set it aside in a safe place, along with all nuts and lock washers.

9. All pots are now supported only by their leads. On the bottom of the board, locate the failed pot and de-solder the three connecting leads. The figure below illustrates the silk-screened pot symbol on the board.

10. Replace the failed pot in the proper orientation, and carefully re-solder the three leads.

11. Prior to re-assembling all components, please test out the replaced pot:

   • Set the circuit board on a piece of cardboard so as to insulate it, and re-connect all power and data cables to the circuit board.
   • Turn on control panel power.
   • Perform the diagnostic test as outlined in step 1.
   • Once you have verified that the pot has passed the test, turn off control panel power, disconnect all power and data cables from the board, and continue with the full re-assembly.

12. Reconnect the metal plate using the lock washers and nuts. Tighten all nuts securely.

13. Carefully replace the circuit board through the underside of the control panel.
14. Secure the board to the panel with the mounting screws.

15. Reconnect all power and data cables to the board, and close the top of the control panel.

16. Turn on control panel power, and verify once again that the knob now functions properly.

17. Perform the switcher calibration procedure, to ensure that all pots are properly calibrated. Refer to the section “Switcher Calibration” on page 24-2 for instructions.

This completes the procedure for replacing a knob (potentiometer).
Replacing the Display

This section provides instructions for replacing the entire display. This procedure may be required if the display fails, or more likely, if the backlight begins to fade (with age), and becomes too dim for your preference.

Note: Try adjusting the display contrast before you proceed. Press HOME, MORE, Setup, Display, Large Display, then use the middle knob to adjust contrast. If display readability does not improve, please continue with the replacement procedure.

Use the following procedure to replace the display:

1. Verify the condition of the display as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ Button Test ⇒ MORE ⇒ Display Test.

   ![Display Test Menu]

   • Press any button below the display to advance to the next in the series of display tests. A variety of tests are available.

2. Once you have verified the condition of the display, turn the control panel power switch off.

Caution: Ensure that power is off. This step is extremely important, because high voltages are present in the display module area when it is running.

3. Lift up the top of the control panel to reveal the circuit boards underneath.

4. Unscrew the metal finger shield (an L-bracket) using the two screws in the bottom of the 037 board. Set the shield and screws aside for later reinstallation.

5. Disconnect the data cables from the 15-pin display module header. Depending upon the model of the 037 board, these data cables will originate from a single cable, or from a larger wiring harness.

6. Use needle-nose pliers to disconnect the single small power connector that also originates from the adjacent 037 board.

7. Remove the screws from each corner or the display module, and set them aside for later reconnection.

8. Carefully drop the display module out from underneath the control panel.

9. Install the new display module in the control panel, and secure with the four corner screws.
10. Use needle-nose pliers to reconnect the single small power connector (that originates from the 037 board) to the display module.

11. Reconnect the data cables to the 15-pin display module header, and ensure that they are properly aligned.

12. Reattach the metal finger shield to the bottom of the 037 board.

13. Close the top of the control panel.

14. Turn on control panel power, and verify that the display functions properly.

15. Adjust the display contrast for optimum readability as follows:
   - Navigate to the Large Display Menu as follows:
     ~ Press HOME ➔ MORE ➔ Setup ➔ Display ➔ Large Display.
   - Use the middle knob to adjust the contrast.

This completes the procedure for replacing the display.
Appendix A. Specifications

In This Appendix

This appendix provides technical specifications and connector pinout diagrams. In addition, a comprehensive table is provided that lists all normal, GPI, and special diagnostic Aux panel programming modes.

The following sections are provided:

- Standard Components
- Physical Characteristics
- General Specifications
- Control Panel Specifications
- Rack Frame
- Rack Frame Connector Types
- Control Panel Connector Types
- Power Consumption - Control Panel
- Environmental
- Video Characteristics
- Video Processing
- System Timing
- Video Inputs
- Video Outputs
- Output Characteristics
- Frame Pinouts
- Control Panel Pinouts
- AUX Ports
- Aux Panel Programming Mode Summary

Note

All specifications are subject to change without notice.
Standard Components

The following components are standard on all models:

- Complete Control Panel
- One Chroma key per full MLE
- 4 Pattern Generators per full MLE
- Wipes in full Program/Preset
- 32 Timed Aux Buses
- USB Port and System Control Area
- Custom Control Macro Buttons
- 100 Event Memory System
- 10 GPI Inputs and 10 GPI Outputs
- 36 Tally Outputs
- 10 Meter (33 feet) Control Cable
- System Manuals
- 1 Year Transferable Warranty
Physical Characteristics

General Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Synergy 2</th>
<th>Synergy 2.5</th>
<th>Synergy 3</th>
<th>Synergy 3.5</th>
<th>Synergy 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE Systems</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Serial Digital Inputs</td>
<td>16†</td>
<td>16†</td>
<td>16†</td>
<td>16†</td>
<td>16†</td>
</tr>
<tr>
<td>Crosspoint Buttons</td>
<td>17</td>
<td>30</td>
<td>30</td>
<td>35</td>
<td>35</td>
</tr>
<tr>
<td>Serial Digital Outputs</td>
<td>16‡</td>
<td>16‡</td>
<td>16‡</td>
<td>16‡</td>
<td>16‡</td>
</tr>
<tr>
<td>Matte Generators</td>
<td>10</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>20</td>
</tr>
</tbody>
</table>

† Expandable to 96
‡ Expandable to 48

Control Panel Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Synergy 2</th>
<th>Synergy 2.5</th>
<th>Synergy 3</th>
<th>Synergy 3.5</th>
<th>Synergy 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>36.875&quot;</td>
<td>51.75&quot;</td>
<td>51.75&quot;</td>
<td>56.25&quot;</td>
<td>56.25&quot;</td>
</tr>
<tr>
<td></td>
<td>(93.8 cm)</td>
<td>(131.4 cm)</td>
<td>(131.4 cm)</td>
<td>(143.9 cm)</td>
<td>(143.9 cm)</td>
</tr>
<tr>
<td>Height</td>
<td>11.25&quot;</td>
<td>11.625&quot;</td>
<td>11.625&quot;</td>
<td>12.5&quot;</td>
<td>12.5&quot;</td>
</tr>
<tr>
<td></td>
<td>(28.6 cm)</td>
<td>(29.5 cm)</td>
<td>(29.5 cm)</td>
<td>(31.8 cm)</td>
<td>(31.8 cm)</td>
</tr>
<tr>
<td>Depth</td>
<td>22.375&quot;</td>
<td>24.125&quot;</td>
<td>24.125&quot;</td>
<td>29.0&quot;</td>
<td>29.0&quot;</td>
</tr>
<tr>
<td></td>
<td>(56.8 cm)</td>
<td>(61.3 cm)</td>
<td>(61.3 cm)</td>
<td>(73.7 cm)</td>
<td>(73.7 cm)</td>
</tr>
<tr>
<td>Height above desktop</td>
<td>9.0&quot;</td>
<td>9.25&quot;</td>
<td>9.25&quot;</td>
<td>10.0&quot;</td>
<td>10.0&quot;</td>
</tr>
<tr>
<td></td>
<td>(22.9 cm)</td>
<td>(23.5 cm)</td>
<td>(23.5 cm)</td>
<td>(25.4 cm)</td>
<td>(25.4 cm)</td>
</tr>
<tr>
<td>Desk cutout width</td>
<td>35.5&quot;</td>
<td>50.25&quot;</td>
<td>50.25&quot;</td>
<td>54.75&quot;</td>
<td>54.75&quot;</td>
</tr>
<tr>
<td></td>
<td>(90.2 cm)</td>
<td>(127.6 cm)</td>
<td>(127.6 cm)</td>
<td>(146.7 cm)</td>
<td>(146.7 cm)</td>
</tr>
<tr>
<td>Desk cutout depth</td>
<td>21.25&quot;</td>
<td>23.0&quot;</td>
<td>23.0&quot;</td>
<td>28.0&quot;</td>
<td>28.0&quot;</td>
</tr>
<tr>
<td></td>
<td>(54.0 cm)</td>
<td>(58.4 cm)</td>
<td>(58.4 cm)</td>
<td>(70.5 cm)</td>
<td>(70.5 cm)</td>
</tr>
</tbody>
</table>

Rack Frame

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td># Rack Units (RU)</td>
<td>8</td>
</tr>
<tr>
<td>Width</td>
<td>19.00&quot; (48.3 cm)</td>
</tr>
<tr>
<td>Height</td>
<td>14.13&quot; (35.9 cm)</td>
</tr>
<tr>
<td>Depth (rack ears to BNCs)</td>
<td>25.00&quot; (63.5 cm)</td>
</tr>
</tbody>
</table>
Rack Frame Connector Types

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>BNC Type (Female)</td>
</tr>
<tr>
<td>Reference</td>
<td>BNC Type (Female)</td>
</tr>
<tr>
<td>Peripheral Ports</td>
<td>DB9 (Female)</td>
</tr>
<tr>
<td>GPI I/O</td>
<td>DB25 (Female)</td>
</tr>
<tr>
<td>Panel Port (to control panel)</td>
<td>RJ-45 (Female)</td>
</tr>
<tr>
<td>10/100 Ethernet Port</td>
<td>RJ-45 (Female)</td>
</tr>
<tr>
<td>USB Ports</td>
<td>USB 1.1 Compatible, Type A (host)</td>
</tr>
<tr>
<td>AC Power (primary, redundant)</td>
<td>3-Pin IEC</td>
</tr>
</tbody>
</table>

Control Panel Connector Types

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Port (USB Drive)</td>
<td>USB 2.0 Compatible, Type A</td>
</tr>
<tr>
<td>Remote Ports</td>
<td>DB9 (Female)</td>
</tr>
<tr>
<td>Tally Ports</td>
<td>DB25 (Female)</td>
</tr>
<tr>
<td>Frame Port (to rack frame)</td>
<td>RJ-45 (Female)</td>
</tr>
<tr>
<td>AUX Ports</td>
<td>RJ-12 (Female)</td>
</tr>
<tr>
<td>AC power 1 and 2</td>
<td>3-Pin IEC</td>
</tr>
</tbody>
</table>

**Important**
The cable for connecting the Synergy Control Panel to the Synergy Q/MD-X Frame is not wired as a standard CAT5 ethernet cable. If you need a cable of a specific length, contact your Ross Video Representative for ordering information.

Power Consumption - Control Panel

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage</td>
<td>90V<del>250 VAC, 47</del>63 Hz</td>
</tr>
<tr>
<td>Synergy 2 Control Panel</td>
<td>350 VA</td>
</tr>
<tr>
<td>Synergy 2.5 Control Panel</td>
<td>350 VA</td>
</tr>
<tr>
<td>Synergy 3 Control Panel</td>
<td>350 VA</td>
</tr>
<tr>
<td>Synergy 3.5 Control Panel</td>
<td>350 VA</td>
</tr>
<tr>
<td>Synergy 4 Control Panel</td>
<td>350 VA</td>
</tr>
</tbody>
</table>

Power Consumption - Rack Frame

The QMD-X and MD-X frames use a 500 or 700 Watt Power Supply, depending on the frame you have. The following table provides the number of power supplies that are required for a fully populated frame.
The information provided in the following table lists power consumption for the QMD-X and MD-X frames.

### Frame Power Supply Modules for Fully Populated Frame

<table>
<thead>
<tr>
<th></th>
<th>QMD-X</th>
<th>MD-X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Supply Watts</td>
<td>700W</td>
<td>500W</td>
</tr>
<tr>
<td>Number of Supplies</td>
<td>2/4</td>
<td>3/4</td>
</tr>
</tbody>
</table>

### Frame Power Consumption

<table>
<thead>
<tr>
<th>Frame</th>
<th>Parameter</th>
<th>Power Consumption</th>
</tr>
</thead>
<tbody>
<tr>
<td>QMD-X</td>
<td>Power Supply Rating</td>
<td>100-120V~</td>
</tr>
<tr>
<td></td>
<td></td>
<td>220-240V~</td>
</tr>
<tr>
<td></td>
<td></td>
<td>47-63 Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9A 650W</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Canada 120V~ only)</td>
</tr>
<tr>
<td></td>
<td>Base System</td>
<td>~225W</td>
</tr>
<tr>
<td></td>
<td>Fully Loaded</td>
<td>~975W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Frame</th>
<th>Parameter</th>
<th>Power Consumption</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD-X</td>
<td>Power Supply Rating</td>
<td>100-120V~</td>
</tr>
<tr>
<td></td>
<td></td>
<td>220-240V~</td>
</tr>
<tr>
<td></td>
<td></td>
<td>47-63 Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9A 650W</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Canada 120V~ only)</td>
</tr>
<tr>
<td></td>
<td>Base System</td>
<td>~225W</td>
</tr>
<tr>
<td></td>
<td>Fully Loaded</td>
<td>~975W</td>
</tr>
</tbody>
</table>

### Power Rating - Tallies

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Voltage</td>
<td>24V AC (rms) / 40V DC</td>
</tr>
<tr>
<td>Maximum Current</td>
<td>170mA</td>
</tr>
<tr>
<td>Impedance</td>
<td>&lt;15 ohms</td>
</tr>
</tbody>
</table>

### Environmental

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel and rack frame separation</td>
<td>1000 ft (305m) max.</td>
</tr>
<tr>
<td>Ambient temperature range</td>
<td>0 - 40 degrees C</td>
</tr>
</tbody>
</table>

- The boards, cards and power supplies in the Q/MD-X frame are cooled by fans using a side-to-side airflow (left to right when looking at the front of the frame).
• The control panel is convection cooled (no fans) for silent operation.

Caution

Ensure that you leave space around the frame for adequate ventilation. Both sides of the frame must be kept clear so that switcher airflow is not restricted in any way. Failure to provide adequate ventilation could result in overheating and damage to your switcher may occur.
**Video Characteristics**

**Video Processing**

- 10 bit 4:2:2 Component Digital Video and Key Processing.
- 4:3 and Anamorphic 16:9 switchable Aspect Ratio where applicable.
- The Synergy Q/MD-X switcher can operate in the following Video Formats:

  ```
  • 480i
  • 480i 16:9
  • 576i
  • 576i 16:9
  • 720p 60Hz
  • 720p 59.94Hz
  • 720p 50Hz
  • 720p 30Hz
  • 720p 29.97Hz
  • 720p 25Hz
  • 720p 24Hz
  • 720p 23.98Hz
  • 1080i 60Hz
  • 1080i 59.94Hz
  • 1080i 50Hz
  • 1080p 30Hz
  • 1080p 29.97Hz
  • 1080p 25Hz
  • 1080p 24Hz
  • 1080pSF 30Hz
  • 1080pSF 29.97Hz
  • 1080pSF 25Hz
  • 1080pSF 24Hz
  • 1080pSF 23.98Hz
  ```

**Video Formats**

The Synergy Q/MD-X switcher can use the following Input Reference formats:

<table>
<thead>
<tr>
<th>Input Reference</th>
<th>Usable Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>480i</td>
<td>• 480i, 480i/16:9</td>
</tr>
<tr>
<td></td>
<td>• 1080i 59.94 Hz</td>
</tr>
<tr>
<td>576i</td>
<td>• 576i, 576i/16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 50 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 50 Hz</td>
</tr>
<tr>
<td>720p 59.94 Hz</td>
<td>• 720p 59.94 Hz</td>
</tr>
<tr>
<td>720p 50 Hz</td>
<td>• 720p 50 Hz</td>
</tr>
<tr>
<td>1080i 59.94 Hz</td>
<td>• 480i, 480i/16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 59.94 Hz</td>
</tr>
<tr>
<td></td>
<td>• 720p 60 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 59.94 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 60 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080pSF 30 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080pSF 29.97 Hz</td>
</tr>
<tr>
<td>1080i 50 Hz</td>
<td>• 576i, 576i/16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 50 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 50 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080pSF 25 Hz</td>
</tr>
<tr>
<td>1080p 24 Hz</td>
<td>• 1080p 24 Hz</td>
</tr>
<tr>
<td>1080pSF 24 Hz</td>
<td>• 1080pSF 24 Hz</td>
</tr>
</tbody>
</table>
System Timing

- All video inputs are zero-time relative to reference input. Auto timing corrects for inputs out of sync by up to ±¼ line (16us).
- Refer to Chapter 2, “System Architecture” for a complete technical overview of Synergy auto-timing.

LTC Timecode Input

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Level</td>
<td>0.5 - 2.0 V (1.0 V nominal)</td>
</tr>
<tr>
<td>Termination</td>
<td>600 ohm, soft-selectable</td>
</tr>
</tbody>
</table>

Video Inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy 2 Q/MD-X</td>
<td>16, 32, 48, 64, 80, 96</td>
</tr>
<tr>
<td>Synergy 2.5 Q/MD-X</td>
<td>16, 32, 48, 64, 80, 96</td>
</tr>
<tr>
<td>Synergy 3 Q/MD-X</td>
<td>16, 32, 48, 64, 80, 96</td>
</tr>
<tr>
<td>Synergy 4 Q/MD-X</td>
<td>16, 32, 48, 64, 80, 96</td>
</tr>
<tr>
<td>Equalization (using Belden 1694 cable)</td>
<td>&gt;75m @ 1.5Gb/s</td>
</tr>
<tr>
<td>Impedance</td>
<td>75 ohm, terminating</td>
</tr>
<tr>
<td>Return Loss</td>
<td>&gt;20 dB @ 1.5GHz</td>
</tr>
</tbody>
</table>

- All Video Inputs are SMPTE 259M/292M serial digital, non-looping.
- Inputs can be used for either Key or Video.
- The Reference Input is a non-terminating, looping, input that is selectable as analog black for Standard Definition operation or tri-level sync for High Definition operation.
## Video Outputs

<table>
<thead>
<tr>
<th>Output Types</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Synergy 2</td>
</tr>
<tr>
<td>Main Program (PGM)</td>
<td>1</td>
</tr>
<tr>
<td>Preview Matrix (no overlay)</td>
<td>1</td>
</tr>
<tr>
<td>Preview Matrix (overlay)</td>
<td>1</td>
</tr>
<tr>
<td>MLE 1 PGM (BKGD)</td>
<td>1</td>
</tr>
<tr>
<td>MLE 1 PV (PST)</td>
<td>1</td>
</tr>
<tr>
<td>MLE 1 Look Ahead Preview</td>
<td>1</td>
</tr>
<tr>
<td>MLE 1 Clean Feed</td>
<td>1</td>
</tr>
<tr>
<td>MLE 2 PGM (BKGD)</td>
<td>1</td>
</tr>
<tr>
<td>MLE 2 PV (PST)</td>
<td>1</td>
</tr>
<tr>
<td>MLE 2 Look Ahead Preview</td>
<td>1</td>
</tr>
<tr>
<td>MLE 2 Clean Feed</td>
<td>1</td>
</tr>
<tr>
<td>MLE 3 PGM (BKGD)</td>
<td>1</td>
</tr>
<tr>
<td>MLE 3 PV (PST)</td>
<td>2†</td>
</tr>
<tr>
<td>MLE 3 Look Ahead Preview</td>
<td>1</td>
</tr>
<tr>
<td>MLE 3 Clean Feed</td>
<td>3‡</td>
</tr>
<tr>
<td>MLE 4 PGM (BKGD)</td>
<td></td>
</tr>
<tr>
<td>MLE 4 PV (PST)</td>
<td></td>
</tr>
<tr>
<td>MLE 4 Look Ahead Preview</td>
<td></td>
</tr>
<tr>
<td>MLE 4 Clean Feed</td>
<td></td>
</tr>
<tr>
<td>DVE Send</td>
<td>1</td>
</tr>
<tr>
<td>DVE Send Alpha</td>
<td>1</td>
</tr>
<tr>
<td>Aux Bus</td>
<td>32</td>
</tr>
<tr>
<td>Clean Feed</td>
<td>1</td>
</tr>
<tr>
<td><strong>Maximum Output BNCs</strong></td>
<td>48</td>
</tr>
</tbody>
</table>

† The Mix/DSK option adds 2 separate, dedicated, Clean Feeds.
‡ All video types can be assigned to any of the Output BNCs, with the exception of those outputs generated by the MultiDSK or Mix/DSK options.
Output Characteristics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return loss</td>
<td>&gt;18 dB @ 1.5GHz</td>
</tr>
<tr>
<td>Output Jitter</td>
<td>&lt;130 ps</td>
</tr>
<tr>
<td>Rise and fall time</td>
<td>800 ps +/- 10% (SD)</td>
</tr>
<tr>
<td></td>
<td>240 ps +/- 10% (HD)</td>
</tr>
<tr>
<td>Signal level</td>
<td>800 mV +/- 10%</td>
</tr>
<tr>
<td>DC offset</td>
<td>0 volts</td>
</tr>
<tr>
<td>Overshoot</td>
<td>&lt;8%</td>
</tr>
</tbody>
</table>

- All video outputs are 10-bit SMPTE 259M-C (SD Mode) or 10-bit SMPTE 292M (HD Mode) serial digital.
- EDH is inserted into all video outputs, and can be disabled. Aux Bus outputs do not have EDH insertion, but do pass previously inserted EDH.
Frame Pinouts

This section provides pinouts for the following frame connectors:

- **Peripheral Ports**
- **Panel Port (to frame)**
- **GPI I/O Port**
- **LAN Ports**
- **AC POWER Ports**

**Peripheral Ports**

The table below provides the pinouts for the **PERIPH1** through **PERIPH4** ports at the back of the CPU Board in the Synergy Q/MD-X frame.

- **Connector:** DB9, Female
- **Communications Format:** Software selectable for RS-232 or RS-422

Pinout — Peripheral Ports

<table>
<thead>
<tr>
<th>Pin #</th>
<th>RS-232</th>
<th>RS-422</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n/c</td>
<td>Odd/Even Tx+</td>
</tr>
<tr>
<td>2</td>
<td>Rx</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>Tx</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>n/c</td>
<td>Odd/Even Tx-</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>9</td>
<td>n/c</td>
<td>5V 1K Pull-up</td>
</tr>
</tbody>
</table>

**Note:** n/c = not connected

**Panel Port**

The table below lists pinouts for the **PANEL** port.

- **Connector:** 8-pin RJ-45, Shielded
- **Communications Format:** RS-422 Data Link to Control Panel
GPI I/O Port

The table below lists pinouts for the GPI I/O connector.

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>2</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>5</td>
<td>ODD/EVEN+ (Transmit)</td>
</tr>
<tr>
<td>6</td>
<td>ODD/EVEN- (Transmit)</td>
</tr>
<tr>
<td>7</td>
<td>Ground (AC coupled)</td>
</tr>
<tr>
<td>8</td>
<td>Ground (AC coupled)</td>
</tr>
</tbody>
</table>

**Important**

It is recommended that GPI Out signals be used to drive high impedance loads (2000 ohm and higher).

- **Connector**: DB25, Female
- **GPI Out 1-10**: Active Drive 3.3V TTL-compatible signals
- **GPI In 1-10**: 5V TTL-compatible edge or level trigger
- **System Fail**: 2 System Fail and 2 System Fail Return relays: 0 - 24 VDC, contact-closure FET, normally-closed relays.

**Note**

The System Fail relays are not yet implemented.
## Pinouts — GPI I/O Port

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>System Fail 1</td>
</tr>
<tr>
<td>3</td>
<td>System Fail 0</td>
</tr>
<tr>
<td>4</td>
<td>GPI In 10</td>
</tr>
<tr>
<td>5</td>
<td>GPI In 9</td>
</tr>
<tr>
<td>6</td>
<td>GPI In 8</td>
</tr>
<tr>
<td>7</td>
<td>GPI In 7</td>
</tr>
<tr>
<td>8</td>
<td>GPI In 6</td>
</tr>
<tr>
<td>9</td>
<td>GPI In 5</td>
</tr>
<tr>
<td>10</td>
<td>GPI In 4</td>
</tr>
<tr>
<td>11</td>
<td>GPI In 3</td>
</tr>
<tr>
<td>12</td>
<td>GPI In 2</td>
</tr>
<tr>
<td>13</td>
<td>GPI In 1</td>
</tr>
<tr>
<td>14</td>
<td>System Fail Return 1</td>
</tr>
<tr>
<td>15</td>
<td>System Fail Return 0</td>
</tr>
<tr>
<td>16</td>
<td>GPI Out 10</td>
</tr>
<tr>
<td>17</td>
<td>GPI Out 9</td>
</tr>
<tr>
<td>18</td>
<td>GPI Out 8</td>
</tr>
<tr>
<td>19</td>
<td>GPI Out 7</td>
</tr>
<tr>
<td>20</td>
<td>GPI Out 6</td>
</tr>
<tr>
<td>21</td>
<td>GPI Out 5</td>
</tr>
<tr>
<td>22</td>
<td>GPI Out 4</td>
</tr>
<tr>
<td>23</td>
<td>GPI Out 3</td>
</tr>
<tr>
<td>24</td>
<td>GPI Out 2</td>
</tr>
<tr>
<td>25</td>
<td>GPI Out 1</td>
</tr>
</tbody>
</table>
LAN Ports

The table below lists pinouts for the **LAN 10/100** ports.

- **Connector:** 8-pin RJ-45, Shielded
- **Communications Format:** 10Base-T and 100Base-TX Ethernet

![LAN Port on Frame](image)

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tx+</td>
</tr>
<tr>
<td>2</td>
<td>Tx-</td>
</tr>
<tr>
<td>3</td>
<td>Rx+</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>n/c</td>
</tr>
<tr>
<td>6</td>
<td>Rx-</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
</tbody>
</table>

AC POWER Ports

The table below lists pinouts for the **AC POWER** connectors.

- **Connector:** 3-Pin IEC Male

![AC Power Port on Frame](image)

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Neutral/Line 2</td>
</tr>
<tr>
<td>2</td>
<td>Line</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>
Control Panel Pinouts

This section provides pinouts for the following control panel connectors:

- Remote Ports
- Frame Port
- AUX Ports
- Tally Ports
- AC Power Ports

Remote Ports

The table below lists pinouts for the **REMOTE** ports on the control panel.

- **Connector:** DB9, Female
- **Communications Format:** Software selectable for RS-232 or RS-422.

![Remote Port on Control Panel]

<table>
<thead>
<tr>
<th>Pin #</th>
<th>RS-232</th>
<th>RS-422</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Chassis</td>
<td>Chassis</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Note:** n/c = not connected
Frame Port

The table below lists pinouts for the **FRAME** port.

- **Connector:** 8-pin RJ-45, Shielded
- **Communications Format:** RS-422 Data Link to Frame

![Frame Port on Control Panel]

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>5</td>
<td>ODD/EVEN+ (Receive)</td>
</tr>
<tr>
<td>6</td>
<td>ODD/EVEN- (Receive)</td>
</tr>
<tr>
<td>7</td>
<td>Ground (AC coupled)</td>
</tr>
<tr>
<td>8</td>
<td>Ground (AC coupled)</td>
</tr>
</tbody>
</table>

AUX Ports

The table below lists pinouts for the **AUX** Ports.

- **Connector:** 6-pin RJ-12, Shielded
- **Communications Format:** RS-422 Data Link to Remote Aux Panels

![AUX Port on Control Panel]
Tally Ports

The following table lists pinouts for the Tally ports.

- **Connector:** DB25, Female
- **Communications Format:** Solid state relay contact closure to TALLY COMMON

### Pinout — AUX Port

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>2</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>3</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>4</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>5</td>
<td>RESET (Transmit)</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
</tbody>
</table>

### Pinout — Tally Port

#### Pinouts — Control Panel

#### Pinouts — Tally Port

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Tally 1 Port</th>
<th>Tally 2 Port</th>
<th>Tally 3 Port</th>
<th>Tally 4 Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 1</td>
<td>TALLY 19</td>
<td>TALLY 37</td>
<td>TALLY 55</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 3</td>
<td>TALLY 21</td>
<td>TALLY 39</td>
<td>TALLY 57</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 5</td>
<td>TALLY 23</td>
<td>TALLY 41</td>
<td>TALLY 59</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 7</td>
<td>TALLY 25</td>
<td>TALLY 43</td>
<td>TALLY 61</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 9</td>
<td>TALLY 27</td>
<td>TALLY 45</td>
<td>TALLY 63</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 11</td>
<td>TALLY 29</td>
<td>TALLY 47</td>
<td>TALLY 65</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 13</td>
<td>TALLY 31</td>
<td>TALLY 49</td>
<td>TALLY 67</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 15</td>
<td>TALLY 33</td>
<td>TALLY 51</td>
<td>TALLY 69</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 17</td>
<td>TALLY 35</td>
<td>TALLY 53</td>
<td>TALLY 71</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>14</td>
<td>TALLY 2</td>
<td>TALLY 20</td>
<td>TALLY 38</td>
<td>TALLY 56</td>
</tr>
<tr>
<td>15</td>
<td>TALLY 4</td>
<td>TALLY 22</td>
<td>TALLY 40</td>
<td>TALLY 58</td>
</tr>
<tr>
<td>16</td>
<td>TALLY 6</td>
<td>TALLY 24</td>
<td>TALLY 42</td>
<td>TALLY 60</td>
</tr>
<tr>
<td>17</td>
<td>TALLY 8</td>
<td>TALLY 26</td>
<td>TALLY 44</td>
<td>TALLY 62</td>
</tr>
<tr>
<td>18</td>
<td>TALLY 10</td>
<td>TALLY 27</td>
<td>TALLY 46</td>
<td>TALLY 64</td>
</tr>
</tbody>
</table>
AC Power Ports

The table below lists pinouts for the AC POWER connectors.

- **Connector:** 3-Pin IEC Male

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Tally 1 Port</th>
<th>Tally 2 Port</th>
<th>Tally 3 Port</th>
<th>Tally 4 Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>TALLY 12</td>
<td>TALLY 30</td>
<td>TALLY 48</td>
<td>TALLY 66</td>
</tr>
<tr>
<td>20</td>
<td>TALLY 14</td>
<td>TALLY 32</td>
<td>TALLY 50</td>
<td>TALLY 68</td>
</tr>
<tr>
<td>21</td>
<td>TALLY 16</td>
<td>TALLY 34</td>
<td>TALLY 52</td>
<td>TALLY 70</td>
</tr>
<tr>
<td>22</td>
<td>TALLY 18</td>
<td>TALLY 36</td>
<td>TALLY 54</td>
<td>TALLY 72</td>
</tr>
<tr>
<td>23</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>24</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>25</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
</tbody>
</table>

**Pinouts — Tally Port**

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Tally 1 Port</th>
<th>Tally 2 Port</th>
<th>Tally 3 Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>2</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>3</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
<td>TALLY COMMON</td>
</tr>
</tbody>
</table>

**Pinout — AC Power Port**

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Neutral/Line 2</td>
</tr>
<tr>
<td>2</td>
<td>Line</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>
## Aux Panel Programming Mode Summary

The table below summarizes all normal, GPI, and special diagnostic Aux panel programming modes for new generation remote Aux panels.

### Aux Panel Programming Mode Button Assignment

<table>
<thead>
<tr>
<th>Button / LED</th>
<th>Normal Mode</th>
<th>Program Mode Bus Assignment ( (*1) )</th>
<th>Program Mode GPI Offset</th>
<th>Power Up Diagnostic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Black)</td>
<td>Select Xpt 1</td>
<td>Display/modify this panel’s rights to Aux Bus 1</td>
<td>Set GPI to group 1 (offset 0) ( (*2) )</td>
<td>Start Walking LED Test ( (*6) )</td>
</tr>
<tr>
<td>2</td>
<td>Select Xpt 2</td>
<td>Display/modify this panel’s rights to Aux Bus 2</td>
<td>Set GPI to group 2 (offset 1)</td>
<td>Start Pushbutton LED test</td>
</tr>
<tr>
<td>3</td>
<td>Select Xpt 3</td>
<td>Display/modify this panel’s rights to Aux Bus 3</td>
<td>Set GPI to group 3 (offset 2)</td>
<td>Start DUART Test ( (*3) )</td>
</tr>
<tr>
<td>4</td>
<td>Select Xpt 4</td>
<td>Display/modify this panel’s rights to Aux Bus 4</td>
<td>Set GPI to group 4 (offset 3)</td>
<td>Start EEPROM Test</td>
</tr>
<tr>
<td>5</td>
<td>Select Xpt 5</td>
<td>Display/modify this panel’s rights to Aux Bus 5</td>
<td>Set GPI to group 5 (offset 4)</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Select Xpt 6</td>
<td>Display/modify this panel’s rights to Aux Bus 6</td>
<td>Set GPI to group 6 (offset 5)</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Select Xpt 7</td>
<td>Display/modify this panel’s rights to Aux Bus 7</td>
<td>Set GPI to group 7 (offset 6)</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Select Xpt 8</td>
<td>Display/modify this panel’s rights to Aux Bus 8</td>
<td>Set GPI to group 8 (offset 7)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Select Xpt 9</td>
<td>Display/modify this panel’s rights to Aux Bus 9</td>
<td>GPI 8 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Select Xpt 10</td>
<td>Display/modify this panel’s rights to Aux Bus 10</td>
<td>GPI 7 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Select Xpt 11</td>
<td>Display/modify this panel’s rights to Aux Bus 11</td>
<td>GPI 6 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Select Xpt 12</td>
<td>Display/modify this panel’s rights to Aux Bus 12</td>
<td>GPI 5 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Select Xpt 13</td>
<td></td>
<td>GPI 4 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Select Xpt 13</td>
<td></td>
<td>GPI 3 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Select Xpt 15</td>
<td></td>
<td>GPI 2 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Select Xpt 16</td>
<td></td>
<td>GPI 1 Status (ON = shorted to ground)</td>
<td>LED used in EEPROM test</td>
</tr>
<tr>
<td>17 (Shift) ( (*5) )</td>
<td>Select Xpt 17 or Shift</td>
<td>Toggle between allowing Shifted Xpts or allowing only simple Xpts ( (*4) )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clean Feed</td>
<td></td>
<td>Switch to GPI program mode. LED flashes.</td>
<td>Switch to Assignment Program mode.</td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td></td>
<td>Send software version message to main panel</td>
<td>Send software version message to main panel</td>
<td></td>
</tr>
<tr>
<td>Active LED</td>
<td></td>
<td>Indicates selected Aux Xpt is used in Program output</td>
<td>Flashing (along with Clean Feed)</td>
<td>Test Fail Status ( (*6) )</td>
</tr>
</tbody>
</table>
Please note:

(*1) For the first 12 LEDs in this column, information applies to the Synergy 3 and 4 assignable panels only. On the Synergy 2 assignable panels, use the 12 assignment buttons on the bottom row of the panel.

(*2) LED indicates the current group setting. Only one LED in the first eight switches can be ON at a time. A panel that has never been programmed may have all eight LEDs OFF, until it is programmed to one of the eight possible GPI groups.

(*3) Requires special loop-back tester cables. Contact Customer Support for details.

(*4) Only used on older version main panel software. New main panel software sets this value automatically to be the same as the panel during normal operation. The LED displays the state of this option. The Panel does not support special modes of shifted crosspoints (such as Reverse Shift, etc.).

(*5) On the Synergy 3 panel, the LED is located at Shift/30, on Synergy 4, the LED is located at Shift/35.

(*6) In the EEPROM and DUART tests, the “Active” LED indicates Test Failed if the “Active” LED remains lit. In the same tests, the Xpt 1 (Black) LED indicates Test Passed when lit.
Appendix B. Installation Worksheets

In This Appendix

This appendix provides worksheet tables to help plan and record switcher installation settings and wiring connections. The following worksheets are included:

- Input Worksheet
- Bus Map Worksheet
- Output Worksheet
- Remote Control Worksheet
- Standard GPI Input Worksheet
- Standard GPI Output Worksheet
- Custom Control Worksheet
Input Worksheet

Make copies of this blank worksheet for use as required. Complete the following worksheet for all of your video inputs, including primary sources, keys and fills.

<table>
<thead>
<tr>
<th>BNC #</th>
<th>Actual Source</th>
<th>Remote Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Audio Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td>VTR 1</td>
<td>Remote 1</td>
<td>VTR Blue</td>
<td>VTR</td>
<td>12</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Sample 2</td>
<td>CG Alpha</td>
<td>Remote 2</td>
<td>CG Alpha</td>
<td>Alpha</td>
<td>—</td>
<td>Unshaped</td>
<td>C15</td>
<td>—</td>
</tr>
</tbody>
</table>

C01
C02
C03
C04
C05
C06
C07
C08
C09
C10
C11
C12
C13
C14
C15
C16
D01
D02
D03
D04
D05
D06
D07
D08
D09
D10
D11
D12
D13
D14
D15
D16
### BNC Input Worksheet

<table>
<thead>
<tr>
<th>BNC #</th>
<th>Actual Source</th>
<th>Remote Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>E01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E07</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E08</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F07</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F08</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G07</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G08</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For further details, see the “Input Connection” section in Chapter 4, “Preliminary Cabling and Video Installation”.

<table>
<thead>
<tr>
<th>BNC #</th>
<th>Actual Source</th>
<th>Remote Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>G09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H07</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H08</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Bus Map Worksheet

Make copies of this blank worksheet for use as required. Complete the following worksheet for all of your button mappings.

Bus Map Name: ______________________

For further details, see the “Setting up Panel Buttons” section in Chapter 7, “BNC Configuration and Check”.

<table>
<thead>
<tr>
<th>Physical Button</th>
<th>Input Name</th>
<th>Physical Button</th>
<th>Input Name</th>
<th>Physical Button</th>
<th>Input Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Black</td>
<td>26</td>
<td>CG 3</td>
<td>51</td>
<td>SHIFT</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>22</td>
<td>7</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>28</td>
<td>8</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>29</td>
<td>9</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>30</td>
<td>0</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>31</td>
<td>1</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>32</td>
<td></td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>33</td>
<td></td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>34</td>
<td></td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>35</td>
<td></td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>36</td>
<td></td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>37</td>
<td></td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>38</td>
<td></td>
<td>63</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>39</td>
<td></td>
<td>64</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>40</td>
<td></td>
<td>65</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>41</td>
<td></td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>42</td>
<td></td>
<td>67</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>43</td>
<td></td>
<td>68</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>44</td>
<td></td>
<td>69</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>45</td>
<td></td>
<td>70</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>46</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>47</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>48</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>49</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>50</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Output Worksheet

For each output (moving from left to right in the worksheet columns):

- Check whether the output is locked because of an option.
- Fill in the output type.
- Fill in the destination of the output.

**Note**
If you have the MultiDSK or Mix/DSK options installed, certain Output BNCs will be locked to specific output types. The Aux Mixer, and Aux Mixer/Keyer options will also lock Output BNCs, but you can select which ones are locked.

<table>
<thead>
<tr>
<th>BNC Output Connector #</th>
<th>Locked Output (Mix/DSK or MultiDSK)</th>
<th>Locked Output (Mix/DSK and MultiDSK)</th>
<th>Output Type</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>e.g. 1 K01</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>e.g. 1 K13</td>
<td></td>
<td></td>
<td>AuxBus 1:3</td>
<td>Monitor 6</td>
</tr>
<tr>
<td>K01</td>
<td>Program</td>
<td></td>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>K02</td>
<td>Program</td>
<td></td>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>K03</td>
<td>Preview without Overlay</td>
<td>Preview without Overlay</td>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>K04</td>
<td>Preview without Overlay</td>
<td>Preview without Overlay</td>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>K05</td>
<td>Clean Feed 1</td>
<td>Clean Feed 1</td>
<td>Clean Feed 1</td>
<td></td>
</tr>
<tr>
<td>K06</td>
<td>Clean Feed 2</td>
<td>Clean Feed 2</td>
<td>Clean Feed 2</td>
<td></td>
</tr>
<tr>
<td>K07</td>
<td>Preview with Overlay (not locked)</td>
<td>Clean Feed 3</td>
<td>Clean Feed 3</td>
<td></td>
</tr>
<tr>
<td>K08</td>
<td>Clean Feed 4</td>
<td></td>
<td>Clean Feed 4</td>
<td></td>
</tr>
<tr>
<td>K09</td>
<td>Program</td>
<td></td>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>K10</td>
<td>Program</td>
<td></td>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>K11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>K12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>K13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>K14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>K15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>K16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J01</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J02</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J04</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J05</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J06</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J07</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J08</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BNC Output Connector #</td>
<td>Locked Output (Mix/DSK or MultiDSK)</td>
<td>Locked Output (Mix/DSK and MultiDSK)</td>
<td>Output Type</td>
<td>Destination</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------</td>
<td>-------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>J09</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I01</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I02</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I03</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I04</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I05</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I06</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I07</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I08</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I09</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Remote Control Worksheet

Using the figure below for reference, complete the following remote control worksheet. Copy the worksheet as required. Fill in the serial controlled device and the remote control port (on the device) that is used for serial control.

If you have installed a Remote Port Expander (BSS4) to the Synergy switcher, there are four additional remote ports labelled A, B, C and D, corresponding to the Slave Ports on the BSS4 that will start with the number of the remote port that the BSS4 is connected to.

The figure below illustrates the location of the eight remote control connectors on the rear of the control panels.

![Remote Control Connectors](image-url)

**Remote Control Worksheet**

<table>
<thead>
<tr>
<th>Remote Connector</th>
<th>Serial Controlled Device</th>
<th>Device Serial Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5C</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For further details, refer to Chapter 9, “Basic Communications Setup”, in the *Synergy Q/MD-X Engineering Manual*.

<table>
<thead>
<tr>
<th>Remote Connector</th>
<th>Serial Controlled Device</th>
<th>Device Serial Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote 5D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8D</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Standard GPI Input Worksheet**

Make copies of this blank worksheet for use as required. Complete the following Standard GPI Input worksheet.

<table>
<thead>
<tr>
<th>Standard GPI Input #</th>
<th>Event Type</th>
<th>Event Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample GPI Input #1</td>
<td>Auto</td>
<td>MLE 1</td>
<td>Low</td>
</tr>
<tr>
<td>Sample GPI Input #2</td>
<td>Cut</td>
<td>Fade to black</td>
<td>High</td>
</tr>
<tr>
<td>Sample GPI Input #3</td>
<td>Cust Ctrl</td>
<td>Custom08 1#08</td>
<td>High</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For further details, see the “**Standard GPI Setup**” section in Chapter 12, “**Additional Installation Setups**”.
Standard GPI Output Worksheet

Make copies of this blank worksheet for use as required. Complete the following Standard GPI Output worksheet.

<table>
<thead>
<tr>
<th>Standard GPI Output #</th>
<th>Output Name</th>
<th>Trigger Type</th>
<th>Trigger Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample GPI Output #1</td>
<td>PrevStill</td>
<td>Edge</td>
<td>Low</td>
</tr>
<tr>
<td>Sample GPI Output #2</td>
<td>Roll VTR</td>
<td>Level</td>
<td>High</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For further details, see the “Standard GPI Setup” section in Chapter 12, “Additional Installation Setups”.
Custom Control Worksheet

Complete the following custom control worksheet. Make copies of this blank worksheet as required.

Operating Tip: Keep custom control functions such as time clock and VTR physically grouped together on your custom control buttons.

<table>
<thead>
<tr>
<th>Custom Control Button Name</th>
<th>Custom Control Function(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
</tr>
</tbody>
</table>
## Custom Control Worksheet

**Custom Control Bank Name/Number:**

<table>
<thead>
<tr>
<th>Custom Control Button Name</th>
<th>Custom Control Function(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
</tr>
</tbody>
</table>
Appendix C. IP and Web Issues

In This Appendix

This appendix provides information on standard network security practices with consideration to ethernet connections.

The following topics are discussed:

- Standard Network Security
- Understanding IP Addresses
- Software Licenses
Standard Network Security

Upgrades can be uploaded to the Synergy Q/MD-X switcher from a PC using an Ethernet port on the back of the Synergy Q/MD-X frame. Images and animations can be copied from a PC to the internal hard drive on the switcher for use by the Global-Store and MediaCache. The Ethernet port can also be used to transfer images and animations from the hard drive on the switcher to a PC. This allows image captures on the switcher to be used elsewhere in the studio. Refer to Chapter 6 “Software Upgrades and Options” in the Synergy Q/MD-X Engineering Manual, Volume I for set up information. Contact your Network Administrator for information on your ethernet network.

Note

The Ethernet port is required for upgrades and not for switcher operation.

Ethernet Connection Precautions

Important

It is recommended that you unplug your ethernet cable when not in use; being connected on a network carries security risks that could impact the performance of the switcher. Contact your Network Administrator for more information.

If the Synergy Q/MD-X frame is to be left connected to the ethernet, the following precautions should be taken:

- **Do not connect directly to the Internet** — Anyone who can access your network will also gain access to sensitive data and equipment. Limit network access by using a firewall, or a separate network segment, to control who can access your switcher. Contact your Network Administrator for more information.

- **Change the default passwords** — The Synergy Q/MD-X frame is initially set with default passwords. To change your default passwords, contact Ross Video Technical Support.

- **Disable unused services** — The Synergy Q/MD-X frame provides access to three default services provided by Ross Video: web server, FTP server, and the Telnet server. Contact Ross Video Technical Support for information on how these services can be disabled individually or keep your network unplugged.

Note

It is not recommended to install or enable services that are not provided by Ross Video.
Understanding IP Addresses

Internet Protocol (IP) Address parameters must be assigned to configure the Synergy Q/MD-X frame for network operations. The values must be chosen so as not to conflict with other devices on the network. Your Network Administrator should provide these values. Once configured, the Synergy Q/MD-X frame can be accessed using its IP Address.

IP Addresses

Internet Protocol (IP) Addresses are used to identify devices on a network. This address is used to route messages through the network, back and forth between devices. There are two types of addresses: IPv4 which can take on the form of 32 bits, 4 numbers separated by periods (for example, 192.168.1.1) or IPv6 with 128 bits. The Synergy Q/MD-X frame supports IPv4 Addresses.

There are two configuration methods for IP Addresses supported by the Synergy Q/MD-X frame:

- **Static** — Static IP Addresses require you to manually provide the IP Address, the netmask, the domain name server, and the gateway/router addresses.
- **DHCP** — Dynamic Host Configuration Protocol (DHCP) IP Addresses are obtained automatically from your network each time the Synergy Q/MD-X frame connects to the network.

Default Services

| Note | The addresses provided in this section are examples only. Refer to Chapter 6 “Software Upgrade and Options” in the Synergy Q/MD-X Engineering Manual, Volume I or contact Ross Video Technical Support for more information. |

Ross Video provides three default services for the Synergy Q/MD-X frame which can be accessed with the following addresses:

- **Web server** — The web server is used for upgrades and set up as well as WebDAV connections for drag and drop image transfer. The URL Address is http://192.168.1.1, using port 80.
- **Telnet server** — The Telnet server is used for diagnostic and maintenance purposes. You must first manually launch the Telnet application, and then connect at telnet://192.168.1.1.

| Note | The Telnet server should be disabled when not in use. |
Software Licenses

The Synergy Q/MD-X System includes software licensed under one or more of the following licenses:

- GNU General Public License
- Lesser GNU Public License (LPGL)
- BSD License
- Apache License
- Expat License

Important

As per the GNU General Public License and the Lesser GNU Public License (LPGL), source code can be obtained for at least 3 years from Ross Video. Please contact Ross Video Technical Support for details; contact information is listed at the front of this manual.

GNU General Public License

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users. This General Public License applies to most of the Free Software Foundation's software and to any other program whose authors commit to using it. (Some other Free Software Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced by others will not reflect on the original authors' reputations.
Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributes of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to any such program or work, and a “work based on the Program” means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language. (Hereinafter, translation is included without limitation in the term “modification”. Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

   a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.
   b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.
   c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License.

(Example: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:
The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it and “any later version”, you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Lesser GNU Public License (LPGL)

GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the ordinary General Public License is the better strategy to use in any particular case, based on the explanations below.
When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want it; that you can change the software and use pieces of it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave you. You must make sure that they, too, receive or can get the source code. If you link other code with the library, you must provide complete object files to the recipients, so that they can relink them with the library after making changes to the library and recompiling it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by someone else and passed on, the recipients should know that what they have is not the original version, so that the original author's reputation will not be affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent license obtained for a version of the library must be consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser General Public License, applies to certain designated libraries, and is quite different from the ordinary General Public License. We use this license for certain libraries in order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a combined work, a derivative of the original library. The ordinary General Public License therefore permits such linking only if the entire combination fits its criteria of freedom. The Lesser General Public License permits more lax criteria for linking other code with the library.

We call this license the “Lesser” General Public License because it does Less to protect the user's freedom than the ordinary General Public License. It also provides other free software developers Less of an advantage over competing non-free programs. These disadvantages are the reason we use the ordinary General Public License for many libraries. However, the Lesser license provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does the same job as widely used non-free libraries. In this case, there is little to gain by limiting the free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free software. For example, permission to use the GNU C Library in non-free programs enables many more people to use the whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a program that is linked with the Library has the freedom and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a “work based on the library” and a “work that uses the library”. The former contains code derived from the library, whereas the latter must be combined with the library in order to run.
GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also called “this License”). Each licensee is addressed as “you”.

A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which use some of those functions and data) to form executable.

The “Library”, below, refers to any such software library or work which has been distributed under these terms. A “work based on the Library” means either the Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter, translation is included without limitation in the term “modification”).

“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running a program using the Library is not restricted, and output from such a program is covered only if its contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this License along with the Library. You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

   a) The modified work must itself be a software library.

   b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

   c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

   d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort to ensure that, in the event an application does not supply such function or table, the facility still operates, and performs whatever part of its purpose remains meaningful.

   (For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be optional: if the application does not supply it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative works made from that copy. This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with it, is called a “work that uses the Library”. Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library (because it contains portions of the Library), rather than a “work that uses the library”. The executable is therefore covered by this License. Section 6 states terms for distribution of such executables.

When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work for the customer's own use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you must include the copyright notice for the Library among them, as well as a reference directing the user to the copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-readable “work that uses the Library”, as object code and/or source code, so that the user can modify the Library and then relink to produce a modified executable
containing the modified Library. (It is understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of the library already present on the user's computer system, rather than copying library functions into the executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long as the modified version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the above specified materials from the same place.

e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and utility programs needed for reproducing the executable from it. However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Library at all. For example, if a patent license
would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this License would be to refrain entirely from
distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply, and the section as a whole is intended to apply in other circumstances. It is not the
purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of
any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
system which is implemented by public license practices. Many people have made generous contributions to the
wide range of software distributed through that system in reliance on consistent application of that system; it is up
to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee
cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Library under this License may add an explicit
geographical distribution limitation excluding those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this
License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License
which applies to it and “any later version”, you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are
incompatible with these, write to the author to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
LIBRARY “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE
THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

BSD License

General

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Apache License

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

“License” shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this document.

“Licensor” shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

“Legal Entity” shall mean the union of the acting entity and all other entities that control, are controlled by, or are under common control with that entity. For the purposes of this definition, “control” means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (i) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

“You” (or “Your”) shall mean an individual or Legal Entity exercising permissions granted by this License.

“Source” form shall mean the preferred form for making modifications, including but not limited to software source code, documentation source, and configuration files.

“Object” form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, generated documentation, and conversions to other media types.

“Work” shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

“Derivative Works” shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

“Contribution” shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor.
for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, “submitted” means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as “Not a Contribution.”

“Contributor” shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without modifications, and in Source or Object form, provided that You meet the following conditions:

   a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

   b) You must cause any modified files to carry prominent notices stating that You changed the files; and

   c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and

   d) If the Work includes a “NOTICE” text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement You may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.
7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its Contributions) on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

Expat License

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
Copyright (c) 2001, 2002, 2003 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Appendix D. Custom Device Protocols

In This Appendix

This appendix provides information and procedures for setting up a custom device and programming a serial protocol to communicate with said device from a Synergy Q/MD-X peripheral or remote port.

The following sections are provided and discussed:

• Custom Devices – Uses and Limitations
• Custom Devices Modify Menu
• Programming Commands
• Programming Worksheets
• Advanced Topics and Tables
Custom Devices – Uses and Limitations

The Custom Devices Setup Menu allows the user to program serial command protocols for controlling external devices not otherwise supported by Synergy Q/MD-X Custom Devices are also useful in testing out currently unsupported commands to external devices, as well as other general communications testing.

There are two user-programmable custom device protocols available, these being CUSTOM0 and CUSTOM1. Ports on both the panel and the frame can be used, with the following limitations and requirements.

- To use custom devices on the panel, you must have purchased and installed the VTR Remote Control option. Refer to the chapter, “Software Upgrades and Options” for details on installing this option.
- Any data received back from the external device is ignored. Therefore, queries for Current-time-sense (e.g. grab timecode), Inpoint, Outpoint and Clip-ID-names are not supported.
- If suitable commands are programmed (e.g., command tag PLAY, etc.), VTRs and VTR-like devices can be controlled via custom control buttons or by remote menus and ROLL VTR transitions.
- You can control other non-VTR devices (e.g., CCUs, CGs, etc.) by substituting their commands for those in the Command-tag list of the Custom Device Menu. Refer to the section “Advanced Topics and Tables” on page 33-8 for a list of available command tags. This list also appears (for applicable commands) in the VTR Functions area of the chapter, “Custom Controls”.

When substituting for other commands, record these substitutions on the worksheet provided in this appendix. As an aid, we recommend that the custom control used to perform the command be suitably named. As a rule, these devices will have no BNC association, and consequently will not be accessed by ROLL VTR or by any remote menus.

- Custom Devices can use any of the control panel remote ports and any of the frame peripheral ports. However, custom devices protocols cannot be used on the Aux ports.
- To use custom devices on the frame, you must have purchased the DVE Send and Remote Control option.
- Some protocol usage may exceed the maximum number of bytes (19) allocated per command. In cases where a custom control is used, 2 command slots (and 2 tags) can be used and a custom control programmed to invoke them in immediate succession. Each user-programmed device supports a maximum of 10 command slots. There may be other practical problems with the protocol you are trying to reproduce that may render custom devices unsuitable. Please do not hesitate to contact Ross Video technical support for assistance in using this feature.
Custom Devices Modify Menu

The Custom Devices Modify menu is divided into five main areas.

In the upper left hand corner (below the title), line numbers (or byte numbers) are displayed, followed by the Hexadecimal representation of the data byte at that location.

To the right of these line numbers and data values, under the heading Ascii/Param., are the ACSII text characters equivalent to the data values. Refer to the section “Decimal to Hexadecimal to ASCII Conversion Table” on page 33-11 for converting decimal to hexadecimal to ASCII text. These two areas can also show special option values. Refer to the section “Advanced Topics and Tables” on page 33-8 for more information.

As with all other Synergy Q/MD-X menus, the far right of the LCD lists the options modified by the three optical knobs, and the bottom label area allows for menu selection using the F1 to F6 soft keys.

Just above the label area is a line of single characters from 0 to 9 and A to F. This line is the hexadecimal number line. This line is where the cursor (controlled by the Set Nybble knob) indicates the value of the currently selected nybble of the byte being edited. The top knob determines which line to edit and the F2 soft key button determines which nybble to edit (upper most significant nybble or lower least significant nybble).

```
Custom Devices Modify Menu

<table>
<thead>
<tr>
<th>Line Number, Hex Value</th>
<th>Ascii/Param.</th>
<th>Choose Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>81 21</td>
<td></td>
<td>Play</td>
</tr>
<tr>
<td>62 20</td>
<td>Current nybble being edited</td>
<td>Frame Advance</td>
</tr>
</tbody>
</table>

Hex number line

Current nybble being edited

Toggle between nybbles in same byte

Text value or example

Command Tag: PLAY

Insert Line

Toggle Nybble

Delete Line

Toggle Special

Special Options

Clear Command

Cursor

Toggle between nybbles in same byte

The following section provides procedures for programming your custom devices.
Programming Commands

Use the following procedure to program your custom devices:

1. Navigate to the Custom Device Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications ⇒ Custom Devices.
2. Use the middle Knob to select the custom device that you wish to modify.
3. Press Modify to display the Custom Devices Modify Menu.

4. Below are some examples of programming simple commands in a Custom Device Protocol. The first example demonstrates how to set the PLAY Command Tag to send the Sony Betacam play message, as shown here.

5. Start the first line by pressing Insert Line, and dialing the middle knob (Set Nybble) until the first nybble of the first line (00) indicates a 2. This will also be highlighted on the Hex digit number line to the left of the Command Tag.

6. Use Insert Line again to add a second byte to the command as shown here.
7. Use the **Toggle Nybble** soft key to move to the lower nybble of the byte, and dial the middle knob to set the second byte to 01.

8. Press **Insert Line** to add the final line.

9. Use the **Set Nybble** knob to set the first nybble to 2.


11. In a similar fashion the Stop tag can be set to hex values of \texttt{20, 00 20} as shown here.

Program your custom devices in accordance with the information and tables attached.
Use the following Programming Worksheets to record your substituted commands.

<table>
<thead>
<tr>
<th>#1</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#2</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#3</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#4</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#5</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#6</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#7</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#8</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#9</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#10</th>
<th>Description</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Suggested abbreviations for parameter flags notation: 
H – Hex, B – BCD, AH – ASCII Hex, AB – ASCII BCD / 1-8 (digits) or 4,8..32 (bits) / M – Mot, I – Int. / S – Sca, E – Ext, + – Sign.

Example: B4/ M/+ would be a signed 4 digit BCD with Motorola ordering
### Second Custom Device Protocol CUSTOM1 – Programming sheet

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>#1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Suggested abbreviations for parameter flags notation:**
H – Hex, B – BCD, AH – ASCII Hex, AB – ASCII BCD / 1-8 (digits) or 4,8..32 (bits) / M – Mot, I – Int. / S – Sca, E – Ext, + – Sign.

**Example:** B4/ M/+ would be a signed 4 digit BCD with Motorola ordering.
Advanced Topics and Tables

Besides strings of constant Hex values (bytes), commands can be programmed with special characters and with converted parameter values. Examples of the special characters include the two special values to perform a communications break. The communications break is formed by a data zero event that extends beyond the normal data bit length permitted in the serial data word (e.g., serial word length of 8-Odd-1Stop bit is 1+8+1+1 = 11 bits long). The commonly used minimum length for break is 17 bits long or one and a half to two data-words. To implement a break in custom devices, there needs to be a [Break On], a [Break Off], and an optional delay in between.

Certain commands pass a parameter to the custom device driver that can be converted into a string of bytes using a special packed command in place of a single byte. Only one of these special command lines may appear in any given command slot (since only one parameter is ever passed). This command line is converted during runtime into the specified one to four bytes of parameter data, and included at that location in the command string. One command tag that gets a parameter is the Cue to Clip command. The value passed when a Cue to Clip command is triggered is the desired cue time as represented in a packed word timecode format. Typically, this value must then be converted into some representation of packed timecode bytes to be sent to the external device. The packed command flags are described in the following table. You may want to use the Panel Diagnostic\RX/TX\Monitor to view the results when using parameters in commands.

<table>
<thead>
<tr>
<th>Special Names</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Break On]</td>
<td>Force the outputs to data low value (for RS232 data low is a positive voltage)</td>
</tr>
<tr>
<td>[Break Off]</td>
<td>Release the outputs from a forced data low</td>
</tr>
<tr>
<td>[Checksum]</td>
<td>Insert the checksum byte (currently supports only simple 8-bit additive checksum)</td>
</tr>
<tr>
<td>[Posn X]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Posn Y]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Posn Z]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Param...]</td>
<td>Parameter (see parameter formatting flags below)</td>
</tr>
</tbody>
</table>

**Parameter Formatting Flags**

<table>
<thead>
<tr>
<th>Special Formats</th>
<th>Description</th>
</tr>
</thead>
</table>
| Hex             | Parameter take as is and converted into string of bytes (1-4)  
**Note:** if the parameter is already in a packed BCD format then using Hex format will preserve the BCD format of the parameter |
| ASCII Hex       | Text representation of above “Hex” format. |
| BCD             | Binary Coded Decimal (each nybble represents 1 digit 0-9) Converts a parameter that is in non-BCD format to a BCD format |
| ASCII BCD       | Text representation of above “BCD” format. Converts a parameter from a non-BCD format to a text representation of the equivalent BCD format. |

**Byte Format Ordering**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mot</td>
<td>Motorola ordering. Most Significant Byte (MSB) first, LSB last.</td>
</tr>
<tr>
<td>Int</td>
<td>Intel ordering. Least Significant Byte (LSB) first, MSB last.</td>
</tr>
</tbody>
</table>
### Special buttons

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scaled (Sca)</td>
<td>Re-scales a 12-bit parameter to fit output range</td>
</tr>
<tr>
<td>ASCII Extended (Ext)</td>
<td>Extends up the output to an even number of digits/characters without changing the output range</td>
</tr>
<tr>
<td>Signed (Sign)</td>
<td>Internal use - sign conversion</td>
</tr>
</tbody>
</table>

### BCDWidths

<table>
<thead>
<tr>
<th>BCD Widths</th>
<th>(examples in Motorola ordering)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Digit</td>
<td>1 byte of 1 digit, [00] to [09]</td>
</tr>
<tr>
<td>2 Digits</td>
<td>1 bytes of 2 packed digits each, [00] to max [99]</td>
</tr>
<tr>
<td>3 Digits</td>
<td>1 bytes of 2 packed digits and 1 byte of 1 digit, [00][00] to max[09][99]</td>
</tr>
<tr>
<td>4 Digits</td>
<td>2 bytes of 2 packed digits each, [00][00] to max[99][99]</td>
</tr>
<tr>
<td>5 Digits</td>
<td>2 bytes of 2 packed digits and 1 byte of 1 digit, max [09][99][99]</td>
</tr>
<tr>
<td>6 Digits</td>
<td>3 bytes of 2 packed digits each, max [99][99][99]</td>
</tr>
<tr>
<td>7 Digits</td>
<td>3 bytes of 2 packed digits and 1 byte of 1 digit, max [09][99][99][99]</td>
</tr>
<tr>
<td>8 Digits</td>
<td>4 bytes of 2 packed digits each, max [99][99][99][99]</td>
</tr>
</tbody>
</table>

### HexWidths

<table>
<thead>
<tr>
<th>Hex Widths</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 Bits</td>
<td>[00] to [0F]</td>
</tr>
<tr>
<td>8 Bits</td>
<td>[00] to [FF]</td>
</tr>
<tr>
<td>12 Bits</td>
<td>[00][00] to [0F][FF] (or Intel [FF][0F])</td>
</tr>
<tr>
<td>14 Bits</td>
<td>[00][00] to [3F][FF] (or Intel [FF][3F])</td>
</tr>
<tr>
<td>15 Bits</td>
<td>[00][00] to [7F][FF] (or Intel [FF][7F])</td>
</tr>
<tr>
<td>16 Bits</td>
<td>[00][00] to [FF][FF]</td>
</tr>
<tr>
<td>24 Bits</td>
<td>[00][00][00] to [FF][FF][FF]</td>
</tr>
<tr>
<td>32 Bits</td>
<td>[00][00][00][00] to [FF][FF][FF][FF]</td>
</tr>
</tbody>
</table>
### List of available Custom Device Commands for VTRs

<table>
<thead>
<tr>
<th>Tag</th>
<th>Parameter</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEEK TIMECODE (use Goto Clip in Custom Controls)</td>
<td>VTRClip Time as a packed BCD HHMMSSFF</td>
<td>VTR remote menus, Custom controls, VTR Clips. Use Hex to output BCD</td>
</tr>
<tr>
<td>REWIND</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>FRAME REVERSE</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>PAUSE</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>STOP</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>PLAY</td>
<td>None</td>
<td>Needed for ROLL VTR, VTR remote menus. Also custom controls (VTR and DVE)</td>
</tr>
<tr>
<td>FRAME ADVANCE</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>FAST FORWARD</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>RECORD</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
<tr>
<td>DIAGNOSTIC 1</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
<tr>
<td>DIAGNOSTIC 2</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
<tr>
<td>DIAGNOSTIC 3</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
</tbody>
</table>
### Decimal to Hexadecimal to ASCII Conversion Table

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00</td>
<td>43</td>
<td>2B +</td>
<td>86</td>
<td>56</td>
<td>V</td>
<td>129</td>
<td>81</td>
<td>172</td>
<td>AC</td>
<td>215</td>
<td>D7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>01</td>
<td>44</td>
<td>2C ,</td>
<td>87</td>
<td>57</td>
<td>W</td>
<td>130</td>
<td>82</td>
<td>173</td>
<td>AD</td>
<td>216</td>
<td>D8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>02</td>
<td>45</td>
<td>2D -</td>
<td>88</td>
<td>58</td>
<td>X</td>
<td>131</td>
<td>83</td>
<td>174</td>
<td>AE</td>
<td>217</td>
<td>D9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>03</td>
<td>46</td>
<td>2E .</td>
<td>89</td>
<td>59</td>
<td>Y</td>
<td>132</td>
<td>84</td>
<td>175</td>
<td>AF</td>
<td>218</td>
<td>DA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>04</td>
<td>47</td>
<td>2F /</td>
<td>90</td>
<td>5A</td>
<td>Z</td>
<td>133</td>
<td>85</td>
<td>176</td>
<td>B0</td>
<td>219</td>
<td>DB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>05</td>
<td>48</td>
<td>30 0</td>
<td>91</td>
<td>5B [</td>
<td>\</td>
<td>134</td>
<td>86</td>
<td>177</td>
<td>B1</td>
<td>220</td>
<td>DC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>06</td>
<td>49</td>
<td>31 1</td>
<td>92</td>
<td>5C \</td>
<td>]</td>
<td>135</td>
<td>87</td>
<td>178</td>
<td>B2</td>
<td>221</td>
<td>DD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>07</td>
<td>50</td>
<td>32 2</td>
<td>93</td>
<td>5D  }</td>
<td></td>
<td>136</td>
<td>88</td>
<td>179</td>
<td>B3</td>
<td>222</td>
<td>DE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>08</td>
<td>51</td>
<td>33 3</td>
<td>94</td>
<td>5E ^</td>
<td></td>
<td>137</td>
<td>89</td>
<td>180</td>
<td>B4</td>
<td>223</td>
<td>DF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>09</td>
<td>52</td>
<td>34 4</td>
<td>95</td>
<td>5F _</td>
<td></td>
<td>138</td>
<td>8A</td>
<td>181</td>
<td>B5</td>
<td>224</td>
<td>E0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>0A</td>
<td>53</td>
<td>35 5</td>
<td>96</td>
<td>60</td>
<td></td>
<td>139</td>
<td>8B</td>
<td>182</td>
<td>B6</td>
<td>225</td>
<td>E1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>0B</td>
<td>54</td>
<td>36 6</td>
<td>97</td>
<td>61 a</td>
<td></td>
<td>140</td>
<td>8C</td>
<td>183</td>
<td>B7</td>
<td>226</td>
<td>E2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0C</td>
<td>55</td>
<td>37 7</td>
<td>98</td>
<td>62</td>
<td>b</td>
<td>141</td>
<td>8D</td>
<td>184</td>
<td>B8</td>
<td>227</td>
<td>E3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>0D</td>
<td>56</td>
<td>38 8</td>
<td>99</td>
<td>63 c</td>
<td></td>
<td>142</td>
<td>8E</td>
<td>185</td>
<td>B9</td>
<td>228</td>
<td>E4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>0E</td>
<td>57</td>
<td>39 9</td>
<td>100</td>
<td>64</td>
<td>d</td>
<td>143</td>
<td>8F</td>
<td>186</td>
<td>BA</td>
<td>229</td>
<td>E5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>0F</td>
<td>58</td>
<td>3A :</td>
<td>101</td>
<td>65</td>
<td>e</td>
<td>144</td>
<td>87</td>
<td>187</td>
<td>BB</td>
<td>230</td>
<td>E6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>10</td>
<td>59</td>
<td>3B ;</td>
<td>102</td>
<td>66 f</td>
<td></td>
<td>145</td>
<td>91</td>
<td>188</td>
<td>BC</td>
<td>231</td>
<td>E7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>11</td>
<td>60</td>
<td>3C &lt;</td>
<td>103</td>
<td>67 g</td>
<td></td>
<td>146</td>
<td>92</td>
<td>189</td>
<td>BD</td>
<td>232</td>
<td>E8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>12</td>
<td>61</td>
<td>3D =</td>
<td>104</td>
<td>68 h</td>
<td></td>
<td>147</td>
<td>93</td>
<td>190</td>
<td>BE</td>
<td>233</td>
<td>E9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>13</td>
<td>62</td>
<td>3E &gt;</td>
<td>105</td>
<td>69 i</td>
<td></td>
<td>148</td>
<td>94</td>
<td>191</td>
<td>BF</td>
<td>234</td>
<td>EA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>14</td>
<td>63</td>
<td>3F ?</td>
<td>106</td>
<td>6A j</td>
<td></td>
<td>149</td>
<td>95</td>
<td>192</td>
<td>C0</td>
<td>235</td>
<td>EB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>15</td>
<td>64</td>
<td>40 @</td>
<td>107</td>
<td>6B k</td>
<td></td>
<td>150</td>
<td>96</td>
<td>193</td>
<td>C1</td>
<td>236</td>
<td>EC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>16</td>
<td>65</td>
<td>41 A</td>
<td>108</td>
<td>6C l</td>
<td></td>
<td>151</td>
<td>97</td>
<td>194</td>
<td>C2</td>
<td>237</td>
<td>ED</td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>17</td>
<td>66</td>
<td>42 B</td>
<td>109</td>
<td>6D m</td>
<td></td>
<td>152</td>
<td>98</td>
<td>195</td>
<td>C3</td>
<td>238</td>
<td>EE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>18</td>
<td>67</td>
<td>43 C</td>
<td>110</td>
<td>6E n</td>
<td></td>
<td>153</td>
<td>99</td>
<td>196</td>
<td>C4</td>
<td>239</td>
<td>EF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>19</td>
<td>68</td>
<td>44 D</td>
<td>111</td>
<td>6F o</td>
<td></td>
<td>154</td>
<td>9A</td>
<td>197</td>
<td>C5</td>
<td>240</td>
<td>F0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>1A</td>
<td>69</td>
<td>45 E</td>
<td>112</td>
<td>70 p</td>
<td></td>
<td>155</td>
<td>9B</td>
<td>198</td>
<td>C6</td>
<td>241</td>
<td>F1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>1B</td>
<td>70</td>
<td>46 F</td>
<td>113</td>
<td>71 q</td>
<td></td>
<td>156</td>
<td>9C</td>
<td>199</td>
<td>C7</td>
<td>242</td>
<td>F2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>1C</td>
<td>71</td>
<td>47 G</td>
<td>114</td>
<td>72 r</td>
<td></td>
<td>157</td>
<td>9D</td>
<td>200</td>
<td>C8</td>
<td>243</td>
<td>F3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>1D</td>
<td>72</td>
<td>48 H</td>
<td>115</td>
<td>73 s</td>
<td></td>
<td>158</td>
<td>9E</td>
<td>201</td>
<td>C9</td>
<td>244</td>
<td>F4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>1E</td>
<td>73</td>
<td>49 I</td>
<td>116</td>
<td>74 t</td>
<td></td>
<td>159</td>
<td>9F</td>
<td>202</td>
<td>CA</td>
<td>245</td>
<td>F5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>1F</td>
<td>74</td>
<td>4A J</td>
<td>117</td>
<td>75 u</td>
<td></td>
<td>160</td>
<td>A0</td>
<td>203</td>
<td>CB</td>
<td>246</td>
<td>F6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>20</td>
<td>75</td>
<td>4B K</td>
<td>118</td>
<td>76 v</td>
<td></td>
<td>161</td>
<td>A1</td>
<td>204</td>
<td>CC</td>
<td>247</td>
<td>F7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>21</td>
<td>76</td>
<td>4C L</td>
<td>119</td>
<td>77 w</td>
<td></td>
<td>162</td>
<td>A2</td>
<td>205</td>
<td>CD</td>
<td>248</td>
<td>F8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>22</td>
<td>77</td>
<td>4D M</td>
<td>120</td>
<td>78 x</td>
<td></td>
<td>163</td>
<td>A3</td>
<td>206</td>
<td>CE</td>
<td>249</td>
<td>F9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>23</td>
<td>78</td>
<td>4E N</td>
<td>121</td>
<td>79 y</td>
<td></td>
<td>164</td>
<td>A4</td>
<td>207</td>
<td>CF</td>
<td>250</td>
<td>FA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>24</td>
<td>79</td>
<td>4F O</td>
<td>122</td>
<td>7A z</td>
<td></td>
<td>165</td>
<td>A5</td>
<td>208</td>
<td>D0</td>
<td>251</td>
<td>FB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>25</td>
<td>80</td>
<td>50 P</td>
<td>123</td>
<td>7B [</td>
<td></td>
<td>166</td>
<td>A6</td>
<td>209</td>
<td>D1</td>
<td>252</td>
<td>FC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>26</td>
<td>81</td>
<td>51 Q</td>
<td>124</td>
<td>7C ]</td>
<td></td>
<td>167</td>
<td>A7</td>
<td>210</td>
<td>D2</td>
<td>253</td>
<td>FD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>27</td>
<td>82</td>
<td>52 R</td>
<td>125</td>
<td>7D }</td>
<td></td>
<td>168</td>
<td>A8</td>
<td>211</td>
<td>D3</td>
<td>254</td>
<td>FE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>28</td>
<td>83</td>
<td>53 S</td>
<td>126</td>
<td>7E ~</td>
<td></td>
<td>169</td>
<td>A9</td>
<td>212</td>
<td>D4</td>
<td>255</td>
<td>FF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>29</td>
<td>84</td>
<td>54 T</td>
<td>127</td>
<td>7F</td>
<td></td>
<td>170</td>
<td>AA</td>
<td>213</td>
<td>D5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>2A</td>
<td>85</td>
<td>55 U</td>
<td>128</td>
<td>80</td>
<td></td>
<td>171</td>
<td>AB</td>
<td>214</td>
<td>D6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** 7-bit printable ASCII range from 32 to 126 decimal. The Custom device menus represent text values outside that range with a period `.`.
Active Video Lines — All video lines not occurring in the vertical blanking interval. The portion of the video signal that contains picture information.

Aspect Ratio — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

Auto Transition — An automatic transition in which the manual movement of the fader handle is simulated electronically. The transition starts when the AUTO TRANS button is pressed and takes place over a pre-selected time period, measured in frames.

Border — Effects created around the edges of a pattern or on a keyer. If an optional dual border generator card is installed, several border, shadow, and outline effects are available on that keyer as well.

Border Generator — Circuitry that generates various border effects on keys created by the switcher.

Chroma Key — An effect in which video from one source replaces video of a specific hue in a second video source. The blue and green hues are most commonly used for chroma keying.

Chrominance — The “depth” or saturation of a color. The three characteristics of a TV color signal are chrominance, luminance and hue.

Cut — An instantaneous switch from one video signal to another.

Dissolve — A transition from one video signal to another in which one signal is faded down while the other is simultaneously faded up. The term “mix” is often used interchangeably with “dissolve”.

Downstream Keyer (DSK) — A keyer that places a key “downstream” of the MLE effects system output. This “top level” effect usually consists of a character generator title.

External Key — A video input (non-primary video) used to produce a key effect. Examples of external key sources are character generators and cameras.

Fade-to-Black — A controlled change of the on-air picture signal level down to black level.

Field — One half of a complete picture (or frame) interval containing all of the odd, or all of the even lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are required to make a complete picture (which is a “frame”).

Field Frequency — The rate at which one complete field is scanned, approximately 50 times per second in 625 video, or 60 times per second in 525 video.

Frame — One complete picture consisting of two fields of interlaced scanning lines.

GPI — An abbreviation for General Purpose Interface, a device which typically allows switcher automatic transition functions to be controlled remotely.
Hue — The characteristic of a color signal that determines whether the color is red, yellow, green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, luminance, and hue). White, black, and gray are not considered hues.

Internal Key — The use of a primary input to produce a key effect.

Key — An effect produced by “cutting a hole” in background video, then filling the hole with video or matte from another source. Key source video cuts the hole, key fill video fills the hole. The video signal used for cut and fill can come from the same or separate sources.

Key Fill — A video input which is timed to “fill the hole” provided by the key source video. An example of key fill is the video output of a character generator.

Key Invert — An effect that reverses the polarity of the key source so that the holes in the background are cut by dark areas of the key source instead of bright areas. The KEY INV push-button selects this effect.

Key Mask — A keying technique in which a pattern is combined with the key source to block out unwanted portions of the key source.

Key Source — The video signal which “cuts a hole” in the background video to make a key effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer circuit will switch from background to key fill video.

Key Video — See Key Source.

Linear Keys — Linear keys make it possible to fully specify the transparency of a key from opaque, through transparent, to fully off. The transparency is specified by the key signal (also known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer capable of a linear key converts the key signal voltage directly to the transparency effect on the screen. The KEY MEM button allows the user to store the CLIP and GAIN settings required to match the incoming key signal to your requirements.

Line Frequency — The number of horizontal scans per second. For 525 line 60 Hz systems, this is approximately 15734 scans per second.

Luminance Key — An effect in which video from one source is replaced by video that exceeds a set level in a second video source.

Mask — See Key Mask.

Matte — A solid color signal that is generated by the switcher and can be adjusted for hue, saturation, and luminance levels.

Matte Key — A key effect in which the fill video is a matte, provided by one of the internal matte generators.

Memory — The memory feature provides storage and recall of complete switcher setups.

MIX — See Dissolve.

MLE — An abbreviation for multi-level effects.

PGM Output — The on-air video output of the system.

Primary Input — Video sources selected by the control panel push-buttons for the crosspoint buses. These buses are normally labeled “KEY”, “PGM”, and “PST”.

PV Output — A switcher output that shows the scene that will go on-air when the next automatic or manual transition takes place.

Self Key — A key effect in which the same video signal serves as both the key signal and key fill.
**Soft Edge** — A pattern edge effect produced by mixing key source and key fill signals in such a way that the edge of the pattern is not sharp.

**Split Screen** — An effect in which a wipe pattern provides the key source signal. This is known as a “preset pattern” key.

**Tally** — An indicator which illuminates when the associated push-button or control is selected or is on-air.

**Termination** — A means of closing a circuit by connecting a resistive load to it. In video systems, a termination is typically a 75 ohm resistive load.

**Transition** — A controlled change from one video input to another video input or black. The change can occur through a wipe, cut, dissolve or “DVE Send” effect.

**Transition Preview** — A transition seen only on the preview monitor. It may be observed and adjusted without disturbing the program or “on-air” output.

**Video** — The electrical signal produced by a television camera, character generator or other image source. The signal amplitude varies in relation to the tonal scale from black to white presented at the source. White produces the highest amplitude; black produces the lowest signal amplitude.

**Wipe** — A transition from one video signal to another, in which the change proceeds according to the shape of a specific pattern. A moving transition line separates the two picture signals.
Index

Numerics
360 Systems Digicart
  Audio Server ........................................... 15-9
  communications setup ................................ 15-7
360 Systems Digicart/E
  Audio Server ........................................... 15-10
360 Systems Image Server 2000
  Video Server ........................................... 16-25
4317A-034 .............................................. 26-2
4317A-036 .............................................. 26-2
4317A-037 .............................................. 26-2
4317A-130 .............................................. 26-2
4530A-034 .............................................. 26-3
4530A-035 .............................................. 26-3
4530A-130 .............................................. 26-3
4530A-131 .............................................. 26-3
4530A-138 .............................................. 26-3
4530A-202 .............................................. 26-3
4735A-032A .............................................. 26-4
4735A-032B .............................................. 26-3
4735A-034 .............................................. 26-4
4735A-035 .............................................. 26-4
4735A-036A .............................................. 26-4
4735A-036B .............................................. 26-3
4735A-037 .............................................. 26-3, 26-5
4735A-130 .............................................. 26-4
4735A-131 .............................................. 26-4
4735A-202 .............................................. 26-5
4735A-203 .............................................. 26-5

A
Abekas6000
  communication settings ................................ 16-30
AC port, pinout (Frame) ................................ 30-14
AC port, pinout (Panel) ................................ 30-18
Accom APR Clipstore
  extra options ........................................... 14-9
  VTR ......................................................... 14-12
Active MLE Transition, Custom Contro........... 23-17
AFV, see Audio-Follow-Video
Alcorn McBride DVM2
  VTR ....................................................... 14-12
Arm mode, ROLL VTR .................................. 14-16, 15-12, 16-35
Assign Audio, custom control ....................... 19-34
Audio
  Communications ........................................ 19-3
  ganging mixers ....................................... 19-7
  Large interface ...................................... 19-3, 19-5, 19-7, 19-12
  memory recalls, custom control ............... 19-41, 19-42
  Merger ................................................ 19-7
  MIDIator ............................................. 19-5, 19-7
  Operational Overview .............................. 19-47
  Small interface ................................... 19-3, 19-5, 19-12
  supported Audio Mixers ........................... 19-2
  Topics ............................................... 19-1
  Yamaha Control Cable ................................ 19-3
Audio All Off, custom control .................... 19-37
Audio Bank setup ..................................... 19-32
Audio CH Off, custom control ..................... 19-41
Audio CH On, custom control ...................... 19-40
Audio channel assignment .......................... 19-30
Audio Level
  PGM .................................................... 19-42
  PST ..................................................... 19-43
Audio levels, adjusting ............................ 19-48
Audio Memory, custom control .................... 19-38
Audio mixer ........................................... 19-1
  audio transition MLE assignment ............... 19-31
  channel and group setup ......................... 19-28
  channel assignment ................................ 19-30
  connecting .......................................... 19-3
  Ganging ............................................. 19-7
  Interface Options ................................ 19-1
  local control ....................................... 19-32
  port baud rate ...................................... 19-15
  remote control setup .............................. 19-13
Audio Mixer Configuration
Calrec Sigma ........................................ 19-24
Studer .................................................. 19-24
Wheatstone D-9 ....................................... 19-23
Yamaha 01V96 ......................................... 19-19
Yamaha 02R96 ......................................... 19-20
Yamaha DM2000 ....................................... 19-21
Yamaha M7CL-48 ..................................... 19-22
Yamaha PM5D ......................................... 19-22
Audio Mixers, multiple ............................ 19-16
Audio Modes
audio-follow-video .................................................. 19-46
Editor ........................................................................... 19-46
override ....................................................................... 19-46
overview ....................................................................... 19-46
Audio only transitions .................................................. 19-48
Audio Overrides .............................................................. 19-46
Audio Pan settings, adjusting ......................................... 19-48
Audio Remote Control Setup ......................................... 19-28
Audio Servers .................................................................. 15-1
360 Systems Digicart ...................................................... 15-9
360 Systems Digicart, cabling .......................................... 15-4
360 Systems Digicart, port .............................................. 15-3
360 Systems Digicart/E .................................................... 15-10
360 Systems Digicart/E, cabling ....................................... 15-5
360 Systems Digicart/E, port .......................................... 15-3
clip (cut) registers .......................................................... 15-13, 15-19
clip name ..................................................................... 15-19
clip setup ..................................................................... 15-19
Communication Setup, switcher ....................................... 15-7
Communication Setup, Video Server ............................... 15-9
custom controls ............................................................. 15-15
custom controls, functions .............................................. 15-17
Cut ID ........................................................................... 15-13, 15-20
Cut Name ..................................................................... 15-13, 15-20
Cut Time ...................................................................... 15-13, 15-20
Enco DAD ....................................................................... 15-11
cabling ....................................................................... 15-6
port .............................................................................. 15-4
operation ...................................................................... 15-22
pre-roll, using ................................................................. 15-12
Roll VTR ........................................................................ 15-12
Roll VTR and OverDrive .................................................. 15-12
Sony MiniDisc .................................................................. 15-10
cabling ....................................................................... 15-5
port .............................................................................. 15-4
supported ...................................................................... 15-2
Audio Transition .............................................................. 19-48
Audio Transition MLE Assignment ................................... 19-31
Audio Transitions, overview ............................................ 19-47
Audio-Follow-Video ....................................................... 19-46
Automation, OverDrive ................................................... 23-14
Aux
1-3 connector pinouts ..................................................... 30-16
AUX 1, 2, 3 .................................................................. 26-8
Aux Bus
remote panel programming summary ................................ 30-19

Avid AirSPACE
Video Server .................................................................. 16-20
Avid AirSPEED
Video Server .................................................................. 16-26

B
Basic interconnections, control panel .................................. 26-9
Baud rate
audio mixer port ............................................................. 19-15
Betacam
Accom APR Clipstore .................................................... 14-12
Alcorn McBride DVM2 .................................................... 14-12
BitCentral Précis ........................................................... 14-13
Fast Forward Video Omega ............................................. 14-11
NPlay Retries ................................................................ 14-11
protocol setup ................................................................ 14-7
Target Machine ............................................................. 14-9
Wait nFields .................................................................. 14-10
BitCentral Précis
cabling .......................................................................... 14-5
communication settings .................................................. 14-13
communications connections ........................................... 14-3
BNC
input worksheet ................................................................ 31-2, 31-5
BNC Setup
robotic camera ................................................................. 20-22
router ............................................................................. 17-26
still store ....................................................................... 18-8, 21-14
video servers .................................................................. 16-32
VTR ............................................................................. 14-14
Boards
control panel, Synergy 2 .................................................. 26-2
control panel, Synergy 3 .................................................. 26-3
control panel, Synergy 4 .................................................. 26-4
extended tallies ................................................................. 28-3
BSS4, see Remote Port Switch (BSS4)
Bulb replacement ............................................................... 29-2
Bus Maps
worksheet ....................................................................... 31-5
Button
replacement .................................................................... 29-4
test menu ...................................................................... 29-4
Button test menu .............................................................. 24-8

C
Cabling
Audio, Small .................................................................... 19-5, 19-7
Yamaha Control Cable ........................................ 19-3
Calibrating power supply, control panel .......... 25-4
Calibration
knobs .......................................................... 24-3
menu .......................................................... 24-2
positioner ...................................................... 24-2
switcher ......................................................... 24-2
Calrec Audio System
serial connections ......................................... 19-4
Calrec Sigma Audio System
port .................................................................. 19-5
settings .......................................................... 19-24
wiring chart .................................................... 19-11
CG, see Character Generators
Character Generator
Chyron Duet LEX, port .................................. 21-3
Communication Setup, character generator... 21-9
Leitch Inca, port .............................................. 21-3
Character Generators ..................................... 21-1
Alpha BNC ...................................................... 21-16
Auto Key Setup ............................................. 21-17
Chyron Duet LEX
communication settings ................................. 21-12
Lyric software setup ..................................... 21-11, 21-12
Chyron Duet LEX CG, cabling ........................ 21-4
Chyron Duet LEX Character Generator.......... 21-10
Chyron HyperX
Lyric software setup ..................................... 21-11, 21-12
port ................................................................. 21-3
Communication Setup, switcher ...................... 21-7
communications connections ...................... 21-3
Custom Control ............................................. 21-18
Leitch Inca ...................................................... 21-9
Leitch Inca CG, cabling .................................. 21-4
Miranda Kaleido-K2
cabling .......................................................... 22-4, 22-12
Miranda Kaleido-X
cabling .......................................................... 22-4, 22-12
Pinnacle FXDeko II
cabling .......................................................... 21-5
port ................................................................. 21-4
supported ........................................................ 21-2
Video (Fill) BNC ............................................. 21-14
VizRT
cabling .......................................................... 21-5
communication settings ................................. 21-12
port ................................................................. 21-4
Choose Clip ID, video servers ......................... 16-40
Chyron Aprisa 100 Still Store ......................... 18-7
Chyron Duet LEX Character Generator .......... 21-10
communication settings ................................. 21-12
Lyric software setup ..................................... 21-11, 21-12
Chyron Freeway Router .................................. 17-20
Chyron HyperX Character Generator
Lyric software setup ..................................... 21-11, 21-12
port ................................................................. 21-3
Clip Control
audio server .................................................... 15-22
video server .................................................... 16-44
VTR ................................................................. 14-24
Clip ID, VTR ..................................................... 16-44
Clip ID Extended Character Set, VDCP ......... 16-19
Clip ID, VTR ..................................................... 14-24, 16-44
Clip Inpoint/Outpoint, video servers ............. 16-40
Clip Name ...................................................... 14-20, 15-19, 16-39
Clip Number, VTR ......................................... 14-24, 15-22, 16-44
Clip Registers
audio server .................................................... 15-13, 15-19
naming .......................................................... 14-20, 15-19, 16-39
timecode........................................................ 14-21
timecode, grab .............................................. 14-22, 16-42
video server .................................................... 16-39
VTR ................................................................. 14-20
Codan Kondor Router
ASCII ............................................................. 17-24
Geneos .......................................................... 17-21
Com port
editor ............................................................... 23-6
Command Queuing, VDCP .............................. 16-18
Communications
Audio mixer remote control setup .................. 19-13
connectors, overview ...................................... 26-8
Editor Protocol .............................................. 23-13
menu ............................................................... 33-4
Communications connections
character generator ......................................... 21-3
editors .......................................................... 23-3
overdrive ....................................................... 23-4
robotic cameras ............................................ 20-3
router, Codan NK ........................................... 17-12
routers .......................................................... 17-3, 22-3
still stores ....................................................... 18-3
video servers .................................................. 15-3, 16-3
VTR ................................................................. 14-3
Communications Setup
audio server .................................................... 15-9
character generator ......................................... 21-9
protocol uses and limitations .......................... 33-2
Custom Devices Modify Menu .......................... 33-3
Cut ID, Audio Server ................................. 15-13, 15-20
Cut Name, Audio Server ............................. 15-13, 15-20
Cut Time, Audio Servers ............................. 15-13, 15-20
Cuts, Audio Server .................................. 15-13, 15-19

D

DDRs
Betacam .................................................. 14-1, 16-1
Default Audio Level, setting ....................... 19-28
DHCP Address .......................................... 32-3
Diagnostics .............................................. 24-4, 24-17
button test .............................................. 24-8
display test ............................................. 24-9
fader test ................................................. 24-5
information menu .................................... 24-4
joystick test ............................................ 24-7
lamp test .................................................. 24-8
memory test ............................................ 24-9
potentiometer test ..................................... 24-5
tally relay test ........................................ 24-12
tools ................................ ..................... 24-1
TX/RX test .............................................. 24-10, 24-17
DIP Switch, Power Supply ......................... 27-15
DIP/Jump Test menu .................................. 24-12
Dispatcher (K2), see Miranda Dispatcher
Display
replacement ............................................. 29-11
test menu ................................................ 24-9
Display Test Menu ..................................... 29-11
Dynamic Host Configuration Protocol .......... 32-3
Dynamic text, monitor wall ......................... 22-20

E

Eagle Pan Tilt System
Extra Options ........................................... 20-16
Eagle PT-101
Phoenix Connection Block ......................... 20-8
Eagle Robotic Camera ................................ 20-20
Editor
com port ............................................... 23-6
Peripheral Port Pinout .............................. 30-11
Editor Protocol, OverDrive ...................... 23-13
Editor Type, GVG100 ............................... 23-8
Editors ............................................... 23-1
Communication Setup, switcher .............. 23-6

Synergy Q/MD-X Engineering Manual (v9.1 MD)  Index • IX–5

communications connections .................. 23-3
extra options .......................................... 23-8
GVG100, editor type ............................... 23-8
GVG100, extra options ............................. 23-8
GVG100, pattern .................................... 23-9
GVG4000, extra options ......................... 23-10
operation .............................................. 23-18
protocol .............................................. 23-6
protocol menu ....................................... 23-6
Enco DAD
communication settings ......................... 15-11
setup .................................................. 15-11
End-of-life disposal .................................. 1-8
Enter Clip ID, video servers ..................... 16-40
Environmental Information .................... 1-8
Environmental specifications .................. 30-5
Errors, panel and frame ......................... 24-4
Ethernet connection, precautions ............... 32-2
EVS Broadcast Equipment maxS
Video Server ......................................... 16-26
Extended tallies
board ............................................... 28-3
option ................................................. 28-3
External Device
audio server .......................................... 15-1
Character Generators .............................. 21-1
DDRs (Betacam) ...................................... 14-1, 16-1
Editors ............................................... 23-1
OverDrive ............................................ 23-1
Robotic Camera ...................................... 20-1
Routers .............................................. 17-1, 22-1
Still Store ............................................. 18-1
Video Servers (Betacam) ......................... 14-1, 16-1
VTRs (Betacam) ..................................... 14-1, 16-1
Extra Options
Chyron Duet LEX .................................... 21-11
Eagle Pan Tilt System .............................. 20-16
editors .................................................. 23-8
GVG100 .............................................. 23-8
GVG100, Editor Type ............................. 23-8
GVG100, Pattern .................................. 23-9
GVG4000 .......................................... 23-10
multiple remote audio mixer .................. 19-16
remote audio mixer ............................... 19-15
robotic cameras ................................... 20-15
routers .............................................. 17-18
Studer Audio Mixer ................................. 19-24
Telemetrics .......................................... 20-15
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>20-15</td>
<td>Telemetrics Serial Switch</td>
</tr>
<tr>
<td>20-16</td>
<td>Telemetrics, ReTime</td>
</tr>
<tr>
<td>20-16</td>
<td>Telemetrics, ShotOffset</td>
</tr>
<tr>
<td>16-16</td>
<td>Video Servers</td>
</tr>
<tr>
<td>14-9</td>
<td>VTR</td>
</tr>
<tr>
<td>20-16</td>
<td>Telemetrics, RclTime</td>
</tr>
<tr>
<td>20-16</td>
<td>Telemetrics, ShotOffset</td>
</tr>
<tr>
<td>16-16</td>
<td>Video Servers</td>
</tr>
<tr>
<td>14-9</td>
<td>VTR</td>
</tr>
<tr>
<td>29-6</td>
<td>Fader replacement</td>
</tr>
<tr>
<td>29-6</td>
<td>test menu</td>
</tr>
<tr>
<td>24-5</td>
<td>Fader test menu</td>
</tr>
<tr>
<td>24-6</td>
<td>Synergy Slots</td>
</tr>
<tr>
<td>14-11</td>
<td>Fast Forward Video Omega</td>
</tr>
<tr>
<td>14-12</td>
<td>VTR</td>
</tr>
<tr>
<td>30-16</td>
<td>Frame connector pinouts</td>
</tr>
<tr>
<td>30-4</td>
<td>connector types</td>
</tr>
<tr>
<td>27-2</td>
<td>CPU</td>
</tr>
<tr>
<td>24-4</td>
<td>errors</td>
</tr>
<tr>
<td>24-4</td>
<td>information</td>
</tr>
<tr>
<td>30-3</td>
<td>specifications</td>
</tr>
<tr>
<td>26-8</td>
<td>Frame connector</td>
</tr>
<tr>
<td>27-13</td>
<td>Frame Motherboard</td>
</tr>
<tr>
<td>19-7</td>
<td>Ganging, audio mixers</td>
</tr>
<tr>
<td>16-24</td>
<td>Gee Broadcast Systems Geevs</td>
</tr>
<tr>
<td>30-3</td>
<td>General Specifications</td>
</tr>
<tr>
<td>24-20</td>
<td>GfxBuffDDR Test menu</td>
</tr>
<tr>
<td>31-11</td>
<td>GPI input worksheet, standard</td>
</tr>
<tr>
<td>31-11</td>
<td>output worksheet, standard</td>
</tr>
<tr>
<td>30-12</td>
<td>standard I/O connector pinouts</td>
</tr>
<tr>
<td>24-18</td>
<td>Test, menu</td>
</tr>
<tr>
<td>16-42</td>
<td>Grab a Timecode, Video Server</td>
</tr>
<tr>
<td>14-22</td>
<td>Grab a Timecode, VTR</td>
</tr>
<tr>
<td>20-21</td>
<td>Grass Valley CameraMan 3e 3-CCD communication settings</td>
</tr>
<tr>
<td>20-23</td>
<td>BNC setup</td>
</tr>
<tr>
<td>20-9</td>
<td>cabling</td>
</tr>
<tr>
<td>20-21</td>
<td>communications settings</td>
</tr>
<tr>
<td>20-12</td>
<td>communications setup</td>
</tr>
<tr>
<td>20-4</td>
<td>port</td>
</tr>
<tr>
<td>28-14</td>
<td>Hard Drive replacement overview</td>
</tr>
<tr>
<td>28-17</td>
<td>Ribbon Cable Connector</td>
</tr>
<tr>
<td>28-2</td>
<td>Hardware Options</td>
</tr>
<tr>
<td>16-40</td>
<td>Inpoint, Video Server Clip</td>
</tr>
<tr>
<td>30-8</td>
<td>Input specifications</td>
</tr>
<tr>
<td>31-2, 31-6</td>
<td>worksheet</td>
</tr>
<tr>
<td>27-7</td>
<td>Input Board, Frame</td>
</tr>
<tr>
<td>22-18</td>
<td>Input channels, monitor wall</td>
</tr>
<tr>
<td>15-17</td>
<td>Insert Special Audio Server functions</td>
</tr>
<tr>
<td>23-17</td>
<td>Automation</td>
</tr>
<tr>
<td>20-24, 20-27</td>
<td>Recall Camera</td>
</tr>
<tr>
<td>20-26</td>
<td>Insert Special, Recall Camera</td>
</tr>
<tr>
<td>28-3</td>
<td>Installing extended tallies option</td>
</tr>
<tr>
<td>28-10, 28-31</td>
<td>MediaCache</td>
</tr>
<tr>
<td>28-8</td>
<td>mnemonic controller board</td>
</tr>
<tr>
<td>28-5</td>
<td>mnemonics display</td>
</tr>
<tr>
<td>28-6</td>
<td>mnemonics display modules</td>
</tr>
<tr>
<td>28-5</td>
<td>precautions</td>
</tr>
<tr>
<td>28-22</td>
<td>Squeeze &amp; Tease MD</td>
</tr>
<tr>
<td>28-29</td>
<td>XFX card</td>
</tr>
<tr>
<td>28-22</td>
<td>Installing S&amp;T MD daughter cards</td>
</tr>
</tbody>
</table>
Installing the S&T DSP Card............................. 28-23
Installing the S&T MD Card.............................. 28-24
Installing the S&T MD WARP Card.................. 28-26
Installing the XFX Extra Effects Card ............... 28-29
Interconnections, control panel ............................ 26-9
IP Addresses
  default services ............................................ 32-3
  web server .................................................. 32-3
IP Addresses
  DHCP .......................................................... 32-3
  overview ...................................................... 32-3
  static .......................................................... 32-3
  Telenet server .............................................. 32-3
J
  Joystick test menu ........................................... 24-7
  Jupiter Router ................................................ 17-18
K
  Kaleido-K2 Monitor Wall ................................ 22-9
  Keys Off Air, Custom Control ........................... 23-17
  Knob replacement ........................................... 29-8
L
  Lamp test menu...........................................24-8, 29-2
  LAN Port, pinout ........................................ 30-14
  Large Audio Mixer Interface 19-3, 19-5, 19-7, 19-12
  Layout, monitor wall .................................... 22-16
  LED indicator
    PANEL ....................................................... 25-2
  LEDs Test menu...........................................24-18, 24-19
  Leitch ASC VR300
    version 2 .................................................. 16-20
    version 2.7 .................................................. 16-20
  Video Server .............................................. 16-20
  Leitch Inca Character Generator .......................... 21-9
  Leitch Nexio
    communication settings .................................. 16-31
  Leitch VR440
    Video Server .............................................. 16-21
  Lyric software, setup ..................................21-11, 21-12
  replacing a bulb ......................................... 29-2
  replacing a button ..................................... 29-4
  replacing a fader ....................................... 29-6
  replacing a knob ....................................... 29-8
  replacing the display .................................. 29-11
  Media ID Length, VDCP .................................. 16-17
  MediaCache
    installing ...........................................28-10, 28-31
  Memory
    test menu .................................................. 24-9
  Menu
    button test ...........................................24-8, 29-4
    calibration ............................................ 24-2
    communications ......................................... 33-4
    DIP/Jump Test ........................................ 24-12
    display test ..........................................24-9, 29-11
    fader test ............................................. 24-5, 29-6
    GfxBuffDDR Test ....................................... 24-20
    joystick test ........................................... 24-7
    lamp test ............................................... 24-8, 29-2
    LEDs Test .............................................. 24-18, 24-19
    memory test ............................................. 24-9
    modify custom device .................................. 33-4
    panel information ..................................... 24-4
    pots test ............................................... 24-5, 29-9
    Remote Control ........................................ 14-25, 16-45
    Router Matrix Control .................................. 17-32
    Router Other ........................................... 17-27
    select editor protocol ................................ 23-6
    tally test ............................................... 24-12
    TX/RX test ........................................... 24-10, 24-17
  Merger, MIDI ............................................ 19-7
  MIDI Merger ............................................. 19-7
  MIDI Merger for multiple Audio Mixers ............... 19-16
  MIDIlator ................................................. 19-5, 19-7
  MIDIlator converter ..................................... 19-15
  MIDIlator Interface Cable ................................ 19-5, 19-7
  Midplane ...................................................... 27-4
  Miranda Dispatcher ....................................... 22-5
    IP Address ............................................ 22-8
    Port Number ............................................ 22-8
  Miranda Kaleido-K2 Monitor Wall
    assigning input channels ................................ 22-18
    custom controls for .................................. 22-16
    loading a layout ....................................... 22-16
    modifying dynamic text ................................ 22-20
  Miranda Kaleido-K2, Dispatcher....................... 22-5
MLE
   Active Transition Custom Control................ 23-17
Mnemonic controller board, installing .......... 28-8
Mnemonics display
   installation .............................................. 28-5
   installing modules................................... 28-6
   removing cover plates............................. 28-5
   test menu................................................ 24-9
Modify
   monitor wall dynamic text.......................... 22-20
Monitor Walls
   Communication Setup, monitor wall............. 22-9
   Communication Setup, under monitor display ... 22-12
   custom controls....................................... 22-16
   custom controls, assigning input channels ... 22-18
   custom controls, loading a layout............. 22-16
   custom controls, modifying dynamic text.... 22-20
   dispatcher setup, IP address.................... 22-8
   dispatcher setup, port number................... 22-8
   dynamic and static text............................ 22-20
   Kaleido-K2.............................................. 22-9
   Miranda Kaleido-K2, cabling..................... 22-5
   Miranda Kaleido-K2, port ......................... 22-3
   operation.................................................. 22-23
   operation, assign channel....................... 22-23
   operation, layouts.................................... 22-23
   operation, modify text............................. 22-23
Motherboard, Frame.................................. 27-13

N
   NAKs, VTR (Betacam).............................. 14-9
   Naming Audio Server Clips........................ 15-19
   Naming Video Servers Clips…………………... 16-39
   Naming VTR Clips........................................ 14-20
   Network security...................................... 32-2
   ethernet connections.............................. 32-2
Not Acknowledgement, see NAKs
NPlay Retries, Betacam.............................. 14-11

O
   Omneon Video Server
      cable pinouts....................................... 16-9
      communication settings........................ 16-31
Operation
   monitor wall.......................................... 22-23
   monitor wall assign channel.................. 22-23
   monitor wall layout............................... 22-23
   monitor wall modify text........................ 22-23
Option
   hardware, overview .................................. 28-2
   installing extended tallies.................... 28-3
   mnemonics display installation.............. 28-5
   redundant power..................................... 25-1
   Remote Port Switch (BSS4), cabling ......... 28-20
Option cards........................................... 27-3
Options
   MediaCache, installation....................... 28-10, 28-31
   Squeeze & Tease MD, installation............... 28-22
   XFX card, installation............................. 28-29
Output
   specifications........................................ 30-9
Output Board, Frame.................................. 27-10
OverDrive............................................... 23-1
   Communication Setup............................... 23-12
   communications connections.................. 23-4
   control panel interface cabling............. 23-5
   custom controls (automation).................. 23-16
   operation............................................... 23-18
   Synergy 2 limitations............................ 23-18
OverDrive, audio mode.............................. 19-46
OverDrive, Roll VTR................................. 14-16, 15-12, 16-35
Overrides, audio...................................... 19-32, 19-46

P
   Pan settings, adjusting............................ 19-48
   Panasonic AW-PH500p............................. 20-20
   cabling................................................. 20-9
Panel
   errors................................................... 24-4
   information............................................ 24-4
   remote control worksheet..................... 31-8
Panel CPU board, layout......................... 26-6
   PANEL LED.............................................. 25-2
Panel Monitoring
   logging to frame.................................... 24-13
   logging to remote port........................... 24-14
Panel Port, pinout.................................... 30-11
Pattern, GVG100.................................... 23-9
Peripheral Port
   connector pinouts................................. 30-11
Editor....................................................... 30-11
Personality
roll VTR mode ......................14-16, 15-12, 16-35
Pesa Cougar Router................................. 17-19
PGM Audio Level ................................... 19-42
PGM Audio Level, custom control ................. 19-42
Phoenix Connection Block, Eagle PT-101 ......... 20-8
Pinnacle FXDeko II Character Generator
cabling .............................................. 21-5
port ..................................................... 21-4
Pinnacle Thunder
Video Server ........................................... 16-21
Pinouts
AC Power (Frame) .................................... 30-14
AC Power (Panel) ...................................... 30-18
Aux 1-3 connectors ................................... 30-16
frame ................................................... 30-11
frame connector ...................................... 30-16
LAN Port .................................................. 30-14
Panel Port .............................................. 30-11
Peripheral Port ........................................ 30-11
Remote Port............................................ 30-15
standard GPI I/O connector .......................... 30-12
Tally port ............................................... 30-17
Play mode, ROLL VTR ....14-16, 15-12, 16-35
Playback Mode, VDCP ................................ 16-18
Port Commands, VDCP ................................ 16-19
Pots Test Menu.......................................... 29-8
Pots test menu ........................................... 24-5
Power
connector pinouts (Frame) ......................... 30-14
connector pinouts (Panel) ......................... 30-18
consumption specifications ....................... 30-4
redundant................................................. 25-1
supply, control panel, calibrating ................. 25-4
supply, control panel, replacing ................. 25-2
supply, DIP switch 2 ................................. 27-15
tally ratings ............................................. 30-5
Power Consumption
Frame ..................................................... 30-5
Power Supplies
Frame ..................................................... 30-4
Pre-Roll, Audio Server ............................... 15-12
Pre-Roll, video server ............................... 16-15
Pre-Roll, VTR .......................................... 14-8, 14-16, 16-35
Primary
system boards .......................................... 27-2
Pro-Bel Halo Router
communication settings ............................. 17-21
Protocol
editor .................................................. 23-6
PST Audio level ........................................ 19-43
PST Audio Level, custom control ................. 19-43
Q
Queuing a Clip ........................................... 14-24, 15-22, 16-44
R
Rack frame
connector types ........................................ 30-4
specifications .......................................... 30-3
Recall Camera, Telemetrics .......................... 20-16
Rear panel
connectors .............................................. 26-7
Recall Camera Custom Controls .................... 20-24
Recall Shot Custom Controls ........................ 20-25
Record Time, VDCP .................................... 16-18
Redundant power ...................................... 25-1
Remote
aux panel programming summary ................. 30-19
Remote audio mixer control
audio transition on MLE ............................. 19-31
overrides ............................................... 19-32
setup channels and groups ......................... 19-28
setup communications .............................. 19-13
Remote device control .............................. 26-8
Remote Port Switch (BSS4)
cabling .................................................... 28-20
Remote Port, pinouts ................................ 30-15
Removing the S&T MD Carrier ...................... 28-22
Repair policy .......................................... 1-7
Replacing
control panel bulb .................................... 29-2
control panel button ................................ 29-4
control panel display ............................... 29-11
control panel fader .................................. 29-6
control panel knob .................................. 29-8
hard drive .............................................. 28-14
power supply, control panel ....................... 25-2
Reset Audio, custom control ....................... 19-35
Ribbon Cable Connector ............................. 28-17
Robotic Camera
ethernet communication setup .................. 20-10
Roll VTR

- arm mode ........................................ 14-16, 15-12, 16-35
- OverDrive ........................................ 14-16, 15-12, 16-35
- play mode ....................................... 14-16, 15-12, 16-35

Routers ............................................. 17-1, 22-1

- BNC Setup ........................................ 17-26
- Chyron Freeway ................................... 17-20
- Codan Kondor (ASCII), cabling .................. 17-11

Robotic Cameras ..................................... 20-1

- BNC Setup ........................................ 20-22
- Communication Setup, robotic camera ......... 20-18
- Communication Setup, switcher ................. 20-11
- communications connections .................... 20-3
- custom controls ................................... 20-24
- custom controls, camera all stop ............... 20-27
- Eagle ............................................... 20-20
- Eagle PT-101 Pan Tilt, cabling .................. 20-8
- Eagle PT-101 Pan Tilt, port ....................... 20-4
- extra options ..................................... 20-15

Grass Valley CameraMan 3e 3-CCD
- cabling ............................................. 20-4
- communication settings ......................... 20-21
- pinouts ............................................. 20-9
- Panasonic AW-PH500Pp .......................... 20-20
- cabling ............................................. 20-9
- port .................................................. 20-4
- Sony BRC-300/300P .................................. 20-19
- cabling ............................................. 20-7
- port .................................................. 20-4
- supported .......................................... 20-2

Telemetrics ......................................... 20-18

- DS-4, cabling ....................................... 20-6
- DS-4, port ......................................... 20-4
- DS-4, settings ...................................... 20-18
- ShotOffset ......................................... 20-16
- STS-12, port ....................................... 20-4

Telemetrics PT-CP-S2, cabling ..................... 20-4

Telemetrics PT-CP-S2, port ......................... 20-3

Telemetrics PT-HP-S2, cabling ..................... 20-4

Telemetrics PT-HP-S2, port ......................... 20-3

Telemetrics PT-LP-S2, cabling ..................... 20-4

Telemetrics PT-LP-S2, port ......................... 20-3

Telemetrics STS-12 ................................ 20-18

Telemetrics, extra options ......................... 20-15

Telemetrics, RclTime ................................ 20-16

Telemetrics, serial switch ......................... 20-15

Vinten Series 200, connecting ..................... 20-10

Vinten, com settings ................................ 20-20

Jupiter .............................................. 17-18

- matrix control menu .................................. 17-32
- operation .............................................. 17-32

Other Menu .......................................... 17-27

Pesa Cougar ....................................... 17-19

- PESA Cougar, cabling ........................... 17-5
- Philips Jupiter, cabling ......................... 17-4
- Philips Jupiter, port .............................. 17-3
- Philips PESA Cougar, port ...................... 17-4

Pro-Bel Freeway, cabling ......................... 17-6

Pro-Bel Freeway, port .............................. 17-4

Pro-Bel Halo ........................................ 17-21
- cabling ............................................ 17-7
- port .................................................. 17-4

Router Setup Menu ................................ 17-27

Sierra Yosemite .................................... 17-24

- Sierra Yosemite, cabling ....................... 17-13
- Sierra Yosemite, port ............................ 17-4

Utah Scientific .................................... 17-25

- Utah Scientific, cabling ......................... 17-14
- Utah, port ......................................... 17-4

Routing Switchers, see Routers
S

S&T Carrier Board ........................................ 27-21
S&T DSP Card ............................................. 27-23
S&T MD Card.............................................. 27-25, 27-27
S&T see Squeeze & Tease

Specifications

Selecting Video Servers Clips............................... 16-40
Send Tries, VDCP ........................................... 16-17
Serial Switch, Telemetrics .................................. 20-15

Setup

OverDrive Communication .................................. 23-12
ShotOffset, Telemetrics ................................... 20-16
Sierra Yosemite Router ................................... 17-24
Slots, Synergy ............................................... 24-6
Small Audio Mixer Interface ............................. 19-3, 19-5, 19-12
SoftMetal

Video Server ................................................ 16-27
Software licenses ............................................ 32-4
Sony BRC-300/300P ....................................... 20-19
Sony MiniDisc
communication settings .................................. 15-10
setup .......................................................... 15-10

Spare Parts Kit

Hard Drive replacement .................................. 28-14
Special

program audio channel off .................................. 19-41
program audio level ........................................... 19-42
program automation ........................................ 23-16

Specifications

carrier removal ........................................ 28-22
dsp card .................................................. 27-23
Dsp Card installation ...................................... 28-23
MD Card .................................................. 27-25, 27-27
MD Card installation ...................................... 28-24
MD WARP Card installation ............................... 28-26

Squeeze & Tease Carrier Board .......................... 27-21
Squeeze & Tease DSP Card ................................. 27-3, 27-23
Squeeze & Tease MD
installing .................................................. 28-22
Squeeze & Tease MD Card ................................. 27-3, 27-25, 27-27
Squeeze & Tease MD WARP Card ......................... 27-3

Static discharge ........................................... 1-6
Static, precautions ......................................... 28-5, 28-8
Still Store .................................................. 18-1

Chyron Aprisa 100, port .................................. 18-3

Still Stores

BNC Setup .................................................. 18-8, 21-14
Chyron Aprisa 100 ......................................... 18-7
Chyron Aprisa, cabling ................................... 18-4
Communication Setup, still store ....................... 18-7
Communication Setup, switcher ......................... 18-5
communications connections .......................... 18-3
operation .................................................. 18-10
Still Setup Menu ........................................... 18-9
supported ..................................................... 18-2

Studer Audio Mixer
extra options ............................................. 19-24
port .......................................................... 19-4
settings ..................................................... 19-24
wiring chart .............................................. 19-11
Summary, remote aux programming ..................... 30-19

Switcher

calibration ................................................. 24-2

Switcher Communication Setup
audio server .............................................. 15-7
character server .......................................... 21-7
editor ...................................................... 23-6
overdrive .................................................. 23-12
robotic camera ........................................... 20-11
routers ....................................................... 17-15, 22-6
still store .................................................. 18-5
video server ............................................. 16-14
VTR ......................................................... 14-7

Switches
frame configuration ....................................... 27-15
Synergy diagnostics ........................................ 24-4, 24-17
Synergy 2 control panel boards ......................... 26-2
Synergy 2, OverDrive operation ........................................ 23-18
Synergy 3 control panel boards ............................ 26-3
Synergy 4 control panel boards ............................ 26-4
Synergy Slots........................................................ 24-6
System primary boards ........................................ 27-2
specifications .................................................. 30-1
standard components ...................................... 30-2
System Board Midplane ........................................ 27-4
System Boards CPU .............................................. 27-13
Crosspoint ..................................................... 27-19
Input ................................................................ 27-7
Output ........................................................... 27-10
S&T Carrier .................................................. 27-21
Video Processor ............................................ 27-17
System Cards S&T DSP .......................................... 27-23
S&T MD ....................................................... 27-25, 27-27
XFX Extra Effects ........................................ 27-29

T Tally
connectors ....................................................... 26-8
extended option ............................................. 28-3
test menu ....................................................... 24-12
Tally Port, pinouts .............................................. 30-17
Target Machine, Betacam ......................................... 14-9
Target Machine, VDCP ......................................... 16-16
Telemetrics Extra Options ............................................ 20-15
Extra Options, RclTime ........................................... 20-16
Telemetrics Device Server DS-4
BNC setup ....................................................... 20-23
Telemetrics DS-4 communications settings ................. 20-18
Telemetrics Robotic Camera ..................................... 20-18
Telemetrics Robotic Camera Controller
Extra Options, ShotOffset ........................................ 20-16
Telemetrics Serial Switch
Extra Options ....................................................... 20-15

Telemetrics STS-12 Switch communications settings .... 20-18
Test buttons ....................................................... 24-8
DIP/Jump switches ............................................. 24-12
display .......................................................... 24-9
fader .............................................................. 24-5
GPI ................................................................ 24-18
joystick ......................................................... 24-7
lamps .............................................................. 24-8
memory ......................................................... 24-9
potentiometers ............................................... 24-5
tally relays ..................................................... 24-12
TX/RX ....................................................... 24-10, 24-17
Timeout, VDCP .................................................. 16-17
Transitions Audio only ........................................... 19-48
TX/RX test menu ............................................. 24-10, 24-17

U Upgrading
MediaCache memory ........................................ 28-10, 28-31
Utah Router port .............................................. 17-4
Utah Scientific 400/64 Router communication settings .... 17-25
Utah Scientific Router cabling ................................ 17-14

V VDCP
360 Image Server 2000 ........................................ 16-25
Abekas6000 .................................................. 16-30
Avid AirSPACE ............................................. 16-20
Avid AirSPEED ............................................. 16-26
Clip ID Extended Character Set ............................. 16-19
Command Queuing ........................................... 16-18
EVS Broadcast Equipment maXS ......................... 16-26
Gee Broadcast Systems Geevs .......................... 16-24
GVG M-Series .............................................. 16-28
GVG Profile .................................................. 16-29
GVG Turbo .................................................. 16-29
Leitch ASC VR300 ........................................ 16-20
Leitch Nexio .................................................. 16-31
Leitch VR440 .................................................. 16-21
Media ID Length ............................................. 16-17
Omneon Video Server.............................. 16-31
Pinnacle Thunder .................................. 16-21
Playback Mode ....................................... 16-18
Port Commands ...................................... 16-19
protocol setup ...................................... 16-14
Record Time ......................................... 16-18
Send Tries ............................................ 16-17
SoftMetal ............................................. 16-27
Spencer Technologies ............................... 16-24
Target Machine ...................................... 16-16
Timeout ............................................... 16-17
Video
input specifications ............................... 30-8
output specifications .............................. 30-9
system timing specifications .................. 30-8
Video Input Board ................................ 27-7
Video Output Board ................................. 27-10
Video Processor Board ............................ 27-17
Video Servers
360 Systems Image Server 2000 .............. 16-25
360 Systems Image Server 2000, cabling .. 16-8
360 Systems Image Server 2000, port..... 16-4
Abekas6000 ......................................... 16-30
Abekas6000, cabling .............................. 16-12
Abekas6000, port ................................ 16-4
Avid AirSPACE ...................................... 16-20
Avid AirSPACE, cabling ......................... 16-5
Avid AirSpace, port ................................ 16-3
Avid AirSPEED ....................................... 16-26
Avid AirSPEED, cabling ......................... 16-9
Avid AirSpeed, port ............................... 16-4
Betacam ................................................... 14-1, 16-1
BNC Setup ............................................ 16-32
choose clip ID ....................................... 16-40
Clip ID Extended Character Set ............. 16-19
clip name ............................................ 16-39
clip registers ....................................... 16-39
clip selection ....................................... 16-40
clip setup ............................................ 16-39
clip timecode, grab ............................... 16-42
Command Queuing ................................ 16-18
Communication Setup, switcher ............. 16-14
Communication Setup, Video Server ........ 16-20
communications connections ............... 15-3, 16-3
custom controls .................................... 16-36
custom controls, functions ................... 16-37
custom controls, functions ................... 16-37
enter clip ID ......................................... 16-40
EVS Broadcast Equipment maXS ............ 16-26
EVS Broadcast Equipment maXS, port .... 16-4
EVS maXS, cabling ............................... 16-8
Gee Broadcast Equipment Geevs ........... 16-24
Gee Broadcast Systems Geevs, cabling .... 16-7
Gee Broadcast Systems Geevs, port ...... 16-4
Generic, cabling ................................. 16-13
Generic, port ...................................... 16-4
GVG M-Series ....................................... 16-28
GVG M-Series, cabling ......................... 16-10
GVG Profile ......................................... 16-29
GVG Profile, cabling ............................ 16-11
GVG Profile, port ................................ 16-4
GVG Turbo .......................................... 16-29
GVG Turbo, port ................................ 16-4
inpoint/outpoint .................................. 16-40
Leitch ASC VR300 ................................ 16-20
Leitch ASC VR300, port ........................ 16-3
Leitch Nexio ......................................... 16-31
Leitch Nexio, cabling ........................... 16-12
Leitch Nexio, port ................................. 16-4
Leitch VR440 ....................................... 16-21
Leitch VR440, port ................................ 16-3
Leitch ASC VR300, cabling .................... 16-5
Media ID Length .................................... 16-17
Omneon ............................................. 16-31
cabling ............................................. 16-9
Omneon, port ...................................... 16-4
operation ............................................. 16-44
Pinnacle Thunder .................................. 16-21
Pinnacle Thunder, cabling ..................... 16-6
Pinnacle Thunder, port .......................... 16-3
Pinnacle ThunderLT, port ....................... 16-3
Pinnacle ThunderMXe, port .................. 16-3
Playback Mode ..................................... 16-18
Port Commands .................................... 16-19
Pre-Roll ............................................. 16-15
queuing a clip ...................................... 15-22, 16-44
Record Time ......................................... 16-18
remote control menu ............................ 16-45
Roll VTR ............................................. 16-35
Send Tries ............................................ 16-17
SoftMetal ............................................ 16-27
SoftMetal, cabling ............................... 16-10
SoftMetal, port .................................... 16-4
Spencer Technologies ................................... 16-24
Spencer Technologies, cabling ....................... 16-7
Spencer Technologies, port ........................... 16-4
Target Machine ............................................. 16-16
Timeout......................................................... 16-17
VDCP extra options...................................... 16-16
Vinten Robotic Camera
communication setup................................. 20-12
ethernet connection .................................... 20-10
Vinten Series 200 Control System ................. 20-20
VizRT Character Generator
  cabling ............................................................ 21-5
  communication settings ....................... 21-12
  communications.............................................. 21-8
  port ........................................................... 21-4
VTR Clip ID .................................................. 14-24, 16-44
VTR Clip Number .................................14-24, 15-22, 16-44
VTRs
  Accom APR Clipstore ............................... 14-12
  Accom APR Clipstore, cabling .................. 14-5
  Alcorn McBride DVM2 ................................ 14-12
  Alcorn McBride, cabling ............................ 14-4
  Alcorn McBride, port ..................................... 14-3
  Betacam ................................................ 14-1, 16-1
  Betacam extra options .............................. 14-9
  Betacam NAKs .............................................. 14-9
BitCentral Précis
  cabling ....................................................... 14-5
  communication settings ....................... 14-13
  port ........................................................... 14-3
BNC Setup .................................................... 14-14
clip name....................................................... 14-20
clip registers.............................................. 14-20
clip setup ....................................................... 14-20
clip timecode.............................................. 14-21
clip timecode, grab ..................................... 14-22
Communication Setup, switcher..................... 14-7
Communication Setup, VTR ........................... 14-11
communications connections........................ 14-3
custom controls......................................... 14-17
custom controls, functions.......................... 14-18
Fast Forward Video Omega ......................... 14-11
Fast Forward Video Omega, cabling ............... 14-4
Fast Forward Video Omega, port ................... 14-3
Generic, cabling .......................................... 14-6
Generic, port ............................................... 14-3
NPlay Retries............................................... 14-11
operation......................................................... 14-24
Pre-Roll.......................................................... 14-8
pre-roll, using.................................. 14-16, 16-35
queuing a clip............................................... 14-24
remote control menu .................................. 14-25
Roll VTR ....................................................... 14-16
Roll VTR and OverDrive .............................. 14-16, 16-35
supported .............................................. 14-2, 16-2
Target Machine ............................................. 14-9
Wait nFields ................................................... 14-10

W
Wait nFields, Betacam...................................... 14-10
Warranty ................................................................. 1-7
Wheatstone D-9
  settings ..................................................... 19-23
Worksheet
  custom control ............................................ 31-12
  input ...................................................... 31-2, 31-5, 31-6
  remote control .......................................... 31-8
  standard GPI input ..................................... 31-11
  standard GPI output ................................... 31-11

X
XFX card
  installing ................................................... 28-29
XFX Extra Effects
  Card installation ........................................ 28-29
  XFX Extra Effects Card .............................. 27-29

Y
Yamaha
  PM5D Audio Mixer settings....................... 19-22
Yamaha 01V96 Audio Mixer
  port .......................................................... 19-6
Yamaha 01V96 Audio Mixer settings ............. 19-19
Yamaha 02R6 Audio Mixer
  port .......................................................... 19-4
Yamaha 02R96 Audio Mixer
  wiring chart ............................................. 19-10
Yamaha 02R96 Audio Mixer settings ............. 19-20
Yamaha Control Cable .................................... 19-3
Yamaha DM2000 Audio Mixer
  port .......................................................... 19-4
  wiring chart ............................................. 19-10
Yamaha DM2000 Audio Mixer settings ............. 19-21
Yamaha M7CL-48 Audio Mixer
    settings.......................................................... 19-22
Yamaha PM5D Audio Mixer
    port ................................................................. 19-6